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Introduction 

Welcome! 

Thank You for purchasing EzStamp. Welcome to the age of computerized philately. 

Should you have any suggestions, questions, or comments please write to us at the 
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address on the front of this package. If you have any requests for enhancements 

that would be nice to have.., please let us know and we will try to incorporate any 

useful ideas into future releases. That's how EzStamp has grown to be the mature 

product that it is. 

If you like EzStamp, please tell your friends about us. Dealer inquiries are welcome. 

If you find any errors or omissions in the documentation, please let us know. We're 

here to help. 

There are many new features in this release of EzStamp. For those of you who are 

upgrading from a previous version, please read the quick start guide or the 

following section on Importing from prior versions of EzStamp. 

 

Please note our E-mail address is staff@ezstamp.com  or 

mariost22@gmail.com . It is the fastest and easiest way to get help if you need it 

(other than Reading the Manual). Our web site is located at www.stamptools.com 

or www.ezstamp.com and you can also reach us at (705) 254-6201 

We have extensive Training videos available here: 

https://www.youtube.com/user/softpro2010 

 

or here 

 

https://ezstamp.com/support/softpro-training-videos/ 

 

The marks SCOTT and SCOTT’S are Registered in the U.S. Patent and Trademark 

Office, and are trademarks of Amos Press, Inc. dba Scott Publishing Co.  No use 

may be made of these marks or of material in this publication which is reprinted 

from a copyrighted publication of Amos Press, Inc., without the  express written 

permission of Amos Press, Inc., dba Scott Publishing Co., Sidney, Ohio. 

 

 

 

EzStamp For Windows is owned by SoftPro 2001.  

Unauthorized Use or Duplication by any means is Prohibited by 

Law. © 2011-2024 SoftPro 2001. All Rights Reserved 

  

http://www.stamptools.com/
http://www.ezstamp.com/
https://www.youtube.com/user/softpro2010
https://ezstamp.com/support/softpro-training-videos/
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System Requirements 

Operating System Support 

 

 RAM As much system memory as needed to comfortably run EzStamp 

within your installation of Windows. A minimum of 512 MB is 
required, but 2 GB or more provides the best performance 

Video EzStamp is designed to run at a minimum resolution of 1024 x 768 

pixels, with a minimum of 256 colors. Higher resolutions are 

recommended for using the secondary support windows, such as 

the Stamp List and Thumbnail Viewers. 

Disk Space Approximately 375 MB of hard disk space is required for the USA 
Edition. An additional 500 MB of disk space to copy images to your 
hard drive (this is optional but recommended). Up to 25 GB of disk 

space is required to copy all 717,000+ images from the World 
Edition of EzStamp (currently only available as a Download). 

CD/DVD World Edition installations are Downloads only. Others can be 
provided on CD/DVD & a CD/DVD drive is required for installation. 

Third Party 
Software 

Adobe Acrobat reader or a compatible PDF document viewer is 

required to view the printable version of the manual. FREE 

Software downloads are available from www.adobe.com  

Additional An online connection to the Internet is required to access the Free 
updates feature of EzStamp. An Internet browser is required to use 
the eLook™ feature. EzStamp makes use of Microsoft database 

technology to store country data and EzStamp configuration 
settings. This software is installed by the EzSetup application to the 

EzStamp installation path. 

Printer A Windows compatible printer and associated driver software must 

be installed on your system to print reports. EzStamp can print 
reports in color with images, if your printer supports color output. 

Microsoft 
.NET 
Framework 

EzStamp was built using the Microsoft .NET Framework, version 
2.0. Your installation of Windows must have at least version 2.0 of 
the framework installed (Vista and Windows 7/8/10/11 generally 

have this installed by default). EzStamp is compatible with higher 
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versions (3.x and 4.x) of the framework. Free downloads of the 

framework can be found on the Microsoft website at 
www.microsoft.com 

Additional Online Help 
 

Our website will be regularly updated with the latest information about updates, 

additional modules and databases and other pertinent information. 

We will be providing online video tutorials to guide you through the different tasks 

in EzStamp from how to backup and restore, how to add your own images and 

varieties and may other topics. 

 

We also have the Quick Start Guide available on our site at 

 

http://www.ezstamp.com/ezstamp/QT/Ez8_QSG.pdf 

 
This guide describes the basic functions and features what you will use on a regular 

basis and gives you an overview of some important features. 

 

We also maintain a FAQ (Frequently Asked Questions) page on our site. 

The Tips of the Day feature can be accessed anytime from the Help menu in 

EzStamp. 
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Support, Questions and Comments 
 

Technical Support: Many of the most commonly asked questions about our products 

are available on our website in the FAQ (Frequently Asked Questions) or Support 

pages at www.ezstamp.com . If you still have questions after having read the 

product manuals, guides or on-line help, please contact us.  We welcome any 

questions, comments or suggestions you may have about our products. Customer 

service and prompt attention to your needs is a priority at SoftPro. 

Telephone / Fax              705-254-6201        

Mailing Address    SoftPro 2010 Inc.  

     118 Palomino Dr.  

     Sault Ste. Marie, Ontario  

     Canada  P6A 0B2   

 

Questions / Support   techsupport@ezstamp.com  or  staff@ezstamp.com  

Priority Remote Support 

We are also pleased to offer Priority Remote Support to our customers so that 

we can Securely Remote into your PC & assist you in solving problems or questions 

you may have. This can also be used as a training session to demonstrate how to 

perform certain functions or simply if you would like us to use our expertise to train 

you to use our software more effectively.  

Here's how it works.   

• Contact us and ask for Priority Remote Support. We will set up a time , 
usually right away. You MUST have internet access to use this service. Once 

the Remote Control Software is installed on your PC, you will be provided 
with a user ID & password for this session. We will need these codes to 
initiate the session 

• We will contact you via phone or email, & then we will take control of your PC 
to solve issues or demonstrate what you need help with. You will be able to 

watch everything we do and ask any questions that you may have. You can 
close the connection at any time.  

• Is this safe and secure?   Absolutely. The entire connection is encrypted and 

safe and used by large corporations worldwide.  

• To initiate a Priority Remote Support session, please call us at  

705-254-6201        or email us at   techsupport@ezstamp.com 

• Once initialized, you will see a partner ID & a password ( auto generated ).  

We need these codes to initiate the session http://get.teamviewer.com/SoftPro 
Click on the above link to begin after you have contacted us  

http://get.teamviewer.com/SoftPro


EzStamp Reference – Version 8.0 

Page | 25 
 

EzSetup – Installing or Removing EzStamp 
EzStamp is provided on one or more CD, DVD or BD discs. Unless the disc is purely 

for image files, it will come with an installation program named EzSetup.exe. Trial 

and downloadable versions of EzStamp will contain this application as part of a self-

extracting archive, which can be found in the location you chose to extract the files 

to. 

Trial Versions and EzStamp Activation 

EzStamp is provided as a trial (demo) version and a release version. Trial version 

setup is functionally identical to the release setup. In fact the setup programs are 

identical. The only difference is in the setup package file which EzSetup references. 

Once you install a trial version of EzStamp, you can convert it to a release version 

with an activation code. However, EzSetup should always be used to install the 

necessary application files, as it can automatically detect what files need to be 

updated/installed based on the setup package contents. 

Cumulative Installations 

EzSetup has the ability (which is the default installation setting) to update an 

existing installation of EzStamp on your system. For example, if you have 2 discs, 

one for Canada and one for USA, each disc’s setup package will contain all the core 

application files for EzStamp, plus country files for Canada (on the Canada disc) and 

USA (on the USA disc). Each installation disc will contain all EzStamp core files. 

Country files are specific to each disc however. When EzSetup installs core files 

from the disc, it will detect what version of each file is currently installed on your 

system, and only install or replace any files which are newer. 

Country Update vs. New Install 

When choosing a country file to install, EzSetup will check if that country is 

currently installed on your system. If the country data on the installation disc is 

newer than what is currently provided, EzSetup will place an update file (i.e. 

Canada.upc) into the Setup folder of your EzStamp installation path. This 

represents pre-supplied data/pricing information and will be applied to your country 

file(s) the next time you run EzStamp. If EzSetup detects that your country file is 

already up to date, no new information will be installed for that country. If the 

country file doesn’t exist, EzSetup will install a new SDF file into the DB folder 

where EzStamp is installed. 
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Running EzSetup 

To start EzSetup, simply run the EXE directly from the disc (or from the self-

extraction location for downloadable installation packages). A multi-step setup 

wizard will be provided. Simply follow the on-screen instructions and click the Next 

button as needed until you reach the option to click on an Install button. Use the 

Previous button to step backwards in the setup wizard. Click Cancel to close 

EzSetup. When the installation is completed, you will see a final window with two 

checkbox options, one for placing a shortcut to EzStamp on your Windows Desktop, 

the other to view the Read Me text file. 

Most of the wizard screens are self-explanatory. However, two of them are 

described below as they offer a choice of installation options. 

Existing v8.x EzStamp Installation 

 

EzSetup will detect any existing installation of EzStamp, as long as it is based on 

version 8.x, and provide 4 setup choices. 

1. Install and Update as Needed. This is the default option and the safest, 

providing a cumulative setup of your existing installation. EzSetup will only 

install or update new files as needed and leave any existing up-to-date 

information as is. 

2. Clean EzStamp Installation. This option will remove all EzStamp core data 

files, leaving only country files intact. Only choose this option if you are sure 

you want to perform a “fresh” EzStamp installation, yet preserve any active 

country data. 
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3. Full Installation. This option will remove every EzStamp file from the 

installation path, including country files. Note: You will NOT be able to 

recover deleted files from this installation option. 

4. Remove EzStamp. This option uninstalls EzStamp from your system. 

Country File Selection 

 

Each installation disc will have one or more country files available to install. Check 

country files from the available list to install. If the country is already installed, 

EzSetup will detect if the installed version needs any supplied data/pricing updates 

from the disc. By default, EzSetup preselects every country file available. 

Installation to Existing Folders 

EzSetup will allow you to install to any existing directory on your system. If EzSetup 

detects non-EzStamp files in that directory, a warning prompt will be displayed. 

EzSetup will not remove existing files or folders, unless they conflict with any file or 

folder reserved for use exclusively by EzStamp. It’s recommended that you install 

EzStamp to the default installation path provided by the setup wizard. If you wish 

to install to another location, please make sure that the location contains only 

EzStamp v8.x files or is empty. EzSetup will not recognize installations of EzStamp 

prior to or later than version 8.x. 
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Windows Vista/Windows 7/8/10 and User Access Control (UAC) 

EzSetup and EzStamp are safe applications in the sense that they will not try and 

perform any privileged actions which would otherwise violate user access control 

policies on your system. EzSetup deploys shortcuts and files under the ownership of 

the current user logged into Windows. If you have multiple users logged into your 

PC who need to use EzStamp, you will need to create shortcuts for each additional 

user from within EzStamp. 

You should not install EzStamp into the Program Files area of Windows when using 

Vista or Windows 7. This may cause UAC issues due to restricted access rights 

defined for that area. EzSetup’s default installation path will not point to Program 

Files. Note that if an existing v8.x EzStamp installation is detected by EzSetup, the 

default installation path will automatically switch to where EzStamp is installed. 

EzStamp Activation 

A fresh installation of EzStamp will run under Trial/Demonstration mode. This will 

be indicated in the title bar of the application as “Unregistered”. You can only open 

trial versions of country files contained the DemoDB folder where EzStamp is 

installed. 

Activation is done using a 16 character activation code. There are additional 

activation codes for extra features such as SRS and the Washington Franklin 

Identifier. All activation code types are entered using a single window within 

EzStamp. Choose the EzStamp Activation option from the Help menu. 
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The activation code is entered in 4 parts of 4 characters each, as outlined in red in 

the above window sample. Enter all 16 characters (without dashes) and then click 

on the Activate button. At this point EzStamp will be registered. If the Activate 

button is grayed out, it means that the application is already registered. 

Extra features use a dropdown list with a choice of activation types. The activation 

process is the same for these codes. Just use the second Activate button for the 

selected feature. 

Both a SoftPro web URL link and email button are provided in the activation 

window. 
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EzStamp Overview 
This section summarizes the various components which make up the main EzStamp 

window. You can access this help topic from the EzStamp application by clicking on 

the Help button on the right side of the main toolbar. An example of the main 

window is shown below. 

 

Menu Bar 

The menu bar provides all of the options available within EzStamp. The shortcut 

keys associated with each menu item can be customized to use any set of shortcuts 

you need. 

 

1 The File menu contains options for opening and closing country files, 
performing backups and restorations, and various utilities such as file 

merging and supplied data updates. 

2 The Navigate menu contains options for browsing stamp records, including 

Bookmarks, Tags, and Stamp Lists to manage groups of records. 
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3 The Edit menu contains all the basic tools to manipulate the stamp record 

data, including quick mode edit features and rapid multi-entry. 

4 The Search menu contains basic search options in EzStamp including eLook™ 

and Power Search. 

5 The Reports menu contains all the report options from the previous versions 

of EzStamp, plus a few new additions. The Grand Totals reports and report 
profile customizations are also available in this menu. 

6 The Utility menu contains various options used to maintain and edit country 
file information. The menu also contains a more advanced version of the 
Search and Replace utility. 

7 The Extras menu contains additional features of EzStamp. As new special 
features are added to EzStamp, they will appear in this menu. Some of these 

features may require a specific country file to be opened, or require an 
additional activation code to be purchased. 

8 The View menu contains the options to view additional windows of 
information, such as the Thumbnail viewer or the Stamp List. These windows 
are supplementary to the main EzStamp window and can be dragged and 

resized around the main window. 

9 The Options menu contains items which allow you to customize EzStamp at 

the application or country file level. The general preferences item contains 
most of the application customization points in EzStamp. 

10 The Help menu contains items to access the context-sensitive help topics, 
tips of the day, product activation and miscellaneous features within 

EzStamp. 

 

Tool Bar 

The tool bar provides access to the most frequently used features of EzStamp. A 

shortcut buttons configuration tool is available which will allow you to assign 

additional buttons to a secondary window which can be displayed in any position 

alongside the main EzStamp window. 

 

1 The blue arrows are used to step backwards and forwards through the stamp 
records. Hold down CTRL to step to the first or last record. 

2 The number symbol button is a drop down menu which allows you to select 
the stepping method which will be used for the blue arrow buttons. By default 

stepping is in Scott number order. 

3 The green arrows are used to step through inventoried records in Scott 

number order only. 

4 The purple arrows are used to step through the contents of the active 

Navigation List. These lists can be generated from any search or report within 
EzStamp. 

5 EzStamp record drill down filter, used to find stamps quickly and easily using 
the key attributes of a stamp record. 
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6 The blue checkmark is used to add the current stamp to your inventory or 

update any changes to the current record. 

7 The red “X” icon will remove the current record from your inventory. 

8 The eraser icon will clear the current fields on screen. By default only 
inventoried or customized data is cleared (priority want/sell list data and pre-

supplied fields are not erased). To clear the entire screen of data, hold down 
CTRL while clicking the icon. 

9 Click this icon to duplicate the current Scott number as a new record. The 
bottom status bar will include new information to indicate duplicate record 
status. 

10 Click this icon to add the selected grades to the Priority Want List. Hold down 
CTRL while clicking to use the alternate method of addition. The 2 methods 

used (based on a general preference setting) will be Quick Add (no pop up 
dialog) or Normal Addition (dialog with options to select grades, set quantity 

and type to buy). You don’t have to select any grades to add the Scott 
number to the PWL – in this case the PWL entry will be indicated as “Any 
Grade”. 

11 Click this icon to add the selected grades to the Priority Sell List. As with the 
PWL, there are two modes of addition based on whether the CTRL key is held 

down while clicking on the icon. 

12 Click on this icon to provide a quick report of all pre-supplied data in Scott 

number order. Hold down CTRL to provide a report of all inventoried records 
in Scott number order. 

13 This icon will re-run the most recent search menu item chosen from the 
Search menu. 

14 This icon will re-run the most recent report menu item chosen from the 
Report menu. 

15 This icon will re-run the most recent QStats menu item chosen from the 
Report menu. 

16 Click this icon to show or hide the custom user field window. 

17 The image links icon is used to access the image links editor, allowing you to 

configure up to 5 images for each stamp record. 

18 This icon shows the thumbnail image viewer based on the current Scott 

number displayed in the main screen. 

19 This icon will only be enabled when Special Notes and Information is available 

in the pre-supplied data. When enabled, click the icon to view this 
information. 

20 If the pre-supplied data contains watermark information, click this icon to 
view the watermark images. 

21 Click this icon to export the current stamp record to AlbumGen. Hold down 

CTRL to perform a multi-export of a range of stamp records to AlbumGen. 

22 Click this icon to view the current image in the image comparison window. As 

you navigate to new stamp records, the image comparison window will retain 
the current image. 

23 This icon presents a drop down list of special characters which can be used in 
place of the shortcut key combinations which normally must be used to insert 

special symbols. 



EzStamp Reference – Version 8.0 

Page | 33 
 

24 This button allows you to save any modifications to pre-supplied stamp 

information without adding the stamp to your inventory. 

25 If you are using single image display mode to show stamp images, and you 

have more than one image link assigned to the record, this drop down item 
will appear allowing you to see alternate images. A preference option can be 
used to show up to 4 images at one time in the image preview area. 

26 Provides a quick help link to the EzStamp main application summary. 

27 This icon will present a dialog window containing summary statistics for the 
current open country file. 

 

Stamp Details 

This area of the main application window contains the basic stamp details 

information. The image preview area and the stamp details share the same 

horizontal band of the main window. You can drag the vertical separator between 

these 2 areas to reallocate the size for each area. 

 

1 To enter or retrieve a stamp, simply enter the Scott # and hit the ENTER or 
TAB key on your keyboard. If the stamp is already inventoried, the record 
will be retrieved. If not, pre-supplied stamp info will be retrieved and you 

can inventory the item. If the stamp record can’t be found based on the 
Scott #, you will be asked to inventory the record as a custom variety. 

2 If a stamp is already inventoried, a GREEN checkmark is displayed as a 
visual cue. A RED checkmark indicates that a CUSTOM catalog number was 

inventoried. A VIOLET checkmark indicates that this is a duplicated record. 

3 If you have imported a cross reference file (See Utility, Edit Catalogue # 

Formats, Import), you can enter or retrieve stamp information by the Alt Cat 
No. Simply enter the number and hit the ENTER or TAB key on your 
keyboard. There are up to 4 Alt Cat #’s available to you and each can be 
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renamed to suit your specific needs. Each ID can be relabeled for ALL 

countries or just the specific country you have open. Left Clicking on the 
Label will allow you to switch Cat #’s and rename these fields. 

4 This is the Year of issue for the stamp. Expected format is YYYY. This is a 
pre-supplied field. 

5 Enter the Month and Day of issue (mm-dd) plus the official City of issue if 
available.  (i.e.  6-29- Toronto, ON). This is a pre-supplied field. 

6 This field contains the denomination and color description for the stamp. 
EzStamp uses the format of 32c rather than 32 cents or .32c or $1 rather 
than $1.00 or One Dollar. This is important to know when you are 

performing searches by denomination. Searches by denomination must 
match the format EzStamp uses. This field can also contain other information 

such as paper color, stamp type (i.e. Type IV) or other relevant information 
about the stamp. This is a pre-supplied field. 

7 This field indicates whether the stamp is watermarked or not. If the stamp is 
watermarked, its numerical designation will be indicated. On the Tool Bar at 
the top of the screen, there is a Watermark Icon. Clicking this Icon will 

display an image of the watermark to help you identify your stamp. This is a 
pre-supplied field. This field can also contain other relevant stamp 

information. 

8 This field indicates the perforation measurements of the stamp. If a stamp 

has a compound perforation measurement (i.e. 10 x 12), this indicates that 
the TOP and  BOTTOM perforations measure 10 while the Left and Right 
sides measure 12. The perforation count is the number of perforations in a 2 

cm distance (i.e. # of perfs per 2 cm). This is a pre-supplied field. This field 
can also contain other relevant stamp information. 

9 This field will provide information regarding the Printing method (i.e. 
Lithographed, Engraved, Photogravure etc.) as well as a description of the 

stamp and or its reason for issue. Other details such as overprints, 
surcharges and other specific details may also appear here. This is a pre-
supplied field. If you have other details you wish to record about the stamp, 

you can use the Comments field (large white area below the Category field to 
enter other information about your stamps) 

10 Use this field to enter the physical location of a stamp (i.e. Book1 Pg 3). This 
field can be renamed to suit your needs. This is NOT a pre-supplied field. 

LEFT Clicking on the Label will allow you to rename the field. If you populate 
this field, you will be able to produce reports by location (i.e. all stamps in 
Book 3). 

11 This field is used to store the number of stamps that make up a full sheet 
(not a souvenir sheet or mini sheet). This is to be used for full sheets of 

stamps that have multiple copies of the same stamp on the sheet – usually 
sheets of 50 or 100. This is NOT a pre-supplied field (SoftPro may supply 

sheet sizes in the future). 

12 Enter a cross reference to another numbering system (i.e. Michel , Gibbons) 

here. Make all entries the same length (i.e. 0001 , 0100 etc) to allow for 
proper sorting. This field can be renamed to suit your needs. LEFT Clicking 
on the Label will allow you to rename the field. This is NOT a pre-supplied 

field. 
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13 This field records the size of a plate block (not the physical dimensions of the 

block, but the # of stamps making up the block). For the USA, it can vary 
anywhere from the default of 4 to 24 .This is a pre-supplied field. The default 
size is always 4. 

14 Use this field to categorize each stamp by topic or other methods. Once you 
categorize stamps, you can run searches and reports based on categories 

(i.e. Find all stamps I have categorized as Medicine or Insects). This is a pre-
populated field (i.e. an extensive category list is already supplied. You can 

add to the list at any time). Entries can also be removed from the list via the 
List Editor in the Utility Menu. 

15 This field is used to enter the # of stamps issued for this Scott #. It can be 
very useful in determining a rarity factor. If there were only 5,000 stamps 
issued versus 1,000,000, which would you rather own! We use this field to 

run a report to see which stamps were issued in the smallest quantities and 
actively purchase those stamps as they are most likely to increase in value 

the most. This is a pre-supplied field (for USA and Canada). Other databases 
will be updated with the quantity issued as time permits. 

16 You can enter any additional comments for this record, up to 4,000 
characters in length. This comment window can be vertically resized using a 
general preferences option, or can be hidden altogether when using the 

secondary comments window. 

 

Tabbed Spreadsheet Data Grids 

Depending on the country opened, and on some general preference options to show 

additional tabs of data, this area will contain spreadsheet-style data grids for the 

following stamp information: FDC Cachet Data, PNC Data, PNB Data, the Priority 

Want/Sell Lists, or Custom Fields. Click any tab to show the grid view for the 

respective information type. The fields which appear in the grid view can be 

reordered or removed from the grid altogether using the Field Filter edit utility. 

 

The grades tab is slightly different from the other grid views in that it contains 

status icons on the left side. Each icon indicates a specific state for the grade, as 

follows. 

 The grade is part of your inventory. 

 The grade is in the Priority Want List. 
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 The grade is in the Priority Sell List. 

 The grade is part of your inventory and in the PWL. 

 The grade is part of your inventory and in the PSL. 

 The grade is in both the PWL and PSL. 

 The grade is part of your inventory, in the PWL and also in the PSL. 

 

Grade Options Tool Bar 

For the grade grid tab only, a special tool bar is shown with several elements. 

 

1 This field is present so that you can override and enter a price for any single 
grade (i.e. a grade by grade basis). This is NOT your cost, but your override 
of the supplied price for any specific grade that you have selected in the 

Grades window. You MUST first select a grade by highlighting the row and 
then enter your value and click on the green $+ icon to accept your entry. 

This is NOT is a pre-supplied field 

2 This field is used to enter the quantity of the stamps you own for a specific 

grade that you have selected. The default value is 1, but you may change it 
to reflect the quantity you own. Please note that you can enter a value of 
zero (0) and still record this grade as inventoried! .This is NOT is a pre-

supplied field 

3 This field indicates the percent surcharge that will be applied to Never 

Hinged stamps. For example, if the VF Mint value is $150 and there is a 
100% surcharge listed, the value for a VF NH stamp will be $300. EzStamp 

uses values for VF Mint and VF used to derive the other values. This is a pre-
supplied field (when value is known). 

4 This is the EzStamp market value for VF Mint, VF Used, FDC, Plate Block or 
Mint Sheet stamps, depending on the grade you have selected. You may 
override this value if you choose to. Selecting any Mint Grade will display the 

VF Mint market value. Changing this value will automatically change the 
values for the other Mint Grades based on the percentages that have been 

set up by EzStamp. Selecting any Used Grade will display the VF Used 
market value. Changing this value will automatically change the values for 
the other Used Grades based on the percentages that have been set up by 

EzStamp. Also note that you can set a Price Lock on any stamp so that Price 
Updates will never alter these values! (See price lock icon at the bottom left 

portions of the Status Bar. This is a pre-supplied field. 

5 This is the same as the blue checkmark in the main application toolbar, used 

to add the record to your inventory. 

6 Use this icon to commit the data you have entered for the selected grade 

(i.e. qty, your value, dates, comments etc.). This does NOT save the record 
to disk yet. It just accepts the entries for that selected grade. You can select 
multiple grades at a time and commit them at the same time. To actually 

SAVE the record to disk, you must left click on the Save Record Icon (blue 
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checkmark) or Right Click in the Grades Area and select ADD and SAVE from 

the Pop Up Menu. 
 
A general preferences option can be enabled to allow you to auto add grades 

when you click the blue check icon to save the record. It performs the 
function of Blue Check + this button in one step. 

7 Use this icon to remove the selected grades from your data (i.e. qty, your 
value). To CLEAR ALL fields for the Grades, hold down Ctrl and Left Click on 

the $- .This does NOT remove the record from your inventory, just the 
selected grades. To remove the entire record/stamp from your inventory, 
you must click on the RED X on the Tool bar. You can select multiple grades 

at a time and deselect them at the same time. You may also deselect grades 
by selecting grades and then RIGHT clicking in the grades area and click 

Remove Selected from the popup Menu. 

8 Use this icon to bring up the single quick grade edit window. In this window 

you can edit any of the dates, prices and comments. Compare this to the 
Grades quick Editor icon which allows for editing multiple grades and the 
associated details at the same time. 

9 Use this icon to allow editing of multiple grades in a grid view editor. You can 
make changes to the data for any of the grades listed. You can clear all 

fields. Any changes you make can be undone within the CURRENT quick edit 
session. Once the window closes, changes cannot be undone. This provides a 

quick way to make multiple changes to multiple grades in one convenient 
window. An option available in the Preferences Menu allows you to auto-save 
the stamp record. Once you save the data in the Quick Edit window (click on 

the Apply Changes Icon) so that you do not have to also click on the Blue 
checkmark (Save Record Icon) in the main screen to save the stamp record. 

10 If you have selected a grade or multiple grades, you can click on the Grades 
Deselect Icon to deselect the grade. This does NOT clear any data, but just 

deselects the grades. 

 

Status Bar 

The bottom of the main EzStamp window contains a status bar with several 

elements. Not all of these elements will be visible, depending on what the current 

country opened is, the state of the current record, or any special background tasks 

running. 

 

1 This is the current record status. See below for a list of all status types. 

2 If SRS batch mode is running, this icon will appear. When SRS batch mode is 

completed, this icon will change from red to green. 

3 If you enforce pricing locks on a stamp record, this icon will be enabled. Price 

locks prevent EzStamp from applying price changes when new pricing 
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information becomes available. 

4 If duplicate stamp records are created on the same Scott number, this status 
area will indicate the current and total number of duplicate records. 

5 Use these arrows to navigate between the duplicate records. Note that by 
default the green arrows will navigate the duplicate records as well. These 

supplementary arrows are useful when you disable duplicate record stepping 
on the green arrows. 

6 The total quantity of stamp grades inventoried on this record. 

7 The total value of the inventoried grades. This does not include FDC, PNB or 
PNC data. 

8 If a navigation list is active, this status indicates the current and total number 
of records in the list. 

9 The area to the right is used for help hint messages and also for progress 
status on background tasks being performed. 

 

Stamp Record Status Indicator 

The bottom left icon in the main EzStamp window contains a status icon for the 

current stamp record. 

 There is no country file opened, or no current stamp record shown in the 
main window. 

 EzStamp is busy performing a background task and can’t be interrupted. 

 The record is pre-supplied data and has not been added to your inventory. 

 The record is part of your inventory and is based on pre-supplied data. 

 The record is part of your inventory and is a custom variety or part of a 

custom country file. 

 The record is one of two or more duplicate Scott numbers. 

 

Context Sensitive Popup Menus 

The following areas on the main window have special popup menus by right or left 

clicking within the area or on a specific label. 

• Right click within the data grids in the bottom tabbed area to show specific 

options related to the grid type (i.e. right clicking within Grades will give you 

grade-specific options). 

• Left click the X-Ref, Location or Alternate Catalog ID labels for customization 

options. 
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Support Windows 
You can display additional secondary windows which support information contained 

in the main EzStamp window. These secondary windows are displayed (or hidden) 

by selecting options from the View menu. Some of these items are popup dialog 

windows, which must be closed before the main window can be accessed. Other 

window types can be sized and positioned around the main window, and will remain 

on your screen until you close or hide them. When the latter types of windows are 

visible, a small checkmark icon will appear to the left of the menu item name. 

 

1 The thumbnail viewer provides a grid of images which can be resized and 
configured to contain up to 140 stamp images on screen at one time. There 

are 4 methods for displaying the images. 

2 The special information window is only available for specific Scott numbers 

and specific country files – it’s not available for custom countries or custom 
stamp varieties. This will include such things as differences between Types, 
special identification features, re-engravings, etc. Special information for a 

country can be expanded to include more stamp records in future supplied 
data updates. 

3 This option will show a small window which allows you to cycle through all the 
watermark images for the open country file. 

4 The image comparison window displays stamp images in a separate window 
from the main EzStamp image area, allowing you to compare two similar 

stamps on screen at the same time. 

5 Custom fields are extensions you can make to any country file, to save 

additional data for stamp records. 

6 EzStamp provides a small area below the stamp details area for comments. 
You can disable this area and opt for a sizeable window for holding the stamp 

comments. 
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7 Custom fields can include image link field types. You can display these 

secondary images in a separate window, which is what this item is for. 

8 If you would like to extend the toolbar button commands to a secondary 

window, this would be the one to use. Many of the options in the main 
EzStamp menu can be attached to a shortcut button window for convenient 
access. 

9 The Stamp List viewer is a small data grid viewer for stamp records. You can 
use this viewer as a mini-browser for stamp records obtained from 

bookmarks, tag lists, searches and reports. 

10 The global search window provides a spreadsheet view of all the stamp 

records found using a Global Search within the various Searches and Reports 
in EzStamp. 

11 The data grids at the bottom of the EzStamp window can contain many fields 
of information, which can result in frequent horizontal scrolling to see the 

fields of interest to you. You can display the vertical view window to show one 
record of data from selected rows in the data grids in a top-down manner, 
allowing you to see most, if not all of the field data at one time. 

12 The vertical data image preview is actually a secondary image viewer which 
shows the image link attached to the selected PNC/PNB Plate Number or FDC 

Cachet Number (Image links of these types can’t be shown in the main 
EzStamp image area). 

 

Thumbnail Viewer 

The thumbnail viewer provides a convenient grid of stamp images. The grid is 

displayed using one of 4 display methods: 

• Scott Order: The default display method will show images in Scott number 

order, starting with the current Scott/Catalog number shown on the main 

screen. 

• Scott Order (Main Varieties): Only stamp records which are identified to 

be a main variety will be displayed on the viewer. 

• Alternate Catalog ID: Only stamp records which are inventoried based on 

the current catalog ID will be displayed. There are 4 alternate ID types which 

you can associate with stamp records. Only one of them can be chosen for 

display in the main EzStamp window at a time. The thumbnail viewer will be 

based on the current type in the main window. 

• Navigation List: You build navigation lists generally from searches and 

reports. You can show all the stamp images which are part of the active list. 
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An example of the viewer window is shown below: 

 

The number of rows and columns can be configured from the EzStamp general 

preferences. Up to 14 columns and 10 rows can be used. The window itself can be 

resized. Once you release the mouse button when dragging the window to a new 

size, all of the stamp images will be adjusted to fill the new dimensions, while 

maintain the proper image proportions. 

The bottom of the window shows basic summary information for the selected 

stamp. If you move the mouse over any stamp in the grid, the information will 

change accordingly. You can “lock” a stamp record and display it in the main 

EzStamp window by simply clicking an image. A selection rectangle will appear 

around the image you clicked on. 

If you wish to lock an image in the viewer but NOT change the stamp record in the 

main window, right-click the image. 

To close the viewer and select a stamp for the main window at the same time, 

either double-click an image, or select the image, then click on the show (“S”) icon 

at the bottom right of the viewer window. 

To navigate pages of images, use the up and down arrow icons, or press the cursor 

up or down arrows on the keyboard (Note: keyboard shortcuts for thumb viewer 

navigation only work when the viewer is the “active” window in EzStamp). 



EzStamp Reference – Version 8.0 

Page | 42 
 

To move the selection rectangle along the current page of images, use the left and 

right arrow keys on the keyboard. 

To move to the first or last page of images, use the left and right arrow icons, or 

press the Home or End keys on the keyboard. 

Clicking the preferences icon (hammer and screwdriver) will display the preferences 

tab for thumbnail viewer customizations. 

Missing and Alternate Images 

The viewer will show the primary stamp image by default. You can change which 

image (1 to 4, or the FDC image) using a general preference option. If the 

secondary image is not available, EzStamp will default back the primary image for 

the stamp. 

When images are not available for a given Scott/Catalog number, the position in 

the grid will be shown as a blank square. 

Image Display Speed 

EzStamp will build each page of images one stamp at a time. As the image page is 

building, you can do other things in EzStamp, or even close the viewer while the 

images are being painted. 

The time to display a page of images depends on a few things: 

• If the images are being accessed from CD/DVD disc (hard drive image folders 

are significantly faster). 

• The image display quality (a low quality setting will result in faster 

rendering). 

• The performance level of your PC. 

Single Row Mode 

You can right click any area in the information pane of the thumb viewer window to 

collapse the viewer into a single row of stamp records. To restore the original 

number of rows, simply right click on the information pane a second time.  
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Image Comparison 

This option displays a stamp image in a secondary window which can be sized and 

positioned independent of the main EzStamp window. An example of this window is 

shown below. 

 

The comparison window has a few toolbar options available. 

The number buttons display the first (primary), second, third, and fourth images. 

The “F” button displays the FDC image. The title bar of the compare window will 

show which of these images is active. The Scott and Alternate catalog numbers are 

also shown in the title bar. The image compare represents the stamp record which 

the image is associated with, not necessarily the one currently visible in the main 

EzStamp window. 

The swap button (black/white arrows) will exchange the stamp record in the image 

compare with the one in the main screen. For example if the image in the compare 

window is Scott #573 and the one in the main window is #571, then clicking the 

swap icon will place the image for Scott #571 into the compare window, and the 

main EzStamp window will show the stamp details for Scott #573. 

The 1:1 button switches the image view from 100% (i.e. 1:1) mode and fit to 

window (scale the image down, if needed, to fit it completely within the current size 

of the image comparison window). 

The magnifier button will display a second floating window called the "Magnifier". 

This displays a portion of the original image zoomed in to a specific level. By 

moving the mouse around the main comparison image, the magnifier will zoom in 
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on the area where the mouse point is currently positioned. You can hold down the 

mouse button while moving to drag the main image around instead of using the 

scroll bars. This drag-scrolling feature is not enabled unless viewing the image at 

100% size with scroll bars present. 

Click on the white zoom level label to see a popup menu with zoom factor choices 

from 100 to 600 percent. 

These windows can be dragged to any size and position and EzStamp will 

remember this when you close the application. 

Note that the magnifier window automatically closes when you minimize the 

application, or when you close the image comparison window. Clicking on the 

magnifier button a second time will also close the window. 

 

Custom Fields 

You can choose to show custom fields as a secondary window which can be resized 

and dragged alongside the main window, and/or place the fields as a data grid tab 

in the main window using a general preferences option. An example screen of each 

type is shown below. For details on defining custom fields, refer to the editor in the 

Utilities help section. 

Secondary Custom Fields Window 

 

You can resize this window as small or as large as needed. If the window is smaller 

than the number of fields, scroll bars will automatically appear. 
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Main Window Data Grid Tab 

 

To show the secondary window, use the Custom Fields Window option under the 

View menu. 

Comments 

Comments can be shown as a small window between the stamp details area and 

the data grid tabs. This area can be resized to one of several values based on a 

percentage of the main window screen height (from 10 to 30%), or it can be turned 

off completely. You can display the comments in a secondary window using the 

Comments Windows option from the View menu. 

Custom Field Image Preview 

If you have defined a custom field as an image link data type, you can see a 

preview of the image by CTRL + Clicking the ellipsis (…) button to the right of the 

image link field in the custom fields window (normal single clicking provides a 

browser window to locate an image file). 

If you are using the custom fields data grid view in the main EzStamp window, you 

can show the image by simply selecting the image field in the grid. If the custom 

image preview window isn’t displayed, you can enable this from the View menu or 

by right clicking in the data grid and choosing the show option from the popup 

menu. 

Custom images retain their current image until you decide to preview another 

image, even if you change to another stamp or close the country file. 

Command Shortcuts 

If you have created custom shortcuts for the EzStamp main menu commands, you 

can show this customized button window by choosing the Command Shortcuts 

option from the View menu. 
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This window can be positioned or resized as needed. There is a minimum allowable 

size for this window; however there is no restriction on how large or how many 

buttons you want to put on it. As you resize the window, the buttons will 

automatically rearrange themselves to fit the window width.  

If you hover the mouse cursor over a button, its help hint message will appear in 

the status bar at the bottom. The title bar shows the current button set you are 

using, and the total number of buttons active in this set. 

To change to a different button set, click one of the numbered buttons at the 

bottom. You can use up to 5 different sets of shortcuts. If you want to swap to 

additional shortcut button configurations, or edit the current button sets, click on 

the edit icon at the bottom right. Refer to the shortcut button editor help for more 

details on customizing the buttons for this window. 

Stamp List Viewer 

The Stamp List is a small mini-browser for stamp records, which can be positioned 

and resized as needed. The viewer can be displayed using the Stamp List option 

from the View menu. 
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This browser operates independent of other activities within EzStamp. Think of it as 

a separate mini-application which can browse the current open country file. If you 

make changes within the main EzStamp window, they will not necessarily be 

updated to the browser (record changes are picked up, record deletions will 

generally not be updated). 
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The stamp list is managed exclusively using the options in its toolbar. 

 

1. Add the current stamp in the main EzStamp window to the end of the 

stamp list. 

2. Remove selected entries from the stamp list. This option does NOT remove 

the records from your inventory. 

3. Erase the contents of the stamp list. 

4. Transfer the active navigation list to the stamp list. Since searches and 

reports can send the stamp records directly to a navigation list, this feature 

is convenient method to get report results into the stamp list. 

5. Transfer the stamp list to the navigation list. Since a navigation list can be 

sent to the report viewer using any report profile of your choosing, this is a 

convenient way to get stamp list reports. 

6. Transfer a tag list to the stamp list. Tag lists are the primary bookmarking 

method in the main EzStamp window. You can tag stamps as needed and 

then transfer them to the stamp list to review what you have tagged. 

7. Export the stamp list to a navigation list file. This provides a way for you to 

make a permanent copy of a stamp list which can be recalled at any time. 

8. Edit the fields to show in the Stamp List window. This option uses the 

report profile field editor to allow for customization of which fields to show 

in the stamp list data grid. You can’t display secondary field information 

(i.e. PNB or FDC Cachet data), but you can choose from most of the 

primary stamp details fields. 

9. Refresh any changes from EzStamp. As mentioned at the start of this topic, 

the Stamp List window maintains an independent link to your stamp 

records. Most of the time, these changes can be updated to the stamp list 

automatically. However, you can make changes from within the report 

viewer in EzStamp, and not all changes from that window can be 

automatically refreshed back to the stamp list. Use this option to update 

any changes which did not automatically update. 

10. This option shows or hides a small image preview window on the left side 

of the viewer for the current selected stamp’s image. 

 

 



EzStamp Reference – Version 8.0 

Page | 49 
 

Vertical Data Viewer 

This window shows a vertical presentation format for the current selected data 

record in one of the Grades, PNB, PNC or FDC Cachet data records in the main 

EzStamp window. The choice of which data is displayed is based on which data grid 

is currently visible in the main window. The window can be displayed using the 

Vertical Data Viewer option under the View menu. 

 

The window is a very simple design. It shows the same fields as in the main data 

grid, but oriented using a top down list. You can resize this window to show as 

many fields as needed. As you select new rows in the main window data grid, this 

view will always be updated at the same time to show the selected row’s field data. 

You can edit the data by double clicking anywhere within the vertical field list. 

If you select any FDC/PNC/PNB record which has an active image link field, this 

image will be shown in the vertical image preview window, if it’s displayed. 
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Vertical Data Image Preview 

This image preview window is specifically provided to show the image links for PNC, 

PNB and FDC Cachet records. It can be enabled using the Vertical Data Image 

Preview option from the View menu. 

 

This window has a few toolbar options: 

• Link a new image. 

• Erase the current image link. 

• Paste an image from the Windows clipboard. 

• The 1:1 button switches the image view from 100% (i.e. 1:1) mode and fit to 

window (scale the image down, if needed, to fit it completely within the 

current size of the image comparison window). 

• The magnifier button will display a second floating window called the 

"Magnifier".  

This displays a portion of the original image zoomed in to a specific level. By 

moving the mouse around the main preview image, the magnifier will zoom in 

on the area where the mouse point is currently positioned. You can hold down 
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the mouse button while moving to drag the main image around instead of using 

the scroll bars. This drag-scrolling feature is not enabled unless viewing the 

image at 100% size with scroll bars present. 

Click on the white zoom level label to see a popup menu with zoom factor 

choices from 100 to 600 percent. 

These windows can be dragged to any size and position and EzStamp will 

remember this when you close the application. 

Note that the magnifier window automatically closes when you minimize the 

application, or when you close the preview window. Clicking on the magnifier 

button a second time will also close the window. 
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Working with Country Files 
EzStamp uses a single database file to store each country. These files are located in 

the DB folder in the EzStamp installation file and have an extension of .SDF. 

Country files supplied by SoftPro will contain pre-supplied stamp information, and 

will need to be initialized for first-time use. When opening a country file for the first 

time, you will be asked to confirm a one-time configuration of the file. This task is 

relatively quick and is required before you can use the file. 

Trial (Demo) and Release Country Files 

Trial versions of EzStamp can only work with demonstration versions of country 

files. A trial country has a limited activation period (approximately 30 days) and will 

only contain a limited subset of pre-supplied stamp information and images. In 

addition, some of the more advanced features of EzStamp will not be available with 

the trial version. 

Once you register EzStamp, release versions of country files can now be used. 

However, trial versions will no longer function with a registered EzStamp. Trial 

country files can’t work with a registered EzStamp and registered versions of 

EzStamp can’t open trial country files. 

Converting a Trial Country to Release 

If you have inventoried information into a trial country file and wish to import this 

into a Release version, you can do so using the Secure Export feature. Simply open 

a trial country BEFORE you enter an activation code for EzStamp. Then choose the 

Secure Export option to save all your inventoried data to a ZIP archive file. After 

activating EzStamp, open the release version of the same country file as the trial 

version. Then use the Secure Import option to load of the trial data into the country 

file. Note: You will NOT be able to export the data after activating EzStamp, since a 

demo country can’t be opened with the release version of the application. 

Opening a Country File 

There are a few ways in which to open a country file: 

• Choose Open from the File menu. This will provide a standard Windows file 

open dialog pointing to the DB folder (or DemoDB for the trial version of 

EzStamp). Select any SDF file from the list and click the Open button. 

• Use the Open with List option from the File menu to show a window with a 

list of country files, their country names (country identity of origin) and their 

descriptions. This window will also show the current build version of the 

country as well as an image of the country’s flag. 

• Use the Recent Files Open submenu to access the most recent countries 

opened. EzStamp maintains a list of the last 4 country files opened. 
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• Enable a general preference option to automatically open the country file 

which was previously opened when you closed the EzStamp application. 

Automatic Backup and Restoration 

A general preference option determines if EzStamp will automatically create a 

backup of your country file if it can be successfully opened. EzStamp will make a 

100% copy of the SDF file in the Backup folder. 

If for any reason a country file could not be opened, EzStamp will attempt to 

automatically restore the previous backup copy if it’s available. 

EzStamp Country File Browser 

The Open with List option along with many other functions in EzStamp which 

require selection of country files will share a common browser window. 

 

The list shows the country of origin (Country Name), description, file name, and 

build version. All current country files are on version 1.2 of the file format. 

The action button to the left of the Exit button will vary depending on the EzStamp 

option you select (the example screen is for Compacting a country file). 

The 5 buttons on the left are shared for all options which use this browser. 



EzStamp Reference – Version 8.0 

Page | 54 
 

Click Hide to turn off visibility for all selected country files in the list. They will 

remain hidden until you click on the Show All button, which will make all country 

files visible. 

Click on Properties to see statistical information for the selected country. 

Use Select All to select every country file in the list. 

The Initialize button will apply a first-time initialization to all selected countries. 

Note that opening any country file in the main EzStamp window will also perform 

this function automatically for you. The Initialize button is primarily intended for 

those users with many country files for which initialization can be accommodate for 

all files with a single click. Note that initialization for dozens of countries can take 

several minutes to complete. 

Double clicking any row in the list can be used as a shortcut only to Open a country 

file. 

A country which has never been opened at least one time will show un-initialized in 

the list. Until you open the file, EzStamp will not show any details about the country 

in the list. 

Closing a Country 

To close a country, you can choose the Close option from the File menu. However, 

a country file will automatically be closed when you open another country, and also 

when you close the EzStamp application. 

Version Upgrades 

From time to time, EzStamp will contain enhancements to the structure of a 

country file. This necessitates increasing the version number of the country file to 

ensure that EzStamp has the correct enhancements applied to a file before working 

with it. 

If you receive a notification prompting you to upgrade the country file version, you 

will use the Country File list dialog for this. The normal location for the Open button 

will be replaced by an Upgrade button. This will apply a version upgrade to each 

country file selected. Only those countries selected which have a version update 

requirement will be affected. 

Creating a New Country 

If you want to create a new country, use the New option from the File menu. 
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Data File Name This is the actual file name the country will be created as. 

The .SDF extension is not required to be entered here. 

EzStamp will default the country file name if you choose a 

country reference from the dropdown list. You will not be 

allowed to create a country file if the name is already in 

use. 

Country Reference All custom and pre-supplied countries are provided in this 

dropdown list. You can choose any of them from the list, or 

create a custom country reference by simply entering a new 

text value in the dropdown field. 

Description The description is pre-populated when choosing a country 

reference from the dropdown list. To enter a new 

description, enter any text value of your choosing. 

Currency Factor The default currency conversion rate is 1.0, which means 

the country defaults to U.S. Dollar (USD) currency values, 

which is how pre-supplied country prices are provided. If 

you set a new conversion rate, EzStamp will automatically 

adjust prices and values as needed on screen and in printed 

reports. Internally, the currency is always stored in U.S. 

dollars. 

Currency Decimals The number of decimal places for the fractional part of the 

currency value. The default value is 2, which corresponds to 
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cents in U.S. dollars. 

Currency Symbol The currency symbol is an arbitrary text value, which can 

be placed to the left or right of the currency value. The 

default value is the U.S. currency dollar ($) symbol, and is 

placed to the left. You can use more than one character for 

the symbol and it can include spaces. 

Enable PNB Data Check this option to enable Plate Number Block data for the 

country. 

Enable PNC Data Check this option to enable Plate Number Coil data for the 

country. 

Enable FDC Data Check this option to enable FDC Cachet data for the 

country. 

Include in Grand 

Totals 

Check this option to include this country in the grand totals 

reports. If not checked, EzStamp will exclude it from the 

report. 

Use NH Surcharge 

Ratios 

For never hinged grades, this option determines if NH 

surcharges are applied to the base price of the grade. 

Use Auto-

calculations 

For any grades which are derived from another grade (i.e. 

MH-XF is derived from MH-VF prices) this option enables 

automatic re-pricing based on the calculation multiplier 

value associated with the grade configuration. 

Use NH Percent 

Surcharges 

Each stamp can have a never hinged percentage 

adjustment value. If you check this option, then all never 

hinged grades will be re-priced based on the NH percentage 

value. 

Default Master 

Grade List 

EzStamp comes pre-supplied with a master grade list, 

containing all of the current grades common to most 

countries. If you want to create a new country using a 

custom grade list, uncheck this option then click on the 

Grades button. You will need to provide a grades export file 

(.GRD extension), which is created using the grade 

configuration editor in the Utility menu. The grades which 

will be added to the country file are shown in the list at the 

bottom of the window. 
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Country Labels 

Click the Labels button to define custom labels for the 4 alternate catalog ID 

values, location, and cross reference fields. EzStamp will assign default label text 

for you should you choose not to customize them. 

Custom Grades 

If you want to use a different grade list than the default provided, uncheck the 

default grades option and click the Grades button. You will need to export a 

custom grade configuration to a grade (.GRD) file to use for the list. 

Custom Country Creation 

If you enter a Country reference which isn’t in the current dropdown list of available 

supplied/custom countries, then a second window will be displayed, requesting 

additional information before the file can be created. 

 

This window provides the basic information needed to register a new country type 

with EzStamp. The identity doesn’t have to be a physical country per se; any type 

of naming convention of your choice will work. 

The data directory name uniquely identifies the country, and determines the folder 

name for custom images. 

The upper case and mixed case names are usually the same. 

The flag/image dropdown list contains all files installed under the Images\~~Flags 

subfolders in the EzStamp installation path. If you intend to create custom flag 

images, you need to adhere to the proper dimensions for the small (80 pixels width 

by 50 pixels tall) and large (176 x 110) files. Each file must have the same name, 

and be located in their respective Small/Large subfolders. 
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You can enter a custom eBay and StampWants category for use with the eLook™ 

search feature of EzStamp. 

Once a country file is created, you can open it in EzStamp. The file will not have 

any stamp information in it. As a custom country format, you are responsible for 

populating the data. If you want to make use of pre-supplied country information in 

a new country file, you can use the duplicate or merge utilities. 

Importing Data from Prior Versions of EzStamp 

If you have a previous version of EzStamp with the 64-bit export capability, you 

can export all of your inventoried data to a special ZIP format archive file. Use the 

Import from Prior EzStamp option from the File menu to populate the data into an 

existing country file. 
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Import File This is the ZIP archive which you exported from the 

previous version of EzStamp. You will need to browse for a 

file before the import dialog window appears. 

Source Data File If pre-supplied data is to be included in the file, the source 

data file indicates the pre-supplied file which will be used as 

the data source. 

Country Reference This identifies the country of origin for the exported data. 

The country file you import to must also be associated with 

this country reference. 

New Description If you want to customize the description for this country, 

enter a new value in this field. 

Import To The drop down list will contain all registered country files 

with the same country reference as the import file. For 

example, if you exported from Canada, then only country 

files which are based on Canada will appear in the drop 

down list. You can enter a new file name here instead of a 

dropdown list name. 

Replace with 

Supplied Prices 

Check this option to replace all your inventoried prices with 

the latest pre-supplied pricing. If you don’t check this 

option, the pricing as it was in the previous version of 

EzStamp will be kept. 

Excluding Supplied 

Data 

Check this option, and EzStamp will discard all pre-supplied 

stamp information. This will in effect create a custom 

country. 
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Secure Import and Export 

This is available from the Export and Import option under the File menu. A secure 

export is a special encrypted portable ZIP archive of your inventoried stamp 

information. It’s not intended to be used as a replacement for the normal backup 

facility in EzStamp. Secure data exports are designed to take a snapshot of your 

country data for troubleshooting or data transfers between multiple systems. The 

ZIP archive will be much smaller than the SDF file equivalent. 

 

For any open country file, simply enter the name of a file and click the Begin 

button. The files are saved to the Export folder in the EzStamp application path. 

 

For importing the data back into the country file, use the Browse button to locate 

an export file (default location will be the Export folder), then click the Begin 
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button. Note that EzStamp will close the country file before importing, as the file 

can’t be opened during the restoration process. 

Country File Settings 

This option in the File menu allows you to change some basic settings for the 

current open country file. 

 

You can change the same basic information which is available when creating a new 

country. Refer to the documentation topic for Creating a New Country for details on 

the various settings in this window. 

You can change the data file name as long as it’s not in use by any other country 

file. 

Note that disabling the PNC, FDC, or PNB options will automatically remove the 

associated data grid tabs in the main EzStamp window. 

Changing the currency conversion factor, multiplier or surcharge options will 

automatically result in price and value recalculations for the country file when you 

close the dialog window. 
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Country File Properties 

This option is available in the File menu and also by clicking the Info icon in the 

top right corner of the EzStamp main window. It will display basic summary 

statistics for the current open country file. 
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Country File Utilities 
This submenu under the File menu contains several important options for 

maintaining and supporting the data contained in your country files. Some of these 

options require a country file to be opened, and others will prompt you to close the 

country file for proceeding. 

Supplied Data and Pricing Updates 

When SoftPro issues supplied data and pricing updates for country files, they are 

provided as special files which are transparently applied to the read-only pre-

supplied repository inside the country file.  

Consider a country file as consisting of two parts: 

• Part A is a read-only copy of all pre-supplied stamp information and prices. 

This is how new country files are provided on the original EzStamp CD/DVD 

media. 

• Part B is a copy of all of the same information as in Part A, PLUS any 

additional inventoried information you add. Almost all of the pre-supplied 

information, including prices, can be modified, and this is all saved in the 

second part of the file. 

When supplied updates are applied to a country file, EzStamp will only make the 

updates to the read-only copy (Part A) of the file. Your inventoried data and the 

modifiable pre-supplied data (Part B) are left intact. 

EzUpdate and Supplied Data Updates 

The EzUpdate application is used to apply supplied pricing and data updates to 

EzStamp. The application itself doesn’t have any functionality to work with country 

files – that capability is exclusive to EzStamp. What EzUpdate does is place country 

update files into the EzStamp application path, to prepare them for import the next 

time your run EzStamp. 

When EzStamp starts with pending updates (there can be multiple country files 

pending, EzStamp will handle all of them in order), you will see a small dialog 

window appear, which you will not be able to cancel (but you can click STOP and 

the process will stop AFTER the current file has been updated). 
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EzStamp will apply updates to every country file which has pre-supplied data 

attached to it, even if the country is duplicated into more than one file. Once this 

process is completed, a summary dialog window will appear. 

 

This dialog indicates which country files had supplied data updates applied. At this 

point, your inventoried data has NOT been affected, nor have any customizations 

you’ve made to pre-supplied records been touched. Only the read-only pre-supplied 

data repository in the country file has been updated. 

EzStamp and Supplied Data Effective Dates 

Each supplied data update has an effective date assigned to it. When you open a 

country file which has had a supplied data update applied to it, EzStamp will check 

the current data’s effective date to see if new updates have been applied to the 

read-only copy of the stamp information. If a newer date is detected, a small 

warning dialog will appear: 



EzStamp Reference – Version 8.0 

Page | 65 
 

 

You can choose to ignore this dialog, cancel, or apply the update. Clicking Ignore 

turns off the nag dialog for this country – you will not get nagged again for this 

update. Clicking Cancel will skip the update process, however you will once more 

be nagged with this dialog the next time you open the country. If you click Apply, 

the supplied data and pricing update window will be shown. This is the same as 

choosing the similar named option from the Country Date File Utilities submenu. 

The Batch Update option will take you to a supplied update window where you can 

apply updated for multiple country files at one time. 

 

The top of the window shows the current pre-supplied effective date of your copy of 

the stamp data, and the effective date of the read-only copy of the same data. If 

your data is up-to-date, only one date will be shown – you can still re-apply the 

update, even if it’s not needed. 

The checkbox options allow you to choose what pre-supplied data to update.  
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Pre-Supplied Prices Mint, Used, FDC, Mint Sheet, Plate Block Mint, Plate Block 

Used, Line Pair Mint and Line Pair used prices are updated. 

Primary Stamp 

Attributes 

Denomination and Color, Notes, Watermark, Year Issued, 

Date of Issue, Plate Block Size, Mint Sheet Size, Quantity 

Issued, Never Hinged Percentage. 

Image Links and 

Sizes 

Your custom image links are replaced with the pre-supplied 

image links. If EzStamp doesn’t provide an image link, your 

custom links will be left intact. Image sizes are provided for 

AlbumGen data exports. 

PNB and PNC Data All pre-supplied plate numbers and pre-supplied notes are 

updated. Any inventoried attributes or custom plate 

numbers are left intact. 

PNB and PNC Prices For pre-supplied plate numbers, the VF-H and VF-NH prices 

are updated for plate number blocks and the Strip of 1, 3, 

and 5 prices are updated for plate number coils. 

Zero Price and Blank Data in Pre-Supplied Data 

If SoftPro doesn’t provide a price (i.e. Line Pair Mint) or data value (i.e. 

Denomination and Color) for a given Scott number, then no update is applied. That 

is, EzStamp will not try and write zero prices or empty data values to your copy of 

the pre-supplied data. A valid stamp attribute has to be pre-supplied to be included 

in the update process. 

Price Locks 

If you check the option Lock Pre-Supplied prices you have modified, then EzStamp 

will not touch any of the pre-supplied prices you changed. Even if this option is not 

checked, EzStamp will not replace your custom price changes if there is no 

available pre-supplied price provided by SoftPro. 

The option named Do not update any price values for records which have price 

locks is used to control updates for stamp records which you have applied a price 

lock to. EzStamp will leave the pre-supplied prices alone for any price locked 

records. 

NH Ratio, Value Multiplier and Stamps Per Grade 

Pre-supplied grades from SoftPro contain some attributes which you can modify. 

However, it’s possible that SoftPro may amend attributes with future patch updates. 

As such you can prevent or allow a pre-supplied change for NH Ratio, Value 

Multipliers or Stamps per Grade to be applied to any pre-supplied grades. By 

default this feature is enabled to allow pre-supplied updates to change these values 
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Grade Price Update Method 

There are 3 available choices for how to update grade prices: 

Keep your custom prices and update pre-supplied prices: Any price overrides you 

made on a per grade basis (i.e. you entered a value in the Your Value field in the 

main EzStamp window) will be left intact. 

Zero out your custom prices and update pre-supplied prices: Any custom price 

override values you applied to stamp records will be lost. This in effect will restore 

the market value of every grade back to pre-supplied values, with the latest 

effective pricing available. 

Zero out your custom prices and retain current pre-supplied prices: This option 

basically resets the pricing structure for EzStamp to the default state you would get 

if the country were brand new, albeit with the existing pricing. The latest effective 

prices would exist only in the read-only repository of the country file.  

Update Reminders 

If you chose to ignore the dialog which warns you of pending updates when you 

open a country file, you can still see if new pricing is available by looking at the 

EzStamp main window title bar. 

 

Automatic Backups 

A general preference option is available in EzStamp to perform an automatic 

country file backup before applying a supplied data update. This option is enabled 

by default. 

Customizations Import and Export 

For any country with pre-supplied stamp information, SoftPro may provide one or 

more of the following attributes for a given stamp record: 

Year Date of Issue Denomination/Color 

Watermark Perforation Notes 

NH Percent Plate Block Size Mint Sheet Size 

Quantity Issued Stamp Width Stamp Height 

Mint Price Used Price FDC Price 

Plate Block Mint Price Plate Block Used Price Line Pair Mint Price 

Line Pair Used Price Mint Sheet Price  
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Image links are also pre-supplied, but can’t be modified. You can customize your 

own image links to supersede pre-supplied ones, but you can never alter the 

original file names. 

If you need to change a pre-supplied value, you can simply edit any stamp record 

and change one of the above values (stamp width & height, used for AlbumGen 

export, are modified from the Image Links window). 

If you want to change pre-supplied data without adding the record to your 

inventory, use the special “S” icon in the main toolbar to the left of the Help icon. 

This saves pre-supplied modifications but doesn’t inventory the record. 

Click on the Export Customizations button to save all changes you have made to 

any of the above fields to a special file which will always be located in the Exports 

subfolder of EzStamp. 

 

The checkbox option determines if you want to save any pre-supplied price changes 

(checked) or just the basic stamp details (unchecked). Each type of save file will 

have different file extension: .ex1 for exports without pricing, and .ex2 if price 

changes are included. 

It doesn’t matter if the stamp records are inventoried or not – the export option will 

still save changes to any record in the country file where pre-supplied data has 

been modified. 

Click on the Import Customizations button to restore all pre-supplied changes 

from an export file. 
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As with the export option, choose whether to restore pricing or just the same 

details using the checkbox option provided. 

You won’t be able to directly enter a file name in the textbox. Use the Browse 

button to find the .ex1 or .ex2 file types in the Export folder. The original source file 

and the export date will be shown in the status bar at the bottom of the dialog 

window when the file has been verified by EzStamp to be valid. 

Note: Normal EzStamp archival backups only save your inventoried records. Since 

pre-supplied data can be changed on non-inventoried records, the export feature is 

the only way to make backups for changes to those records. Once a pre-supplied 

update is applied (assuming you checked on the appropriate update options), you 

won’t be able to recover customizations without an export file. 

Batch Supplied Update 

This option is available from the Country Data File Utilities menu and works similar 

to the single country supplied update dialog window. The batch update version 

allows you to apply updates to multiple files at one time. 
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The update process for multiple country files is slightly different. The update 

options are however, all the same as for the normal single country update window. 

Any options you choose will be applied the same to each selected country file. If 

you need to use different update options per country, you will need to either select 

specific countries for the batch update with specific options, or use the single 

country update option. 

Conditions for a Batch Update 

• There is no import or export option for customizations for a batch update 

process. 

• Country files must contain pre-supplied information – custom countries may 

not be selected. 

• The pre-supplied information must be newer than what has already been 

applied in the past. You may not re-apply the same supplied update multiple 

times using the batch option. 

• Trial versions of EzStamp do not allow for batch updates – the Check 

Countries option will always return zero available files. 

Step 1: Checking Available Files 

Click on the Check Countries button to validate all installed country files for 

pending pre-supplied updates. You can click on the STOP button to stop at any 

point, but until a complete check is made, the Choose Countries and Update 
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buttons will remain disabled. The status bar at the bottom left will show how many 

countries may be selected for an update. 

Step 2: Choosing Countries 

If at least one country file is available for an update, the Choose Countries button 

will be enabled. Click on it to go to a pick list screen where you may select 

individual countries using combinations of the Ctrl and Shift keys, or use the short 

cut button to select all available countries. 

Step 3: Applying Updates 

If you choose at least one available country file, the Update button will be enabled. 

Click on it to start the update. Depending on the number of files selected, the 

amount of inventoried data in each country and the performance of your PC, the 

complete update job could take some time to complete. You may click the STOP 

button to stop at the current country file in process. This would undo any updates 

being applied on the current file, but not any which may have been completed on 

previous files in the list. You may resume the batch update again with any 

remaining countries at a later time. 

Duplicating a Country 

You can make a copy of the current open country file with the duplicate country 

option. 

 

When duplicating the country, you will provide the following information: 

• The new file name, which can’t be the same as any existing country file. 

• The Country Reference is not modifiable – it’s just there for your reference. 

• The description is taken from the current country file. You can modify this as 

needed for the duplicated file. 
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• If you check the Copy Supplied Data option, then all pre-supplied information 

is copied into the duplicated file. If not checked, you will be creating a 

custom country file, which will no longer be part of supplied data updates. 

• If you check the Copy Inventoried Data option, then all your inventoried 

information will be preserved in the duplicated country. The combination of 

these two checkbox options determines the type of duplicate file you are 

creating. Check both to make a 100% identical copy of the original file. 

Merging Country Files 

The merge utility allows you to combine one country file into a second file, or 

combine 2 files into a new third file. 

 

Source and Target Files 

The source country is always the file which information is taken from. It will not be 

altered in any way, and it can exist in the EzStamp DB folder or from any location 

on your system. Use the Browse button to locate a country SDF file, or choose one 

from the drop down list. The list will only show SDF files registered with your copy 

EzStamp. 

The target file must always be in the EzStamp DB folder. You can choose any 

country file as long as the country of origin is identical. For example, you can’t 

merge Canada and USA together, as they are not the same country of origin. 
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By default, EzStamp will merge the source file into the target file. The target 

country will contain the contents of both files (based on the merge attributes). If 

you want to merge the source and target to a brand new country file, check the 

Merge into new country file option at the bottom and you will be prompted for a 

new name and description for this file. 

Record Exists Options 

These options are applicable when a Scott/Catalog number exists in both files. 

Append the source country record as a duplicate: If the Scott/Catalog numbers 

exist in both the source and target files, the source record will be set as a duplicate 

and the target’s record will remain as the primary record. 

Insert the source country record ahead of the existing record: This option makes 

the source record the primary one – the matching target record is duplicated. 

Overwrite the target country's record from the source file: For collisions on 

Scott/Catalog number, the source record will replace the matching record in the 

target file. 

Skip the source country record and don't add it: For matching Scott/Catalog 

numbers, the source record is ignored and the record in the target file is left as is. 

New Record Options 

These options are applicable when the Scott/Catalog number in the source file 

doesn’t exist in the target file. 

Add the record from the source country file: Add the source file record as a new 

Scott/Catalog number. 

Skip the source country record and don't add it: The source file’s record is ignored. 

Supplied Data Exists Options 

These options are only applicable if either the source or target files contain pre-

supplied stamp information. If both files are custom countries, the dropdown list is 

disabled. 

Select a source and target file first: This appears in the list if you haven’t selected 

both files. It’s not really an option, just a visual cue. 

No supplied data exists in either file: Both files are custom countries, therefore no 

choice will exist. 

Erase the supplied data in the target country (Custom country): This option will 

result in a custom country – all pre-supplied information is discarded and supplied 

updates can no longer be applied to it. 
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Use the supplied data from the source country file: All pre-supplied data from the 

source file is copied to the target file. If any pre-supplied data already exists, it’s 

discarded. 

Use the supplied data which already exists in the target country: Pre-supplied 

information which already exists in the target file is left intact. 

Excluding Duplicate Records 

If you check this option, then all duplicate records in the source file are ignored. For 

example, if Scott #500 exists in the source file as a main record and has 2 

duplicate records, then main record is kept and the 2 duplicates are skipped. Any 

existing duplicate records in the target file are left as is. 

Removing Country Files 

When you open a country file in EzStamp, the file will be “registered”. What this 

means is that EzStamp keeps a record of the file, how it’s used and accumulates 

statistics on it for the purpose of grand totals reports and supplied data updates. If 

you remove country files outside of EzStamp, you remove the audit tracking 

without making the application aware that the file has been removed. EzStamp can 

usually adjust for this, but it’s recommended that you use the built in functionality 

to remove country files you no longer need. 

The remove country option uses the standard country list browser window. Select 

the countries you want to remove then click on the Remove button. Note: You will 

not be able to get the deleted files back unless you have a backup to restore from. 

Backups and Restoration 

EzStamp uses special ZIP format archive files to create backups of your data files. 

There are also automated backups, which simply copy a country file to a special 

subfolder in the EzStamp application path. A third level of protection is provided by 

our Cloud Backup Options available under the Extras Menu 

Automated Backups 

The automated backup processes in EzStamp simply take the current SDF country 

file and copy it 100% to another backup location. Preference options can disable 

some of these automated backups. The following processes in EzStamp can have 

automated backups. Use the Restore SDF Files option under the country data file 

utilities submenu to restore these files. 

Auto Backup Automatic backups are performed every time you open a 

country file. 

Merges These backups take place just before you merge two country 

files together. 
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Supplied Updates When you apply a supplied data/pricing update, the country 

is backed up before the update commences. 

Imports Importing from previous versions of EzStamp will create a 

backup before starting. 

 

Restoring from an Automated Backup 

 

This window will appear when you choose one of the 4 Restore SDF File options. 

Each type of backup stores the SDF files in a unique subfolder under Backup in the 

EzStamp application path. 

The list shows the file name, size, and date/time of modification. To restore a file, 

select it and then click on Restore. Note the checkbox option at the bottom. The 

restore can backup the current file to the TempDB folder. There is NO provision to 

restore a backup from this folder. If you need to restore anything from TempDB, 

you need to manually copy the file back to the DB folder. 

Restoring from Outside EzStamp 

If you manually copy an SDF file into the DB folder outside of the application, the 

country file registration will not be accurate and grand totals reports will not be 

correct. If you ever do manual restorations like this, always perform a grand totals 

recalculation. 
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Archival Backups 
This is the recommended method by which you should backup your data. This 

option is available as Create Backup from the country data file utilities submenu. 

 

Backup Type 

Current Country: This will create a backup of the current open country file only. 

Country backup archives contain only inventoried stamp attribute data and any 

customization/configuration information. 

Specific Countries: Use the Select Countries button to select one or more 

countries to backup. 

All EzStamp Data: This option creates a backup of all non-country specific 

EzStamp data, which can include the following: 

• Configuration settings for all dialog windows. 

• General Preferences. 

• Report Profiles. 

• Default Search Conditions for Reports. 

• Custom Search Export Files. 

• Any files you have saved to the User folder in EzStamp. 

• Custom Grade Group Filter Files. 

• Navigation Lists. 
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• Custom Categories. 

• Custom FDC Makers. 

• Custom PWL/PSL Type Lists. 

• Report Field Customizations. 

• Snapshot Files. 

Application Specific Data: This is a subset of the All Data option which is based 

on the checkbox options which appear in the backup window. 

Application Specific Data 

There are 3 types of application specific data, which can be selected when choosing 

this type of backup. 

Application Data: FDC Makers, Categories, PWL/PSL Type Lists, and Report Field 

customizations, which are all contained in the EzStamp.sdf application configuration 

file. 

Application Preferences: EzStamp general preferences are stored in a special file 

named EzStamp.cdt. This file is always updated whenever you close the application. 

Check this option to include it in the backup. 

Snapshot Files: Check this option to back up the contents of the Snapshots folder. 

Custom Image Backups 

The installation path of EzStamp contains a folder named Images. If you store 

custom image files under this folder, EzStamp can archive them to backup. The way 

image backups work is based on the type of backup. For open country or selected 

country backup types, only the image files associated with the country are included 

in the backup. For the other two backup types, the entire contents of the Images 

subfolder are backed up, for Scott numbers which are NOT pre-supplied names. For 

any country supplied by SoftPro with images, image names are provided which are 

considered ‘reserved’. Therefore, custom image links should always use names 

which don’t conflict, as reserved image names are not part of the backups. 

Backup Location, Name and Description 

The default location to save the archive to is the Backup folder in the EzStamp 

installation path. Use the Browse button to set a different backup path. The 16 

most recently used backup paths are maintained in a dropdown list for 

convenience. 

Backup Verify 

Use the Verify button to check the amount of data to backup, and to also ensure 

the files to be backed up are without error. 
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Backup File Format 

All archive backups are saved as 2 files, one with a .CFG extension and the other 

with a .ZIP extension containing all the backup data. You can’t restore from backup 

without the .CFG file. You can open the .ZIP file, but you will not be able to restore 

any data to SDF-type files without using EzStamp. All of the other data files in the 

archive are stored as they exist in the EzStamp installation path and its various 

subfolders. 

Restoring from Backup 
Use the Restore from Backup option to restore all or part of a backup archive. 

 

The restoration window allows you to selectively choose what data to restore from a 

given archive file. 

The 16 most recent paths used to create backup archives will be remembered by 

EzStamp. Use the drop down list to select one of these backup paths, and the file 

drop down list will automatically show every backup archive under that path. If no 

backup paths are shown, use the Browse button to select a specific path 

containing backup archives. 
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The top of the window is summary information for the contents of the archive, 

including its type, backup date, description, number of files and size. 

The checkbox options allow you to select which items in the archive to restore. If 

items associated with a checkbox options are not actually in the archive file, the 

checkbox option will be grayed out. 

If country or image files are contained in the archive, then the Select Images and 

Select Countries buttons will be enabled, allowing you to restore the country file 

data and/or the image files associated with the country. The Restore All buttons 

simply select every country or image file directory available in the archive. 

Once you start a restoration, it can’t be undone. If a restoration did not complete 

100%, you can attempt the restoration again. EzStamp will resume the restoration 

from where it was halted. 

Country file restorations are intelligent. If any error happens during a country file 

restoration, all changes made to it are rolled back and the file is left as it was 

before the restoration started. However, EzStamp data file restorations can’t be 

rolled back. Once files are replaced from backup, they are changed for good. 

IMPORTANT: If any Application settings have been restored from any backup, you 

will need to restart EzStamp in order for these changes to take effect. 

Assigning a Country to Import Pre-Supplied Data 

If you attempt to restore from a country which is not already in EzStamp and the 

backup references pre-supplied stamp information from SoftPro, you will be 

provided a dialog window to assign pre-supplied information from an alternate 

installed country.  

Verification, Repair and Compaction 

These options are available under the country data file utilities as Verify, Repair, 

and Compact. EzStamp uses Microsoft SQL database technology for the country 

file storage format, and as such, these utilities make use of built in features within 

their software to handle the work. As a side effect of this, all 3 of these features can 

take several seconds or more to complete for a single country file, during which 

time EzStamp will not be able to respond to your input. 

All 3 options make use of the standard country list browser window. 

• Verification will open selected country files and check them for any internal 

database errors. If any errors are detected, use the repair option to attempt 

to fix them, or make use of data backups to restore from. EzStamp contains 

extensive error handling and detection methods to keep your country files in 

good working condition, which should prevent errors from ever happening. 
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• The Repair option will attempt to fix a county file which can’t be opened by 

EzStamp. The repair process is part of the Microsoft database product, so the 

effectiveness of the data repair can’t be documented. If you still can’t open 

the country file after a repair, or critical data has gone missing, or the repair 

fails, then you will have to restore from a backup archive. 

• The Compact option will attempt to reclaim unused space within the SDF file. 

EzStamp has an automated compaction timer built into each country file, 

which can be configured using the general preferences.  
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Version Upgrades 

Country files contain a highly optimized structure for storing stamp records, 

configuration and customization options. If future updates to EzStamp involve 

additions of new features which require extending the country file structure, it will 

be necessary to ensure your existing files are kept up-to-date. Each country file has 

a build number, which is indicated in the country file list browser window. This is 

also shown in the properties window as the Data Version attribute, which is 

currently build version 1.2. 

If the file structure changes, a new build number will be issued in the EzStamp 

application. When you attempt to open a country file which has an older build 

version (i.e. out-of-date), you must upgrade the country file to the latest build 

version. 

The option Update Version in the country data file utilities submenu is provided 

for updating your country file’s structure to the latest format which is version 1.2.  

If your data is not on this latest version, you must perform the Update Version to 

access your data. 

Resetting a Country File 

This option is intended only for restoring a country file to a pre-supplied un-

initialized state. All customizations and inventoried stamp information will be 

discarded, leaving the file the way it was when you first installed it from the 

EzSetup application. Be aware that you will not be able to get the data back once 

you reset the country. 

  



EzStamp Reference – Version 8.0 

Page | 82 
 

EzStamp Cloud Backup & Restore 
The Cloud backup feature is a new option available from the Extras menu. This 

type of backup stores the files remotely on a Cloud server. There are some 

differences between normal backups and Cloud backups which are summarized 

below. It's recommended that you continue to rely on your local backups as the 

primary method to safely store your collection data. 

Cloud Backup vs. Local Backup 

Given that the Cloud backups must be stored on a remote server shared with other 

EzStamp users, there are some limitations with this type of backup to ensure 

capacity on the server is sufficient, and that the backup process is streamlined for 

ease of use. 

• Only 1 backup of a country file's data can be stored on the Cloud server. 

• Country backup files are segregated for efficiency in selective backups and 

restorations. 

• No options are available to choose what to backup other than which countries 

to backup. Each country is backed up as complete inventoried data 

(excluding pre-supplied information which hasn't been customized). 

• Application data is always transparently backed up with any country file. 

There are no options to choose what type of application data to backup. All 

data is backed up, with the exceptions listed below. 

• Supplied & Custom images, snapshot files, and global search result files are 

not saved to the Cloud server. These items can be quite large, making file 

transfers slower and require significantly more capacity than the normal 

backup data. 

• As data must be moved into and out of the Cloud server, backups will never 

be as fast as the local file backups in EzStamp. The speed of Cloud backups 

is dependent on your Internet connection speed, the Cloud provider's 

bandwidth, and your PC's performance level. 

Registering for Cloud Backups 

Under the Cloud submenu in Extras, choose the item Register for Use. This will 

show a dialog as follows. 
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The Cloud Identity key is a 6 character code used to reserve space on the Cloud 

server for your backups. The key and registration process is a one-time process - 

simply contact SoftPro to obtain a Cloud backup key. Then enter the key into the 

fields in this dialog to complete the registration. A minimal fee applies ($10) 

Re-Registration and Multiple Keys 

A Cloud key reserves one area on the server for your backups. The key is stored 

locally with the installation of EzStamp. If you install multiple copies of EzStamp, or 

re-install the application for any reason, you will need to re-register with the key 

again. 

Important Note: You should never perform backups or restorations from 2 

different installations of EzStamp at the same time, even if the application resides 

on different PCs. As there is only one set of backup files on the server, attempting 

to access them at the same time from multiple copies of EzStamp can result in 

errors or potentially lost backup data. 

That being said, if you have multiple installations of EzStamp and prefer to keep 

separate Cloud backups, you can request an additional Cloud Identity key to use for 

a different copy of EzStamp. This allows you to keep the backups completely 

separate from each other. Note that SoftPro may restrict the number of additional 

keys which may be issued. 

Cloud Backups 

Choose the Backup option from the Extras Menu, Cloud Utilities. This will 

present the following dialog window. Note that there will be a brief delay before this 
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dialog appears, as EzStamp will need to check the server for backup contents and 

perform some basic integrity checks on the data to ensure everything is valid. 

 

The list presented is identical to the one you see using the Open With List menu 

option to select country files to open. If you have hidden any countries from the list 

when using the Open With List option, then they will also be hidden in the Cloud 

backup list. 

Each item in the list will have an icon displayed to the left, which can be any of the 

following: 

 Blank means no backup exists on the cloud server. 

 
The entry is marked for backup. You will need to mark files for backup using 

the marking buttons at the bottom of the dialog. 

 
There is a valid backup file on the server. 

 
When a backup has been completed, the icon will change to the green 
checkmark to indicate success. 

 

Selecting Backup Data 

To backup just the application data, don't mark any country files and click on the 

Backup button. This will transfer the application data to the Cloud server. 

To backup countries, select the ones you wish to backup, and use the Mark Files 

button. To backup all countries, use the Mark All button. 
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Initialize and Refresh 

The Initialize and Refresh buttons serve the same purpose as in the Open With List 

dialog.  

The Initialize button will apply a first-time initialization to all selected countries. 

Note that opening any country file in the main EzStamp window will also perform 

this function automatically for you. The Initialize button is primarily intended for 

those users with many country files for which initialization can be accommodate for 

all files with a single click. Note that initialization for dozens of countries can take 

several minutes to complete. 

The Refresh List button will check all country files for description and version 

details if they haven't been opened yet. 

Starting a Backup 

When you are ready to start the backup, click on the Backup button. As each 

backup is made to the server, the icon status will change to a green checkmark. 

Note that the version and file size information are not updated in the dialog until a 

backup resides on the server. 

Cloud Restoration 

Choose the Restore option from the Cloud menu. This will present the following 

dialog window. As with the backup option, there will be a brief delay before this 

dialog appears while EzStamp checks the server for backup contents. 
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The cloud restoration dialog shows the same basic list of country files, with one 

notable difference: Only files residing on the Cloud server are displayed. 

There are additional icon states for the restoration list: 

 
The entry is marked for backup. You will need to mark files for restoration.  

 
There is a valid backup file on the server AND there is also a local matching 

file with the same country identity.  

 
The backup file on the server has a country identity that doesn't match the 

local country installed in EzStamp. You will not be able to restore from this 
backup unless you rename the local country file to something else. 

 
The restore was completed from the server without error. This only appears 
once you click on the Restore button. 

 
A server backup exists but no local file with the same name exists in the 
EzStamp application folder. See the section below to understand how 

restoration works without a matching country file in EzStamp. 

 

 

Restoring Without a Matching Country File 
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Similar to local backups in EzStamp, the backup information only contains 

inventoried records, customizations made to pre-supplied data, or any stamp 

attributes not associated with pre-supplied information. 

When restoring custom countries from backup, there is no difference between 

restoring to a country file which already exists in EzStamp, or for when a file 

doesn't exist, as the backup file contains 100% of the country data. 

For pre-supplied countries from SoftPro, pre-supplied pricing, image links, and 

other pre-supplied stamp attributes are not backed up, unless you have changed 

their pre-supplied values to create customized records. 

If you restore a local or Cloud backup file to EzStamp and the country isn't already 

installed, you will end up with a custom country restoration without pre-supplied 

data (non-inventoried stamp records will not exist in the restored file). 

For this reason, always ensure you have the pre-supplied country files re-installed 

before performing and restoration. If for some reason, you don't do this, then you 

will need to merge the pre-supplied data into the restored file from a copy of the 

pre-supplied country file. If you run into this scenario and are unsure of how to 

proceed, contact SoftPro for assistance. 

Starting a Restoration 

There are two buttons available for restoration. Restore App Data will only restore 

application backup data - no countries are restored. Restore Countries will always 

restore application data first, followed by the countries which are marked. 

As each restoration is made from the server, the icon status will change to a green 

checkmark. 

Resuming Backups or Restorations 

Since Cloud backups require an Internet connection, there is always a remote 

possibility that a connection can be dropped during a file backup or restoration. 

EzStamp has auto-recovery capabilities to restore any prior backup of country or 

application data if the backup session was ended unexpectedly. 

For restorations, a lost connection will result in no lost data, but you will be 

required to manually select the files to restore which were not completed.  

EzStamp maintains a log file for backups and restorations, which can be found in 

the application's User folder as file names CloudRestore.log and 

CloudBackup.log. These log files are plain text format and indicate the status of 

each file backed up or restored, and any error conditions that may have been 

encountered. 
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Assigning a Country to Import Pre-Supplied Data 

If you attempt to restore from a country which is not already in EzStamp and the 

backup references pre-supplied stamp information from SoftPro, you will be 

provided a dialog window to assign pre-supplied information from an alternate 

installed country.  

Responsibility for Data 

By using SoftPro's Cloud Backup module, You acknowledge and agree to take full 

and sole responsibility for all files and data transferred, and to maintain all 

appropriate separate local backup of files and data stored on our cloud servers. 

SoftPro will not be responsible for any data loss of your uploaded data from your 

account under any circumstances.   

SoftPro does not assume any liability whatsoever for actual, direct or indirect losses 

or for losses incurred due to the unavailability of use or data losses in connection 

with the use of SoftPro's Cloud Backup services.  

It is good backup practice to have multiple backups of your data. SoftPro suggests 

a 3 tier backup solution. 

1)      Backup to your hard drive 

2)      Backup to a physical external drive or Flash/USB Drive 

3)      Cloud Backup 

 

Should any one fail for any reason, you will have alternate methods of data 

recovery 

Cloud Backups & What to Use Them For 

Cloud backups give you extreme flexibility for restoring data across several devices. 

One of the most important is the ability to Synchronize laptops/tablets & PC’s. 

Imagine being on the road or travelling & you forgot to bring your EzStamp backup 

on your flash drive. With Cloud backups, you can restore your cloud data onto your 

laptop & enter your stamps or purchases. Then do a cloud backup when you are 

done. When you get home, you can do a Cloud Restore to your desktop & continue 

where you left off. With cloud backups, your data is available to you anywhere you 

have an internet connection. You data is extremely secure in our cloud service. All 

EzStamp cloud data uses AES-256 bit encryption. The cloud backup is intended to 

be an extra layer of data protection for your data. You should still continue to do 

local EzStamp backups to your hard drive & an external drive/flash drive. 
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Restoring Backups Without Installed Countries 

When restoring from either local or Cloud backup files, EzStamp will check the 

countries which are being restored to see if they have references to pre-supplied 

stamp data from SoftPro. 

Backup archives only contain your customizations to a country file, plus any 

inventoried stamp data not provided by SoftPro. When restorations are made from 

a backup, EzStamp will look for the country file with the same name to see if it's 

already installed. If the country file is present, EzStamp will merge pre-supplied 

information in the installed version and replace all of your custom/inventoried 

information from the backup archive. 

Since the backup archive doesn't contain the pre-supplied stamp data, it's 

important to have the ability to import that information from a compatible country 

which is already installed. 

EzStamp will provide you with a special dialog window to assign an installed country 

with pre-supplied stamp information to use as the source when restoring a country 

from backup. 

An example of this dialog window is shown below. 

 

For a backup file to appear in the list, it must meet the following conditions: 
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1. The backup country must not be custom. If the country was not associated with 

pre-supplied data from SoftPro at the time of backup, it will not appear. 

2. The country is not already installed with the same file name in the DB subfolder 

of the EzStamp application path. 

Assigning a Country to Import Pre-Supplied Data 

To assign pre-supplied stamp information to a backup country, follow these steps. 

1. Select the country from the list. 

2. Select a compatible country from the drop down list. 

3. Click on the Assign button. Use the Un-Assign button to remove the pre-

supplied association. 

A compatible country is one which is based on the same country of origin, and 

contains pre-supplied stamp information from SoftPro. For example, you can choose 

USA for any backup country which is based on the country United States, as long as 

the installed version of United States contains pre-supplied information. 

You may choose to restore any country without pre-supplied information. However, 

a warning will be given asking you confirm your decision. In this case, the country 

will be restore as a custom format, and no pre-supplied stamp data will exist after 

the restoration is completed. 

An example of a pre-supplied assignment is shown below. 
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Navigation 

Finding Stamps by Scott or Alternate Catalog ID 

The easiest way to find a stamp record is to enter a Scott or Alternate Catalog ID 

number from the 2 input fields at the top of the stamp details area: 

 

The left field (labeled in red as “1”) is for the Scott number (or catalog ID number 

for custom/sub-varieties). The right field is for the alternate catalog ID number. 

To find Scott/Cat #s, use one of the following methods: 

• Type the ID value in the left input field and press TAB. 

• Type the ID value in the field and press ENTER. 

• Type the ID value in the field and press F5 (the F5 option is a general 

“Refresh” feature and works no matter what field you are currently 

positioned in). 

• Choose the Find Scott option from the Navigate menu. 

The first 2 methods from above can be used when typing an ID value into the 

alternate catalog ID (labeled in red as “2”) field on the right as well. For method 3, 

the shortcut key is Ctrl + F5, and for the 4th method, the menu option is named 

Find Alternate. 

If the stamp record can’t be found when looking up by Scott #, then a small dialog 

window will appear: 

 

At this point, EzStamp is expecting to save this record as a new item in your 

inventory. You must provide two conditions for the save to complete: 
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1. Decide if this record to be saved as a main variety or a sub-variety. 

2. Choose to save the ID value as mixed case or upper case. The numbering 

format is case-sensitive, so saving an ID as “17x” is not the same as saving 

it as “17X”. 

Note: You will not be able to enter an invalid ID format. There are many rules 

based on the country of origin which determine what is considered valid to be 

compliant with the Scott numbering system. If you enter any ID value which 

doesn’t abide by these rules, you will be presented with an error window explaining 

the reason. 

Once you click on the Save button the record will be automatically added to your 

inventory as a custom entry. If there was any pre-supplied stamp information in 

the stamp details area at the time you saved, it will be added to the record. 

However, since this is now a custom Scott/Catalog number, it will no longer be 

subject to pre-supplied data updates from SoftPro. 

Assuming the Scott/Catalog number was found, the record will be recalled from the 

country file and displayed in the main window. If you have any of the secondary 

windows open (i.e. FDC/PNC/PNB viewer, Comments, Custom Fields, etc.) the 

information in those windows will also be updated accordingly. 

Alternate Catalog ID Values 

The way lookup failures work on the alternate catalog ID field is slightly different 

than when the lookup fails on the Scott ID value entered (if the alternate catalog ID 

matches on any stamp record in the country file, it will be recalled the same as 

when you enter a Scott number). 

There can be up to 8 additional numbering formats available for a given country 

file. Four of them are reserved by SoftPro for alternate pre-supplied numbering 

formats that may be made available in the future for specific countries. If SoftPro 

hasn’t issued an alternate numbering format for a country file, it will not appear in 

EzStamp. 

Four additional numbering formats are available for your own use, and these have 

the default labels of User Cat 1-4 # (or short form of U-Cat 1-4#). You are free to 

rename these labels at the global (for all countries) level or just for the current 

country file. SoftPro will not issue any country file with these 4 ID formats pre-

populated. 

Since there is only one input field on the screen for the alternate catalog ID, you 

will need to choose what the current format is by using any of the following 

methods: 
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Left click the label to the left of the field and a small popup menu will appear. 

 

You can choose from any of the available formats and the input field will change to 

reflect that format. EzStamp will expect for you to enter ID values which are 

specific to the current format chosen. The Rename option allows you to change the 

displayed and printed labels associated with each catalog ID format (see the next 

section). 

If you don’t have an alternate catalog ID currently saved with the record, you will 

be asked to confirm the new value with the following popup window: 

 

Each catalog ID currently assigned on all 4 customizable formats will be shown. You 

can change any or all of these ID values at one time. Use the Clear button to 

remove the associated catalog ID from the stamp record. Click on Clear All to 

remove all custom ID values associated with the record. 

Renaming Catalog Labels 

Each catalog ID has an associated label which is used for printed reports or display 

in the report viewer. There are short and long formats for display/print, for a total 

of 4 labels per type. The editor is available from the Rename option in the popup 

menu when clicking on the label. 
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In addition to the 4 catalog ID labels, you can change the Location and Cross-

Reference labels. 

The checkbox option at the bottom of the window determines if the labels will be 

applied to all country files, or just the current active country. The global 

application-wide labels are stored in the Master Report fields configuration (you can 

rename the global labels in the Master Fields editor too), whereas the country-

specific labels are stored within each country file. 

This checkbox option is identical to the one available in the EzStamp general 

preferences – they both perform the same function: switch between country 

specific or global labels. 

Alternate Catalog ID Settings 

You can choose to keep the default Scott formatting rules for your alternate Catalog 

ID numbering systems, or use custom formats. To view/modify the catalog 

numbering formats, refer to the help section for EzStamp Options, Edit Catalog 

Numbering Formats. All pre-supplied and custom country files will default all 4 

alternate ID formats to “EzStamp”, which is the Scott numbering format. 
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Stepping to Next and Previous Records 

There are 3 pairs of colored arrows in the EzStamp toolbar. The color determines 

how you can step forwards and backwards through the stamp records. 

Blue Step by Scott or Alternate Catalog ID, using the current ID type. The 

# icon between the 2 arrows defines the stepping method (see 

below). 

Green Step by Inventoried records in Scott number order only. Any pre-

supplied records which are not inventoried will be skipped over. 

Violet Step through records in the active Navigation List. Navigation lists 

can be created from most searches and reports, bookmarks, stamp 

lists or tag lists. 

 

If you hold down the CTRL key while clicking on any arrow button, you will 

automatically step to the first or last record based on the associated stepping type. 

Setting the Stepping Method 

Click on the # icon between the 2 blue arrows to set the stepping method which will 

be used when you click one of these arrows. 

 

If SoftPro has provided pre-supplied alternate numbering formats for a country file, 

they will also appear in this popup menu. The above example shows the 6 available 

stepping types which are always available for every country file. 

Scott is the default stepping method, and will display all records present in the 

country file, in Scott number order.  

The Non-inventoried option will filter out inventoried records. This makes the blue 

arrows functionality opposite of the green arrows – only pre-supplied records which 

have yet to be inventoried are valid. 
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The User Cat options are for your alternate catalog numbering systems. If you 

have no alternate numbering system attached to any of the 4 choices, the blue 

stepping arrows will in effect become disabled. 

Note that the green and violet arrows have only one fixed stepping method. The 

navigation list stepping is based on the sort order of the navigation list, which is 

usually the same order as a report or search which was used to create it. 

Stepping & Duplicate Scott Numbers 

When stamps are duplicated on the same Scott number, you will notice 3 things at 

the bottom of the EzStamp window in the status bar. 

 

1. The stamp status icon changes to the violet “DD” symbol. 

2. The current and total number of duplicate records for the current Scott 

number is shown in the status bar. 

3. The 2 yellow arrow icons are used to step back and forth between the 

duplicate records. 

In addition to using the yellow arrows for stepping between records, the blue and 

green arrows in the toolbar will take duplicate records into account. If you want to 

ignore duplicate record stepping on the blue and green arrows, a general 

preference option can be used to disable the default stepping behavior (Include 

duplicates when using navigation stepping methods). 

Automatic Back-stepping when Deleting Records 

A general preference option (Step to previous supplied on inventory deletions) will 

cause EzStamp to step backwards to the previous pre-supplied Scott number when 

you delete a record from your inventory. This is enabled by default. 

Stepping with Pending Stamp Changes 

By default, EzStamp will warn you when you attempt to step away from the current 

stamp record if you have made any changes to the data. This warning can be 

disabled from the EzStamp general preferences. 
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Navigate Menu Options 

All of the navigation options in EzStamp can be found under the EzStamp main 

Navigate menu. Default shortcut keys have been defined for the most frequently 

used options. You can customize the keyboard shortcuts for other options as 

needed, or attach menu options to a customizable tool button window which 

extends the default EzStamp toolbar. 

Menu Item Shortcut Description 

Next Supplied Stamp Ctrl + Up Equivalent to clicking the right blue arrow. 

Next Inventoried Stamp Ctrl + Right Equivalent to clicking the right green arrow. 

Next Stamp in List Ctrl + Page Up Equivalent to clicking the right violet arrow. 

Next Duplicate  Equivalent to clicking the right yellow arrow icon 

in the status bar. 

Previous Supplied Stamp Ctrl + Down Equivalent to clicking the left blue arrow. 

Previous Inventoried Stamp Ctrl + Left Equivalent to clicking the left green arrow. 

Previous Stamp in List Ctrl + Page Down Equivalent to clicking the left violet arrow. 

Previous Duplicate  Equivalent to clicking the left yellow arrow icon 

in the status bar. 

First Supplied Stamp  Equivalent to clicking the left blue arrow while 

holding down CTRL. 

First Inventoried Stamp  Equivalent to clicking the left green arrow while 

holding down CTRL. 

First Stamp in List  Equivalent to clicking the left violet arrow while 

holding down CTRL. 

Last Supplied Stamp  Equivalent to clicking the right blue arrow while 

holding down CTRL. 

Last Inventoried Stamp  Equivalent to clicking the right green arrow while 

holding down CTRL. 

Last Stamp in List  Equivalent to clicking the right violet arrow while 

holding down CTRL. 

Lookup Method  Equivalent to clicking the label to the left of the 

Alternate Catalog ID text input field. 

Stepping Method  Equivalent to clicking the # icon between in the 

2 blue arrows in the toolbar. 
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Setting Bookmarks on Stamp Records 

EzStamp will allow you to bookmark up to 8 stamp records per country file. 

Bookmarks are accessed from the Navigate menu under the bookmark submenus. 

 

There is one submenu for setting the bookmarks, and one for recalling them. Use 

the Clear All option to remove all current bookmarks. If you expect to make 

frequent use of the bookmark option, you should assign the bookmark options to 

the shortcut button window or attach shortcut keys.  

Bookmarks are saved to the country file, and therefore will be retained even when 

you close EzStamp. 

If you need to make use of more extensive bookmarking on stamp records, 

consider using tags, stamp or navigation lists. All of these methods require you to 

export the lists to file if you intend to retain them after closing EzStamp. 
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Tagging Stamp Records 

The Tag option under the Navigate menu provides you with an easy method to 

create record lists which have an unlimited size. A tag list can be transferred to a 

navigation list, which can in turn be applied to an ad-hoc report or displayed in the 

thumbnail viewer. 

 

A tag list is identical to a navigation list, and is in fact the only way outside of 

searches and reports to build a navigation list.  The tag list was designed to allow 

you to interactively create a navigation list one stamp record at a time. 

No default shortcut keys or toolbar buttons are assigned to tag list functions. If you 

intend to make frequent use of the tag list feature, you should create shortcut 

buttons or keys for easier accessibility. 

Adding and Removing Records 

Use the Add option to add the current stamp record displayed in the main EzStamp 

window to the end of the current tag list. Use the Delete option to remove the 

current record from the list. Deletions will have no effect if the current record isn’t 

already part of the list. 

Navigation of the Tag List 

Use the Next, Previous, First and Last options to step through the tag list. 

Loading, Saving and Transferring Lists 

The Load from List and Save to List options recall and store tag lists in the 

navigation list file format. As such, the tag and navigation lists are 100% 

interchangeable allowing you to run reports and thumbnail views from tagged 

records. 

The Stamp List viewer works with navigation and tag lists as well. You can transfer 

the tag list to the stamp list, or a navigation list to a stamp list. Refer to the Stamp 

List help section for more details. 
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Stamp List Viewer 

The stamp list viewer is a special window which can co-exist with the main EzStamp 

window. You can drag this window to any position on your screen and resize it as 

needed to fit within your workspace. When you run EzStamp for the first time, the 

window is hidden from view. Use the Stamp List Viewer option from the View 

menu to show or hide this window. A typical stamp list would appear similar to the 

following example. 

 

The stamp list window has 3 basic components: An optional image preview pane, a 

data grid to show some basic fields of data (this can be customized), and a toolbar 

with a handful of options. 

Toolbar Options 

The following table summarizes the buttons on the toolbar (in left to right order). 

Add to Stamp List Add the current stamp to the end of the stamp list. 

Remove from Stamp List Removes the most recent stamp added, or if you’ve 

selected one or more specific records in the list, only 

the selection will be removed. This does not remove 

the record from your inventory. 

Clear Stamp List This clears all records from the stamp list. 

Transfer Navigation List to 

Stamp List 

The active navigation list will be transferred to the 

stamp list. Whatever records were in the stamp list 

before the transfer will be lost. 

Transfer Stamp List to 

Navigation List 

This option transfers the stamp list to the active 

navigation list. The contents of the existing 

navigation list are discarded. 

Transfer Tag List to Stamp 

List 

The contents of the current tag list are transferred 

to the stamp list, replacing the existing list. 
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Export to File The stamp list will be saved to a navigation list file. 

Edit the Field List The fields within the stamp list can be edited to 

show more, less, or different stamp attributes. The 

report field profile editor is used to configure the 

fields to be used in viewer. Only the primary stamp 

attributes can be added as fields to the stamp list 

viewer. 

Refresh from EzStamp Since the stamp list maintains its own internal 

connection to the country file using special files to 

contain the stamp records, these files will not 

contain any records you may delete from the main 

EzStamp application. You can use this option to 

refresh the stamp list as needed. 

Show/Hide the Image 

Preview 

The left side of the stamp list window can show an 

image pane area, similar to what the report viewer 

shows. Use this button to show or hide the image 

pane. 

 

Menu Options 

The stamp list options are all contained under the Stamp List option in the 

Navigate menu. These options mimic the buttons in the stamp list viewer window. 
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EzStamp Drill Down Search Filter 

This feature allows you to quickly find stamp records based on the key attributes: 

• Year (single year or a range of years) 

• Date of Issue 

• Denomination and Color 

• Watermark 

• Perforation 

• Keyword and/or Notes 

There is no filter choice for Scott numbers, as other searches provide that facility 

already. You can access this option from the Search menu or the main EzStamp 

toolbar. 

 

Match Conditions 

Excepting the year, which must always be a complete year or year range, the other 

attributes are based on one of 3 conditions, each of which may be set separately 

per attributes: 

Contains: The search value matches in whole or in part anywhere in the stamp's 

value. For example entering red in Denomination and Color will match any value 

containing the text red. Search text is never case sensitive, so you may enter 

values in upper, lower or mixed case. 
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Starts With: This matches your search value to the beginning of the stamp's 

associated value. For example if you enter $1 in Denomination and Color, then only 

records where the value starts with $1, such as $1 dp brn will count. 

Exact Match: The value you enter must match the stamp's value exactly (case-

insensitive). 

Four of the attribute search fields have a drop down list containing the complete set 

of possible stored values for that attribute for the current open country file. You can 

use the drop down list to pick a value, or simply enter any search text directly into 

the field. 

Running a Search 

When you have your search values in place, click on the Search button or press the 

F3 key. All possible matching stamp records will appear in the list, with a stamp 

image preview for the currently selected item in the results list. 

After the search, the drop down lists will automatically filter to only include any 

combinations tied to the number of stamp records returned. This is the notion of 

the Drill Down feature - as you add more search conditions, the list of available 

stamp records which match those conditions grows smaller and smaller. 

Rolling Back a Search Condition 

The small buttons with the red X next to each search condition will remove that 

filter from the drill down, and in the process automatically re-run the search for you 

- no need to click the Search button. The stamp results in effect will be expanded 

once more to not include the search condition you just removed. 

Use the Reset button to clear all search conditions and start fresh. 

Choosing a Record to Display 

Use the Choose button to display the selected stamp record in the list in the main 

EzStamp window. This will close the drill down dialog. Double clicking the entry in 

the list will also display the stamp record and close the search window. Single 

clicking a record will simply display the stamp and not close the dialog. 

Keyword/Notes Search 

This condition matches to both the Notes value in the stamp record and the internal 

keyword dictionary which only exists for pre-supplied countries (also accessible via 

the Keyword search feature). Due to the number of possibilities for notes and 

keywords, there is no drop down list option. 

  



EzStamp Reference – Version 8.0 

Page | 105 
 

Navigation Lists 

Navigation lists are collections of stamp records for a given country file. A list 

contains the Scott/Catalog ID values and nothing more. The primary source for a 

navigation list is from a search or report. All EzStamp searches and reports create 

an internal navigation list file which in turn is used by the report viewer to display 

the search results. The main EzStamp window supports an “active” navigation list, 

which can be assigned from any search or report, or you can create the list 

interactively using stamp lists or tag lists. 

When a navigation list is active, you can use the violet arrow buttons to step 

through the list. The status bar at the bottom of the EzStamp window will indicate 

an active list when the list status is displayed, showing the current and total records 

in the list. 

 

Loading and Saving Lists 

An active list can be loaded or saved using the Navigation List options under the 

File menu. 

 

A list can’t be loaded except for the country file for which it was saved from. For 

example, a list file for Canada is not compatible with a USA country file. 

Lists will automatically be adjusted when loaded, to account for deleted records. For 

example, if you created a navigation list which included Scott #500 in the file, and 

then deleted this record, the loaded list would automatically be adjusted to drop 

that record. 
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When saving a navigation list to file, you will be prompted for a file name and 

description. The list file will always be saved under the country name’s subfolder, 

within the Lists folder of the EzStamp installation path. The files will have an 

extension of .LST. 

When loading a list, the country subfolder will be checked for list files and their 

names, descriptions, and total stamp record counts will be shown as in the dialog 

window above. 

Use the Delete button to remove selected lists permanently. There are no backup 

list files, so choose your deletions carefully. 

You can also double click on any list file to open it. 

Assignments from Reports and Other Sources 

1. Reports and searches provide the option to send the stamp records directly 

to the active navigation list, as the following screen example shows. 
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2. A stamp list can be transferred to the active navigation list, or exported to 

file. 

3. The report viewer provides the ability to assign the report results (or 

bookmark sections of the report) to the navigation list. Bookmarked records 

within the viewer can also be saved to file. 

4. Tag lists can be saved to file. 

Creating a Slideshow 

Choose the Run Slideshow option to cycle through the list by showing each stamp 

record on the main EzStamp screen for a period of time. The amount of time to 

show each stamp record is controlled by a general preference option (default is 5 

seconds). The slideshow will automatically cancel the next time you run any menu 

option from the main menu. While the slideshow is running, the title bar of the 

main application window will indicate this with the text “(Slideshow)” appearing 

after the country file name. 

Sorting Lists 

Choose the Sort option to reorder the stamp list on any of the primary attributes. 

The sort dialog window is identical to the one used for report profiles, allowing for 

up to 5 field levels, in ascending or descending order per field. 

Combining and Editing Lists 

Similar to combining reports together to create custom stamp record result sets, 

you can combine 2 navigation lists together in the exact same way. 

Add Scott/Alternate catalog ID numbers from the first list are combined to 

with the second list, such that the records unique to both lists are all 

that remains. Duplicate entries are not created.  

Subtract Subtracts all stamp records from the first list which match on the same 

Scott/Alternate catalog ID numbers from the second list. 

Combine Takes all Scott/Alternate catalog ID numbers from both lists and 

discards any records which are not common to BOTH lists. 
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The combine list dialog window is shown below. 

 

Select a list from the data grid and click on Set First. Select the second list and 

click on Set Second. Then click the Combine button (this button will change to 

Add or Subtract depending on the type of combination you chose from the menu). 

The second list will be modified for the combination - the first list will remain 

unaltered. 

The Delete and Open buttons work the same as in the Load list dialog window. 

Ad-hoc Reporting and Editing 

There are two methods for editing the contents of the active navigation list. You can 

transfer the list to the Stamp List viewer and then remove unwanted records. You 

can also run an ad-hoc report by choosing the Navigation List option in the Report 

menu. Refer to the Searches and Reports help section for more details. 

There is no provision to reorder individual records within the list, other than 

applying a sort order. 
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Editing Stamp Information 

Stamp Record Attributes 

Before saving a record to your inventory, familiarize yourself with the various 

sections of the main EzStamp window. Primary stamp details are organized in the 

top left section of the window, including most pre-supplied values. 

The upper right section of the window is for image views, which can show from 1 to 

4 stamp images simultaneously using a variety of display methods. 

The bottom half of the window contains the data grids for secondary stamp 

attributes. The data grids are tabbed for easy access. Simply click a tab to view the 

inventoried status for the associated data type. 

Additional windows are available which can be shown alongside the main EzStamp 

window. These windows are available from the View menu, for the following: 

Custom 

Fields 

A country file can be assigned additional data fields for your 

inventory, using whatever naming conventions and data types you 

need. 

Comments EzStamp by default reserves a small space below the stamp details 

area and above the data grids to allow for comments to be added to 

any stamp record. If you would like more space to view/enter 

comments, a secondary window can be displayed and resized 

accordingly. 

Vertical 

Data View 

Data grids for PNB, PNC and FDC Cachet data can contain many fields, 

requiring horizontal scrolling to see all of the record. EzStamp allows 

you to show a selected record from the data grid in a vertical format 

using the special viewer options in the View menu. There is one 

viewer for the grid data and another for the FDC/PNC/PNB image 

which can be linked to the record.  

 

Saving Stamp Records to Your Inventory 

With pre-supplied country files, all records will initially not be part of your inventory 

and will need to be saved to add them. For custom country files you create, there 

will initially be no records whatsoever. 

When saving a record, the minimal amount of information required is the 

Scott/Catalog ID value – all other attributes are optional. 

Saving a record to your inventory can be accomplished in multiple ways: 
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• Click on either of the blue checkmark buttons. There is one in the toolbar at 

the top and a second one in the grades toolbar at the bottom beneath the 

data grid. 

• Use the shortcut key (default is Ctrl + S) or choose the Save option from the 

Edit menu. 

• The report viewer has the ability to add records using either Rapid Multi 

Entry or Quick Inventory methods. 

• Rapid Multi Entry is also available from the Edit menu, and can be used in 

both pre-supplied Scott range and custom ID range modes. 

• Auto-saving options are available from the quick edit features for Grade, 

PNB, PNC, and FDC Cachet data. 

• Auto-saving can be enabled when adding grades to the active stamp record. 

Auto-saving features are intended for bulk data entry and are disabled by 

default. 

• Use the Duplicate record feature to make a 100% copy of the current stamp 

record displayed in the main EzStamp window. 

• The EzImport feature will import all inventoried records from previous 

versions of EzStamp (which have 64-bit export capability). 

You can determine the status of an inventoried record by checking the status icon 

at the bottom left corner of the EzStamp window. 

 
There is no country file opened, or no current stamp record shown in the 

main window. 

 EzStamp is busy performing a background task and can’t be interrupted. 

 
The record is pre-supplied data and has not been added to your 

inventory. 

 The record is part of your inventory and is based on pre-supplied data. 

 
The record is part of your inventory and is a custom variety or part of a 

custom country file. 

 The record is one of two or more duplicate Scott/Catalog numbers. 
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In addition to this indicator, a small colored checkmark will appear to the right of 

the Scott/Catalog ID label in the top left of the stamp details area with one of 3 

colors: 

Green The record is part of your inventory and is based on pre-supplied data. 

Violet The record is one of two or more duplicate Scott/Catalog numbers. 

Red 
The record is part of your inventory and is a custom variety or part of a 

custom country file. 

 

Saving Pre-Supplied Records 

Call up any pre-supplied stamp record and simply click the blue checkmark button 

to save it to your inventory. You are free to modify existing pre-supplied fields 

before saving. EzStamp will keep a permanent copy of all pre-supplied data for 

every record, allowed for easy restoration if you changed a field by accident. 

Saving Custom Varieties 

To save a pre-supplied record under a custom variety, call up any supplied record 

and modify the Scott/Catalog number to one which is not a pre-supplied value, then 

hit the TAB key. You will be asked to confirm the record as a main variety or sub-

variety, after which the record will now be marked as a custom type, even though it 

was based on pre-supplied data. 

 

By default, EzStamp will erase the contents of the main screen when saving the 

new custom record. If you want any information to carry forward from the current 

stamp record on-screen to the new custom record, click on the Copy Filter button. 

This will present a dialog window allowing you to choose what information will be 

preserved when saving under the new Scott number. 
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Duplicating a Record 

A stamp record for any Scott/Catalog number can duplicated with a 100% identical 

copy by clicking on the duplicate icon in the toolbar. When a given Scott/Catalog 

number has been duplicated, the status bar at the bottom of the EzStamp window 

will show the current and total number of duplicate records. 

Saving Pre-Supplied Customizations 

If you want to change any pre-supplied information without adding a record to your 

inventory, the special “S” icon to the left of the Help button in the toolbar can be 

used. This will save any changes you make to the following pre-supplied values: 

Year Date of Issue Denomination/Color 

Watermark Perforation Notes 

NH Percent Plate Block Size Mint Sheet Size 

Quantity Issued Stamp Width Stamp Height 

Mint Price Used Price FDC Price 

Plate Block Mint Price Plate Block Used Price Line Pair Mint Price 

Line Pair Used Price Mint Sheet Price  
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The record will not be saved to your inventory. Note that if the record is already in 

your inventory, this icon will behave exactly the same as clicking on the blue 

checkmark save icon. 

Removing Records from Your Inventory 

The red X icon adjacent to the blue checkmark in the toolbar is used to remove the 

current displayed stamp record from your inventory. How the record is removed 

depends on whether the Scott/Catalog number is part of the pre-supplied data 

provided by SoftPro, or is a custom variety. For custom country files, the records 

are always treated as custom varieties. 

• Custom variety records are deleted and will no longer be available in the 

country file. 

• Pre-supplied records will be returned back to pre-supplied status – all custom 

changes to supplied fields and any of your own data (i.e. grades, FDC 

Cachet, Location, etc.) will be discarded, leaving only the pre-supplied field 

information. 

Removing Duplicate Records 

If the displayed stamp record is a duplicate (i.e. not the first record is a set of 

duplicated records), it will also be removed, as a duplicate record is considered to 

be a custom variety even if it’s based on a pre-supplied Scott/Catalog number. 

Clearing Field Information 

The eraser icon in the toolbar allows you to clear all fields which are not pre-

supplied values, which includes: 

Category Cross Reference 

Comments  Comments by Grade 

Custom Image Links Inventoried Grades 

Price Locks FDC Cachet Records 

Alternate Catalog ID Values Custom PNB Records 

Location Custom PNC Records 

 

Clearing the fields does NOT save the record changes to the country file. You must 

still click the blue checkmark icon to commit the changes. 

If you want to clear everything in the main EzStamp window, hold down CTRL while 

clicking the eraser icon. 

These 2 clear field options are also available in the Edit menu. 
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Editing Grade Data 

EzStamp uses the bottom half of the main window to show a set of tabbed data 

grids, containing records for secondary stamp information. The first data grid is 

used for displaying inventoried grade status, and also the status of any grade if it’s 

part of the priority want/sell lists. 

 

Each of the tabs will show an inventory count in parentheses to the right of the tab 

label. This is the number of records of the associated type which are in your 

inventory for the current Scott/Catalog number. 

The status icon indicates each grade’s inventory/PWL/PSL state, according to the 

icon types shown below. 

 The grade is part of your inventory. 

 The grade is in the Priority Want List. 

 The grade is in the Priority Sell List. 

 The grade is part of your inventory and in the PWL. 

 The grade is part of your inventory and in the PSL. 

 The grade is in both the PWL and PSL. 

 The grade is part of your inventory, in the PWL and also in the PSL. 

 

Selection details below the grid are based on how many grades are currently 

selected in the data grid. The table below summarizes these input fields. 

Your Value EzStamp normally applies supplied prices to any grade, when 

available. Some grades have prices derived from a base price and 

are calculated using one or more “multipliers”. For example, MH-

XF is based on the supplied price for MH-VF, so the MH-XF grade 
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is derived from the MH-VF grade. 

 

You can override a supplied price by entering a value into this 

field and it will be considered the “absolute” price for the grade. 

No additional calculations will be applied by EzStamp to change 

this value. The market value will be ignored when calculating Net 

Value, which will now be Your Value * Grade Quantity. 

Quantity The number of items for the selected grades which will be part of 

your inventory. A value of 0 is acceptable. Note that this quantity 

is not the quantity of physical stamps in your inventory. Each 

grade has a Stamps Per Grade (S.P.G.) value associated with it. 

The physical stamp quantity is this grade quantity * the S.P.G. 

value. 

NH Percent Each Scott/Catalog record may have a Never Hinged percentage 

multiplier, which is used for the never hinged grades. This value 

is applied at the stamp record level, so it doesn’t matter what 

your current grade selection is when you change the value. You 

can enter any value from 0 to 1000 percent. 

Supplied Price This field only appears when a single grade is selected in the data 

grid. The selected grade must also be based on a pre-supplied 

price (Mint, Used, Plate Block Mint/Used, FDC, Line Pair 

Mint/Used, or Mint Sheet). 

The pre-supplied price will be shown in this field. You can 

override the pre-supplied value by simply entering a new price. 

Every grade which depends on that price will automatically be 

recalculated. If you erase the contents of this field, EzStamp will 

restore the original pre-supplied value. 

Note: for custom countries or custom varieties, you can still 

enter a price and EzStamp will consider this to be a pre-supplied 

value for calculation purposes. 

 

Filtering the Grid Fields 

Each of the data grids (for FDC, PNC, PNB and Grade data) can contain many fields, 

some of which may not be of interest to you for displaying in the main EzStamp 

window. If you want to only show a subset of the fields for a data grid, you can 

filter out the ones you don’t want to show. Refer to the help topic under Options 

for the item Field Display Filter for Tabbed Data. 
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Using the Vertical Display View 

As an alternative to filtering the data grid fields, you can show the fields for the 

current selected row in the data grid in a secondary window. Use the Vertical Data 

Viewer item under the View menu to display this secondary window. 

 

This window can be dragged and resized as needed. It will always show the current 

selected record for the active data grid. When you switch from one tab to another 

(i.e. Grades to PNC), the vertical view will switch accordingly. 

Selecting and Saving 

EzStamp provides a small toolbar within the grades tab area to assist with adding 

and removing grade information. 

 

1. The blue checkmark icon provides the same shortcut functionality as the 

one in the top toolbar. It will save all changes for the current Scott/Catalog 

number to the country file. 

2. The green $+ icon will add the selected grades to your inventory, using the 

current quantity (and Your Value if entered). Changes are not saved to the 
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country file until you click the blue checkmark. Note that EzStamp has a 

general preferences option to auto-select and add grades when you click on 

the blue checkmark. This option basically is the same as clicking the $+ and 

blue checkmark icons in one step. 

3. The red $- icon will remove selected grades from your inventory. If the 

grade isn’t currently part of your inventory, this option will have no effect. 

4. This option will display the single grade edit window (see below), allowing 

you to change all the field values for the grade. You can only select one 

grade at a time to use this option. 

5. This option will display the quick edit window for all grades, in a 

spreadsheet format. 

6. Given that EzStamp has options to auto-commit selected grades when 

saving, you may want to ensure that grades are not selected when working 

with other data such as the stamp details fields. This icon simply de-selects 

any selected grades in the data grid. 
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Quick Edit 

The quick edit modes for data grid information (FDC, Grades, PNB, PNC, PWL and 

PSL) all share the same basic editor window. The grade tab has a shortcut icon for 

this quick editor. For the other data types, you can access this option from the main 

menu as the Quick Edit option under the Edit menu. The quick edit option is also 

available from the popup menu when you right click within the data grid area. You 

can double click any area of a data grid to enter Quick Edit mode. 

 

The quick edit window is identical for all data types. The title bar indicates what the 

current Scott number is, and the type of editor which is being used (Grade, PNC, 

FDC, etc.). 

There is a small toolbar window below a menu of options, with the remainder of the 

window being the spreadsheet editor. 

Changing the values in the grid is done by simply moving the selection cursor to 

any cell, and typing in a new value (F2 can be used to initiate edit mode, but 

pressing a valid key will also start edit mode). Once in edit mode, enter a new 

value, and press ENTER to commit the change, or press ESC to cancel. Clicking with 

the mouse on any area outside the cell being edited will behave as if you hit the 

ENTER key. 
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Some fields can’t be edited as they contain information which is read-only, such as 

the grade name or the net value. The cells will be color-coded to indicate if a field is 

read-only. 

Grid Display Order 

A general preference option can be used to set the grid display order to match the 

data grid row order in the main EzStamp window. This option is enabled by default. 

For example, if MH-VF is the first grade in the main EzStamp window, then it will 

also be the first grade in the quick editor grid. If this option is not enabled, then the 

grid order will use the EzStamp pre-defined sort order for grade data, and 

alphabetical sort order (by FDC/Plate Number) for the other data grid types. 

Grid Fields 

If you have filtered any fields in the data grid in the main EzStamp window, then 

they will also be filtered out in the editor. If you need to edit fields which you have 

turned off, use the single grade edit mode instead. 

Options Menu 

Apply Apply all changes and exit the editor. By default, EzStamp will not 

save changes to the country file until you click the blue checkmark 

icon from the main window. If you want to auto-commit changes 

to the country file directly from the quick edit window, a general 

preference option can be enabled for this. 

Exit This option will exit the editor without saving any changes you 

may have made. 

 

Edit Menu 

Undo This option will undo every change you made to all records. 

Clear Erases all field data for the selected grade. 

Clear All Erases all field data for all grades in the grid. 

Current Date If you have a buy or sell date cell selected, you can use this option 

to assign today’s date to the field. 

Choose Date If you have a buy or sell date cell selected, you can use this option 

to display a date picker popup window to set a specific date. 
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Single Grade Edit Mode 

If you want to edit the grade attributes for a single grade, you can use the single 

edit mode option. This option is accessible as a shortcut icon, from the right-click 

popup menu, or from the Quick Edit (Edit Selected) option under the Edit menu. 

 

All of the fields other than grade name and description can be changed. If Stamps 

per Grade is changed, the new value will override the pre-supplied value. If you 

leave it blank, the pre-supplied S.P.G. value is used.  
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Re-Arranging Duplicate Stamp Records 

When you duplicate a record in EzStamp, it's simply added to the end of the 

duplicate set for the Scott number. Hence, the last time you duplicate a stamp 

record will result in that duplication being at the end of the set. 

For those who require a specific sort/display order for their duplicate stamp records, 

a re-arranging option has been added to the EzStamp Edit menu named Re-

Arrange Duplicate Stamps. 

 

Before and After Lists 

The left side is the original list of duplicate stamps, with the primary stamp record 

at the top. The right side list is the new arrangement, which will initially be empty. 

You will create a new sort order by adding stamp records from the left side to the 

right side, until no more stamps appear in the left list. 

To add stamps to the right side, select them in the left side list, and Right Click or 

use the Assign button. 
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To remove stamps from the right side and put them back (i.e. Undo), right click a 

selection in the right side list or use the Remove button. 

Once you have stamps in the right list, use the Move Up or Move Down buttons 

to move a selection of stamps in the right side to the top or bottom. Hold down Ctrl 

to move them to the very top or bottom when clicking one of those 2 buttons. 

Previewing the Stamps 

The dialog window doesn't contain meaningful information for what Duplicate #4 is 

as an example. To view the selected stamp in either the left or right side list in the 

main EzStamp window, double click the entry in the list, or use the Show button. 

Changing the Primary Stamp Record 

You can make the Primary Stamp Record a duplicate and make any duplicate the 

primary stamp record simply by ensuring the primary stamp record is not topmost 

in the right list. The topmost entry will become the new primary stamp record. 

Click on OK to save the new sequence of duplicate records. There is no undo option 

here. If you made a mistake after saving, you will need to use the re-arrange 

option a second time to fix it. 
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Priority Want and Sell Lists 

Priority want and sell lists are used to identify grades which you would like to buy 

or sell. The PWL/PSL system is designed to work with grades; however you can add 

any Scott/Catalog number to the list even if you don’t select a grade. In this case 

EzStamp will identify the PWL/PSL entry as “Any Grade”, meaning you want to add 

the stamp to the list and don’t care which grade. 

Adding Grades 

To add specific grades to the PWL or PSL, select them in the grades data grid and 

click on either the shopping cart (PWL) or dollar (PSL) icons in the main toolbar. 

EzStamp provides quick PWL/PSL modes or the standard (default) interactive mode. 

For interactive mode, a dialog window will be displayed with options. 

 

You can enter a Quantity and Type to Buy/Sell value for all selected grades. The 

checkbox list will reflect the current grade selection in the main EzStamp window. 

You can refine this selection by checking or un-checking any of the grades in the 

list. Use the No Grades button to clear the selection. 

The Replace Existing Grades checkbox determines how any existing PWL/PSL 

entries are affected. If this option is checked, then any existing PWL/PSL entries are 

removed and replaced with only the new values in the checkbox list. If you leave 

this option unchecked, then the grades you check will be added to what is already 

present in the record. 

If no grades are selected, this will result in a PWL/PSL entry of “Any Grade”. 
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The Type and Quantity values are applied to the selection. If you want to use 

different type or quantity values per grade in the PWL/PSL, you must add them one 

at a time, and ensure that the Replace Existing option is NOT checked. 

Once the stamp record is in the PWL or PSL, the shopping cart/dollar icons in the 

toolbar will change from gray to green. Also, the status indicator icons in the grade 

data grid will change for any grade which is part of the PWL/PSL. 

Removing Grades and Clearing the List 

To remove entries from the PWL/PSL, hold down CTRL while clicking on the 

shopping cart/dollar icon in the toolbar. The dialog window displayed allows for 

removal of one or more grades from the associated list. 

 

The checkbox list will reflect the selection of grades in the main EzStamp window. 

Use the No Grades button to clear the checkbox list. The removal of entries is 

directly tied to the checkbox selections in the list. If you selected every grade, this 

removes all entries from the PWL/PSL, even if the grade wasn’t originally part of 

the list. 

The Remove Non-Grade Specific option is designed to allow removal of PWL/PSL 

entries which had NO grades in the list to begin with (i.e. the PWL/PSL entry for the 

stamp record is shown as “Any Grade”). This option, if checked, will ensure that a 

generic Any Grade PWL/PSL entry is properly removed from the list. 

PWL/PSL Auto-Save and Inventoried Status 

An important thing to note about the PWL/PSL system is that records do not have 

to be inventoried to be part of either list. These lists are maintained separately from 

the inventoried record information. The blue checkmark icons are not used to save 
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PWL/PSL entries. Instead, when you click on the shopping cart/dollar icons to add a 

PWL/PSL entry, the information it automatically saved to the country file in the 

associated list. 

PWL/PSL Quick Entry Modes 

A general preference option can be enabled for PWL/PSL quick entry. When 

enabled, you will no longer be provided any dialog window to enter a type, quantity 

or grade selection list. The selected grades will be added to the PWL/PSL using no 

type and quantity of 1. All existing entries for the stamp record will be replaced 

with the new selection. You can still use interactive mode to show the options 

dialog windows by holding down the SHIFT key when clicking the shopping 

cart/dollar icons in the toolbar. 

The quick entry modes also apply to removing entries when CTRL clicking the icons 

(hold down CTRL + SHIFT to bring up the remove options dialog window of quick 

mode is enabled). 

PWL/PSL Menu Options 

The Edit menu provides PWL/PSL submenu options to add, remove and clear 

entries. If quick entry mode is enabled, you will once again need to hold down the 

SHIFT key while selecting the menu item to display the add/remove dialog 

windows. 

Adding PWL/PSL Entries from Data Grids 

You can add PWL and PSL tabs to the main EzStamp window as data grids for 

display and quick edit the list entries. The tabs can be enabled from the EzStamp 

general preferences. As with any of the data grids in the main window, you can 

right click on the grid for a context-sensitive popup menu with common options 

which are also available from the main menu, or double click the grid for quick edit 

mode. 

Quick Edit Mode 

The Quick Edit option under the Edit menu contains submenu choices for using the 

spreadsheet editor for PWL/PSL entries. Refer to the help topic for FDC/PNC/PNB 

quick edit mode for more information. 

Editing the Type List 

When you add new entries to PWL/PSL, you can choose the type to buy/sell from a 

dropdown list of pre-supplied values. However, you can also type new custom text 

strings in the dropdown edit field and your custom types will be added to the 

existing list. A list editor is available for PWL/PSL types from the List Editor option 

under the Utility menu. 
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Quick Edit for FDC, PNC, and PNB Data 

FDC Cachet, PNC, and PNC data for a stamp record use a slightly different version 

of the spreadsheet editor, which is accessible from the Quick Edit submenu under 

the Edit menu, or by double/right clicking the data grid. 

The quick editor for grade information presents all available grades for the current 

country as a fixed number of data rows in the editor window. You can’t add or 

remove records from this grid. 

The other data types allow for record additions and removals, including editing and 

removing records which are pre-supplied by SoftPro (FDC Cachet records are not 

currently pre-supplied). The editor window looks similar to the grade editor, with 

some changes to the toolbar, which are summarized in the table below. 

 

The quick edit window works like a typical spreadsheet editor. Select a cell and 

press F2 to start editing the cell, or simply start typing some text. Use ENTER to 

commit your cell changes (or click on a different cell), or ESC to cancel the edit. 

For PNC and PNB data, pre-supplied plate numbers may be provided for some Scott 

numbers. To distinguish which plate numbers are currently in your inventory, the 

record number tab to the left of each data row in the grid will be color coded in 

green to indicate that the plate number is in your inventory. In addition, the record 

count to the right of the tab label in the main EzStamp window will show the 
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inventoried and total plate number count in parenthesis. For example, the above 

screen shows 2 inventoried and 5 pre-supplied plate numbers, this will show in the 

main EzStamp window tab label as PNC (2:7). 

The toolbar contains several options as summarized below. 

 

1. Add a new blank FDC/Plate number. 

2. Remove the selected row. 

3. Clear the selected row. 

4. Clear all data on the grid. 

5. Undo all changes since you started the edit session. 

6. Save changes to the stamp record. By default, EzStamp will not save 

changes to the country file until you click the blue checkmark icon from the 

main window. If you want to auto-commit changes to the country file 

directly from the quick edit window, a general preference option can be 

enabled for this. Note: You will not be allowed to save if any record is 

missing a plate or FDC number. All other fields are optional. 

7. Cancel all changes and exit the editor. 

8. Revert to pre-supplied values (PNC/PNB editors only). This option will give 

you two choices: remove all your custom plate numbers and undo all 

customizations of pre-supplied plate numbers (including adding back plate 

numbers which you removed), or restore the pre-supplied data but leave 

your custom plate number records as is. EzStamp maintains a read-only 

copy of all pre-supplied PNC/PNB plate numbers to allow for a full restore. 

9. Link an image to the selected plate/FDC number. See below for more 

details on image links. 

10. Remove the image link for the current plate/FDC number. 

11. Paste an image link for the current plate/FDC number from the Windows 

clipboard. 

 

Choosing from a List 

For values which can be obtained from a list of pre-existing values, such as FDC 

Makers, or for Dates which can use a Date Picker rather than typing in a date by 

hand, an extra icon  will appear, or you can press F4, when the cell highlighted 

represents a value for which a popup pick dialog will appear. 
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You can enter a new value directly, choose from the dropdown list, or pick a recent 

value from the recent values dropdown list. 

Use the None button to choose to erase the current value from the record. 

Use Clear Recent to remove the recent value history from the dropdown list. 

Duplicating a Row 

Select any row and choose the Duplicate (F5) option from the Edit menu to create 

a new row with the exact same field information. 

Setting Date Field Values 

Any Buy/Sell date fields can be changed by entering a date string directly, but you 

must use the proper date format, which can be one of 3 types: 

• The date display (output) format (defined in the EzStamp general 

preferences). 

• The date input format (also defined in general preferences). 

• The date format as defined in the current regional settings of your Windows 

installation. 

You can also use the F3 and F4 shortcut menu options to enter the current date or 

use the popup date picker window to set a date using the standard Windows 

calendar widget. 

Pasting and Linking Images 

Each FDC or plate number can have an image associated with it. EzStamp provides 

reports and secondary windows to view these images (they can’t appear on printed 

reports however). Pasting an image will take any valid image file format currently in 

the Windows clipboard and allow you to save it to a predefined location in the 

EzStamp application folder. 
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Click the Autoname button to set the image link name to the Scott/Catalog 

number + underscore + plate/FDC number for you. Note that if your plate or FDC 

number contains invalid characters for a file name, you will need to change the 

name accordingly. 

The file format is based on the EzStamp Preferences setting, which can bitmap 

(BMP), TIFF (TIF) or JPEG (JPG). 

Image link files are stored in a predefined folder which you can’t change: 

• FDC Images: Images\<Country Name>\UFDC 

• PNC Images: Images\<Country Name>\UPNC 

• PNB Images: Images\<Country Name>\UPNB 

Image linking allows you to select an existing image and attach it to the FDC/plate 

number. The image file can be located anywhere, however EzStamp will always 

make a copy of it and store it in the folder location as shown above. 
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This image link window provides a convenient explorer type browser to locate 

image files. The current path is shown in the status bar at the bottom, along with 

the total number of image files found (file types allowed in EzStamp are TIFF, JPEG, 

BMP, PNG, and GIF). The current path is always retained when you close the 

browser window. 

Use the Change Path button to find another folder with images. Use the Find File 

button to open the Windows file browser dialog window. If you choose an image 

using the latter method, the file’s folder will be chosen as the new browse path and 

the selected file will be highlighted in the list. 

Click OK to link the image to the plate/FDC number. 

FDC Makers and PWL/PSL Types 

Quick editors for these 3 types of data provide a drop down list of choices within 

the data grid cells. You can’t edit the fields directly by simply typing some text into 

the cell. Once you click the cell for an FDC Maker, PWL Type to Buy, or PSL Type to 

Sell value, a drop down list appears at the cell click point. If you need to add a new 

custom entry to the list, choose the Add New option from the Edit menu, at which 

point you will be prompted to enter a new FDC maker/PWL/PSL type. This will then 

be added to the current list the next time you activate the drop down in the cell. 
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Single Record Edit for FDC, PNC, and PNB Data 

If you select a single record within any of the 4 primary data grids (Grades, FDC, 

PNB, PNC) in the main EzStamp window, you can edit that specific record using the 

Single/Edit Selected option, which is available as the first menu option under Quick 

Edit in the Edit Menu, or by right clicking within the data grid and choosing Edit 

Selected from the popup menu. Each edit window is unique to the type of data you 

selected. An example, the PNC single record edit window is shown below. While you 

are in the Quick Edit Window, you can Ctrl+Click on Add in the Edit Menu to view 

and edit all the fields using the Edit windows for FDC, PNC & PNB Data records. 

 

All of the edit windows except for grades will have an image preview for the image 

link field, and 3 buttons for linking new images, clearing the existing image (the “C” 

button) and pasting an image from the Windows clipboard. 
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Vertical Viewer and Record Editing 

For the same 4 data types which provide single record editing options, you can 

access the editor from within the vertical data view window by double clicking 

anywhere within the viewer window. 
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Pricing Locks 

Pricing locks are provided to prevent EzStamp supplied data updates from affecting 

current pre-supplied price values (Mint, Used, FDC, Mint Sheet, Plate Block and Line 

Pair prices). Once a record has its pricing locked, any supplied data updates you 

make will be prevented from changing the current price values. You can lock or 

unlock prices using any of the following methods: 

• Click the padlock icon at the bottom of EzStamp window in the status bar. 

When the icon is grayed out, there is no price lock on the record. When the 

icon is green, a price lock is applied to this Scott/Catalog number. 

• Choose the Lock Pricing option from the Edit menu to lock or unlock pricing. 

Use the Unlock All Pricing option to remove the locks from every record in 

the country file. 

• Pricing locks are enabled through similar menu options in the report viewer. 

If you want to determine what records currently have price locks, run a 

Power Search in which the matching conditions are set to all inventoried 

records with Price Lock = Yes. 

Notes: Price locks have no effect on custom countries or records which are custom 

varieties. In addition, price locks CANNOT be set for any pre-supplied record which 

is not part of your inventory. 

Rapid Multi Entry 

Rapid Multi Entry (RME) has been carried over from previous versions of EzStamp, 

but has been enhanced with additional features. There are 2 different modes of 

RME: one for normal Scott type ranges based on existing data in the country file, 

and a second mode for custom ranges for brand new records.  
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Existing Data RME Mode 

 

This window works similar to the Advanced Field search in EzStamp. You will enter 

specific input conditions and use the Find button to create a match list of 

Scott/Catalog numbers. This list will be used to perform the RME within the report 

viewer. 

Use the Search In drop down list to set the primary filtering of records based on 

inventoried status/record type. 

Use the Types to Show drop down list to select a pre-defined range of Scott 

numbers, or enter a custom range in the From/To fields. 

The Cat ID Type dropdown list allows you to perform RME using any of the 

Alternate Catalog numbering formats. When you choose a type other than Scott, 

the Types to Show option is no longer allowed – you must enter a custom range in 

the From and To fields. 

The Duplicates drop down list filters the data by the duplicate record status. You 

can choose to include duplicates, exclude duplicates, or only perform RME against 

duplicate records. 

Check Main Numbers Only to exclude any custom or sub-varieties. 

Check the Sort order option use the report profile’s sort order (default is Scott 

number on the Default Rapid Multi Entry profile). Un-check this option to use a 

custom sort order when displaying the RME search results in the report viewer. 
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The remaining input fields in the window allow for additional filtering. These values 

are combined matches. That is, if you place “1884” in the Year Issued and “red” in 

Denomination and Color, then stamp records for the RME must be year “1884” 

AND the text value “red” must be part of the denomination and color. 

Choose a report profile if you want to preview the search results in the report 

viewer with a field list different than what is provided in the default profile. Keep in 

mind that the RME feature in EzStamp acts exactly like any other Search/Report. 

Click on the Find button to start searching the country file for matching records. If 

any matches are found, you will be able to click on the Begin RME button. This will 

present the search results in the report viewer. In addition, the report viewer will 

detect that this an RME request, and will automatically do the following for you: 

• Bookmark all records in the report viewer data grid. 

• Run the Rapid Multi Entry option from the Edit menu in the report viewer. 

You can cancel out of the RME dialog at this point and view/modify the results in 

the report viewer as needed, then choose the RME menu option once more. 

Click on the Custom Ranges button to switch to the alternate RME mode. 

Custom Range RME Mode 

 

This mode is for new custom Scott/Catalog ranges. The Scott formatting rules 

requires at a minimum a numeric range in the From and To Number fields. The 

prefix and suffix can be used to attach alpha strings before or after the numbers. 
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For example, a prefix of “A” with a range from 20 to 33 as shown above will create 

14 new records (if not already present) with the sequence A20, A21, A22… 

Check the Include existing supplied & inventoried option to count any records 

which already exist which match the Scott number range being created. For 

example, using the above sample range, if A21 was already in your inventory and 

the option is NOT checked, it will automatically be excluded from RME. 

The remaining text fields are used to enter the same data for every Scott/Catalog 

number in the range. Unlike the existing data RME mode, the text fields used in the 

custom range window are used to populate the custom records created, rather than 

being used as search filters. 

Click on the Existing Data button to switch to the alternate RME mode. 

Prefix and Suffix Requirements 

• The prefix value can’t start with a digit, but it can contain fixed digits in any 

other position in the value. 

• The suffix value can’t end with a digit, but it can contain fixed digits in any 

other position in the value. 

• The combination of the prefix, number range, and suffix must pass the Scott 

formatting rules. Alternate Catalog ID numbering formats can’t be used with 

the Custom Range mode of RME. 

Numeric ranges, prefix, and suffix lengths are restricted to a maximum of 5 

characters each. Technically, you can use a numeric range from 0 to 99999 

(100,000 records), but it’s recommended you avoid creating such large ranges to 

keep the country files from growing too large. 

Quick Duplicate 

EzStamp provides a method to quickly make copies of inventoried stamp records, 

using an interactive dialog based on the Rapid Multi Entry (RME) system. This 

option is available under the Edit menu as Quick Duplicate. 
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Refer to the RME help topic for details on the grade and stamp details attribute 

options in this window. There are a few notable differences between RME and Quick 

Duplicate: 

• The current stamp displayed in the main EzStamp window is always the 

source for the duplication. 

• The duplicate is done exactly one time when you click on the Duplicate 

button. The dialog will remain open until you click on Exit, unless you don’t 

have an active navigation list. In this case, the window will close after the 

duplication. 

• Any existing inventoried information will be discarded in the copy, and will be 

replaced by the information contained in the window above. As such, quick 

duplicate has no provision to add to the existing data, which RME does 

provide. 

• Pre-supplied stamp records which have not been added to your inventory will 

not be duplicated, unless the auto inventory option is enabled. 

Duplication by Navigation List 

Quick Duplicate is designed to work efficiently using the active navigation list. Use 

any search or report to create a navigation list and then run the quick duplicate 

option. When you do this, the QD window will display violet arrow buttons, which 

mimic the behavior of the main toolbar buttons, allowing you to step back and forth 

between stamp records in the navigation list. 
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In addition the Auto Step checkbox will be enabled. When you check this option, a 

click on the Duplicate button will advance automatically to the next stamp record in 

the navigation list – the main window will refresh automatically with the new 

record. 

Auto Inventory Mode 

This checkbox option acts as a safety feature, preventing you from accidently 

adding a non-inventoried pre-supplied record. With this option enabled, any non-

inventoried stamp record will be inventoried (only 1 copy will exist after this). The 

Duplicate button will change to Inventory in these cases. 

Automatic Settings 

When you close the quick duplicate window, all settings are saved and restored 

exactly as before the next time you run this option. Use the Clear and Clear All 

buttons to reset these settings. 

Copy and Paste for FDC, PNC and PNB Data 

You can copy information in the 3 data grids for FDC Cachet, PNB or PNC data from 

one record to another. The copy mode is based on an EzStamp general preference. 

This preference option will dictate if all FDC/PNC/PNB data rows are copied, or just 

the selected rows in the data grid. 

There are separate options for copy and paste under the Edit menu. If you intend to 

make frequent use of these menu options, you can attach custom shortcut keys to 

the menu items, or add them to the custom shortcut buttons window. 
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Editing Based on Pre-Supplied Data Differences 

The Supplied Data/Differences option under the Edit menu provides quick 

method to preview, modify and compare all fields for a stamp record which can be 

pre-supplied by SoftPro. Even if the record has no pre-supplied data, you can still 

use this option to view all the pre-supplied fields at a glance (in which case these 

fields are all customized values). 

 

When editing pre-supplied fields in the main EzStamp window, you may notice the 

background and foreground colors of the fields may change. This indicates that you 

have modified a field to have a different value then what has been pre-supplied by 

SoftPro. 

This dialog window shows the same color coding on any field where you have 

changed the value from a pre-supplied version. This can also be reflected in any 

supplied data updates when you have elected NOT to apply the changes. 

When pre-supplied information is available, this window will contain 2 tabs, one for 

current supplied, which is the values as they are inventoried, and the second tab 

for the original pre-supplied values. EzStamp always maintains a read-only copy of 

the pre-supplied information in every country file. You may alter the inventoried 
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copy as much as you need to, but the read-only version is only changed when 

applying supplied data updates. 

Use the Restore Current button to reset a value for any field which the I-beam 

edit cursor is currently positioned in.  You can also double click any field label to 

reset the value, or click on the Restore All button to change all fields to their pre-

supplied values. 

Click on Save to apply the changes. This will not save the stamp record changes to 

the country file – you still need to click on the blue checkmark icon to commit the 

changes. 

 

Image Links 

Each stamp record can have up to 5 images associated with it. The first image is 

defined as the primary or main image, and by default this is the image that is 

displayed in the main EzStamp window. It is also the primary image for pre-

supplied data. 

You can link up to 4 more images for each record. These are named images 2, 3 

and 4, plus an FDC image. Note that for PNB, PNC and FDC Cachet data, separate 

image link options are provided, but they are not tied to the main EzStamp 

application window’s image preview area. 

Each image is referenced as a link, which is the file name, with or without the file 

extension. If you don’t provide a file extension for a link, EzStamp will try all of the 

valid extensions in the following order: 

1. Bitmap Files:  .bmp 

2. JPEG Files:   .jpg, .jpeg or .jpe 

3. TIFF Files:  .tif, .tiff 

4. GIF Files:  .gif 

5. PNG Files:  .png 

Image links do not have a path name component. For example, 

D:\MyImages\myimage.bmp is not a valid link. How images are located by 

EzStamp is based on the following search precedence: 

1. *EzStamp Application Path (Under the Images\Country folder) 

2. *Alternate Image Path (Under the Country folder) 

3. Hard Disk Image Copy Path (Under the Country folder) 

4. CD/DVD Installation Path (Under the EzStamp folder) 
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The country folder is always the parent for all image files. For example, if you have 

an image named 1.bmp for the United States and have installed EzStamp to 

C:\SoftPro2010\EzStamp8, the image would be in: 

C:\SoftPro2010\EzStamp8\Images\USA\1.bmp 

Swapping Image Search Priority 

The first 2 items in the search precedence list can be swapper so that the alternate 

image path has priority over the application installation path. This is done in the 

Images tab of EzStamp Preferences. 

Special Image Subfolders 

You have the option to store all image files in single folder (for images 1-4 and the 

FDC image), or you can split them off to separate subfolders. These subfolder 

names are 2, 3, 4, and FDC. The USA folder structure would appear as follows: 

• Images\USA  Primary image link (Image 1) 

• Images\USA\2 Second image 

• Images\USA\3 Third image 

• Images\USA\4 Fourth image 

• Images\USA\FDC FDC image (FDC images always are located here) 

Special folders can also exist for the FDC Cachet, PNC and PNB record images, 

under the subfolders UFDC, UPNC and UPNB respectively. 

You have the option to add or modify image links for stamp records and provide 

your own custom link references. Use the image link icon in the toolbar or right 

click the image area in the main EzStamp window to display the image link editor. 
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The left image is the pre-supplied image from SoftPro. If the record is a custom 

variety, or you have are working with a custom country file, or no pre-supplied 

image exists, this image area will be blank. 

The right image is the current custom image link. You can’t alter or remove a pre-

supplied image link, but you can modify your image link at any time. 

Reserved Image Link Names 

For any country with pre-supplied images from SoftPro, image link names are 

considered reserved, to preserve data update processes from SoftPro when pre-

supplied images are revised and updated. As such, when you attempt to use a 

reserved image link name, EzStamp will prefix the name with the text “MY_” as a 

hint to ensure you choose an appropriate image link that doesn’t conflict with a pre-

supplied name. 

The 5 radio buttons below the images are used to select one of the 5 possible 

image links for the current stamp record. A color coded ball icon is shown to the left 

of each radio button, which can be one of 4 possible colors: 

Gray:  There is no supplied or custom image link. 
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Red:  Only the supplied image link is present. 

Green: Only the custom image link is present. 

Blue:  Both supplied and custom image links are present. 

Below the radio buttons is the current width and height of the stamp image in 

millimeters. Image dimensions are used specifically for exporting data to 

AlbumGen. The dimensions you can enter can be in inches (suffix in), millimeters 

(suffix mm), centimeters (suffix cm), or points (suffix pt). For example, “1 in” will 

be converted to 25.4 mm by EzStamp after you key in the value. The dimensions 

are always save in millimeters to match the AlbumGen units of measurement. 

Setting the Image Location 

Aside from the CD/DVD location for supplied images (which can’t be used as a link 

path), you can have up to 3 locations where a custom image can be saved, which 

can be found in the dropdown list. 

• The EzStamp installation path, under the Images folder. 

• An alternate image path which you can define in the general preferences. 

• The image copy path for pre-supplied images, which is defined when you use 

the image copy utility. 

This information is saved in the EzStamp general preferences under the Images tab 

by choosing from 1 of 3 locations: 

 

You can only choose one location for storing new custom images, even though 

EzStamp will search 4 different locations for an image. This is done to keep your 

custom images in one area for easier management of your files. Note that this 

location is also use for image restorations from archival backups. If you back up 

images from the EzStamp application path, then switch to the alternate image 

location, restoration from backup will transfer images restored to the new location. 

Browsing for an Image 

Click on the Browse button to display the image file browser. You can set a 

browsing path to any location which is not the expected target path. In this case, 

EzStamp will physically copy the file from the browse path to the proper location for 

you. You can also copy image files directly to the correct path outside of the 
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EzStamp application, and the Browse option by default will be looking at the correct 

path, avoiding the need to browse to a new location for images. 

 

Notice the browse path in the status bar at the bottom of the image link window. If 

you browsed to a new location, the browse path will point to that location until you 

change to a different browse folder. 

Changing Subfolder Settings for Alternate Images 

If you change the general preferences option to enable subfolders (i.e. subfolders 

2, 3 and 4 for the 2nd to 4th image links), you will find that your images will no 

longer be displayed. You must manually move them to the correct subfolder. This is 

why it’s important to set the storage type one time, and stay with that setting, or 

your images will end up in the wrong location. 

Pasting an Image from the Clipboard 

If you have a valid image in the Windows clipboard, you can click the Paste button 

to place the image into the link window.  
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You will have to provide a valid file name for this image. It will be saved using the 

format type defined for image link pasting in the EzStamp general preferences 

(BMP, TIFF, or JPEG). 

Drag and Drop Images 

You can drag an image file from another application (such as the Windows File 

Explorer) to the image area in the image links edit window (or various other image 

windows in EzStamp) to link the file. 
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When you drop an image for PNB, PNC or FDC Cachet data, you will not see the 

above dialog window. This window is for the primary stamp image. You will need to 

choose a name (taken from the drop source) and designate the image as either the 

primary image or one of the 4 alternate choices. 

Manual File Name Entry and Refresh 

You can manually key any file name (with or without extension) in the image name 

field and then click the Refresh button to find the image file and display it. 

Clearing Image Links 

Click on the Clear button to remove a custom image link. If you hold down CTRL 

while clicking, all 5 image links are erased at one time. Note: You are not 

permitted to clear supplied image links. EzStamp ensures that your custom image 

link has higher priority than a pre-supplied link. Once you remove a custom link, 

the original pre-supplied image will be used instead. 

Pre-Supplied Refresh and Duplicate Stamps 

If you have a duplicate stamp record, EzStamp will disconnect pre-supplied stamp 

information from the record. It will copy the pre-supplied information over before 

creating the duplicate copy, but thereafter the duplicate image will no longer be 

subject to pre-supplied data updates from SoftPro. For this reason, an option to 
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refresh a pre-supplied image link for duplicate stamps has been added. This button 

is named Pre-Supp and will only appear for duplicate stamp records. Click this 

button and pre-supplied image links will be applied to any image where a custom 

link is not already assigned. 

 

Building Face Value Data from Denomination and Color 

EzStamp 8 was designed to be backwards compatible with previous versions with 

regards to the pre-supplied stamp information. As such, the denomination of a 

stamp record is bundled together with the color attribute. 

If you need search and report capabilities to value your inventoried grades based 

on the original face value of the stamp, a special utility is available from the Extras 

menu named Build/Update Face Value Fields. 

 

Since there is no specific denomination field for the current (and previous versions) 

of EzStamp, this utility will generate the face value of the denomination as a new 

Custom Field named EZFaceValue. Along with this, a field named 

EZNetFaceValue will be created which will contain the stamp quantity * face 

value. The stamp quantity is the total sum of (Grade Quantity * Stamps per Grade) 

of all inventoried grades for the stamp. 

For example, if the Denomination and Color value is $10.75 multi (Type II), and 

you have a 3 PB-UL items with a S.P.G value of 4, along with 2 MH-VF with a S.P.G. 

value of 1, then the total stamp quantity is 3 * 4 + 2 * 1 = 14, multiplied by 10.75 

to give you a Net Face Value of $150.50. 

You are free to use the Custom Fields editor to change the configuration of each of 

these 2 fields, except for the following: If you change the data type or the field 
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name, you will no longer be able to use this utility. You can delete the custom fields 

at any time, and if you do, the utility will re-create the fields as they should be. If 

the fields already exist in the proper data type, they will be left as is. 

Important Notes and Limitations 

• The denomination is expected to be the first word in the Denomination and 

Color field. 

• The rules for determining the face value are very strict and highly dependent 

on the format of existing pre-supplied data values. If you create custom 

denomination/color values in other formats, the utility may not be able to 

determine the face value. In this case, nothing will be assigned to the stamp 

record. 

• Face values are not related to your currency conversion rates. If the face 

value is 50 cents, then this is the value used to determine the net face value. 

• Face values are stored as text, whereas the net face value is stored as a 

currency. Keep this in mind, as the face value preserves the format directly 

from the denomination and color field. As such, the symbols $, the suffix of 

“c”, fractions, and decimal points are used to determine the net face value. 

Other currency symbols or notations for a denomination are not currently 

supported. 

• Only country files based on Canada and United States are currently 

supported. 

• Custom country files without pre-supplied data are not supported. 

Removing Existing Field Data 

If you check the option next to the Begin button, then all field data for Face Value 

and Net Face Value is erased before the build starts. Since these are custom fields, 

you are free to alter their values at any time after performing a build. However, 

once you do build the values a second time, EzStamp will replace any field values 

that already exist, provided that they are in the proper format. This checkbox 

option is provided to allow you to preserve custom face values that are based on 

non-standard denomination and color formats. If you leave this unchecked, your 

custom face values are preserved. 

When to Update Face Values 

As the net face values are not part of the EzStamp grade system, they are not 

automatically calculated when your stamp quantity (inventoried grades and their 

associated quantities) change. To have the most accurate face value information, 

run the build utility periodically, or just prior to running a report, to get accurate 

results. 
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Report Profiles 

You can attach these 2 fields to any custom report profile, or use the pre-supplied 

custom report Net Face Value Report. The fields are identified in the profile field 

list as a custom field data type. If you intend to make use of this report often, 

assign it to one of the custom report menu positions using any of your basic or 

advanced search/report types. 
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Searches and Reports 
Searches and reports in EzStamp are basically one in the same. They have been 

structured around two menus and divided in such a way as to retain the same 

organization as previous versions of EzStamp. 

A search/report consists of 4 key features: 

• An initial dialog window containing the input conditions to filter the stamp 

information to show only what you want from the country file. 

• A report profile, which defines the fields which will appear in the report and 

the attributes for printing it. 

• One or more fields on which the report will be sorted. 

• The Report Viewer, which displays the results of the search using the report 

profile. The viewer contains many features for working with the report data; 

so many in fact that is has its own dedicated help section. 

Basic Field Level Search Window 

Many of the searches and reports use 2 primary dialog windows, with only small 

differences for each report type. The basic field level search window provides a 

limited set of input conditions. An example screen is shown below. 
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Search In 

This drop down list provides the initial search depth to filter the data. It can be one 

of the following (based on the type of report and country file. Some of these 

choices will not be available depending on the search being performed): 

All Stamps Unfiltered: every stamp record is included in the 

search. Additional input conditions will filter against 

the complete country file to refine the search. 

Custom Varieties Only custom varieties will be used in the 

search/report. Note that for a custom country file 

with no pre-supplied stamp data, all records are 

technically custom varieties. 

Inventoried Data Only records which have been saved to your 

inventory will be included. For custom country files, 

this is the same as custom varieties (every record is 

counted). 

Modified Supplied Data Any pre-supplied data, whether inventoried or not, is 

included. 

All Customized Data Any modified pre-supplied data, where you have 

altered one or more of the supplied stamp attributes 

(i.e. Denomination & Color), or any custom variety 

records are included. 

Supplied Data Any records based on pre-supplied data are 

included. Custom varieties are not. The records may 

or may not be inventoried. 

Supplied (Not Inventoried) Any records which are based on pre-supplied data, 

yet not inventoried, are included. This choice is 

handy to report on every pre-supplied stamp record 

which is not currently part of your inventory. 

 

Types to Show 

This drop down list is carried forward from previous versions of EzStamp, which 

provides a choice of Scott number ranges to limit the scope of the search. 
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Duplicates 

Duplicate stamps are ones where you have created a copy of an existing stamp 

record number into a new record which uses the same Scott number. There is no 

limit to the number of duplicates you may have for a given Scott number, and each 

one will have its own set of attributes which can be maintained apart from others. 

The drop down list allows you to filter the search based on one of 3 choices: 

All Entries Unfiltered: duplicate and normal stamp records are 

included. 

Ignore Duplicates The duplicate records will not be part of the search, only 

the primary records from which all the duplicates are 

derived from will be in the report. 

Only Show Duplicates Only duplicate stamp records are included. The primary 

record from which the duplicate is based on is not part of 

the report, or any records which have no duplicate 

entries. 

From/To Scott Range 

When you choose a range from Types to Show, the From and To values will 

automatically be adjusted based on the chosen selection from the list. You can 

override these values by simply entering a custom type range into the two input 

fields. The values must conform to the 15 character ID notation used by EzStamp 

for a Scott number. 

Report Profile 

Almost every search and report dialog window in EzStamp will require a Report 

Profile to be assigned. EzStamp comes with several “Default” stock profiles, which 

are based on the items under the Search and Report menus. These profiles will 

start with the word Default to indicate a stock pre-supplied profile. 

Each search and report dialog will have a specific preset profile assigned to it. The 

drop down list can contain additional custom report profiles which you can create, 

or may be provided as additional custom profiles from SoftPro. Only one pre-

supplied stock default profile will be available for each report/search type. 

Report Profile Sort Order 

Each report profile contains sorting conditions on how to display the search results 

in the report viewer and on printed reports. The default for most reports is simply 

to show results in ascending Scott number order. You can check this option to 

override the sort order and specify a custom sort order. The Sort Order button will 

then become enabled. 
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Apply Grade Filtering 

This option is only applicable for reports where you are displaying individual grade 

values and quantities in the report and the profile is restricting which types of 

grades to show (i.e. Grades based on Mint Values only). When checked, the grades 

shown on the report will be filtered to only show the types which match the report 

itself (i.e. a Mint Details report will not show Used grade information). When 

unchecked, the report grade data is unfiltered and will show all grades defined in 

the report profile. 

Main Numbers Only 

Check this option to filter the search results to not include any stamp record where 

the Scott number is not considered to be a Main Variety. 

How to Display Results for Searches and Reports 

Most of the search/report dialog windows will contain up to 5 radio buttons which 

determine which display method will be used for the report data: 

Spreadsheet Viewer This report viewer window will show the stamp records in 

a spreadsheet type grid of rows (records) and columns 

(fields). This viewer contains a wealth of options to view 

and manipulate the stamp records directly from the 

viewer itself without the need to go back to the main 

EzStamp application window to edit or view the record 

data. 

Data Browser The data browser is a special high speed, read-only 

version of the spreadsheet viewer. This choice is similar 

to the report views in the previous versions of EzStamp. 

You can’t manipulate the data in the report in any way; 

however, you have full sorting capabilities on every 

column of data due to its simple presentation format. 

Thumbnail Viewer The report results are displayed as a grid of images in the 

thumbnail viewer window. This viewer sits alongside the 

main EzStamp window and can be resized and dragged to 

any place on your screen. The number of rows and 

columns in the image grid can be changed easily using a 

general preferences option. 

Navigation List Navigation Lists contain all of the stamp records from the 

search results, without any report display capability. The 

list is a collection of Scott & Alternate Catalog ID 

numbers, which can be cycled from the main EzStamp 

window using the purple arrow buttons in the tool bar. 
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These lists can be used for more advanced tasks in 

EzStamp, such as combining multiple searches/reports 

into a new customized search result list, or in the 

creation of slideshow presentations. 

Main Window This option will display the results in the main EzStamp 

window, without leaving the search dialog window. When 

the results are shown, the bottom status bar of the 

search window will show a small white collapse icon, a 

record count, 2 navigation arrows and the current record 

position. When the dialog is collapsed, the search window 

will only occupy a tiny portion of your screen, allowing 

you to see the results in the main window easier.  

 

An example of this collapse search window is shown 

below: 

 

 

 

Note that the main EzStamp window is not accessible 

even with the search window collapsed. Transfer the 

results to a navigation list instead if you need to be able 

to work in the main application window while viewing 

search results this way. 

 

Reset, Find and Show 

Most search and report dialog windows will contain 3 buttons with these names. 

The Reset button will restore the input conditions in the search window to default 

values. EzStamp will normally keep track of all input conditions when you display 

the report data so that the next time you run the same search/report, the input 

conditions will be exactly as you left them. 

The Find button will execute the search against the country file using all of the 

filtering choices you selected. If no matches are found, you will not be able to 

display the result data and the Show button will remain disabled. 
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The Show button will display the search results using the choice you selected from 

the 5 available. 

Customized Sort Order 

Every report profile contains its own sort conditions for displaying the results, and 

this is used no matter which display option you choose. If you need to change the 

display order, you can do so in one of two ways: 

Edit the report profile and change its sort order. This requires you to use the 

Custom Report Profile Editor to change the sort conditions, which is not as quick 

and convenient if you want to temporarily show a report using a different ordering. 

Check the sort profile override option and click on the Sort Order button. This will 

present the following dialog window: 

 

You can sort the report data using up to 5 fields, each of which can be in ascending 

(A to Z) or descending (Z to A) order. Check option for Z to A on each field to 

reverse the sort order. 

The sort field is limited to a specific set of primary stamp attributes and can be 

extended to use custom fields which you can attach to the stamp record. You can’t 

choose attributes which are considered secondary data within EzStamp (Priority 

Want and Sell Lists, FDC Cachet Data, PNB or PNC data, and inventoried grades). 
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Secondary data has special sorting conditions contained within report profiles and 

can also be sorted on-the-fly using the Data Browser view option (but not the 

spreadsheet viewer). 

Advanced Field Level Search Window 

You may have noticed a button named Advanced in the basic search dialog 

window. Clicking this button will switch the input condition window to one with a 

more comprehensive list of choices. This window will also contain a button named 

Basic which will switch you back to the normal basic input window. 

 

All of the choices from the basic window are contained in the advanced version. 

Refer to the basic input window section for details on those parameters. 

Cat ID Type 

This drop down list determines the From/To range values used to search the 

country data. Note that the Types to Show list is disabled when you choose any 

catalog ID type other than Scott. This is due to the fact that alternate catalog 

numbering systems can’t use the pre-defined Scott type ranges. 

Supplied Stamp Details 

The following text input fields are available for attributes which are considered as 

“pre-supplied” information: 
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• Date of Issue 

• Denomination and Color 

• Watermark 

• Perforation 

• Notes 

• Year 

For year values, you can enter a From and To value to match on a range of years, 

or just enter the From value to match a single year. 

When entering a value, EzStamp will consider the match to be valid based on the 

text you entered, and it will not be case-sensitive. For example, if you put red into 

Denom. & Color, the text will match on 5c red orng, 3c dull red (Type I), and 5c 

brt red brn. 

Inventory Details 

The following text input fields are available for attributes which are not part of the 

pre-supplied information: 

• Location 

• Cross Reference 

• Category 

Note: Custom fields are available in a special search type (Inventory Details, User 

Custom Fields). 

Price Filters 

Below the Category drop down list is a button named Price Filter. When you click 

on this button, you will be provided a small dialog window used to restrict the 

report results based on one of the stamp price values (Mint, Used, FDC, etc.). 

 

This price filter will take precedence over all records returned from the other search 

attributes and exclude any records which don't meet the conditions of the price 
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filter. This feature does not support filters on multiple price values (i.e. Mint + Used 

at the same time). 

Once a price filter is active, it will show the price type in a white box to the right of 

the Price Filter button, and an X button to its right. Click on the X button to remove 

an existing price filter or use the No Filter option from the filter dialog window. 

Special Character Entry 

You can use the special symbols boxes (there are 3 for fractions and 2 for currency) 

to enter those characters into any of the text input fields. While entering a search 

string, click the symbol box and the character will be added to the current contents 

text box at the I-beam cursor position. 

Global Searches 

The Global button is used to perform the search against one or more registered 

country files. Since countries are separate files in EzStamp, the time to run a 

search is longer, based on the number of countries selected, the amount of stamp 

record information in each file, and on the time necessary to open and close each 

country as the search is being performed. Unlike a normal search, Global searches 

do not allow you to choose how to display the matching stamp records – they are 

always presented in a floating report view alongside the main EzStamp window, 

same as the Stamp List Viewer.   
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Field Level Searches 

These are very simple search dialog windows which allow you find stamp records 

based on a single pre-supplied or inventory field type. All the input windows are 

basically the same, with the only difference being the actual field searched on. An 

example of this window is shown below. 

 

This dialog window is almost identical to the Basic Field Level search window. Notice 

the additional field at the bottom. This field will change based on the type of search 

chosen. 

All of the pre-supplied and inventoried data field searches share a common default 

report profile, which you can change using a custom profile. 

Pre-supplied Data Searches 

Pre-supplied field searches can be found in the Search menu under the Stamp 

Information submenu. There are searches for the following: 

• Year 

• Denomination and Color 

• Date of Issue 

• Watermark 

• Perforation 

• Notes 
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As with the Advanced Field Level search window, the field value will match against 

the full field contents, provided that the characters which make up your search text 

are contained within the stamp data. 

Inventoried Data Searches 

Inventoried data searches can be found in the Search menu under the Inventory 

Details submenu, for the following: 

• Location 

• Detailed Location  ( ** see Below For details on this type of search ) 

• Cross-Reference 

• Category 

• Comments 

• Custom Fields 

Note that for a custom field search, you must have at least one custom field 

created for the country file. The search window will provide a drop down list 

allowing you to choose which custom field to search on. Depending on the type of 

custom field, you may get a text input field to enter the search value, a date picker, 

or a start/end numeric range. 

 

Detailed Location Search 

EzStamp allows you to define a location for your stamp in 5 different places: 

• Primary record location, as shown in the Loc'n field in the main EzStamp 

window. This location works the same as all previous versions of EzStamp 

and the location is associated with the Scott number for this record. 

• Grade Location, which appears in the grades data grid of the tabbed area at 

the bottom of EzStamp window. 

• FDC Cachet Location, which appears in the grid of the FDC tab. 

• PNB Location, which appears in the grid of the PNB tab. 

• PNC Location, which appears in the grid of the PNC tab. 

EzStamp treats the latter 4 locations as "sub-locations", which can act as a primary 

location at the grade, plate number, or FDC number level, or as a sub-location to 

the primary location defined at the stamp record level. The choice of how to use 

locations is up to you. You can choose to ignore sub-location fields entirely and use 

the data fields filter option to hide location in each of the data grid tabs. 

Unlike the Location search feature in EzStamp, which only searches against the 

primary stamp location data, the Detailed Location search allows you to find stamp 

records for both the primary and sub-location data. 
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This dialog window is almost identical to the Basic Field Level search window. There 

are some additional search conditions which are specific to a Location search. 

The default report profile is named Default Location Report. You can choose to 

customize this report (for both Line Item and Standard versions) profile using the 

Report Profile Editor. 

Filtering by Sub-Location 

The 4 checkbox items to the right of the 5 radio buttons for showing the results are 

used to filter the search conditions and also what appears in the report. 

• Check Grades to extend the search of the sub-location option to the grades 

data for the stamp. 

• Check FDC to extend the search to the FDC Cachet data. 

• Check PNC to extend the search to include PNC record locations. 

• Check PNB to extend the search to include PNB record locations. 

When a checkbox option is checked, the search will be applied to the associated 

record data, assuming a search option was applied from the drop down list under 

the Grade, FDC, PNB and PNC Locations section of the dialog window. 
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A checked option also determines if the associated grade, FDC, PNC, or PNB records 

are displayed on the report. For example, if the FDC checkbox is not checked, then 

FDC data will never appear in the report, nor will FDC records be searched. 

Report Profile Type 

The checkbox named Line Item Report Format is used to set the type of report 

which will be used. When checked, all results are shown using the special Line Item 

format, which shows grade, FDC, PNB and PNC records on a line by line basis 

without any primary stamp information.  

When unchecked, the standard report format is used. The default profile for this 

format will include the sub-locations as separate columns in the report, along with 

columns for individual grades, FDC, PNC and PNB numbers. 

The Report Profile dropdown list will change to a different set of available report 

profiles based on the checkbox state. For Line Item report formats, only profiles 

which are defined for Line Item reports will appear. The Default pre-supplied profile 

has the same name for both report formats, yet are separate profiles within 

EzStamp and can be customized individually. 

Primary Stamp Location 

This area contains 3 items of information associated with search conditions for the 

Primary stamp location. 

Match Type 

The Match Type dropdown list contains the search type to be used. This drop down 

list is the same for both primary and sub-location field searches. 

Do not Search Do not search on the primary location 

 
This disables the search for the primary Location field. 

Searches will instead be applied to sub-location fields only. 

Partial Match Partial match to the search value 

 
Enter a value into the Search Value field. The drop down list 
contains any primary locations for the current country file. The 

search is not case-sensitive, and will match part of the location 
to the value provided. 

Exact Match Exact match to the search value 
 

The Search Value must match the primary location exactly. 
However, the search is not case-sensitive. 

Any Stamp Find any stamp with a location of any value 

 
No search value is provided. The search will find any stamp 

record where the location has any value, regardless of what it 
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is. This option will simply filter out stamp records which don't 

have a location defined. 

No Locations Find any stamp where the location is empty 

 
This option will find stamps which don't have a primary location 
defined. 

 

Matching Primary and Secondary Sub-Location Searches 

As there are 2 search conditions provided, the way that the search is performed is 

based on the checkbox option named Match Primary AND Secondary. 

If this option is checked, then the search result against the primary location and the 

search result against the sub-locations must BOTH be satisfied. 

If this option is unchecked, then a search results in EITHER Match Type will result in 

the stamp appearing on the report. 

Search Values 

The search value is only applicable to partial and exact match types. Any other 

match type will result in this text field not being displayed. The text you enter can 

be in upper or lower case, as the search is not case-sensitive. 

 

Secondary Sub-Locations 

The area labeled Grade, FDC, PNB, PNC Locations also contains 3 items of 

information associated with search conditions for the location fields defined within 

the grade, FDC, PNB and PNC details of the stamp record. 

A search which matches against any of these 4 areas is considered valid for 

appearing on the report. If you don't wish to extend a search/report condition for 

any of the 4 areas, uncheck the appropriate area in the top area of the search 

dialog window. 

The Match Type conditions are almost the same as that for primary with one 

additional type.  

A key point to note about sub-location searches is that records which have no 

quantity associated with them will NOT count in searches. You must inventory a 

grade, FDC, PNC, or PNB record with at least a quantity of 1 (i.e. for PNC numbers, 

at least Qty=1 for Strip of 1, 3 or 5). 

Do not Search Do not search on these secondary locations 
 

This disables the search for all sub-location fields. Searches will 
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only be applied to the primary stamp location. Note that you 

can't have both Match Types set to Do not Search. 

Partial Match Partial match to the search value 

 
This value will be searched against each location for all grade, 
FDC, PNC or PNB data (depending on the filtering using the 

checkbox options). At least one matching record will result in 
the stamp appearing on the report. 

Exact Match Exact match to the search value 
 

The Search Value must match a sub-location exactly. However, 
the search is not case-sensitive. 

Any Stamp Find any stamp with at least one location of any value 
 
No search value is provided. The search will find any stamp 

record where a sub-location has any value, regardless of what 
it is. 

No Locations Find any stamp where not a single location is defined. 
 

This option will find stamps which don't have any location 
assigned at the sub-location level. For example, if only the 
Grades checkbox is checked, this option will return stamp 

records where every inventoried grade has NO location defined. 
If you extend the checkbox states to include FDC, PNB and 

PNC, then results are based on empty locations for ALL plate 
number, FDC numbers and grades which are inventoried. 

One or More 
Empty 

Find any stamp which has one or more empty locations 
 
This type will return any stamp record where a location is not 

defined for at least ONE grade, FDC number, PNC or PNB plate 
number. 

 

Excluding Non-Matching Records from Reports 

This checkbox option is only applicable for Standard Report profiles (when the Line 

Item Report Format is unchecked). For line item reports, the filtering is 

automatically applied and will never include FDC, Grade, PNB, or PNC records which 

don't match the search conditions. 

For standard reports, this works identical to the same option for PNC, FDC, Grade 

and PNB Searches. When checked, any record which doesn't match the search 

condition is dropped from the report. The data is still present, but it's automatically 

hidden from view. The Display All Data Rows option in the Report Viewer can 

restore all the hidden grade, FDC, PNB and PNC data on the report. 
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Note that the profile configuration for a standard report determines how the data is 

displayed. If you choose an alternate report profile which doesn't include FDC, 

Grade, PNB or PNC Date Groups, the report will never show the sub-location 

information. 
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EzBrowse 

EzBrowse is a feature from previous versions of EzStamp which allows you get a 

quick report of all the stamp records in the country file. The browser is based on 

the standard report Spread Sheet viewer, with a limited subset of features. There is 

no dialog window to provide input conditions to filter the search. You can only 

change Main Variety filtering from within the EzBrowse submenu. 

By Pre-Supplied Data 

This option is available in the Search menu under EzBrowse, Supplied Data or 

Ctrl+F. 

 

Refer to the Report Viewer section for details on the various menu and toolbar 

options within the viewer window. Note that the EzBrowse report view will always 

show the image preview pane to the left of the data grid. 

By Inventoried Data 

This option is available in the Search menu under EzBrowse, Inventoried Data. 

The presentation is the same, with two notable differences: 

• Only inventoried records are included. 

• Cross reference and location fields are added to the field list in the report. 
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Supplied Price Search 

This option is available in the Search menu under Supplied Prices. This type of 

search looks at the pre-supplied prices provided in the country file. As such, this 

option is not available for custom country files. 

 

There are a two different ways to search supplied price data using this window. 

Supplied Prices by Grade Type 

Check the grade type option at the top of the window and the Grade Select button 

will be enabled. When you click on this button, you will be given a grade selection 

dialog, allowing you to choose which grades will be searched. 

The current grades which will be used can be seen in the list at the very bottom of 

the window. 
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Grade Selection Dialog Window 

 

The grade selection window allows you to quickly choose specific grades from those 

available in the current country, including pre-supplied grades and custom grades 

which you can create.  

Grade Groups allow you to create a custom selection of grades and save this to a 

file. There are several pre-defined grade groups which will appear in the Grade 

Group drop down list, along with your custom groups. The Delete button can be 

used to remove custom grade groups; however you can’t modify or remove a pre-

supplied group. 

There are several places in EzStamp where grade group selection options are 

provided. When you have the opportunity to do so, this dialog window will always 

be available to allow quick selection of specific grades. 
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Comparison Type 

The Comparison Type list allows you to choose how to compare your search price 

values to the actual Market Value (the pre-supplied price, which may or may not be 

calculated on a grade from which the base price is derived from). You have the 

following comparison options: 

All Values The price/grade value is not $0.00. You don’t 

provide a matching search value for this type. 

Greater Than The search value > pre-supplied value. 

Less Than The search value < pre-supplied value. 

Equal To The search value = pre-supplied value. 

Greater Than or Equal To The search value >= pre-supplied value. 

Less Than or Equal To The search value <= pre-supplied value. 

Not Equal To The search value ≠ pre-supplied value. 

Between The pre-supplied value is between the two search 

values inclusively. 

 

For all comparison types other than All Values, you must provide a search value in 

the first Price field, or two values for the Between comparison type. 

Supplied Prices by Price Type 

All pre-supplied grades in EzStamp use a base price type. Some grades have 

Market values calculated from another grade using one or more price modifiers 

(multipliers). If you want to perform a search based on the supplied base prices 

themselves, ensure that the Grade Type checkbox is unchecked, and choose a base 

price type from the Supplied Price drop down list. Currently, the following base 

price types may be used: 

• Mint 

• Used 

• FDC 

• Mint Sheet 

• Mint Plate Block 

• Used Plate Block 

• Mint Line Pair 

• Used Line Pair 
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Grade Market Value Comparison 

This option is available in the Search menu under Grade Comparison. This type 

of search looks at the pre-supplied (or custom) market value prices associated with 

each grade. Unless you are entering supplied prices (i.e. Mint, Used, FDC, etc.) for 

custom stamp varieties and custom countries, this search utility will only be 

valuable for countries with pricing provided by SoftPro. 

 

The upper third of the dialog contains the basic report settings common to other 

reports in EzStamp. The middle section contains up to 3 levels of grade-specific 

matching conditions. 

At least one source grade must be provided. A source grade can be compared to 

any other grade, or to a specific price, even if the price is zero, by placing the price 

in the Comparison Price field. 

When comparing grade to grade, you may also specify a difference amount in the 

Minimum Difference field. 

Using the screen capture above as an example, the search would match all stamps 

where: 

The Used Very Fine market value is greater than the Mint Hinged Very Find value by 

more than $1,000 AND the Used Very Fine value is also at least $10,000. 
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The 3 checkbox options below the grade conditions are for refining the search. 

Check the Any Valid Comparison option to match a stamp if any of 2 or 3 

conditions are satisfied. Using the example above, this means you will see stamps 

where the USED-VF value is > $10,000 OR the Used Very Fine market value is 

greater than the Mint Hinged Very Find value by more than $1,000 

Use the Search All Stamps option to filter based on all stamp records or just on 

the Inventoried stamps. 

Check the Ignore Duplicate Stamps option to ignore all Scott numbers which are 

duplicated in your inventory. 

Report Grade Auto Filtering 

The default report profile for this search will show all grades across the page with 

their market values. Assuming you don't use a different report profile, the grades 

shown in the report will only include the ones which were in the search conditions. 

Using the example in this topic, only MH-VF and USED-VF will appear in the report. 

 

  



EzStamp Reference – Version 8.0 

Page | 172 
 

Power Search 

This option is available in the Search menu under Power Search. The power 

search provides the most comprehensive method to find stamp records and filter 

the results down to what you are looking for. It doesn’t provide the ability to 

replace all of the other searches and reports, especially the unique searches such 

as FDC Cachet Search, but it can be used as a substitute for all of the basic and 

advanced field level searches. 

  

A power search is comprised of 1 to 3 levels, each level being a unique search unto 

itself. The Level of Search drop down list provides the conditions by which the 

results of the each search level are combined to create the final list of stamp 

records which will be in the report. 

The Search In, “Show In” options, Main Numbers and Profile Sort Order 

options are the same as in the basic/advanced search windows. The Ignore 

Duplicates option is a simple checkbox type (you can’t choose to show only 

duplicates using this option. However, you can accomplish this using a field search 

based on duplicate sequence numbers greater than 1). 

The level of search is used based on matching conditions between each level. For 

each single stamp record searched against, each level counts a match result 

independently. For the example above, if a stamp record has a Pre-supplied mint 
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price that is not $0.00, the first level is considered to be a match. If the 

Denomination and Color field contains the text value red, then the second level is 

considered to be a match.  

Level of Search Types 

As you choose a level of search, the number of levels in the dialog window will 

increase or decrease accordingly. You will not be able to perform a multi-level 

search unless each level’s input conditions are entered. 

Level 1 Only Matches The simplest power search type, only one level of 

search, so a record is considered valid for the report 

if the search conditions are met. 

Level 1 And Level 2 Match A two level search when both levels of search must 

be valid. In the example above, the record must 

have a mint price other than $0.00 and the 

denomination and color must contain the text red. 

Level 1 Or Level 2 Match A two level search where either level must be valid. 

In the example, the record can have a mint price 

other than $0.00 OR the denomination and color 

contains the text red. 

Level 1, 2 And 3 All Match A three level search where all 3 levels must have a 

matching condition. 

Level 1 Or 2 Or 3 Match A three level search where ANY of the 3 levels must 

have a matching condition. 

(Level 1 Or 2) And Level 3 

Match 

A three level search where either level 1 or 2 has a 

matching condition, AND level 3 MUST always have 

a matching condition. 

Level 1 And (Level 2 Or 3) 

Match 

A three level search where either level 2 or 3 has a 

matching condition, AND level 1 MUST always have 

a matching condition. 

Level 1 Or (Level 2 and 3) 

Match 

A three level search where either level 1 has a 

matching condition OR BOTH level 2 AND level 3 

have matching conditions. 

(Level 1 And 2) Or Level 3 

Match 

A three level search where either level 3 has a 

matching condition OR BOTH level 1 AND level 2 

have matching conditions. 
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Search Criteria: Type 

The type of data specifies a specific subgroup of the information in a stamp record. 

Once you select the data type, additional filtering options will be adjusted based on 

the type you chose. Not all types shown below will be available, depending on the 

country which is currently open.  

Primary Fields Primary stamp information, including fields from main 

application stamp details area, supplied prices and 

calculated price and quantity totals. 

Any Text Field Any field which is classified by EzStamp as simple text 

information will be searched. You can filter the text fields 

to a more restricted subset using the Fields button. 

Any Numeric Field Any field which is classified by EzStamp as numeric data 

(quantity or other non-currency numeric types) will be 

searched. Fields can be filtered using the Fields button. 

Any Date Field Any field which is classified by EzStamp as a date value 

will be searched. Fields can be filtered using the Fields 

button. 

Any Currency Field Any field which is classified by EzStamp as a monetary 

value will be searched. Fields can be filtered using the 

Fields button. 

Custom Fields If you have attached custom fields to the country file, you 

can search on any of them using this option. 

Inventoried Grades This option allows you to search specific fields related to 

grades which have been inventoried to the stamp record. 

The Grades button will be enabled allowing for additional 

filtering to one or more specific grades. 

Plate Number Coils This option will search against specific fields associated 

with the PNC data in the stamp record. 

Plate Number Blocks This option will search against specific fields associated 

with the PNB data in the stamp record. 

Priority Want List This option will search against records which are part of 

your Priority Want List. 

Priority Sell List This option will search against records which are part of 

your Priority Sell List. 

FDC Cachet Data This option will search against specific fields associated 

with the FDC cachet data in the stamp record. 
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Note: The search types of PNB, PNC, FDC, PWL, and PSL will search against all data 

rows associated with the stamp record. For example, if you executed a PNC search 

and there are 14 plate numbers assigned to the stamp record, the search is 

performed against all 14 PNC rows, and if at least one row matches the search, 

then the stamp record is also a valid match. 

Search Criteria: Field 

For the “Any” search types, such as Any Text field, this drop down list is disabled. 

For all other search types, this drop down list will contain all the fields which can be 

chosen to search against, based on the data type you chose. Only one field can be 

chosen for the power search level. 

Grades Filter 

For the Inventoried Grades search type, this button will be enabled, allowing you to 

restrict which grades will be searched. Clicking the button will show the Grade 

Selection Dialog Window. 

Any Field Filter 

For the “Any” search types (Text, Numeric, Currency, Date), this button will be 

enabled, allowing you to provide additional restrictions to which fields are in scope 

for the search. 
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Select which fields should be part of the search and click on the OK button. If you 

want to create a custom filter and save it to file, click on the Save button. You can 

recall this filter by using the Load button. 

Note: To clear a field filter, click on Select None then OK. For clearing a grade 

filter, you click on Select All then click on OK. 

When either a Grade or Field filter is in effect, a small white arrow icon will be 

shown between the two buttons, indicating that a filter is being applied to the 

search. If there is no filter in effect, the icon will not appear. 

 

Search Criteria: Operation 

This drop down list contains the operations available to compare your search 

value(s) against the field values in the stamp record. The types of operations 

available are automatically adjusted based on the type of data you are searching 

against. 

Contains For text fields, the search value matches on part of 

the stamp record field value. The search value can be 

contained anywhere within the field. 

Doesn't Contain For text fields, the search value can’t exist anywhere 

within the stamp record field value. 

Empty The field value in the stamp record doesn’t contain 

any data. 

Not Empty The field value in the stamp record contains any data 

other than “nothing”. 

Starts With For text fields, the search value matches on the 

starting characters of the field value. 

Ends With For text fields, the search value matches on the 

ending characters of the field value. 

Greater Than The search value > stamp field value. 

Less Than The search value < stamp field value. 

Equal To The search value = stamp field value. 

Greater Than or Equal To The search value >= stamp field value. 
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Less Than or Equal To The search value <= stamp field value. 

Not Equal To The search value ≠ stamp field value. 

Between The stamp field value is between the two search 

values inclusively. 

Is No For Yes/No type field searches, the stamp record 

value is No. 

Is Yes For Yes/No type field searches, the stamp record 

value is Yes. 

 

Case-Sensitive Searches 

For text-based fields, you can specify that the text search is to distinguish between 

upper and lower case characters by checking this option. 

Search Values 

Depending on the data type, you will enter data into the input field (there will be 

two input fields for the Between search operation) as numeric, text, currency or 

date formats.  

• Numeric data can be either whole numbers without fractions (i.e. quantities), 

or numbers with a decimal point and fractional value. 

• Currency values can be entered with the country file’s defined currency 

symbol, or without it. In effect, a currency value can be entered as a numeric 

type. The currency value is always based on the current conversion rate, 

which is applied to all price values in the data. 

• Date values can be entered using either the display or input date formats 

defined in the EzStamp general preferences. In addition, EzStamp will also 

accept dates entered using the current format defined at the Windows 

system level. Time values (hours, minutes, and seconds) are not acceptable, 

as EzStamp doesn’t store time information for date fields. 

• String data is limited to the maximum allowable length of the field you are 

searching against. 

Last Search, Save and Load Options 

These 3 buttons allow you to save and recall power search input conditions. By 

default EzStamp resets the power search to a default blank state. Once you execute 

a successful power search, the settings are saved automatically as the “last power 

search”. By clicking the Last Search button, the previous input conditions will be 

restored. 
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The Save and Load buttons can be used to save customized power search 

conditions to a file name of your choosing. When loading a saved search, you will 

be asked for a file with a .pwr extension, which by default is saved to the 

Searches\Power folder within the EzStamp application path. 

Running a Power Search 

Click on the Find button to start the search. Depending on the type of search 

conditions (specifically, the “any” field types), the search may take several seconds 

to complete. A progress status will appear at the bottom of the dialog during the 

search. If any matches are found, the Show button will be enabled, allowing you to 

display the results using any of the 5 display options. 
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Keyword Search 

The keyword search is only available with country files containing pre-supplied 

data. Keywords provide an index for classifying stamp records based on custom 

lists of common words or phrases specific to the stamps contained in the country 

file. 

This option is available in the Search menu under the item Keyword. 

  

The key word phrases are grouped alphabetically, from A-Z and numerically (using 

the 0 button).  

The top input window contains a drop down list of every key phrase for the entire 

country file.  

The scrolling list contains a subset of this based on the first character of the key 

phrase. 

The bottom area consists of the basic set of checkbox and display options common 

to the Basic Field Search dialog window. 
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The checkbox named Don’t Search Notes is used to take the Notes field out of the 

search scope. Keywords are normally stored into an internal index that is not 

accessible from any window in EzStamp. The keyword search can extend into the 

displayable Notes field as well, if you don’t check this option. 

Use the A-Z, and 0 buttons to switch the scrolling section in the middle of the dialog 

to different phrase list. You can also accomplish the same thing by clearing the top 

input field and entering the first letter of the keyword phrase. 

Running a Keyword Search 

Click on the Find button to start the search. A progress status will appear at the 

bottom of the dialog during the search. If any matches are found, the Show button 

will be enabled, allowing you to display the results using any of the 5 display 

options. 
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Grades Search 

The Grade search provides a comprehensive set of input conditions to find stamp 

records based on your inventoried grade data. The dialog’s dual tab nature also 

provides Advanced Field search capabilities. These two search methods are 

effectively combined together to generate the report data. 

The grade search is available in the Search menu under Grades Search/Report. 

 

The Grade Search Parameters tab contains the primary input conditions for the 

search. The second tab has default attributes which will not apply additional filtering 

of the stamp data. You can use the second tab to control additional filters which are 

combined with the results based on the first tab. For example, if the Type Search 

Parameters resulted in 100 matching records based on its input conditions, the 

grade search conditions in the first tab will be applied only to the 100 records which 

were matched on the type search based on the second tab. 

In effect, the Type Search conditions are applied before the grade search 

conditions. 
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The Type Search Parameters tab is identical to the Advanced Field Search 

window. The default input conditions on this tab will not result in any additional 

filtering of the stamp records which will be searched (i.e. the first grade search tab 

drives 100% of the search if you didn’t modify the attributes in the second tab).  

Note that there is no drop down list for setting the Search In option – all 

inventoried records are searched, as grade searches can’t be applied to pre-

supplied records which haven’t been inventoried. 

 

Purchased From and Sold To Values 

The 2 bottom right values are used for Grade, PNC, PNB and FDC Cachet searches 

to find parties who you may have purchased stamps from or sold stamps to. Due to 

space limitations on screen, you may see the Purchased From value abbreviated to 

Buy From. 

The following options are identical to the basic/advanced search windows: Main 

Numbers Only, Ignore Duplicate records, Report profile sort order override 

and the 5 display options for showing the search results.  

The default report profile will display the grade information vertically, with multiple 

rows on the report for each stamp record, one row per grade. 
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Inventoried Grade Information 

The following table describes the fields associated with a single inventoried grade. 

Field Description 

Grade Name The short form abbreviated name of the grade, i.e. MH-VF. 

Display Name The description of the grade, i.e. Mint Hinged Very Fine. 

Market Value The calculated pre-supplied price based on one of the base 

price values associated with the Scott number. 

 

If the grade is derived from another grade, the market value 

will be calculated based on the supplied base price it’s derived 

from. 

User Value You can choose to override any pre-supplied price for any 

grade, whether it’s derived or not. By default no user value will 

be applied to any inventoried grade. 

Quantity Quantity can be a value from 0 and up to a maximum of 

99,999,999. A grade can be inventoried with zero quantity. 

Net Value This is quantity * the user value if the user value is applied, 

otherwise it will be the quantity * market value. 

Purchase Date The date the grade was purchased. There is no provision to 

add multiple purchase dates for a single grade. If this needs to 

be tracked, you must duplicate stamp records. 

Purchase Price Purchase price for the grade 

Sell Date The date the grade was sold 

Sell Price Sell price for the grade 

Net Profit This can be either one of two calculated values. 

 

1. Sell price minus buy price. 

 

2. Sell price minus buy price ONLY if a sell price exists. 

 

A general preferences option named Only items with sell prices 

count towards net profit can be used to enforce the second 

type of calculation. 

 

Under the second calculation, there is no net profit value 

unless the FDC, PNC, PNB, or Grade has an associated sell 
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Field Description 

price. 

Stamps Per 

Grade 

The total stamps associated with a single grade. This value is 

multiplied by the grade unit quantity (Quantity of the Grade) to 

result in the total number of physical stamps. 

 

You can override the S.P.G. value. Otherwise it will default to 

the pre-supplied stamps per grade value. 

Stamp Qty Stamps per Grade * Grade Quantity. 

Comments You may enter any text comments to associate with this 

inventoried grade. 

Potential Profit These are new attributes added with the December, 2017 

release of EzStamp. Potential profits indicate the expected gain 

(or loss) from selling a graded item (FDC Cachet number, 

Grade, PNC or PNB number) based on what you paid for it 

versus the current market value. Potential profit values can be 

shown as percentage change or amount change (or both). 

Buy From and 

Sold To 

This information is available from the second tab under Type 

Search Parameters. 

 

Search Conditions 

The following table shows the various input conditions for a grade search. 

Attribute Description 

Value Type This determines what currency value of the grade data will be used 

for the search. See the next section for a list of possible types. 

Quantity Type Quantity can be chosen for single grades, selected (from the check 

box list) or net total. You can also choose to search on a specific 

Stamps per Grade value. 

Value and 

Quantity 

Comparison 

Types 

These are basic comparison operations. The default value of All 

Values implies matching any value or any quantity, regardless of 

what those values are. In order words, if the grade is inventoried, 

it will be counted. 

Buy and Sell 

Dates 

Date ranges can be used limit the grade data returned. If only a 

From value is supplied, then the match will be treated as “Equals”, 

and only records which match exactly on that date are counted. 

Otherwise, you must enter a To value, and this will create an 

inclusive date range. 
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Attribute Description 

Suppress Zero 

Quantity 

When checked, any grade record where the quantity is zero will be 

excluded from the search. 

Suppress Zero 

Values 

When checked, any grade record where the grade user value AND 

market value are both zero will be excluded from the search. 

Grade Selection A grade search is not allowed until you select at least one grade in 

the checkbox list. The Clear and Grades buttons can be used as 

an alternative to checking and un-checking grades one by one. 

Only grades which are selected are used as the basis for the 

search. The exceptions to this are “Totals” Quantity and Value 

attributes, which affect all grades inventoried on the stamp record. 

Comments This is a simple case-insensitive text match to your grade 

comments. 

Exclude Non-

Matching Grades 

This attribute is for the Report Viewer and Printed Reports. When 

un-checked, the reports will always show all grade data rows, 

regardless if the row was a valid matching row based on the search 

filter (i.e. all grades inventoried will show on the report). 

 

When checked, the rows which don’t match the search conditions 

will be removed from the viewer and printed reports. The report 

viewer will allow you to toggle theses hidden grades on and off. 

Records with 

Potential Profit 

Refer to the Potential Profit help topic, which explains in detail 

how a potential profit search works for FDC, PNB, PNC and Graded 

records. By checking this option, you enable a filter on stamps 

which only have a potential profit scope - the from/to buy/sell date 

filter options are ignored when a potential profit filter is enabled. 

 

Value and Quantity Types 

The two Type drop down lists for currency and quantity values are summarized in 

the following table. 

Single grade types will appear on the report if at least one of the selected grades in 

the checkbox list satisfies the search conditions. For example, if MH-F and MH-VF 

are checked, and you specify a Single Grade Market Value greater than $1000.00, 

then the stamp appears on the report if either grade has a market value over 

$1000.00. 

Selected grade types will appear on the report only of the sum total of the quantity 

or value match on the search conditions. For example, if you have checked all 8 
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pre-supplied Mint grades, and specified Selected Net Grade Quantity over 25, then 

the sum of the 8 mint quantities inventoried must total more than 25. 

Total grade types apply to all inventoried grades, regardless of the grades checked. 

You will still need to check at least one grade for this type of search, even though 

every grade inventoried will be counted. 

Type Description 

Single Grade Market Value The supplied price/calculated price for a single grade. 

Single Grade User Value Your custom overridden value for a single grade. 

Single Grade Net Value The user value * quantity or market value * quantity 

calculated price. 

Single Grade Buy Price The purchase price for a single grade. Purchase prices 

of $0.00 are not allowed. 

Single Grade Sell Price The sell price for a single grade. Purchase prices of 

$0.00 are not allowed. 

Single Grade Net Profit The purchase minus sell price for a single grade, 

unless the Adjusted Net Profit preference is enabled, in 

which case this results in Net Profit of $0.00 for any 

grade without a sell price. 

Selected Grades Net Value The sum of Net value for all selected grades. 

Selected Grades Buy Price The sum of Buy price for all selected grades. 

Selected Grades Sell Price The sum of Sell price for all selected grades. 

Selected Grades Net Profit The sum of Net profit for all selected grades. 

Total Net Worth The sum of all Net values for every grade inventoried 

on the stamp record. 

Total Net Buy Price The sum of all Buy prices for every grade inventoried 

on the stamp record. 

Total Net Sell Price The sum of all Sell prices for every grade inventoried 

on the stamp record. 

Total Net Profit The sum of all Net profit values for all grades. 

 

Single Grade Quantity The inventoried quantity of a single grade. A value of 

zero is allowed. 

Single Grade Stamp 

Quantity 

The Stamps per Grade * Quantity result for a single 

grade. 

Stamps Per Grade The Stamps per Grade value for a single grade. 
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Type Description 

Selected Net Grade 

Quantity 

The sum of all quantities for all selected grades. 

Selected Net Stamp 

Quantity 

The Stamps per Grade * Quantity result for all selected 

grades. 

Total Net Grade Quantity The sum of all quantities for all inventoried grades. 

Total Net Stamp Quantity The Stamps per Grade * Quantity result for all 

inventoried stamps. 

Not Part of Inventoried 

Stamp 

When this option is chosen, a search will be made for 

grades not in your inventory. See below for details. 

 

Filtering Rules 

The following table indicates how grade records and the stamp record the grades 

are associated with will be filtered in the search. For searches where a single grade 

is excluded from the report, it will still allow the stamp record to appear with the 

grades which did match the search conditions. However, if the search results in 

elimination of every grade from the report, the stamp record will also be eliminated 

from the report. 

Rule/Condition Result on Failure 

No inventoried grade data present The stamp record will never show in the 

report. 

Default conditions (what you see 

when you click the Reset button) 

status. 

Every stamp record which has at least one 

inventoried grade will appear in the report. 

Comparison type of All for Values No currency values will be subject to filtering 

– any grades with a price count. 

Comparison type of All for 

Quantities 

No quantities will be subject to filtering – any 

grades with a quantity over 0 will count. 

Grades not selected in the checklist 

box 

They will be excluded from a search except 

when using value or quantity Types with the 

“Total” prefix. 

Selected grades Net profit, Net 

Buy, Net Sell, Net Quantity, or Net 

Value fail to match the search. 

The entire stamp record is excluded from the 

report. 

Total Net profit, net buy, net sell, 

net quantity or net worth failed to 

The entire stamp record is excluded from the 

report. 
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Rule/Condition Result on Failure 

match the search. 

Selected date ranges failed for 

buy/sell dates failed to match the 

search. 

The entire stamp record is excluded from the 

report. 

User comments failed to match the 

search. 

Only grades which don’t match on the 

comment text will be excluded from the 

report. 

Suppress Zero quantity is enabled, 

but the grade has no quantity. 

Exclude the grade from the report. 

Suppress Zero value is enabled, 

but the grade has no value. 

Exclude the grade from the report. 

Single Grade search types where 

the grade Quantity, Net profit, 

purchase price, sell price, net value 

or net profit failed to match the 

search. 

Exclude the grade from the report. 

 

How Grade Selections Work 

You must select at least one grade to execute a search. The grade list itself will act 

as a filter for Selected and Single Grade quantity/value Type attributes, dates and 

buy/sell prices. Unchecked grades are excluded, as if you didn’t inventory the 

grades at all for the stamp record. The exception to this is for the Totals Types in 

the quantity and value drop down lists, in which all grades will be used to calculate 

net totals on the stamp record. 

Each grade inventoried is counted as “this grade record has data” even if all of the 

following grade attributes are zero or blank: 

• Quantity 

• User Value 

• Market Value 

• Buy Date and Price 

• Sell Date and Price 

• Comments 

It’s perfectly acceptable to inventory a grade in this way. However, only the default 

All Values comparison search conditions will pick up these types of records on the 

report. Every other comparison type will require the associated attribute to be 

populated for the grade. 
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Input conditions are an all-or-nothing deal. For example, if a sell date range is 

specified and a value type of Single grade net profit over $1000.00 is also selected, 

then both of these conditions must be true.  

Performing the Search 

Click on the Find button to search the country file for matching stamp records. If 

any matches are found, then the Show button will be enabled, allowing you to 

display the results using any of the 5 output types. If the Show in Main Window 

option is chosen, the first matching record will automatically be displayed in the 

main EzStamp window. 

Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\GRD. 

Finding Grades Not in Your Inventoried Stamp Records 

Sometimes it may be desirable to know what grades of stamps you don't have as 

part of a stamp for which you may have other grades inventoried, such as when 

you may want to upgrade from a Used grade to a Mint grade. 

The Quantity drop down list has a special option named Not Part of Inventoried 

Stamp. If you choose this option, select 1 or more grades which you want to find 

which are not in the inventoried stamp record. The grade list is cumulative. That is, 

if you check MH-VF and MH-XF, then the search will find inventoried stamp records 

where BOTH these grades are NOT in your inventory.  

Alternate Method for Non-Inventoried Grades 

A different method can be used instead of the Quantity drop down option. The 

button named Not Inventoried can be used to present a dialog menu with 2 

choices. First, enable the non-inventoried method by checking the option. This will 

enable the 2 choices. 

The first choice on the left will only return stamp records if every checked grade is 

not inventoried. 

The second choice on the right will return stamp records if one or more of the 

checked grades are not inventoried. 

Global Searches 

The Global button is used to perform the search against one or more registered 

country files. Since countries are separate files in EzStamp, the time to run a 

search is longer, based on the number of countries selected, the amount of stamp 

record information in each file, and on the time necessary to open and close each 

country as the search is being performed. Unlike a normal search, Global searches 
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do not allow you to choose how to display the matching stamp records – they are 

always presented in a floating report view alongside the main EzStamp window, 

similar to the Stamp List Viewer. For more details on global searches, refer to the 

Global Searches section in this manual. 
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FDC Cachet Search 

The FDC Cachet search provides input conditions to find stamp records based on 

the FDC Cachet records. This search is available in the Search menu under FDC 

Cachet Search/Report. This option is not available unless FDC Cachet information 

is enabled in the country file settings. 

 

The Type Search Parameters tab is identical to what can be found under the 

Grade Search/Report help. 

The following options are identical to the basic/advanced search windows: Main 

Numbers Only, Ignore Duplicate records, Report profile sort order override 

and the 5 display options for showing the search results.  

The default report profile will display the FDC information vertically, with multiple 

rows on the report for each FDC number. 
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Inventoried FDC Cachet Information 

The following table describes the fields associated with a single inventoried FDC 

Number. 

Field Description 

FDC Number The cachet number for a single entry. 

Day Issued This information by default is copied from the main EzStamp 

DOI field when creating new records. It can contain any text 

information however. 

Description Any text to describe this FDC entry, this can be a pre-supplied 

value. 

FDC Maker EzStamp comes with several hundred pre-supplied FDC 

makers. Custom FDC makers are automatically added to the 

pre-supplied list when you add them to inventoried stamp 

records. 

Value The value of this entry. 

Quantity The total quantity for this entry. 

Net Worth The value * quantity. 

Comments You can enter custom comments for this entry. 

Purchase Date The date the entry was purchased. There is no provision to add 

multiple purchase dates for a single FDC number. If this needs 

to be tracked, you must duplicate stamp records. 

Purchase Price Purchase price for the entry. 

Sell Date The date the FDC number was sold. 

Sell Price Sell price for the FDC number. 

Net Profit This can be either one of two calculated values. 

 

1. Sell price minus buy price. 

 

2. Sell price minus buy price ONLY if a sell price exists. 

 

A general preferences option named Only items with sell prices 

count towards net profit can be used to enforce the second 

type of calculation. 

 

Under the second calculation, there is no net profit value 

unless the FDC, PNC, PNB, or Grade has an associated sell 
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Field Description 

price. 

Image Link Each FDC number can be associated with an image link. The 

image links can’t be printed, except as the file name. However, 

they can be displayed in a special image preview window, and 

also in the Report Viewer if the image link field is selected and 

image preview mode is enabled in the viewer. 

Potential Profit These are new attributes added with the December, 2017 

release of EzStamp. Potential profits indicate the expected gain 

(or loss) from selling a graded item (FDC Cachet number, 

Grade, PNC or PNB number) based on what you paid for it 

versus the current market value. Potential profit values can be 

shown as percentage change or amount change (or both). 

Buy From and 

Sold To 

The second tab contains the options to search by name for 

those who you purchased stamps from or sold stamps to. 

 

Search Conditions 

The following table shows the various input conditions for an FDC search. 

Attribute Description 

Value Type This determines what currency value of the FDC data will be used 

for the search. See the next section for a list of possible types. 

Quantity Type Quantity can be for single FDC numbers or net totals. 

Value and 

Quantity 

Comparison 

Types 

These are basic comparison operations. The default value of All 

Values implies matching any value or any quantity, regardless of 

what those values are. In order words, if the FDC record is 

inventoried, it will be counted. 

Buy and Sell 

Dates 

Date ranges can be used to limit the FDC data returned. If only a 

From value is supplied, then the match will be treated as “Equals”, 

and only records which match exactly on that date are counted. 

Otherwise, you must enter a To value, and this will create an 

inclusive date range. 

Suppress Zero 

Quantity 

When checked, any FDC record where the quantity is zero will be 

excluded from the search. 

Suppress Zero 

Values 

When checked, any FDC record where the value is zero will be 

excluded from the search. 

Comments This is a simple case-insensitive text match to your FDC comments. 
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Attribute Description 

FDC Number This is a simple case-insensitive text match to the FDC number. 

FDC Maker This is a simple case-insensitive text match to the FDC Maker. Use 

the drop down list to choose from an existing maker, or enter a 

partial text string to match against. 

Description This is a simple case-insensitive text match to the FDC description. 

Day Issued This is a simple case-insensitive text match to the Day/Date of 

issue. 

Image Link This is a simple case-insensitive text match to the image link file 

name. 

Exclude Non-

Matching FDC 

Numbers 

This attribute is for the Report Viewer and Printed Reports. When 

un-checked, the reports will always show all FDC data rows, 

regardless if the row was a valid matching row based on the search 

filter (i.e. all inventoried FDC numbers will show on the report). 

 

When checked, the rows which don’t match the search conditions 

will be removed from the viewer and printed reports. The report 

viewer will allow you to toggle the hidden FDC numbers on and off. 

Records with 

Potential Profit 

Refer to the Potential Profit help topic, which explains in detail 

how a potential profit search works for FDC, PNB, PNC and Graded 

records. By checking this option, you enable a filter on stamps 

which only have a potential profit scope - the from/to buy/sell date 

filter options are ignored when a potential profit filter is enabled. 

 

Value and Quantity Types 

The two Type drop down lists for currency and quantity values is summarized in the 

following table. 

Single FDC types will appear on the report if at least one of the FDC numbers 

satisfies the search conditions.  

Total FDC types apply to all inventoried FDC numbers. 

Type Description 

Single FDC Row Item Value The value of a single FDC number. 

Single FDC Row Net Value The quantity * prices for a single FDC number. 

Single FDC Row Buy Price The purchase price for a single FDC number. 

Single FDC Row Sell Price The sell price for a single FDC number. 
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Type Description 

Single FDC Row Net Profit The purchase minus sell price for a FDC number, 

unless the Adjusted Net Profit preference is enabled, in 

which case this results in Net Profit of $0.00 for any 

FDC number without a sell price. 

Total Net Worth The sum of all Net values for every FDC number on the 

stamp record. 

Total Net Buy Price The sum of all Buy prices for every FDC number on the 

stamp record. 

Total Net Sell Price The sum of all Sell prices for every FDC number on the 

stamp record. 

Total Net Profit The sum of all Net profit values for every FDC number 

on the stamp record. 

 

Single FDC Row Quantity The quantity for a single FDC number. 

Total Net Quantity The quantity for all FDC numbers on the stamp record. 

 

Filtering Rules 

The following table indicates how FDC records and the stamp record the FDC 

numbers are associated with will be filtered in the search. For searches where a 

single FDC number is excluded from the report, it will still allow the stamp record to 

appear with the FDC number which did match the search conditions. However, if 

the search results in elimination of every FDC number from the report, the stamp 

record will also be eliminated from the report. 

Rule/Condition Result on Failure 

No inventoried FDC numbers 

present 

The stamp record will never show in the 

report. 

Default conditions (what you see 

when you click the Reset button) 

status. 

Every stamp record which has at least one 

FDC number will appear in the report. 

Comparison type of All for Values No currency values will be subject to filtering 

– any FDC number with a price will count. 

Comparison type of All for 

Quantities 

No quantities will be subject to filtering – any 

FDC number with a quantity over 0 will 

count. 

Text fields (Maker, Comments, The FDC number is excluded from the report. 
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Rule/Condition Result on Failure 

Description, Image Link, Day 

Issued, FDC Number) fail to match. 

The conditions are all or nothing. If you enter 

text for FDC Maker and Description, they 

must both match. 

Total Net profit, net buy, net sell, 

net quantity or net worth failed to 

match the search. 

The entire stamp record is excluded from the 

report. 

Suppress Zero quantity is enabled, 

but the FDC number has no 

quantity. 

Exclude the FDC number from the report. 

Suppress Zero value is enabled, 

but the FDC number has no value. 

Exclude the FDC number from the report. 

Single FDC number search types 

where the grade Quantity, Net 

profit, purchase price, sell price, 

net value or net profit failed to 

match the search. 

Exclude the FDC number from the report. 

 

Performing the Search 

Click on the Find button to search the country file for matching stamp records. If 

any matches are found, then the Show button will be enabled, allowing you to 

display the results using any of the 5 output types. If the Show in Main Window 

option is chosen, the first matching record will automatically be displayed in the 

main EzStamp window. 

Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\FDC. 

  



EzStamp Reference – Version 8.0 

Page | 197 
 

PNB Data Search 

The PNB Data search provides input conditions to find stamp records based on the 

plate numbers associated with the stamp record. This search is available in the 

Search menu under PNB Search/Report. This option is not available unless PNB 

information is enabled in the country file settings. 

 

The Type Search Parameters tab is identical to what is described under the Grade 

Search/Report help with one notable exception: The Search In drop down list is 

available, as PNB information can be pre-supplied. 

The following options are identical to the basic/advanced search windows: Main 

Numbers Only, Ignore Duplicate records, Report profile sort order override and the 

5 display options for showing the search results.  

The default report profile will display the PNB information vertically, with multiple 

rows on the report for each stamp record.  
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Inventoried PNB Information 

The following table describes the fields associated with a single inventoried plate 

number. 

Field Description 

Plate Number Plain text representation of a plate number. 

VF-H/VF-NH 

Buy Date 

Very fine hinged and never hinged purchase dates. 

VF-H/VF-NH 

Buy Price 

Very fine hinged and never hinged purchase prices. 

VF-H/VF-NH 

Sell Date 

Very fine hinged and never hinged sell dates. 

VF-H/VF-NH 

Sell Price 

Very fine hinged and never hinged sell prices. 

VF-H/VF-NH 

Net Value 

Value * Quantity for VF-H and VF-NH. 

VF-H/VF-NH 

Quantity 

Inventoried quantity for VF-H and VF-NH. 

VF-H/VF-NH 

Value 

Pre-supplied or your value of the plate number for VF-H and VF-

NH. 

VF-H/VF-NH 

Net Profit 

This can be either one of two calculated values. 

 

1. Sell price minus buy price. 

 

2. Sell price minus buy price ONLY if a sell price exists. 

 

A general preferences option named Only items with sell prices 

count towards net profit can be used to enforce the second type 

of calculation. 

 

Under the second calculation, there is no net profit value unless 

the FDC, PNC, PNB, or Grade has an associated sell price. 

Image Link Each plate number can be associated with an image link. The 

image links can’t be printed, except as the file name. However, 

they can be displayed in a special image preview window, and 

also in the Report Viewer if the image link field is selected and 

image preview mode is enabled in the viewer. 
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Field Description 

Comments Your comments. 

Net Buy Price Total sum of purchase prices for VF-H and VF-NH. 

Net Profit Total sum of net profits for VF-H and VF-NH. 

Net Quantity Sum of VF-H and VF-NH quantity fields. 

Net Sell Price Total sum of sell prices for VF-H and VF-NH. 

Net Worth Sum of VF-H and VF-NH Net Values. 

Notes Plain text for pre-supplied notes. 

Potential 

Profit 

These are new attributes added with the December, 2017 release 

of EzStamp. Potential profits indicate the expected gain (or loss) 

from selling a graded item (FDC Cachet number, Grade, PNC or 

PNB number) based on what you paid for it versus the current 

market value. Potential profit values can be shown as percentage 

change or amount change (or both). 

Buy From and 

Sold To 

This information is available from the second tab under Type 

Search Parameters. 

 

Search Conditions 

The following table shows the various input conditions for a PNB search. 

Attribute Description 

Value Type This determines what currency value of the PNB data will be used 

for the search. See the next section for a list of possible types. 

Quantity Type Quantity can be for single plate numbers, selected (from the check 

box options for VF-H and VF-NH) or net total.  

Value and 

Quantity 

Comparison 

Types 

These are basic comparison operations. The default value of All 

Values implies matching any value or any quantity, regardless of 

what those values are. In order words, if the plate number is 

inventoried, it will be counted. 

Buy and Sell 

Dates 

Date ranges can be used limit the PNB data returned. If only a 

From value is supplied, then the match will be treated as “Equals”, 

and only records which match exactly on that date are counted. 

Otherwise, you must enter a To value, and this will create an 

inclusive date range. 

Suppress Zero 

Quantity 

When checked, any PNB record where the quantity is zero will be 

excluded from the search. 
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Attribute Description 

Suppress Zero 

Values 

When checked, any PNB record where the value is zero will be 

excluded from the search. 

VF-H and VF-NH 

options 

A PNB search is not allowed until you check either Search on VF-H 

or Search on VF-NH. Only plate numbers which match based on 

the VF-H and VF-NH attributes will be used as the basis for the 

search. The exceptions to this are “Totals” Quantity and Value 

attributes, which affect all plate numbers inventoried on the stamp 

record. 

Plate Number This is a simple case-insensitive text match to the plate number. 

Notes This is a simple case-insensitive text match to the pre-supplied 

plate number notes. 

Comments This is a simple case-insensitive text match to your plate number 

comments. 

Image Link This is a simple case-insensitive text match to the image link file 

name. 

Exclude Non-

Matching Plate 

Numbers 

This attribute is for the Report Viewer and Printed Reports. When 

un-checked, the reports will always show all plate number data 

rows, regardless if the row was a valid matching row based on the 

search filter (i.e. all inventoried plate numbers will show on the 

report). 

 

When checked, the rows which don’t match the search conditions 

will be removed from the viewer and printed reports. The report 

viewer will allow you to toggle the hidden plate numbers on and 

off. 

Any Dates 

Option 

If you check the Search on Any Date option, then the From and To 

date values will be matched to both the VF-H and VF-NH dates if 

present. In short, the date matching now is done at the plate 

number level not at the type (H/NH) level. 

Records with 

Potential Profit 

Refer to the Potential Profit help topic, which explains in detail 

how a potential profit search works for FDC, PNB, PNC and Graded 

records. By checking this option, you enable a filter on stamps 

which only have a potential profit scope - the from/to buy/sell date 

filter options are ignored when a potential profit filter is enabled. 
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Value and Quantity Types 

The two Type drop down lists for currency and quantity values is summarized in the 

following table. 

Single PNB Row types will appear on the report if at least one of the plate numbers 

satisfies the search conditions.  

VF-H/NH Total types will appear on the report if the plate numbers associated with 

the 2 checkboxes match on the search conditions. For example, if Search on VF-NH 

is not checked, then never hinged plate numbers are not counted in the report. 

Each plate number can have hinged and never hinged data associated with it. As 

such it’s possible for a plate number to match on the hinged data, but not on the 

never-hinged data. This would still count as a match. 
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Total Net types apply to all inventoried plate numbers. 

Type Description 

Single PNB Row Item Value The supplied price/your price for a single plate 

number. 

Single PNB Row Net Value The value * quantity calculated price. 

Single PNB Row Buy Price The purchase price for a single plate number. Purchase 

prices of $0.00 are not allowed. 

Single PNB Row Sell Price The sell price for a single plate number. Purchase 

prices of $0.00 are not allowed. 

Single PNB Row Net Profit The purchase minus sell price for a single grade, 

unless the Adjusted Net Profit preference is enabled, in 

which case this results in Net Profit of $0.00 for any 

grade without a sell price. 

VF-H/NH Total Net Value The sum of Net value for all plate numbers based on 

the checkbox options for VF-H and VF-NH. 

VF-H/NH Total Buy Price The sum of Buy value for all plate numbers based on 

the checkbox options for VF-H and VF-NH. 

VF-H/NH Total Sell Price The sum of Sell value for all plate numbers based on 

the checkbox options for VF-H and VF-NH. 

VF-H/NH Total Net Profit The sum of Net profit for all plate numbers based on 

the checkbox options for VF-H and VF-NH. 

Total Net Worth The sum of all Net values for every plate number 

inventoried on the stamp record. 

Total Net Buy Price The sum of all Buy prices for every plate number 

inventoried on the stamp record. 

Total Net Sell Price The sum of all Sell prices for every plate number 

inventoried on the stamp record. 

Total Net Profit The sum of all Net profit values for all plate numbers. 

 

Single PNB Row Quantity The inventoried quantity of a single plate number. A 

value of zero is allowed. 

VF-H/NH Net Quantity The sum of quantities for all plate numbers based on 

the checkbox options for VF-H and VF-NH. 

Total Net Quantity The sum of all quantities for all inventoried plate 

numbers. 
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Filtering Rules 

The following table indicates how PNB records and the stamp record the plate 

numbers are associated with will be filtered in the search. For searches where a 

single plate number is excluded from the report, it will still allow the stamp record 

to appear with the PNB records which did match the search conditions. However, if 

the search results in elimination of every plate number from the report, the stamp 

record will also be eliminated from the report. 

Rule/Condition Result on Failure 

No inventoried PNB data present The stamp record will never show in the 

report. 

Default conditions (what you see 

when you click the Reset button) 

status. 

Every stamp record which has at least one 

inventoried PNB plate record will appear in 

the report. 

Comparison type of All for Values No currency values will be subject to filtering 

– any plate number with a price will count. 

Comparison type of All for 

Quantities 

No quantities will be subject to filtering – any 

plate numbers with a quantity over 0 will 

count. 

VF-H or VF-NH checkbox options 

are not checked. 

They will be excluded from a search except 

when using either of value or quantity Types 

with the “Total” wording. 

VF-H/NH Net profit, Net Buy, Net 

Sell, Net Quantity, or Net Value fail 

to match the search. 

The entire stamp record is excluded from the 

report. 

Total Net profit, net buy, net sell, 

net quantity or net worth failed to 

match the search. 

The entire stamp record is excluded from the 

report. 

Selected date ranges failed for 

buy/sell dates failed to match the 

search. 

The entire stamp record is excluded from the 

report. 

Text fields (Plate Number, 

Comments, Notes, Image Link) fail 

to match. 

The plate number is excluded from the 

report. The conditions are all or nothing. If 

you enter text for plate number and notes, 

they must both match. 

Suppress Zero quantity is enabled, 

but the plate number has no 

quantity. 

Exclude the plate number from the report. 
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Rule/Condition Result on Failure 

Suppress Zero value is enabled, 

but the plate number has no value. 

Exclude the plate number from the report. 

Single PNB row search types where 

the grade Quantity, Net profit, 

purchase price, sell price, net value 

or net profit failed to match the 

search. 

Exclude the plate number from the report. 

 

How PNB VF-F/VF-NH Selections Work 

You must check at least one of the two checkbox options named Search on VF-H 

and Search on VF-NH to execute a search. These two checkboxes will act as a 

filter for VF-H/NH and Single PNB Row based quantity/value Type attributes, dates 

and buy/sell prices. If the option is unchecked for VF-H for example, then plate 

numbers which only have VF-H data are excluded from the report. If the same plate 

numbers have VF-NH data, they will still be used for searching. 

Totals Types in the quantity and value drop down lists will be applied to both VF-H 

and VF-NH plate numbers, regardless of which of the two checkbox items are 

checked. 

Each plate number is counted as “this record has data” for VF-H or VF-NH based on 

the following fields: 

• Value 

• Quantity 

• Net Value 

• Purchase Date and Price 

• Sell Date and Price 

• Net Profit 

The other fields (Image Link, Notes, Comments, Plate Number) are matched 

regardless of the VF-H and VF-NH checkbox states. 

Performing the Search 

Click on the Find button to search the country file for matching stamp records. If 

any matches are found, then the Show button will be enabled, allowing you to 

display the results using any of the 5 output types. If the Show in Main Window 

option is chosen, the first matching record will automatically be displayed in the 

main EzStamp window. 
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Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\PNB.  
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PNC Data Search 

The PNC Data search provides input conditions to find stamp records based on the 

plate numbers associated with the stamp record. This search is available in the 

Search menu under PNC Search/Report. This option is not available unless PNC 

information is enabled in the country file settings. 

 

The Type Search Parameters tab is identical to what is described under the Grade 

Search/Report help with one notable exception: The Search In drop down list is 

available, as PNC information can be pre-supplied. 

The following options are identical to the basic/advanced search windows: Main 

Numbers Only, Ignore Duplicate records, Report profile sort order override and the 

5 display options for showing the search results.  

The default report profile will display the PNC information vertically, with multiple 

rows on the report for each stamp record.  
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Inventoried PNC Information 

The following table describes the fields associated with a single inventoried plate 

number. 

Field Description 

Plate Number Plain text representation of a plate number. 

Strip of 1,3,5 

Buy Date 

Purchase dates for the 3 strip types. 

Strip of 1,3,5 

Buy Price 

Purchase prices for the 3 strip types. 

Strip of 1,3,5 

Sell Date 

Sell dates for the 3 strip types. 

Strip of 1,3,5 

Sell Price 

Sell prices for the 3 strip types. 

Strip of 1,3,5 

Net Value 

Value * Quantity for the 3 strip types. 

Strip of 1,3,5 

Quantity 

Inventoried quantity for the 3 strip types. 

Strip of 1,3,5 

Value 

Pre-supplied or your value of the plate number for the 3 strip 

types. 

Strip of 1,3,5 

Net Profit 

This can be either one of two calculated values. 

 

1. Sell price minus buy price. 

 

2. Sell price minus buy price ONLY if a sell price exists. 

 

A general preferences option named Only items with sell prices 

count towards net profit can be used to enforce the second type 

of calculation. 

 

Under the second calculation, there is no net profit value unless 

the FDC, PNC, PNB, or Grade has an associated sell price. 

Image Link Each plate number can be associated with an image link. The 

image links can’t be printed, except as the file name. However, 

they can be displayed in a special image preview window, and 

also in the Report Viewer if the image link field is selected and 

image preview mode is enabled in the viewer. 
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Field Description 

Comments Your comments. 

Net Buy Price Total sum of purchase prices for all strip types. 

Net Profit Total sum of net profits for all strip types. 

Net Quantity Sum of quantity fields for all strip types. 

Net Sell Price Total sum of sell prices for all strip types. 

Net Worth Sum of Net Values for all strip types. 

Notes Plain text for pre-supplied notes. 

Potential 

Profit 

These are new attributes added with the December, 2017 release 

of EzStamp. Potential profits indicate the expected gain (or loss) 

from selling a graded item (FDC Cachet number, Grade, PNC or 

PNB number) based on what you paid for it versus the current 

market value. Potential profit values can be shown as percentage 

change or amount change (or both). 

Buy From and 

Sold To 

This information is available from the second tab under Type 

Search Parameters. 

 

Search Conditions 

The following table shows the various input conditions for a PNC search. 

Attribute Description 

Value Type This determines what currency value of the PNC data will be used 

for the search. See the next section for a list of possible types. 

Quantity Type Quantity can be for single plate numbers, selected (from the check 

box options for Strip of 1, 3, and 5) or net total.  

Value and 

Quantity 

Comparison 

Types 

These are basic comparison operations. The default value of All 

Values implies matching any value or any quantity, regardless of 

what those values are. In other words, if the plate number is 

inventoried, it will be counted. 

Buy and Sell 

Dates 

Date ranges can be used to limit the PNC data returned. If only a 

From value is supplied, then the match will be treated as “Equals”, 

and only records which match exactly on that date are counted. 

Otherwise, you must enter a To value, and this will create an 

inclusive date range. 

Suppress Zero 

Quantity 

When checked, any PNC record where the quantity is zero will be 

excluded from the search. 
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Attribute Description 

Suppress Zero 

Values 

When checked, any PNC record where the value is zero will be 

excluded from the search. 

VF-H and VF-NH 

options 

A PNC search is not allowed until you check one of Search on 

Strip of 1/3/5 checkboxes. Only plate numbers which match 

based on the strip type attributes will be used as the basis for the 

search. The exceptions to this are “Totals” Quantity and Value 

attributes, which affect all plate numbers inventoried on the stamp 

record. 

Plate Number This is a simple case-insensitive text match to the plate number. 

Notes This is a simple case-insensitive text match to the pre-supplied 

plate number notes. 

Comments This is a simple case-insensitive text match to your plate number 

comments. 

Image Link This is a simple case-insensitive text match to the image link file 

name. 

Exclude Non-

Matching Plate 

Numbers 

This attribute is for the Report Viewer and Printed Reports. When 

un-checked, the reports will always show all plate number data 

rows, regardless if the row was a valid matching row based on the 

search filter (i.e. all inventoried plate numbers will show on the 

report). 

 

When checked, the rows which don’t match the search conditions 

will be removed from the viewer and printed reports. The report 

viewer will allow you to toggle the hidden plate numbers on and 

off. 

Any Dates 

Option 

If you check the Search on Any Date option, then the From and To 

date values will be matched to all of the strip type (1, 3, and 5) 

dates if present. In short, the date matching now is done at the 

plate number level not at the strip (1, 3, 5) level. 

Records with 

Potential Profit 

Refer to the Potential Profit help topic, which explains in detail 

how a potential profit search works for FDC, PNB, PNC and Graded 

records. By checking this option, you enable a filter on stamps 

which only have a potential profit scope - the from/to buy/sell date 

filter options are ignored when a potential profit filter is enabled. 
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Value and Quantity Types 

The two Type drop down lists for currency and quantity values is summarized in the 

following table. 

Single PNC Row types will appear on the report if at least one of the plate numbers 

satisfies the search conditions.  

Strip of 1/3/5 Total types will appear on the report if the plate numbers associated 

with the 3 checkboxes match on the search conditions. For example, if Search on 

Strip of 5 is not checked, then strip of 5 plate numbers are not counted in the 

report. Each plate number can have strip of 1, 3 and 5 data associated with it. As 

such it’s possible for a plate number to match on strip of 1 or strip of 3, but not on 

strip of 5. This would still count as a match. 
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Total Net types apply to all inventoried plate numbers. 

Type Description 

Single PNC Row Item Value The supplied price/your price for a single plate 

number. 

Single PNC Row Net Value The value * quantity calculated price. 

Single PNC Row Buy Price The purchase price for a single plate number. Purchase 

prices of $0.00 are not allowed. 

Single PNC Row Sell Price The sell price for a single plate number. Purchase 

prices of $0.00 are not allowed. 

Single PNC Row Net Profit The purchase minus sell price for a single grade, 

unless the Adjusted Net Profit preference is enabled, in 

which case this results in Net Profit of $0.00 for any 

grade without a sell price. 

Strip Total Net Value The sum of Net value for all plate numbers based on 

the checkbox options for Strip of 1, 3 and 5. 

Strip Total Buy Price The sum of Buy value for all plate numbers based on 

the checkbox options for Strip of 1, 3 and 5. 

Strip Total Sell Price The sum of Sell value for all plate numbers based on 

the checkbox options for Strip of 1, 3 and 5. 

Strip Total Net Profit The sum of Net profit for all plate numbers based on 

the checkbox options for Strip of 1, 3 and 5. 

Total Net Worth The sum of all Net values for every plate number 

inventoried on the stamp record. 

Total Net Buy Price The sum of all Buy prices for every plate number 

inventoried on the stamp record. 

Total Net Sell Price The sum of all Sell prices for every plate number 

inventoried on the stamp record. 

Total Net Profit The sum of all Net profit values for all plate numbers. 

 

Single PNC Row Quantity The inventoried quantity of a single plate number. A 

value of zero is allowed. 

Strip Net Quantity The sum of quantities for all plate numbers based on 

the checkbox options for Strip of 1, 3, and 5. 

Total Net Quantity The sum of all quantities for all inventoried plate 

numbers. 
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Filtering Rules 

The following table indicates how PNC records and the stamp record the plate 

numbers are associated with will be filtered in the search. For searches where a 

single plate number is excluded from the report, it will still allow the stamp record 

to appear with the PNC records which did match the search conditions. However, if 

the search results in elimination of every plate number from the report, the stamp 

record will also be eliminated from the report. 

Rule/Condition Result on Failure 

No inventoried PNC data present The stamp record will never show in the 

report. 

Default conditions (what you see 

when you click the Reset button) 

status. 

Every stamp record which has at least one 

inventoried PNC plate record will appear in 

the report. 

Comparison type of All for Values No currency values will be subject to filtering 

– any plate number with a price will count. 

Comparison type of All for 

Quantities 

No quantities will be subject to filtering – any 

plate numbers with a quantity over 0 will 

count. 

Strip of 1, 3 or 5 checkbox options 

are not checked. 

They will be excluded from a search except 

when using either of value or quantity Types 

with the “Total” wording. 

Strip of 1, 3, 5 Net profit, Net Buy, 

Net Sell, Net Quantity, or Net 

Value fail to match the search. 

The entire stamp record is excluded from the 

report. 

Total Net profit, net buy, net sell, 

net quantity or net worth failed to 

match the search. 

The entire stamp record is excluded from the 

report. 

Selected date ranges failed for 

buy/sell dates failed to match the 

search. 

The entire stamp record is excluded from the 

report. 

Text fields (Plate Number, 

Comments, Notes, Image Link) fail 

to match. 

The plate number is excluded from the 

report. The conditions are all or nothing. If 

you enter text for plate number and notes, 

they must both match. 

Suppress Zero quantity is enabled, 

but the plate number has no 

quantity. 

Exclude the plate number from the report. 
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Rule/Condition Result on Failure 

Suppress Zero value is enabled, 

but the plate number has no value. 

Exclude the plate number from the report. 

Single PNC row search types where 

the grade Quantity, Net profit, 

purchase price, sell price, net value 

or net profit failed to match the 

search. 

Exclude the plate number from the report. 

 

How PNC Strip of 1, 3, 5 Selections Work 

You must check at least one of the three checkbox options named Search on Strip 

1/3/5 to execute a search. These three checkboxes will act as a filter for Strip and 

Single PNC Row based quantity/value Type attributes, dates and buy/sell prices. If 

the option is unchecked for Strip of 5 for example, then plate numbers which only 

have Strip of 5 data are excluded from the report. If the same plate numbers have 

Strip of 1 or Strip of 3 data, they will still be used for searching. 

Totals Types in the quantity and value drop down lists will be applied to all Strip 

combinations for a given plate number, regardless of which of the three checkbox 

items are checked. 

Each plate number is counted as “this record has data” for Strip of 1/3/5 based on 

the following fields: 

• Value 

• Quantity 

• Net Value 

• Purchase Date and Price 

• Sell Date and Price 

• Net Profit 

The other fields (Image Link, Notes, Comments, Plate Number) are matched 

regardless of the 3 Strip of checkbox states. 

Performing the Search 

Click on the Find button to search the country file for matching stamp records. If 

any matches are found, then the Show button will be enabled, allowing you to 

display the results using any of the 5 output types. If the Show in Main Window 

option is chosen, the first matching record will automatically be displayed in the 

main EzStamp window. 
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Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\PNC. 

Potential Profit Search Filter 

The 4 options available from main EzStamp Search menu which can include a 

potential profit filter are: 

• Grade Search 

• FDC Cachet Search 

• PNB Search 

• PNC Search 

Note: The line item report also has an option for potential profit. 

Regardless of which search option is chosen, the way a filter is applied is identical. 

A check box option will be available called: Only Show Records with Potential 

Profit. When checked the purchase/sell date information is replaced with these 

options: 

 

 

Potential Profit Definition 

A potential profit exists under the following conditions: 

• You have an inventoried record (Grades, FDC, PNC, or PNB depending on the 

search dialog chosen). 

• You have purchased the item and recorded a purchase price (purchase date 

is not required). 

• The quantity purchased should be at least 1. 

• There is a market value associated with the item, either pre-supplied or one 

you have provided. 

Unless all of these conditions are satisfied, the item is not considered valid for a 

potential profit. If ALL items for the grade/FDC/PNC/PNB list for the Scott number 
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are not valid, the entire stamp record is excluded from the report. In other words, 

at least one item has to have a potential profit. 

Profit or Loss 

If the market value is less than the purchase price, you have a potential loss. A 

general preferences option can be enabled to exclude any losses from the report. 

A profit or loss is expressed as either a value or percentage. The report profiles can 

include either or both types. 

Calculation of Profit/Loss Values 

There are 2 other key settings in the EzStamp preferences. For clarity, below is the 

section of the General 1 settings dialog showing all 3 preference options: 

 

The second checkbox option was already mentioned earlier, to suppress showing 

potential losses on reports. 

The first option will determine if the quantity in your inventory is based on how 

much you entered for  the purchase price. This setting applies to all stamp records, 

so if you enter purchase prices differently for each stamp, the calculations for 

profit/loss will never be 100% accurate across the entire country file. 

When this option is checked, it's assumed that the purchase price entered was for 

the entire group of stamps. 

Example: Quantity 10, purchase price $1000.00 implies each stamp was purchased 

for $100.00. 

With this option unchecked, it's assumed the purchase price you entered was on a 

per stamp basis. This, the price per stamp in the previous example would be 

$1000.00. 

The third option determines how the potential profit amount is displayed on the 

report - it doesn't affect the percentage loss or gain, as that was based on the per 

stamp price and current market value. 

If this option is checked, then the potential profit is the reported gain (or loss) for 

each stamp you would sell (i.e. quantity 1 of the quantity of 10 in your inventory).  
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If this option is unchecked, then the profit is what you would get for selling every 

stamp in your inventory for that Grade/FDC/PNC/PNB item. 

Any Potential Profit 

With this option checked, a stamp will appear on the report if at least one 

associated Grade/FDC/PNC/PNB item meets the 4 conditions for a potential profit. If 

no items match the conditions, the stamp record is excluded from the report. 

Minimum Percent 

This option requires you to enter a threshold value, which can be positive, negative, 

or zero. 

Examples: 

25%:  Only include stamps where at least one item has a potential profit of 

25% or more. 

0:  Only include stamps where there is a potential profit of any amount. 

-50%: Show any stamps where a potential loss of 50% or more happens. 

Minimum Amount 

This is similar to the percentage option, but you will enter an amount based on the 

currency of the country file currently opened. You can use negative amounts to 

show potential losses only. 

Report Profiles for Potential Profit 

EzStamp report profiles need to include at least one of the 2 potential profit 

attributes (percentage and currency value) to make the report meaningful. Since all 

profiles issues prior to this feature being added do not include potential profit fields, 

SoftPro has issues new default profiles for any time you check the potential profit 

option in one of the 4 search dialogs. 

You will notice the available profiles in the drop down list changes to indicate those 

which you would use for a potential profit vs. those for normal report types. 

EzStamp doesn't block you from using any report profile in a potential profit 

scenario - you can customize any compatible report to include these 2 new fields 

and add them to the drop down list. 

EzStamp simply maintains two sets of profiles to use and ensures that the top most 

profile in either list is the default one associated with a potential profit report and 

one for the default report type. 
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Automatic Filtering of Grade, FDC, PNC and PNB Items 

When you display a report with the potential profit option, any items which don't 

satisfy the 4 conditions mentioned earlier are automatically eliminated from the 

report. For example, if you have an inventoried MH-XF grade item without a 

purchase price, it will never appear in the report. The search option named 

Exclude Non-Matching Grades will be ignored regardless of its checked state. 
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Grades Want List 

The Grade want list report is similar to the Grade search option, but it differs in the 

fact that the report generates listings for grades which are not currently in your 

inventory with a quantity.  

This dialog window is available from the Want and Sell Lists submenu under 

Reports. This report is not applicable to custom country files which have no pre-

supplied stamp content from SoftPro. 

 

The Grade Search Parameters tab contains the primary input conditions for the 

search. The second tab has default attributes which will not apply additional filtering 

of the stamp data. You can use the second tab to control additional filters which are 

combined with the results based on the first tab. For example, if the Type Search 

Parameters resulted in 100 matching records based on its input conditions, the 

grade search conditions in the first tab will be applied only to the 100 records which 

were matched on the type search based on the second tab. 

In effect, the Type Search conditions are applied before the grade search 

conditions. 
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From and To Values 

If the From value is left blank, then there is no minimum grade market value to 

restrict the results. 

If the To value is left blank, then there is no maximum market value. 

Examples: 

From value of $1,000 = show all market values at least this amount. 

To value of $5,000 = show only market values up to and including this amount. 

From = 100.00 and To = 999.99 = show only market values between 100.00 and 

1000.00. 

Grade List 

The grade list chosen represents only those grades you want to show in the report. 

Any grade for a matching stamp record that is either NOT in this list or is in your 

inventory with a quantity of 1 or more will be excluded from the report. 
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PNC Want List 

The PNC want list report is similar to the PNC search option, but it differs in the fact 

that the report generates listings for plate numbers which are not currently in your 

inventory.  

This dialog window is available from the Want and Sell Lists submenu under 

Reports. This report is not applicable to custom country files which have no pre-

supplied stamp content from SoftPro. 

 

The PNC Search Parameters tab contains the primary input conditions for the 

search. The second tab has default attributes which will not apply additional filtering 

of the stamp data. You can use the second tab to control additional filters which are 

combined with the results based on the first tab. For example, if the Type Search 

Parameters resulted in 100 matching records based on its input conditions, the 

PNC search conditions in the first tab will be applied only to the 100 records which 

were matched on the type search based on the second tab. 

In effect, the Type Search conditions are applied before the PNC search conditions. 
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From and To Values 

If the From value is left blank, then there is no minimum price value to restrict the 

results. 

If the To value is left blank, then there is no maximum price. 

Examples: 

From value of $1,000 = show all prices at least this amount. 

To value of $5,000 = show only prices up to and included this amount. 

From = 100.00 and to = 999.99 = show only prices between 100.00 and 1000.00. 

Strip Selection 

Use the 3 checkbox options to restrict the results to specific Strip Of types. 
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PNB Want List 

The PNB want list report is similar to the PNB search option, but it differs in the fact 

that the report generates listings for plate numbers which are not currently in your 

inventory.  

This dialog window is available from the Want and Sell Lists submenu under 

Reports. This report is not applicable to custom country files which have no pre-

supplied stamp content from SoftPro. 

 

The PNB Search Parameters tab contains the primary input conditions for the 

search. The second tab has default attributes which will not apply additional filtering 

of the stamp data. You can use the second tab to control additional filters which are 

combined with the results based on the first tab. For example, if the Type Search 

Parameters resulted in 100 matching records based on its input conditions, the 

search conditions in the first tab will be applied only to the 100 records which were 

matched on the type search based on the second tab. 

In effect, the Type Search conditions are applied before the PNC search conditions. 
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From and To Values 

If the From value is left blank, then there is no minimum price value to restrict the 

results. 

If the To value is left blank, then there is no maximum price. 

Examples: 

From value of $1,000 = show all prices at least this amount. 

To value of $5,000 = show only prices up to and included this amount. 

From = 100.00 and to = 999.99 = show only prices between 100.00 and 1000.00. 

Price Type Selection 

Use the VF-H and VF-NH to choose the value type(s) to show in the report. 
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Pre-Supplied Data Differences 

This is a special report which examines every stamp record in the country file and 

looks for changes you have made to pre-supplied stamp information. The search 

using a special report profile EzPre-Supplied.rpt which contain all of the fields which 

represent pre-supplied data. The search works much like EzBrowse, in that the 

results are immediately placed into the Report Viewer. The contents of this report 

are basically a visual representation of all of the data which is exported from the 

supplied pricing update window using the Export Customizations option. 

Change History 

EzStamp keeps track of changes to inventoried stamp records using internal date 

stamps on each record type. The change history option can be used to find records 

which have been saved within a recent period of time. This option is available in the 

Search menu under Change History. 

 

Date stamps are recorded for the following record types: 

Primary Stamp 

information 

Information which appears in the Stamp Details area 

on the main EzStamp window. 

PNB Data Information which appears in the PNB data grid (PNB 

tab) of the main EzStamp window. 

PNC Data Information which appears in the PNC data grid (PNC 

tab) of the main EzStamp window. 

FDC Cachet Data Information which appears in the FDC data grid (FDC 

tab) of the main EzStamp window. 
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Custom Fields Custom fields which you create and assign to the 

country file. 

Inventoried Grades Grade information which appears in the Grades data 

grid (Grades tab) of the main EzStamp window. 

 

Date Range Type 

Use one of the three radio button options to create a date range based on recent 

days, months, or a specific range using a starting and ending date. When specifying 

a date range, two input windows with date picker browse buttons will appear in 

place of the single days/months input field. 

Running a Change History Search 

Click on the Find button to start a search. If any matches are found the Save and 

Show buttons are enabled. 

Click on Save to write the change history to a plain text file. EzStamp doesn’t 

record previous values which were changes to new values – only a general 

indication of what record type was changed based on Scott number will be saved. 

Click on Show to assign the results to a new Navigation List which will be 

automatically activate in the main EzStamp window. 
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eLook™ 

This feature allows you to perform an eBay™ or HipStamp search using your default 

Internet browser. This option is available in the Search menu under eLook™. 

 

The country reference will be pre-populated from the current open country file. You 

can choose any other reference from the drop down list. 

The Scott/Catalog reference number will be taken from the current active stamp 

record in the main EzStamp window. You can type in any other matching text string 

in this field. 

The Results per Page is only used for eBay™ searches. The search type is also only 

applicable for eBay™ searches. 

Check the Keep this dialog open option to leave the dialog window open after 

running the search. This allows you to perform multiple searches. 

Click on either the HipStamp or eBay™ button to perform the appropriate search. 

EzStamp will launch your default Internet browser to point to the corresponding 

web page with the matching search conditions. 
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EzStamp Basic and Advanced Reports 

The Reports menu contains several items which make use of the same Basic and 

Advanced Field Search windows to enter the search input conditions. Since these 

report types use identical search input windows (the basic and advanced field 

search) are all identical, this section will focus on the differences which are 

apparent in the Report Viewer, based on the report profile assigned to each type. 

Report Summary 

The following table summarizes the report types and what they are for. 

Report Description 

Basic Inventory This report is intended to give you a very quick summary of 

what you have inventoried in a simple format. No grade 

details or grade quantities are shown, but instead the total 

# of stamps inventoried for the Scott #. 

Detailed Inventory This report is designed to provide details at the grade level 

for each stamp that you have inventoried.  

Customized Entries This report shows any custom entries (new varieties) that 

you have made which were not listed in the supplied 

database, and any customizations which have been made to 

pre-supplied stamp information. 

Cross Reference This report provided basic information for Location, X-

Reference, and alternate catalog ID values which can be 

associated with a stamp record. 

Mint Inventory This report will display all Mint singles that you have 

inventoried. 

Used Inventory This report will display all Used singles that you have 

inventoried. 

Mint Sheets This report is used to display all Mint Sheets that you have 

inventoried. 

Plate Block and 

Covers 

This report includes information based on inventoried plate 

block, Cover and FDC grades. This report does not include 

FDC Cachet data. 

Line Pair This report includes information based on inventoried line 

pair grades. 

Comments This report provides a simple listing of all inventoried 

stamps which you have attached comments to. 

Quick Stats 1 Use this report to print a quick summary of your inventory 

with valuations. 
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Report Description 

Quick Stats 2 This report is identical to the Qstats1 report except that 

FDC, Cover and Plate Block information has been added. 

Quick Stats 3 This report is the most comprehensive of the QuickStats 

reports, which adds Plate Number Block and Plate Number 

Coil information. Note that PNB data is currently only 

supplied for the Canada database & PNC data is only 

supplied for the USA database. 

Stamp Info This report is a summary listing of the basic supplied 

information pertaining to a given stamp. It can be useful for 

a quick overall glance at the details for a given country file. 

Want List A want list is a report containing all stamp records from the 

pre-supplied data which are not yet part of your inventory. 

Priority Want List This report contains record of all stamps which you have 

added using the special PWL icon (shopping cart) from the 

main EzStamp window. The PWL can add want list entries at 

the grade or stamp level, and can include stamps which are 

already part of your inventory. 

Priority Sell List This is the counterpart to the PWL. This report contains 

record of all stamps which you have added using the special 

PSL icon (green dollar symbol) from the main EzStamp 

window. The PSL can also add entries at the grade or stamp 

level, and don’t need to be in your inventory. 

 

Pre-Supplied Report Profiles 

Each of the above report types uses a unique report profile, which begins with the 

word “Default”. These pre-supplied profiles are characterized by field lists 

containing the set of stamp attributes to appear on reports. You will not be able to 

modify the pre-supplied profile field lists, but you can change the other report 

attributes. 

If you need to add, remove, or otherwise customize a default report profile, you will 

need to make a copy of report file using the report profile editor, and attach it to 

any search/report using the drop down list provided in input condition dialog 

windows. Once you assign a customized report profile, it will remain as the “new 

default” until such time as you change to a different profile. 
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Report Fields 

The following table shows which fields are assigned to each report type for the list 

from the previous section. There are many additional fields not shown below which 

can be added to a custom report profile. 

Report Field List 

Basic Inventory Scott Number 

Mint Price 

Used Price 

Year Issued 

Denom. & Color 

Perforation 

Notes 

Grade Quantity 

Detailed Inventory Scott Number 

Grade Quantity 

NH Percent 

Mint Qty 

Used Qty 

Net Mint 

Net Used 

Net Worth 

VG Mint Qty + Net 

F Mint Qty + Net 

VF Mint Qty + Net 

XF Mint Qty + Net 

VG Used Qty + Net 

F Used Qty + Net 

VF Used Qty + Net 

XF Used Qty + Net 

Customized Entries Scott Number 

Year Issued 

Date of Issue 

Denom. & Color 

Perforation 

Watermark 

Notes 

Image Link 1 

Cross Reference Scott Number 

User Cat ID #1 

Mint Price 

X-Reference 

Location 

Grade Quantity 

Mint Qty 

Used Qty 

Net Mint 

Net Used 

Net Worth 

Mint Inventory Scott Number 

Mint Price 

Mint Qty 

Net Mint 

Purchase Price 

VG Mint H Qty + Val 

F Mint H Qty + Val 

VF Mint H Qty + Val 

XF Mint H Qty + Val 

VG Mint NH Qty + Val 

F Mint NH Qty + Val 

VF Mint NH Qty + Val 

XF Mint NH Qty + Val 

Used Inventory Scott Number 

Used Price 

Used Qty 

Net Used 

VG Used NH Qty + Val 

F Used NH Qty + Val 

VF Used NH Qty + Val 

XF Used NH Qty + Val 

Mint Sheets Scott Number 

Mint Sheet Price 

Mint Sheet Size 

Mint Sheet Qty 

Net Mint Sheet 
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Report Field List 

Plate Block and 

Covers 

Scott Number 

PB Mint Price 

FDC Price 

Plate Block Size 

PB UL Qty 

PB UR Qty 

PB LL Qty 

PB LR Qty 

PB Tot Qty 

FDC Qty 

Cover Qty 

Net Cover Worth 

Net PB Worth 

Net FDC Worth 

Net Worth 

Line Pair Scott Number 

Line Pair Mint Price 

Line Pair User Price 

Line Pair Qty 

Net Line Pair 

LP Mint Qty + Val 

LP Used Qty + Val 

Comments Scott Number Comments 

Quick Stats 1 Scott Number 

Mint Price 

Used Price 

Mint Qty 

Used Qty 

Mint + Used Qty 

Net Mint 

Net Used 

Net Worth 

Purchase Price 

Quick Stats 2 Scott Number 

Mint Price 

Used Price 

Mint Qty 

Used Qty 

Mint + Used Qty 

Net Mint 

Net Used 

Net PB Worth 

Net FDC Worth 

Net Worth 

Purchase Price 

Quick Stats 3 Scott Number 

Mint Price 

Used Price 

Mint Qty 

Used Qty 

Mint + Used Qty 

Net Mint 

Net Used 

Net PB Worth 

Net FDC Worth 

Net FDC Cachet 

Net PNB Worth 

Net PNC Worth 

Net Worth 

Purchase Price 

Stamp Info Scott Number 

Mint Price 

Used Price 

Year Issued 

Denom. & Color 

Perforation 

Watermark 

Notes 

Want List Scott Number 

Mint Price 

Used Price 

Year Issued 

Denom. & Color 

Perforation 

Notes 

Priority Want List Scott Number Perforation 
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Report Field List 

Mint Price 

Used Price 

Year Issued 

Denom. & Color 

Notes 

PWL Grade 

PWL Qty 

PWL Type 

Priority Sell List Scott Number 

Mint Price 

Used Price 

Denom. & Color 

Notes 

Mint Qty 

Used Qty 

Net Buy Price 

Net Sell Price 

PSL Grade 

PSL Qty 

PSL Type 

Line Item Reports 

This report type displays inventoried grade, PNB, PNC and FDC cachet records on a 

line by line basis. The report will only count records where the inventoried quantity 

is not zero.  

The dialog window is divided into 2 parts. The majority of the window is a copy of 

the search attributes provided by the standard reports’ Advanced Field search 

capabilities.  

The remaining items are provided to filter down the search and display based on 

one of the 4 line item types for inventoried data, using the 4 checkbox options 

below the Duplicates drop down list. 

Note that for PNB and PNC data, there is no option to filter additionally by type. For 

example, a PNB search will look for and display both VF-H and VF-NH records. 

For grade data, you can use the grade filter list on the right side of the window. 

Check the All Grades option to search and display on all grade types. 

The method by which the search works is based on the combination of the 4 

checkbox options and the advanced search attribute items. 

The Line Item report can be found under the Reports menu. The default shortcut 

key Ctrl+F1 has been assigned to this menu item. 
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The primary search conditions (i.e. Scott Range, Types to Show, DOI, Year, etc.) 

are applied first to generate an intermediate set of stamp records. Then the 

combination of the 4 checkbox options and the grade filter list is applied to this, to 

result in a final list of stamp records for the report. 

The default report profile will display only the following fields: 

• Scott # 

• Data Type 

• Grade Name or Plate/FDC Number 

• Your value or a pre-supplied value if available 

• Net Value 

You can create custom Line Item reports with additional fields using the Line Item 

Profile Editor option from the Reports menu. 

Potential Profit Filter 

Similar to the FDC, PNC, PNB and Grade searches, you can choose to run a 

potential profit report by choosing one of the options from the Potential Profit drop 

down list. 

Refer to the Potential Profit help topic for more information. Note that the line 

item reports include all 4 of the item types from those other searches, so the 

visibility for a stamp record is at least one item from Grades, PNC, PNB or FDC 
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inventoried data. For example, if there were no matches for PNC, PNB or FDC 

items, but there was a match for a MH-VF grade item, the stamp will appear on the 

line item report. 

 

Performing the Search 

Click on the Find button to search the country file for matching stamp records. If 

any matches are found, then the Show button will be enabled, allowing you to 

display the results in a spreadsheet viewer. From the viewer you can sort any of the 

columns of data, print the report, or use options to transform all or part of the 

report to a Thumbnail View, Stamp List or Navigation List. 

 

Loading and Saving Search Conditions 

Use the Load and Save buttons to store search conditions to files which can be 

recalled at a later time. These files are saved in the application folder under 

Searches\LIR. 
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The report viewer is a limited version of the standard reports’ spreadsheet viewer. 

You have no option to edit, add, or remove stamp record information. However, you 

can use the summary menu options to view some of the stamp details. 

If you need more access to the records, you can assign all or part of the report to a 

Navigation List, and then transfer that to the normal viewer, which will have all of 

the editing features available to use. 

Detailed Line Item Reports 

A second line item report option is available under the same submenu which is 

based on the customized information which you can add to the record: 

• Purchase date, price and who the item was purchased from. 

• Sell date, price, and who the item was sold to. 

• Custom image link (not applicable to grades). 

• Item location. 

• Your comments. 

• Item description (PNC, PNB and FDC cachet records only). 

• Quantity (for PNC these are the 3 Strip values, for PNB VF-H and VF-NH). 

The search criteria for a detailed line item report is broken into a dialog with 2 tabs 

of information. The first tab is the same as for the Basic Line Item report. The 

second tab is for the list of customized attributes previously mentioned. 

Note that for prices and quantities, the values must be non-zero to match. For 

dates, a purchased or sold date must be present in the record. There is no provision 

on this report type to show records which contain “blank” attributes or values of 

zero. 
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PNC and PNB Subfilters 

When checking the PNB or PNC options in the first tab, you can filter out specific 

types for these records using the 5 checkbox options in the second tab. You will not 

be able to uncheck all of them for a specific type. 

Between Settings for Prices, Dates and Quantities 

These values are shown on the screen with two input fields for a “From” and a “To” 

value. Both are optional, however at least one of the two must be entered to 

perform a filtered search. Consider the Purchased From price: 

• If both values are entered, the purchased price must be between or equal to 

those 2 values. 

• If only the first value is entered, then a match is based on all purchase prices 

greater than or equal to the value entered. 

• If only the second value is entered, the match is based on all purchase prices 

greater than zero and up to and including the value entered. 

Text Keyword Matching 

For buyers, sellers, description, comments and location, the values entered are 

partial matches and act as a keyword to the overall value. For example, you don’t 

enter a full location to match on, unless you want to use the full value or choose 

one from the drop down list. You can enter part of the location and it will still count 

as a matching condition. 
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Text matching is not case-sensitive. 

Image Links 

If you check this option, only records which contain a custom image link will be 

reported. If you check the grades option, no matching grades will ever be reported, 

as grades can’t have image links. 

Description Matching 

Descriptions are either custom or pre-supplied values applicable to PNC, PNB and 

FDC cachet record types. They do not apply to regular stamp grades. 

A description filter will ignore all other match conditions and acts as a simple means 

to report all PNC, PNC and FDC records which match the description entered. As 

such, do not enter a description in combination with any other values available in 

the second tab of this search window. 

Match Combinations 

When more than one value is entered into the second tab of the search window, it 

acts as an additional filter taking in combination with all previous values entered. 

For example: 

• Purchase Price greater than $100.00 

• Purchase Date between December 1, 2019 and December 31, 2019 

The record will only be reported if BOTH conditions are satisfied, as opposed to 

either condition being satisfied. 

Keep in mind that the conditions in the first tab of the search window take 

precedence. Once a record is matched from the primary criteria of the first tab, only 

those matched records are filtered based on the criteria from the second tab. 

 

Custom Report Assignments 

When you create many custom report profiles, you might want to be able to assign 

these to specific reports or searches without changing the default profiles assigned 

to the items under the Search and Reports menus. This is where the Custom Report 

Assignments feature helps. 

A submenu is available in Reports under the Custom Reports menu item. This 

submenu contains 10 custom search/report positions where you can assign a 

custom profile to, along with the associate search/report type. Use the Assign or 

Remove Reports item under the submenu to attach a search/report to one of the 

10 available positions. 
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The 10 radio buttons are used to select one of the 10 menu positions to assign a 

report to. As you click each button, the information in this dialog window will 

change to reflect the report currently assigned to that position. 

Report Types 

The following searches and reports can be assigned to a custom report position: 

Quick Stats 1 PNB Search/Report 

Quick Stats 2 FDC Search/Report 

Quick Stats 3 Power Search/Report 

Basic Inventory Keyword Search/Report 

Detailed Inventory Supplied Price Search/Report 

Mint Inventory Supplied Search (Year Issued) 

Used Inventory Supplied Search (Denomination & Color) 

Mint Sheets Supplied Search (Date of Issue) 

Plate Block and Covers Supplied Search (Watermark) 

Customized Records/Data Supplied Search (Perforation) 

X-Ref/Location Report Supplied Search (Notes) 

Comments Report Inventory Search (Location) 

Stamp Information Inventory Search (X-Ref) 

Want List Inventory Search (Comments) 

Priority Want List Inventory Search (Category) 
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Priority Sell List Inventory Search (Custom Fields) 

Grade Search/Report EzBrowse 

PNC Search/Report EzInventory 

 

Report Profiles 

Only customized report profiles can be assigned to a custom report menu position. 

The pre-supplied “Default” profiles will not appear in this list. Use the Custom 

Report Editor to create new report profiles, or make copies from any of the pre-

supplied stock reports. 

Menu Description and Report File Name 

When you pick a report profile, the file name and current description embedded in 

the RPT file will be shown below the profile drop down list. You will not be able to 

rename the profile; however you can label the report to any text of your choosing. 

This description is what will appear in the submenu when you select it from the 

main EzStamp menu. 

Exporting and Importing Report Sets 

Even though you are limited to 10 custom report positions in the submenu, you can 

swap out profile sets using the Export and Import buttons. Use the Clear button to 

remove a report from a submenu position. The Clear All button will reset all 

submenu positions to empty status. 

Clicking on Save will assign the report positions to main EzStamp menu, and also 

save this information to a special pre-named report set file in the application 

installation path. This will retain your custom menu assignments after EzStamp has 

been closed down. 

Navigation List Report 

Navigation Lists are simply a list of stamp records maintained by EzStamp and 

accessible using the purple arrow buttons in the main toolbar. These lists can be 

generated from Reports, Bookmarks, Tags, Stamp Lists, and Searches. A navigation 

list has no special formatting characteristics – it’s just a collection of Scott/Alternate 

Catalog ID numbers.  

Since a report profile is just the method by which to display a collection of stamp 

records, a special menu option under Reports has been provided for ad-hoc reports 

using the current navigation list. This item has the appropriate name of Navigation 

List. The dialog window is quite simple: 
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Choose a report profile (every pre-supplied and custom report profile is available in 

the drop down list) and click Show to bring up the Report Viewer. 

Global Searches for Reports 

Several of the options under the Search and Reports menus will display a button 

named Global in the associated search criteria window. 

Global searches work exactly the same as a normal search with 3 notable 

exceptions: 

1. The search is performed on a selection of one or more country files.  

2. The results of a search are always displayed in a floating spreadsheet-style 

window alongside the main EzStamp window, or as a set of thumbnail 

images. This is handled as two independent Tabs in the same global view 

window. 

3. You may not create a printed report from the search results. 

Global searches can take longer to execute, and this is based on the following 

conditions: 

a. The number of countries searched. 

b. The number of stamp records in each country file selected. 

c. The performance of your PC, in terms of opening and closing country files, as 

each file will need to be opened in turn while the search is running. 

Initiating a Search 

When you click on the Global button, a small confirmation window will appear, like 

the one shown below. 
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The selection of countries is always retained between searches. You can choose 

which countries should be involved in a global search by clicking on the Countries 

button. Click OK to start the search. 

Selecting Countries 

Clicking on the Countries button will present a selection window as shown below: 
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The available countries are shown in left list and the assigned countries in the right 

list. To add countries to the assigned list, select from the available list, and right 

click or click on the right arrow in the toolbar. 

To remove countries from the list, select them in the assigned list and right click or 

click on the left arrow in the toolbar. 

Use the export and import options to save and load custom country selections. 

Click on the accept button (green check) to use the assigned list of countries for the 

search. 

Search Progress and Cancellation 

Since a Global search can take longer to finish over a normal search, a progress bar 

window will popup when the search begins. You can click on the Cancel button at 

any time to stop the search. 

Showing Search Results 

When the search completes, the total number of stamp records matched will be 

displayed just like a normal search. Click on the Show button to close the search 

window and display the stamp records in the Global Search Window. The format of 

this window will be based on the current report profile assigned in the associated 

search window. 
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Viewer Options 

The viewer window is a floating, sizeable window, and works similar to a Stamp List 

view. The first column of a global report is always the country file reference.  

 

1 Show the current selected record in the main EzStamp window. This can 

also be done by double clicking the stamp record in the spreadsheet view. If 

the country file opened is not the same as the stamp record selected, the 

current country file will be closed and the new country file opened. 

2 Recall the previous search results. If you close down the search window or 

restart EzStamp, you can always recall the previous search results by using 

this option. Note that executing a new search will overwrite the previous 

search, unless you choose to the export option to save the search results 

permanently. 

3 Use the export button to save the current search results to a safe location 
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within EzStamp. The search files are always stored in fail pairs with .GSC 

and .GSD extensions. They can be found in the Searches\Global 

subdirectory of the EzStamp installation path. Global search files can be 

quite large depending on the number of matching stamp records and the 

number of columns in the report profiles used with the search. 

4 Use the import option to recall a previously exported search. See below for 

more details on managing saved search files. 

5 EzStamp will retain the width of each column of data in the spreadsheet to a 

settings file, which is preserved even after EzStamp is closed. The settings 

are tied to the report profile chosen. You can click this button to reset the 

custom column sizes to default values. 

6 This option performs a limited version of the Rapid Multi-Entry (RME) 

feature of EzStamp. See below for more details. 

7 Use this button to toggle the stamp image preview on and off. Only the first 

primary stamp image is displayed, and it will either be a custom image or 

pre-supplied image depending on which one is available. 

8 This option will create a multi-record export to AlbumGen provided that the 

application is installed onto your PC. This is identical to the feature available 

under the normal report viewer, but it will extend across multiple country 

files. This feature may take time to run based on the number of country 

files which need to be opened and closed to retrieve the information 

required by AlbumGen. 

9 The global search results window doesn’t offer the full feature set of the 

normal report view, given that the latter option is only intended to be used 

with a single country file at a time. However, you can transfer the data for 

any given country file in the global search view directly to the normal report 

viewer. Simply select a country record, and click on this button to perform 

the report transfer. All records associated with the country of the selected 

stamp record will be transferred to the standard report view. 

10 A global search file will store the search conditions which summarize the 

conditions by which the search was performed. Click this button to show 

those search conditions. 

 

Thumbnail Image View 

The second tab of the global view window will display thumbnail images, much the 

same as the country-specific thumbnail image window works. There are two 

restrictions to the global thumbnail view: 

• No catalogue ID formats other than Scott number are allowed. 
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• Only the primary stamp image can be displayed. 

The navigation options are the same as the normal thumbnail viewer. The number 

of stamp rows and columns is independent of the normal viewer and can be set in 

the EzStamp General Preferences. 

 

 

Managing Global Search Files 

Since search files can be large, the import option provides a special screen to 

performance maintenance on the search files. 
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For any selected search file, the report type, profile information, size, record count 

and creation date are shown in the bottom panel. 

Use the Delete button to permanently remove the selected search files from your 

PC. 

Use the Rename button to change the name of the selected search file. 

Use the Details button to show the search conditions for the selected file. This 

works the same as the Info button from the Global Viewer window. 

Click on Open to import the selected search file into the Global Viewer window, 

replacing the existing search results. You may also double click any row in the list 

to open the search file. 

You can sort the list of search files by clicking on the caption above either of the 

columns, to sort by file name or report search type. 

Rapid Inventory (Rapid Multi-Entry) 

Use this option to add selected stamp records to your inventory. The option will not 

update any stamp records which are already part of your inventory. 
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This screen is almost identical to the RME dialog available from the Report Viewer. 

Refer to the help topic for the report RME option for more details. If any of the 

selected records are already inventoried, they will be unaffected. Note that 

inventoried records are marked in the Global View window with a green background 

in the record number column. 

Registered, Initialized & Upgraded Country File Requirements 

Global Searches are not available with Trial versions of EzStamp. Country files must 

be initialized and registered to be used with global searches and must also be on 

the latest version of the country file format. EzStamp has options available to easily 

upgrade and initialize all country files as simple one-click features. 

Global Mode SRS Search Results 

The Global Mode option for SRS searches can return stamp data for multiple 

countries. As such, the default Stamp List Browser window is unsuitable for this 

type of search. SRS global search results are shown using the Global Viewer and 

the report type in the import dialog will indicate an SRS search results file type. 

Search Files and Country File Changes 

Search result files contain a snapshot of the stamp information at the time the 

search was performed. This is a read-only snapshot from the country file and as 

such will never reflect changes made to stamp information over time. As such, it 

may be possible to see missing stamp records or stamp records which are present 

in the global search window but no longer in your country file. Or you may see 
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stamp details which are out of date. Global searches are not permanently tied to 

your country files, and as such will not reflect any changes you make. 
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Grand Totals Report 

The grand totals report provides summary statistics for all country files installed 

and registered with your copy of EzStamp. For a country to appear in the report, 

you must have opened it at least one time. By default all countries are un-

registered until the first time you open them. 

The grand totals report uses a unique dialog window for the search input conditions 

as shown below. 

 

Report Orientation 

The Horizontal format will show one line of information for each country file across 

the report. The Vertical format will show grade information vertically, similar to the 

Inventoried Grades Search report. The vertical format will not show the totals for 

PNB, PNC, FDC Cachet, PWL or PSL data – it’s strictly designed to break down the 

statistics on a per grade basis, of which the latter data is not associated with. 

Note: The Vertical Format used separate report profiles than those designated for 

the Horizontal Format. You will see the profile name under the dropdown list 

change accordingly when choosing a format. 
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Grade Selection 

The grade checkbox list is used to filter the grades which will appear on the GT 

report. For example, if you only want to see Mint grades, select the 8 MH and MNH 

grades in the list. The Grades button can be used to select from pre-defined grade 

groups. The All Grades checkbox can be used to enforce all grades on the report 

and the grade list will be ignored. 

Country Selection 

By default all registered countries are included in a GT report. If you want to show 

totals for specific countries, then click on the Countries button. Note the title bar 

at the top of the GT search window. It indicates how many countries are available 

and how many will appear in the report. If a country isn’t registered (i.e., opened at 

least one time) or there are no inventoried records on the country, then it will be 

excluded from the report. 

Report Attributes 

Display Grades 

Horizontally 

This option will add more columns to the report for 

the individual grades (i.e. MH-VF), using the Grade 

Format drop down list to determine what combination 

of quantity and value will be used. 

Report for the Open 

Country File 

If checked this option will restrict the GT report to the 

current open country file. 

Group by Country Name If you have several country files based on a single 

country of origin (i.e. USA), checking this option will 

take the totals for all of the country files of that origin 

and show results as a net sum under a single row in 

the report. 

Include Countries with 

Disabled Totals 

The Country Settings window allows you to disable 

any country file from showing its totals in a GT report. 

If you check this option, then every country file will be 

included in the report even if disabled at the country 

file level. 

Show Flag Images in the 

Viewer 

Check this to display flag images in the on screen 

report viewer. 

Show Flag Images on 

Printed Reports 

Check this to print the flag images on your reports. 

Data Groups Data groups apply to the horizontal format only. 

These checkbox options will filter the types of data in 

the GT report. For example, if you only want to see 

summary statistics for inventoried grades, then 
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uncheck all but Grade Totals. 

Currency Selection By default, a GT report will show totals based on USD 

(USA) currency conversion rates. If you want to 

display the totals based on the conversion rate of a 

different country, then uncheck the USD option and 

select a country from the drop down list. 

Grade Format for 

Horizontal Grades 

This drop down list will be enabled when you choose 

to display grades horizontally. You have the following 

display choices: 

Net Value Stamp Quantity 

Net Profit Record Quantity 

Purchase Price Grade Qty + Net Value 

Sell Price Stamp Qty + Net Value 

Grade/Item Quantity Record Qty + Net Value 
 

 

Running the Report 

Once you have chosen all the input conditions for the report, click on the Show 

button. Depending on the orientation of the report, you will get a view in either the 

horizontal or vertical format. An example of each format is shown below. For 

options available in the menu, refer to the Report Viewer section of the manual. 
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Horizontal Display Format 

 

Vertical Display Format 
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EzStamp Report Viewer 
All searches and reports have a display option to show the data in a Spreadsheet 

Viewer. This viewer shows stamp records in a row and column grid format much 

like a spreadsheet. The Data Browser option available from searches and reports is 

a scaled-down version of the report viewer, without any data manipulation 

capabilities. 

 

The viewer consists of a menu, toolbar, status bar, and a data grid showing the 

stamp report data. Color coding of grid cells and the row tabs is shown in the above 

example. The color coding serves as visual cues for specific attributes about the 

data in the grid. 

An image preview window can be toggle on or off using the F12 key. When turned 

on, the image preview pane will appear on the left. The width of the window is 

divided between the image and the data grid. You can drag the divider between the 

two areas to make the image area smaller or larger. 
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The title bar at the top of the viewer window shows as many of the search input 

conditions as will fit. An option is available under the help menu to see all of this 

information using a popup window. 

Record Tab Color Coding 

The leftmost column of the data grid is fixed and contains the record number. The 

color of this tab indicates a specific status of the record as follows (Note: this 

manual refers to the default colors, which can be changed using the EzStamp 

general preferences). 

Green The record is part of your inventory. 

White on Blue The record has at least one column which matched on a search 

string using the Find menu option. 

White on Red The record has been book marked. 

Green + Red The record is inventoried and book marked. The tab cell will be 

a half-and-half color fill. 

Default The normal color used for data grid header labels based on 

your current Windows color scheme indicates a pre-supplied 

stamp record not part of your inventory. 
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Under Data Browse viewing, no color coding is used so the row 

tabs will always be this color as well. 

Column Header Color Coding 

The column headers which run across the top of the data grid normally use a basic 

default label color consistent with your Windows color scheme. If you are displaying 

Data Groups in your report profile, the header captions will be color coded to match 

the type of data group, and will be colored for only the columns which are part of 

the group. You can change these colors using the EzStamp general preferences. 

Green Inventoried Grade data group. 

Yellow FDC Cachet data group. 

Blue PNC data group. 

Violet PNB data group. 

Light Orange PWL data group. 

Medium Orange PSL data group. 

Default For any columns not part of a data group, or when using Data 

Browse view mode. 

 

Special Color Coding of Data Cells 

The data value for a specific row cell within the grid can be color coded to indicate a 

special status. Normally, all data grids in EzStamp (for all windows) alternate the 

row colors: White for odd rows, Gray for even rows. In addition, a cell may be 

shown with the following colors. 

Images The background color for images can be set in the EzStamp 

general preferences. The default is Black. 

Totals Lines These lines will always use the same color as the column 

header caption row. 

Dark Blue When you click or click and drag to select cells, the selection 

will be highlighted in this color. 

Light Blue The complete data row for any stamp record where at least 

one cell is selected will be highlighted in this color, giving you a 

visual cue of the selected status of the record even when the 

actual cell selection may be scrolled off the left or right side of 

the window. 

 

Note that stamp records can span multiple rows, such as in 
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PNC report with multiple plate block numbers. In this case, all 

grid rows associated with the selected stamp record are 

highlighted in this color. 

White on Green EzStamp has a general preference option to show high 

currency values in this color. You can enable this option and 

set the minimum currency value for which the highlighting will 

be applied. 

Yellow The viewer has an option to search every cell in the report for 

a specific data value. Matched cells will be highlighted in this 

color. In addition, the record number tab will be highlighted in 

the dark blue cursor color to indicate “at least one match on 

this row”. 

Orange The cell represents a pre-supplied stamp attribute, such as 

denomination and color, where the pre-supplied value has 

been altered. This color is not applicable to custom country 

files without pre-supplied data, and is not enabled by default 

for every report – use Alt+F7 to toggle this color coding on and 

off. 

 

Report Viewer Toolbar Options 

 

 

1 Print the current report. 

2 Show the selected stamp record on the main screen. 

3 Close the report viewer. 

4 Find a value in the data grid. 

5 Hide selected columns. 

6 Show all hidden columns. 

7 Remove selected stamp records from the report (does not remove from 

inventory). 

8 Sort the report based on the selected column. 

9 Perform rapid multi entry on the bookmarked/selected stamps. 

10 Add the bookmark/selected stamps to your inventory. 
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11 Remove the bookmark/selected stamps from your inventory. 

12 Perform rapid Priority Want List entry. 

13 Perform rapid Priority Sell List entry. 

14 Add the selected stamps to your bookmark list. 

15 Remove the selected stamps from your bookmark list. 

16 Clear the bookmark list. 

17 Data presence indicators and quick edit modes for Grade, FDC Cachet data, 

PNC data, PNB data, PWL data, PSL data and custom fields. These indicators 

will be gray when the respective data type is not part of the stamp record 

currently selected, or when you have selected more than one stamp record 

at a time 

Note: These indicators are not active unless you select a single stamp 

record. 

18 If there is pre-supplied Special Information or Notes for the selected stamp 

record, this icon will be enabled. 

 

Report Viewer Status Bar 

 

 

1 If any columns are hidden in the current report profile, this icon will appear. 

Hidden status is retained even after the report viewer is closed down and is 

unique for each profile. 

2 This is the stamp inventory status icon. Refer to the main EzStamp window 

status bar help for the various icon types. 

3 This icon will appear if the selected stamp is price locked. 

4 This icon will appear if the selected stamp is defined as not having Never-

Hinged pricing. 

5 When you bookmark stamp records, this indicator will reflect how many 

stamps are in the bookmark list. 

6 The Scott/Alternate Catalog number of the selected row is displayed here. 

7 If you are selecting individual cells with the mouse, the cell contents are 

copied to the status bar. Otherwise, this area contains progress and help 

hint messages. 
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Report Viewer Menu Options 

The Report Viewer (a.k.a. Spreadsheet Viewer), Data Browser, and Grand Totals 

Viewer all share some common functionality, as they use the same viewer window. 

Data Browser and Grand Totals Viewers have limited functions compared to the 

Report Viewer, and many of the options described in the next several sections will 

not appear with the latter two viewing modes. 

The following table is a quick summary of the menu options. Each of these will be 

described in detail in subsequent sections. 

Menu Item Shortcut Description 

Options Show in Main Window F5 Show the selected stamp 

record in the main EzStamp 

application window. 

Options Show as Thumbnail View F6 Show the report in the 

thumbnail viewer. 

Options Assign as new Navigation List F7 Assign the report to the 

Navigation List. 

Options Assign to Stamp List F8 Assign the report to the 

stamp list viewer. 

Options Print Ctrl + P Print the report. 

Options Change Report Profile F10 Change to a new report 

profile. 

Options Show Image Preview F12 Toggle the image preview 

pane on and off. 

Options Show Comments Preview Ctrl + F12 Toggle the comments 

preview pane on and off. 

Options Create Snapshot Ctrl + S Create a snapshot file from 

the report. 

Options Clear Image Cache Ctrl + Shift + C Clear the thumbnail image 

cache. 

Options Report Merge  Merge the current report to 

the previous report. 

Options Exit Ctrl + Esc Exit the viewer. 

Bookmarks Add Selection Ctrl + B Add the selected stamp 

records to the bookmark list. 

Bookmarks Remove Selection Ctrl + Del Remove the selected stamp 

records from the bookmark 

list. 

Bookmarks Add Everything Ctrl + Shift + A Add the report to the 

bookmark list. 
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Menu Item Shortcut Description 

Bookmarks Invert Bookmark List Ctrl + Alt + B Reverse the bookmark 

selection. 

Bookmarks Clear Bookmark List Ctrl + Shift + B Clear the bookmark list. 

Bookmarks Save as Navigation List Ctrl + N Assign the bookmark list to 

the Navigation List. 

Bookmarks Export to AlbumGen Ctrl + G Export the report to 

AlbumGen. 

Edit Rapid Multi Entry Ctrl + M Perform Rapid Multi entry. 

Edit Quick Add to Inventory Ctrl + I Add to your inventory. 

Edit Remove from Inventory Ctrl + Shift + I Remove from your inventory. 

Edit Grade Quick Edit Ctrl + F1 Quick edit for inventoried 

grades. 

Edit FDC Quick Edit Ctrl + F2 Quick edit for FDC cachet 

data. 

Edit PNC Quick Edit Ctrl + F3 Quick edit for PNC data. 

Edit PNB Quick Edit Ctrl + F4 Quick edit for PNB data. 

Edit Priority Want List Edit Ctrl + F5 Quick edit for PWL data. 

Edit Priority Sell List Edit Ctrl + F6 Quick edit for PSL data. 

Edit Lock Pricing Ctrl + F7 Lock pricing on stamps. 

Edit Unlock Pricing Ctrl + F8 Unlock the locked pricing. 

Edit Rapid PWL Entry Ctrl + F9 Perform Rapid entry to the 

PWL. 

Edit Rapid PSL Entry Ctrl + F10 Perform Rapid entry to the 

PSL. 

View Sort Ascending Order Ctrl + 1 Sort the report on the 

selected column. 

View Sort Descending Order Ctrl + 2 Sort the report on the 

selected column. 

View Reset Sort Order Ctrl + 3 Restore the original sort 

order. 

View Hide Selected Columns Ctrl + H Hide all selected columns. 

View Auto Hide Empty Columns Ctrl + Alt + H Hide any columns which have 

no data in them. 

View Unhide All Columns Ctrl + Shift + H Show all columns which were 

hidden. 

View Remove Rows Ctrl + R Remove rows from the 

report. 

View eLook™ Search Ctrl + E Perform an eLook™ search. 

View Find Ctrl + F Perform a text search on the 

data grid. 
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Menu Item Shortcut Description 

View Find Next F3 Find the next occurrence of 

the search text. 

View Find Previous Shift + F3 Find the previous occurrence 

of the search text. 

View Clear Find Ctrl + Shift + F3 Reset the text search. 

View Reset Column Widths Ctrl + W Restore all report column 

widths to default values. 

Summary Supplied Data Alt + F1 View/edit pre-supplied data 

fields. 

Summary Your Data Alt + F2 View/edit your data fields. 

Summary Custom Fields Alt + F3 View/edit custom data fields. 

Summary Special Information Alt + F4 View notes and special 

information. 

Summary Images Alt + F5 Run the image links editor. 

Summary Comments Alt + F6 View/edit comments for the 

stamp record. 

Summary Shows Differences from Supplied Alt + F7 Toggle pre-supplied color 

differences on the data grid. 

Summary Show/Filter all Data Rows Alt + F8 PNC, PNB, FDC and Grade 

reports can show/hide filtered 

data rows. This option 

toggles the filtered rows from 

being displayed. 

Help Report Viewer Context Help F1 Context sensitive help for the 

viewer. 

Help EzStamp General Preferences F2 Show the EzStamp general 

preferences dialog window. 

Help View Report Title Ctrl + T Show all the input conditions 

for the search data which 

generated the report results 

which appears in the title bar. 
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Options Menu 

Navigation List (F7), Stamp List (F8) and Thumbnail Viewer (F6) 

You can assign the entire report to one of the alternate report view methods using 

the options available under Options. When you assign the report, the viewer will 

close. If thumbnail view mode or stamp list modes are chosen, the corresponding 

window will be displayed with the report data. For navigation list assignment, any 

current list will be discarded and replaced with the report data. 

If you want to assign a subset of the report, create a bookmark list, and only the 

bookmarked stamp records will be assigned. 

Printing Reports (Ctrl + P) 

EzStamp will use the printer settings in the current report profile (RPT) file 

assigned. The standard printer settings for most report profiles are as follows: 

• Landscape orientation. 

• The current default printer defined in your version of Windows. 

• The current default paper size and print quality for this printer. 

• Half-inch margins on the left and right, with 1 inch margins top and bottom. 

• Arial font varying between 8 and 10 points. 

• Multi-page format, with Scott number columns repeating on each page 

across. 

• No alternate color banding on data rows – the report is plain black text on a 

white background. 

EzStamp has a general preferences option to enforce the following global settings, 

which will override all report profile settings. These options are available in the 

Printer Setup tab. 

• Printer to send the report to. 

• Paper size. 

• Orientation. 

• Margins. 

• Column width auto-sizing. 

• Column width fill mode for fit-to-page reports. 

Use the print icon, or choose Print from the Options menu option to begin. The 

standard Windows printer settings dialog will appear, allowing you to choose the 

printer, page range, and number of copies.  

EzStamp does not pre-calculate the pages as the choice of printer and any changes 

made to Properties within the printer setup dialog window can result in different 
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page totals. In addition, collating copies is not allowed in EzStamp. If you specify 3 

copies, then each copy will be printed in turn before the next copy. 

EzStamp will send the report using whatever color settings you define in the report 

profile, provided that the printer you chose supports color output. 

EzStamp relies on the Windows spooler to accumulate the report data and print it in 

the background. Until all the pages are sent to Windows to print, you will not be 

able to perform other tasks in EzStamp. A progress dialog will appear to indicate 

the printing status. You can click on the Cancel button to stop printing at any time. 

Reports can be printed in one of 3 formats:  

• Multi-page: The columns of the report span multiple pages wide. 

• Staggered: The report is one page wide, and columns wrap to multiple rows. 

• Fit-to-Page: The report columns must fit into one page width. 

Note: There is a 4th report type, On-Screen Only, which disables all printing 

attributes and can only be used for the report viewer without printing. 

Fit-to-Page reports must not contain too many columns of data, or the scaling 

needed to fit the report onto a single page width will be too great to be printed with 

a readable font size. If this happens, you will be informed that the report can’t fit 

the page width. You can either adjust font sizes, paper width, remove/hide 

columns, or change to a multi-page format. 

Reports and Images 

The default report profiles do not contain any image fields. However, image fields 

can be attached to any custom report and displayed in both on screen and printed 

reports. Preference options determine what the image size will be on screen (pixel 

dimensions) and what it will be on printed reports (width and height in inches). The 

quality of the images displayed and printed can also be adjusted. 

Changing the Profile (F10) 

Every search and report item in EzStamp has a default report profile file (RPT) 

associated with it. These profiles can be changed from within the drop down list 

which appears in the input condition window. Since a profile represents the display 

characteristics and field list for reports and the data itself is independent of this 

profile, EzStamp allows you to swap out profiles on the fly using the Change 

Report Profile option. 
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Select a new profile from the drop down list and click OK. The Edit button can be 

used to run the custom report editor. 

Profile switches don’t affect the default profile associated with any menu option 

under the main EzStamp Search or Reports menus – i.e., if Default Stamp 

Information was the profile used to run the report, it will remain so even after 

switching profiles within the viewer. 

Profile Settings (Widths and Hidden Columns) 

The report viewer bases the default widths for columns on the master field 

definitions shared among all report types in EzStamp. These field definitions can be 

edited using one of the Field Editor options under the Utility menu. There is a width 

setting for displayed information and a width setting for printed reports.  

Since the displayed reports have no physical limitation on the total width available 

to show a report (printed pages can’t have scroll bars) the default width may not 

always show the full information and the field will be cropped on the right. 

You can adjust this by double clicking the divider in the header caption row 

between two fields or simply click and drag the divider area to make the column 

larger or smaller. 

 

EzStamp will remember the width of a column even after you close the viewer 

window and use it for the next time you run the report. The widths are saved on a 

per report basis, meaning that you can use a different width for Denomination and 
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Color on different reports. The settings are saved under the Profiles\Settings folder 

in the EzStamp application path. 

You can also choose to hide columns from the report by using the Hide/Show 

buttons in the toolbar. Hidden columns will not appear in the data grid and will not 

be printed. The data is still present in the report – you can bring the fields back into 

view by clicking the icon to reshow all hidden columns. As with the column widths, 

the hidden status of the columns are also preserved when you close the viewer 

window. 

Image Preview Pane (F12) 

This option will toggle the image preview pane which appears to the left of the main 

data grid. Images will only appear if you have selected exactly one stamp record. 

If you are displaying a report with PNB, PNC, or FDC image link fields, you can 

preview one of those types of images by selecting the image link cell (only) in the 

data grid. 

A general preferences option defines the display format in the preview pane. This 

can be from 1 (primary image) to 4 (secondary/FDC images) images at the same 

time, in a vertical arrangement. 

You can resize the image pane by dragging the divider bar between the left side of 

the data grid and the right side of the image window. The new width will be saved 

after the report viewer window is closed. 

Comments Preview Pane (Ctrl + F12) 

This option will toggle the comments preview pane which appears below the data 

grid. Comments will only appear if you have selected exactly one stamp record and 

the record contains comments. By default a Comments report will show this pane 

when the viewer starts. For all other report types, the initial visibility is based on if 

the images were displayed at the time you closed the viewer window. 

Comments fields in the main data grid can only show a limited amount of text 

information. The remainder can be displayed using either the comments pane or 

the Comments option under the Summary menu. The latter choice provides full 

editing capability. 

You can resize the height of the comments pane by dragging the divider bar 

between the bottom of the data grid and the top of the comments window. This 

height will be saved when you close the viewer window. 
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Creating Snapshot Files (Ctrl + S) 

A snapshot file is a read-only capture of the report data grid. This file can be 

exchanged with other EzStamp users or recalled at any time to view the contents of 

the report. 

When you create a snapshot, you will be asked for the name of the file and a 

description. Once entered the file will be saved to the Snapshots folder where 

EzStamp is installed. 

To view a snapshot file, use the Snapshot Viewer under the Extras menu, or the 

standalone Snapshot Viewer application, available from the SoftPro Web site. 

Report Merges 

EzStamp provides powerful searching capabilities to drill down into the data for a 

country file. However, you may want to combine the search results from different 

reports to make unique “hybrid” report types.  

Report merging doesn’t involve the fields displayed in the report viewer, but rather 

the underlying set of stamp records which populate the data grid. When merging 

reports, the stamp record data is combined together to generate a new set of 

stamp records and will be displayed using the profile of the current report in the 

viewer. You can for example, combine a Power Search and PNC Data Search into a 

single Power PNC Data Search. 

The first step in merging reports is to create an export of a report to combine with 

a second report. There is no limit to the number of combines you want to make. 

However, you have to export each previous report to combine with one which 

follows. If you want to use the results of a power search to filter the results of a 

PNC Data search report, then you would perform the following steps: 

• Run a Power Search and display in the report viewer. 

• Choose Export this Report from the Report Merge submenu. 

• Run a PNC Data Search report and display it in the report viewer. 

• Choose one of the merge options under the Report Merge submenu. 

Add Scott/Alternate catalog ID numbers are combined to make a new report 

with the unique records from each individual report. Duplicate entries 

are not created.  

Subtract Subtracts all stamp records from the current report which match on the 

same Scott/Alternate catalog ID numbers from the previous report. 

Combine Takes all Scott/Alternate catalog ID numbers from both the previous 

and current reports and discards any records which are not common to 

BOTH reports. 
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Report Viewer Image Cache (Ctrl + Shift + C) 

If Image Caching is enabled in the EzStamp general preferences, then small 

thumbnail images of the stamp records are cached to files for faster navigation of 

the report. Image caches are only used for reports where the field profile contains 

one or more stamp image links. 

A general preference option allows EzStamp to auto-clear the cache when the 

application is closed down. If this option is disabled, then the cache files will remain 

within the EzStamp installation path until they are cleared. 

The preferences window provides a Clear Cache option. The report viewer has a 

similar option to perform the same task. You should consider clearing the cache if 

you change the cell size for images in the report viewer, as the cached images will 

be scaled to the previous cell size before you changed it to a new size. 

Bookmarks Menu 

Creating Bookmarks (Ctrl + B) 

Bookmarks are used to tag specific stamp records in the viewer. The record # 

column on the left side of the data grid will be highlighted (default color is red) to 

show which records are bookmarked. There are many options in the report viewer 

which make use of selections and bookmarks according to the table below. 

Viewer Option Selected Records Bookmarked Records 

eLook™ Yes  

Quick Inventory Yes Yes 

Remove from Inventory Yes Yes 

Pricing Lock Yes Yes 

Pricing Unlock Yes Yes 

Rapid PWL Entry Yes Yes 

Rapid PSL Entry Yes Yes 

Add to Bookmarks Yes  

Remove from Bookmarks Yes  

Save Navigation List  Yes 

Hide Report Rows Yes Yes 

Export to AlbumGen  Yes 

Creating a Snapshot  Yes 

Assign to Stamp List  Yes 



EzStamp Reference – Version 8.0 

Page | 266 
 

Viewer Option Selected Records Bookmarked Records 

Show as Thumbnails  Yes 

 

To add to the current bookmark list choose the Add Selection option under the 

Bookmarks menu. You can also click on the add bookmark icon. Right clicking this 

icon will add all records to the bookmark list, as will right clicking on the clear 

bookmarks icon. 

When creating selections in the viewer, hold down the SHIFT key to select ranges of 

records. Hold down the CTRL key to select individual records without affecting the 

current selection. 

Removing Bookmarks (Ctrl + Del) 

Use the Remove or Clear options to remove selected records or all records from 

the bookmark list. The Invert option can be used to mark all records which are not 

bookmarked and unmark all records which are bookmarked. 

Saving to a Navigation List (Ctrl + N) 

The Assign option in the Options menu will apply the bookmark list to the main 

Navigation List in EzStamp, replacing the current active list, if present. The Save 

option under the Bookmarks menu however will allow you to save the list to a file of 

your choosing. Provide a description and file name, and this will be saved to the 

Lists folder in the EzStamp application path, under a subfolder with the name of the 

current country file. 

Exporting to AlbumGen (Ctrl + G) 

This option will send the current bookmark list to AlbumGen if you have that 

application installed. You can then use the Multi Import option from AlbumGen to 

create album pages. Refer to your AlbumGen documentation for additional 

information on multi-import from EzStamp. 
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Edit Menu 

Rapid Multi Entry (Ctrl + M) 

This option will add selected or bookmarks records to your inventory. Even if 

records are already in your inventory, they can still be updated using the RME 

option. 

 

The left side of this window contains the available grades for the current country file 

with an associate quantity field for each grade. If you check a grade, the quantity 

will be set to 1 for you. 

Use the Grade Select button to check multiple grades using the standard grade 

group selection window. 

The Custom Fields button will display a window allowing you to add custom field 

values to the selected/bookmarked records in the report viewer. 

The Previous button will recall the RME settings from the previous run of rapid 

entry you performed. 

The Clear button will uncheck all grades in the grade list. Clear All will erase the 

contents of all fields in the RME window. 
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The two radio buttons for Pre-Supplied and My Values determines how the Mint, 

Used, and FDC values will be applied to the records. If pre-supplied is checked, 

then the FDC, Mint and Used values will ONLY be applied IF there is NO existing 

pre-supplied value for the Scott number. 

If the My Values option is checked, then the FDC, Mint and Used values are always 

applied to the records, even if there is pre-supplied pricing present. 

The Method drop down list at the top determines how any selected/bookmarked 

records which are already inventoried will be affected by the RME operation. 

Do Not 

Update 

Inventoried records will not be updated by the RME. 

Replace Replace grade and data information for existing inventoried records. 

Add Any grades which are already inventoried will be added to whatever 

grades are being applied from the RME operation to create net sum 

totals on those grades. 

Re-grade This option allows you to correct existing grade entries in inventoried 

records by replacing an existing grade with a different one, while 

keeping all other grade attributes intact. See the next section for more 

information. Choosing this option will close the RME dialog window. 

Replace 

or 

Remove 

New Feature added with the 2020-DEC-13 Patch 

This option affects only the inventoried grades, regardless of how 

many grades you select in the checklist group on the left. Ensure you 

select any or all grades to be affected by this option first. 

 

The only attributes for grade records which can be updated by this 

option are within the Individual Grade Information group. 

 

By default, any option you enter within this group will replace the 

current value for matching stamp records and the associated grade 

records. If you leave the attribute empty, no action is performed, 

unless you check one of the Remove checkbox options. In this case, 

any existing value for the associated attribute will be removed 

completely from the grade record. The Remove option is not applicable 

for any of the other 4 RME methods. 
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Buy and Sell Dates/Prices can be attached to the records if you provide dates 

and prices in the input fields. Use the … buttons to use the Date Picker popup 

window. The Notes field will attach the text you enter in that field to each grade. 

The NH Percent field can be used to set/override the Never-Hinged percentage on 

the records. 

The Location, Comments and X-Ref fields can be used to apply the same text 

values to each record. Note that there is a separate attribute field for the locations 

associated with individual grade records (this option was added in the 2020-DEC-13 

patch). 

Click the Begin button to start the Rapid Multi Entry process. When completed, the 

affected records will automatically be updated in the report viewer. 

Re-Grade Using Search and Replace (Ctrl + Shift + G) 

Selected/bookmarked records will be searched for a specific grade and replaced 

with a different grade. This allows you to fix grade entries which were entered 

incorrectly. When choosing this option, a simple search and replace dialog window 

will be shown. 

 

Select the search grade, which is the one you want to change from. Select a 

replacement grade, which is the one you want to change to. 

Only inventoried stamps are affected. You will not be able to change to the 

replacement grade if the stamp already has that grade assigned to your inventory. 

In this case, no replacement will be applied at all. 

Quick Add to Inventory (Ctrl + I) 

Selected/bookmarked records will be added to your inventory. This is the same as 

selecting each record in the main EzStamp window and clicking the blue check mark 

icon to save to inventory. If the record is already inventoried, no action will be 

taken. 
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Remove from Inventory (Ctrl + Shift + I) 

Selected/bookmarked records will be removed from your inventory. Note: If you 

remove a custom variety, or the country file is custom without pre-supplied values, 

the records will be permanently deleted and not recoverable. If the record has pre-

supplied data, removing it from your inventory will reset the record back to a pre-

supplied status. 

Removing Grades from Inventory (No Shortcut) 

This option can be used to remove one or more grades from inventoried records. All 

information associated with the selected grades will be removed, including: 

• Quantity 

• Custom Grade Prices 

• Grade Purchase and Sell Dates/Prices 

• Grade Comments 

• Grade Location 

Care should be taken when using this feature, as you won't be able to recover the 

inventoried information on the removed grades without a backup. This option is 

primarily intended to undo erroneous additions of grades using the Rapid Multi 

Entry (RME) utility. 

 

Choose one or more grades to remove, or use the Grade Select button to use the 

convenient grade picker dialog to set the checkmarks.  

The option below the grade list determines if the stamp record should be removed 

from your inventory once the selected grades are removed. This option will not be 

applied to any stamp records if user customizations among the list below are 

present for the stamp record: 
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• Custom field values 

• Other inventoried grades 

• FDC Cachet records 

• PNB records which are not pre-supplied by SoftPro 

• PNC records which are not pre-supplied by SoftPro 

• Pre-supplied PNC/PNB records containing user comments, purchase/sell 

information, or quantities. 

• Any custom stamp variety which is not pre-supplied by SoftPro 

Note: This option is disabled for custom countries without pre-supplied stamp 

records. 

Once you click remove, grades will be removed from selected/bookmarked records 

which are inventoried. 

Quick Edit Options for Stamp Information 

Each of the quick edit options shown in the table below will present you with a 

spreadsheet editor, much like the report viewer itself. This is the same editor you 

will see when using the quick edit options from the main EzStamp menu. When you 

save changes from the editor, the report view will update automatically to account 

for these changes. 

Quick Editor Shortcut Description 

Grades Quick Edit Ctrl + F1 Edit inventoried grades. 

FDC Quick Edit Ctrl + F2 Edit FDC Cachet data. 

PNC Quick Edit Ctrl + F3 Edit plate number coil data. 

PNB Quick Edit Ctrl + F4 Edit plate number block data. 

PWL Quick Edit Ctrl + F5 Edit the priority want list. 

PSL Quick Edit Ctrl + F6 Edit the priority sell list. 

 

Price Locking (Ctrl + F7) and Unlocking (Ctrl + F8) 

You can lock pricing from being overwritten by EzStamp supplied data updates 

directly from the report viewer, using either the current record selection in the 

viewer or the active bookmark list. Once a record is price locked the padlock icon 

will appear in the status bar. Use the unlock option to remove the lock status. 

Rapid PWL (Ctrl + F9) and PSL (Ctrl + F10) Options 

The rapid entry modes for the priority want and sell lists are used to quickly add (or 

remove) records based on the current selection or bookmark list in the report 

viewer. As these entry dialog windows are basically the same presentation format, 

the PWL dialog window will be used as a reference. 
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The choices you make in this dialog will be applied to all selected (or bookmarked) 

stamp records in the data grid. You can specify the quantity and type to buy (or 

sell). There is no requirement to enter a type or check off a grade. In this case, the 

stamp record is entered into the list as a generic status of “any grade, no type 

specified”. 

Use the Grade Select button to select grades from the pre-defined grade group 

lists. Click on No Grades to uncheck all grades in the checkbox list. 

The 4 buttons above the grade buttons provide the choices on how to update the 

PWL or PSL. 

Add to PWL Add the grades selected to the existing PWL/PSL grades 

currently in the list under the stamp record’s Scott/Alternate 

catalog ID number. If no grades are selected, the record will 

be added to the PWL/PSL if not already present. 

Replace Grades Remove any grades from the PWL/PSL on the stamp record 

which are NOT selected in the checkbox list and add any 

grades which ARE in the checkbox list. If the stamp record is 

not currently in the PWL/PSL, it will be added. 

Remove Grades Remove only selected grades in the checkbox list without 

removing other grades currently in the PWL/PSL. This option 

will NOT remove the stamp record from the PWL/PSL. 

Remove PWL Remove the stamp record from the PWL/PSL and any grades 
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which may be present for this record (complete removal). 

View Menu 

Sorting the Report Data (Ctrl +1, Ctrl +2, Ctrl + 3) 

Most report columns can be sorted in the viewer when using the Spreadsheet (full 

edit capable) view mode. The Data Browse (read only) view mode allows for rapid 

sorting on any column.  

Columns which can’t be sorted on include any belonging to data groups (FDC 

Cachet fields, PNC Data fields, etc.). For these latter field types, the sort order is 

dictated by settings in the report profile and can’t be changed on the fly when 

clicking the column headers in the report viewer data grid. 

To sort on a specific column in the data grid, select any cell in that column and click 

on the sort icon. A single click will sort ascending order, and a second click will sort 

in descending order. Right click the icon to reset the sort order to the default report 

profile order (which is generally by Scott number in pre-supplied profiles). 

You can also click on any column’s header label at the top of the data grid without 

selecting any columns to sort. Use the Ctrl + 2 shortcut key to quickly set a 

descending sort order without the need to click icons or headers 2 times. 

Hiding Columns (Ctrl + H) 

The report viewer allows you to remove columns from the data grid, hiding them 

from both the on-screen display and also from printed reports. The data is still 

present in the report, it’s just not visible. Select one or more columns in the data 

grid and click on the hide columns icon. 

Auto-hiding Columns (Ctrl + Alt + H) 

Some of the more detailed reports can show many columns of information in the 

data grid, such as detailed grade reports. These report types can contain many 

columns which may not have any attribute (zero quantity/value or blank text) for 

the entire set of stamp records in the report. The auto hide option is convenient in 

that it will hide all columns from the report which contain no data. 

Note: When using the auto-hide feature, you choose to hide columns which are 

based on absence of data for a specific set of stamp records. Using this same report 

for a different group of stamp records can result in hidden columns which can 

actually contain information. Always check the bottom left corner of the status bar 

for the hidden columns icon. If you see it there, it means you are hiding columns in 

the report. The hidden status will remain even after you close the viewer window 

and these same columns will be hidden the next time you run the same report. 
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Un-hiding Columns (Ctrl + Shift + H) 

Use this option to restore all hidden columns to the data grid. This affects the 

current report profile only. Hidden status is tied to the actual RPT files containing 

the profile settings, not to the report or search options in the main EzStamp menu. 

Removing Rows (Ctrl + R) 

This option can be used to create a smaller report data grid without exiting the 

viewer. Row removal does NOT remove records from your inventory or the country 

file. It simply discards them in the data grid of the report. Unlike hiding columns of 

data, the rows can’t be recovered in the report once removed – you would have to 

re-run the same report to get those rows back. 

eLook™ Search (Ctrl + E) 

This option is the same as the one accessible from the main EzStamp menu. 

However, you can select up to 10 stamp records at one time, and this will be 

passed to the eLook™ dialog window as a stamp group to search on. 

Finding Data (Ctrl + F, F3, Shift + F3, Ctrl + Shift + F) 

The find option is a simple text string matching feature allowing you to search 

across all rows and columns in the data grid for any stamp attribute which matches 

on the text. The match is always a partial text match; if the text value of a stamp 

attribute contains the text string you entered for the find, then the match is 

satisfied. 

 

Check the Case-sensitive option to force upper and lower case letters to match 

exactly. 

Check the Selected Columns option to restrict the search to data contained only in 

those columns. 

Use the 4 special character buttons to enter those characters into the text value 

string at the current cursor position. 



EzStamp Reference – Version 8.0 

Page | 275 
 

Click on Clear Find to remove any existing find status in the report viewer window. 

If you don’t enter any text value and click OK, then the find status is also cleared. 

Once you start a search, the data grid will be checked to find cells containing your 

search text. Every matching cell will be highlighted (default color yellow) to indicate 

a match status. In addition, the record # tab on the left (default color blue) will 

indicate at least one matching cell for that row in the data grid. The viewer will 

automatically scroll the grid to the first matching cell. 

Use the Find Next and Find Previous options to step forwards and backwards 

through all matching cells in the data grid. Once again, the grid will automatically 

scroll to keep the matching cell in view. 

The Find button in the toolbar provides all the functionality of the separate menu 

options: 

• Click to start a new find. 

• SHIFT + Click to clear the find status. 

• Right Click to step forwards. 

• CTRL + Right Click to step backwards. 

Resetting Column Widths (Ctrl + W) 

Each report profile (RPT file stored under the Profiles folder in the EzStamp 

application path) can have an associated Settings file stored in the Profiles\Settings 

subfolder. When using report profiles for the first time, there will be no settings file 

in this subfolder. As you run reports in EzStamp, these settings files are created or 

updated when the report viewer window closes. 

The settings file only contains 2 types of information: 

• The hidden column status of the data grid. 

• The width of each field displayed on screen in the data grid. 

When a report profile is first used against any type of search or report, the viewer 

will assign a default column width to each field shown in the data grid, based on 

settings in the Master Report Fields configuration (you can alter the default field 

settings using the Field Editors in the Utilities menu). 

You can drag the divider bars between the data grid’s column headers to resize 

columns on the report. The widths will be saved to the settings file when you close 

the viewer.  

If for any reason you need to force a report profile back to default widths, choose 

the reset option under the View menu. Deleting the RST file from the Settings 

folder will accomplish the same thing, and also un-hide hidden columns. 
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Summary Menu 

Supplied Data (Alt + F1) 

This option displays a window which shows you differences between pre-supplied 

field data and the current inventoried data for a selected stamp record. If the 

country file is custom, or the record itself is a custom variety with no pre-supplied 

data, the second tab in the window will not appear. 

 

The first tab shows the inventoried value of pre-supplied fields. The second is the 

original pre-supplied data. EzStamp maintains a read-only copy of pre-supplied 

fields which can’t be altered. You are free to override any of them in your 

inventoried record. If a value is different, you will see the field displayed with an 

alternate background color, as in the Denomination and Color field above. 

You can restore one or more pre-supplied fields to their original values by clicking 

inside a field’s text box and clicking on the Restore Current button, the field label 

to the left of the text box, or by pressing F5. 

You can restore the entire collection of field values by clicking the Restore All 

button. 
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Your Data (Alt + F2) 

This option shows all of the basic stamp details which are not part of the pre-

supplied data. 

 

This includes the 4 alternate catalog ID values, location, cross-reference, category, 

comments, and pricing lock status. 

If the stamp record is custom variety, then the Main Number Variety checkbox will 

be enabled, allowing you to switch the record between main and sub-variety status. 

Custom Fields (Alt + F3) 

This option shows a window containing all of the custom fields you attached to the 

country file. If you have no custom fields created, this option will be disabled. 

Special Information (Alt + F4) 

This option is identical the one in the main EzStamp window. If the special 

information icon is enabled in the report viewer toolbar, you can view special pre-

supplied notes and stamp specifications for the Scott number. 

Images (Alt + F5) 

This option will show the Image Links editor. 
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Comments (Alt + F6) 

This option displays a sizeable comments dialog window, which can be used to view 

and edit your comments attached to the stamp record. 

Show/Hide Differences from Supplied (Alt + F7) 

This menu option toggles special cell coloring on the data grid to indicate which pre-

supplied fields have data values which are different in the inventoried data 

compared to what has been supplied by SoftPro. 

Show/Hide All Data Rows (Alt + F8) 

This menu option toggles display of hidden PNC, Grades, PNB and FDC Cachet data 

rows. When you run a report for any of these 4 types of stamp information, the 

report will not include data rows for any Grades, Plate Numbers, or FDC Numbers 

assigned to the stamp record which didn’t match on the input conditions which were 

used to create the report (i.e. for FDC Cachet reports, the input condition is named 

Exclude Non-Matching FDC numbers). If you exclude non-matching rows, they will 

not appear on the report. You can however use this option to display those rows 

which were originally hidden. 

Help Menu 

Topic Help (F1) 

This option provides context-sensitive help for the report viewer. 

Preferences (F2) 

This option provides access to the EzStamp general preferences window. 

View Report Title (Ctrl + T) 

The title bar of the report viewer will attempt to show all of the input conditions 

which were used to generate the data for the report. For complex searches with 

many input conditions, the information will not fit the title bar. You can use this 

option to show a popup window with all of the search input values listed. 

Other Report Viewer Features 

Right click on the data grid for a popup menu with many of the choices from the 

primary viewer menu. 

If you add images to a field list for a custom profile, you can click the image cell to 

highlight it, then hold down SHIFT and click again to popup an image preview 

window. 

If you hold down SHIFT while clicking in a selected comments field cell, it will bring 

up the comments viewer/editor window. 
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Double click any cell in a stamp record to show the associated record in the main 

EzStamp window. 
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Custom Report Editor 

Reports and Profiles Overview 

Searches and reports in EzStamp rely on a profile of settings which contain the 

basic information for a report to be displayed and/or sent to the printer: 

Style The presentation style for a report, such as fit-to-page or multi-page 

print formats. 

Filters Settings which alter how data is presented in both the report viewer 

data grid and on the printed page. 

Fields The set of columns which make up the report. Fields can be single 

values, value pairs, or groups of related subfields. 

Ordering The primary sort order for the report and secondary sort order for 

field data groups. 

Printer 

Settings 

A set of basic printing attributes (paper size, orientation, margins, 

etc.). 

Titles & 

Subtitles 

The header and footer areas of each printed page contain margins, 

into which the titles and subtitles will be printed. There are up to 6 

title areas and 6 subtitle areas for general report attributes. 

Print 

Attributes 

Option which specifically affect the printed pages only and have no 

effect on displayed stamp records in the report viewer.  

Fonts & 

Colors 

Every area of a printed page (headers, footers, grid headers, total 

lines and data cells) have an associated font and text color which you 

can change. 

Background 

Colors 

For cells contained within the data grids which are printed, special 

background colors can be added for easier readability. 

 

All of this information is self-contained into a single file called a Report Profile, 

which has an extension of .RPT and can be found in the EzStamp installation path 

under the Profiles folder. Profiles have automatic backup capabilities to allow for 

one level of Undo if you are not happy with your customizations and wish to change 

back to the previous settings. This is why there is a subfolder underneath the 

profiles folder named Backup.  

Profiles are also divided among the primary files for general searches and reports, 

plus a small set for Grand Totals reports. Although they share a common RPT file 

extension and use the same editor to make changes to the profile settings, they are 

not compatible with each other, and as such are stored in separate folders within 

EzStamp. 
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Profiles are further divided into Supplied and Custom file types. There are a few key 

differences between them, despite the fact that they share a common folder 

location within EzStamp: 

• Supplied profiles can’t have their field lists modified – you will not be able to 

add, remove, or reorder the fields for these profiles. If you need to alter a 

field list for a supplied profile, you will need to make a copy and save it as a 

custom profile. 

• Supplied profiles are defined for each search and report menu item within the 

main EzStamp Search and Reports menus. These profiles are specifically 

prefixed with the text of “Default” to denote a pre-supplied stock profile. You 

will not be able to rename the RPT files or the description text. 

• The backup copies of supplied profiles are read only, and can’t be modified. 

This is to ensure that if you have any issues with a supplied profile, you can 

easily restore from the pre-supplied backup copy. 

• Supplied profiles are segregated from custom profiles in the editor, using a 

pair of drop down lists. 

• Custom profiles are the only ones allowed for profile switching in any search 

or report window where a profile swap is allowed. A pre-supplied profile can 

only be used for the corresponding search/report menu item where it has 

specifically been assigned to work from. 

• Custom profiles can have fields assigned to them which only exist for a 

specific country file (i.e. you have created a custom field and assigned it to 

the field list of a custom report). For these types of profiles, they will not be 

useable if they are attached to any search or report for another country file 

which doesn’t have that field defined – an error will be displayed when you 

attempt to run the report stating that the field can’t be found in the country 

file. 

• Custom profiles can contain fields referencing custom grade definitions. 

• Pre-Supplied profiles can have more than one profile per report/search dialog 

dropdown list, with the “Default” report always appearing at the top, and any 

alternate pre-supplied reports appearing beneath the default, followed by any 

custom report profiles. 

Report Type Designations 

Any profile can be set to appear only in a specific search or report dialog dropdown 

list (this filtering was added with the March 2019 Release of EzStamp). A custom 

report by default will appear in every dropdown list. If you wanted a report to only 

appear under Quick Stats 1, then you can change type report type designation at 

any time from “Everywhere” to “Quick Stats 1”. 
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Using the Report Editor 

There are 2 menu options under Reports for running the editor. The Grand Totals 

Profile editor is available all the time. The standard Report Profile Editor is only 

available when a country file is open. This is due to the fact that field list editing 

requires an active country file to be able to access any custom fields attached to 

the profile which are part of the country. 

The editor window is organized exactly as described in the overview section, broken 

into several tabs.  

Before working with a report profile, you will need to choose one from either the 

Supplied Profile or Custom Profile drop down lists. If you don’t choose a profile in 

either list, you will be editing an undefined blank template filled with default profile 

settings. If you attempt to save such a profile, you will be asked to provide a name 

and description for it before the save can occur. 

Report Editor Attributes 

Each tab in the editor will be shown with an associate summary table below it to 

describe the various options assigned to the tab. The title bar of the editor will 

always show the file name and description for the current profile selected. 

General Setup 
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Supplied 

Profile 

This list will contain all of the pre-supplied report profiles which are 

assigned to the menu items under Search and Reports. 

Custom 

Profile 

This list will contain all custom report profiles, which you have 

created and which may also be supplied by SoftPro.  

Report 

Style 

There are 4 choices for the report style: 

Screen Only The report can only be used for the report viewer 
window. This option should only be chosen to 

create ad-hoc custom profiles which don’t require 
all of the printer settings to be configured, as the 

report can’t be sent to the printer. When you 
choose this type, all tabs except the first 2 in the 
editor window will disappear. 

Fit to Page This type of report will attempt to fill the page 
width with all of the fields in the field list. If the 
fields will not fit onto the width of a single page of 
paper, you will not be able to print the report. 

Multi Page This is the default type for pre-supplied profiles 
which ensures that the report can be printed by 
spanning the fields across multiple pages. 

Staggered The staggered report is useful for creating 
condensed reports which make maximum use of 

the available area on each printed page. This is 
useful for saving paper for very large reports. The 

fields in the stamp record are staggered left to 
right then top down within a single page width, 

created a row-column block of cells per stamp 
record. 

 

Column 

Repeats 

The leftmost fields in the field list can be replicated onto each page 

which spans all the pages of a multi-page format report. The default 

value of zero means no fields will replicate across pages (unless 

Scott field repetition is used, see below). If you put a value of 3 in 

this setting for example, then the first 3 fields in the field list will 

appear on each page which spans the width of the report. 

Header 

Rotation 

For reports with fields which contain many narrow fields (such as 

grade price or quantity details), the header labels can be significantly 

wider than the data values in the grid. This can result in wasted 

paper and the chance that a report defined as fit-to-page won’t fit 

the paper width. Header rotation can print the label text at 90 

degree angles to the data cells, allowing for a more condensed 

report, at the expense of some vertical paper space to contain the 

header area of the grid. 

Justification The data grid can be justified to align to the left margin, center 
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within the margins, or fill the paper width. For the last option, the 

grid cells will proportionally be resized to ensure that the grid will 

have its edges flush with the left and right margins. 

Rotation 

Alignment 

When using 90 or 270 degree header rotation, you can choose if the 

vertical alignment of the text is flush with the top or bottom of the 

cell containing the header label. 

Data Group 

Repeat 

The three choices here determine how the field list is replicated 

across the pages of a multi-page report. If the Scott number choice 

is used, then this field appears on each page, even if the column 

repeat option is set to 0. For the Repeat on Regular fields option, the 

column repeat value defines how many of the leftmost fields in the 

field list will appear on each page. This value is not applicable for 

staggered or fit-to-page reports. 

Comments 

Span Page 

Width 

The comments field can contain up to 4,000 characters of data. As 

such, how this field is presented in a report can determine how many 

pages of paper are needed to print it. By using the spanning option, 

the comments will appear below all other fields in the grid, as a 

single cell of data, exactly the width of the page, and as tall as 

needed to show all the text. 

 

You should NOT enable this option for any report profile which has 

the comments field in the field list, or you will be showing the same 

information twice. 

Yes/No 

Text Values 

EzStamp is currently provided as an English-only distribution. 

However, all of the text which appears on the printed report can be 

customized by editing the Master Fields configuration to suit any 

language. Since there are fields defined in the this list which are 

classified as Yes/No data types, you can choose to use other text 

values in place of the default “Yes” and “No” strings. 

Header 

Long Name 

Format 

Check this option to print header labels using the long format text. If 

you want to conserve paper, use the short formats of the labels. 

Both the long and short names can be customized in the Master 

Fields configuration. 

Hiding “No” 

Values 

Check this option to suppress the “No” text for Yes/No field types on 

the report. 

Suppress 

Zero Values 

Check this option to suppress currency and quantity fields on the 

report if they have no value assigned to them (i.e. $0.00 and 0). 

VF Supplied 

Calculations 

Check this option to enforce net value calculations for grades which 

will be based on the Very Fine Mint price alone. 
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Report Fields  

 

This tab doesn’t really provide field editing capabilities. To edit the field list, click on 

the Edit Fields button to run the field profile editor. The Total Fields label indicates 

primary field totals only. Any primary field which is based on a data group with 

subfields can in turn contain many additional report fields. 

Data Group Sort Order 

Any profile where you have assigned one of the 4 types of data groups (fields which 

contain multiple subfields) for Grades, FDC Cachet, PNC, or PNB data can be 

assigned a secondary sort order, independent of the primary field sort order. 

Clicking any of the 4 buttons will bring up the sort options window as shown below. 
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The drop down list will contain the field which will act as the secondary sort for all 

the rows of data within the report. For example, if you have a PNC record with 14 

plate numbers, you can choose to sort on PNC Net Value descending order for the 

14 data rows which will appear under a single Scott/Alternate catalog number. 

The sort will be applied even if the field itself is not part of the report profile. 

Click on the Reset button to apply the default sort order for the data group. 

Field Profile Editor 

Click the Edit Fields button to run the field profile editor.  

 

The editor window is organized into the following sections: 

• A menu bar across the top contains all editor options. 

• The toolbar contains short cut icons for frequently used editing options. 

• The left side list contains the available report fields which can be assigned to 

the profile. 

• The right side list contains the current fields assigned to the report. As you 

add more fields, the left side list will shrink and the right side list will grow. 
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• The small scrolling grid at the bottom is the current field list preview pane. It 

provides a visual cue of the complete set of primary and subfields which will 

be part of the report. 

• The status bar at the bottom is used to display help hint messages. 

Toolbar Options 

 

1 Use the left arrow to remove fields from the report (move from the right 

list to the left). 

Use the right arrow to assign fields to the report (move from the left list to 

the right). 

NOTE: As a shortcut, you can simply right click the selected fields in either 

list to move them to the opposite list. You can also double-click individual 

fields to assign or remove them. 

2 Undo all field edit changes since you started the editor. 

3 Erase all fields in the report. You will not be able to remove the Scott 

number field. 

4 The up and down arrows move selected fields in the assigned (right) list 

within the list. The top-down ordering of fields in the editor is the actual 

left-to-right ordering on displayed and printed reports. 

5 Click this icon to change the primary report sort order. 

6 This icon saves all changes to the field list. This does NOT save the report 

profile changes (The field list is only one part of the overall profile). You 

must click Save from the report editor window to save changes to the 

report file. 

7 Click this icon to cancel all changes made to the field list. 

8 You can export and import field lists for use with other report profiles. 

9 These icons access the data group editors for the following: 

• Grades and Values (Horizontal field presentation of grade data) 

• Inventoried Grades (Vertical presentation of grade data) 

• FDC Cachet data (vertical presentation) 

• PNC data (vertical presentation) 

• PNB data (vertical presentation) 

• PWL data (vertical presentation) 

• PSL data (vertical presentation) 

The vertical format implies that these data groups contain multiple data 
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rows for a single stamp record, and as such will be displayed top down in a 

vertical format, using as many rows on the report as there are rows of data 

in the stamp record. 

 

Exporting and Importing Field Lists 

Use the export option to save the field list configuration to a file. The files are saved 

with an RFC extension. You can import a field list into another report profile, 

provided that any custom fields in the list are also present in the current country 

file. The editor will also reject an import file if it references a custom grade 

definition not defined in the current country. 

Setting the Field Preview Format 

Use the Field Preview option (Ctrl + N) in the Edit menu to change the way the 

preview pane at the bottom displays the field configuration. Short names will 

substitute the shorter labels for the fields and swap the field sample text with field 

position numbers. 

Setting a Primary Sort Order 

Choose this option from the Edit menu to bring up the field sort dialog window. 

 

You can sort the report data using up to 5 fields, each of which can be in ascending 

(A to Z) or descending (Z to A) order. Check option for Z to A on each field to 

reverse the sort order. 
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The sort field is limited to a specific set of primary stamp attributes and can be 

extended to use custom fields which you can attach to the stamp record. You can’t 

choose attributes which are considered secondary data within EzStamp (Priority 

Want and Sell Lists, FDC Cachet Data, PNB or PNC data, and inventoried grades). 

Field Data Groups 

There are 7 data groups which can be assigned to a report profile field list. You can 

assign one or more of these groups to the report, after which you should configure 

how the subfields are organized for the group. 

Six of these groups are defined under the Data Groups menu. These groups always 

show their data vertically in the report: 

• Grades 

• FDC Cachet Data 

• PNC Data 

• PNB Data 

• PWL Data 

• PSL Data 

You will find the data group fields at the very bottom of the available field list, 

below any custom fields which will appear below the regular stamp fields. 

 

Once you assign any of the fields with the (Data Group) tag to the right side list, 

you can access the data group editor by choosing the menu option or clicking on 

the appropriate icon in the toolbar. 
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The data group editor looks remarkably similar to the field profile editor. The 2 lists 

represent subfields which belong to the group. The left side list contains the 

available subfields, and the right side list contains the assigned fields. The menu 

and icon options are identical in behavior to the ones in the field list editor. 

Inventoried Grade Values/Quantities 

The 7th data group is slightly different than the other 6, as this one is specifically 

designed for horizontal presentation of inventoried grade data using combinations 

of quantity and currency value types. 

Once you assign the Inventoried Grade Values/Quantities field to the right side list, 

you can choose the menu option under Inventoried Grades, or click on the G+V 

icon. 
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This editor involves creation of custom subfields based on combinations of quantity 

and currency values assigned to each subfield. The editing of grade subfields for 

this type of data group is perhaps the most complex option in EzStamp to work 

with, yet it is also the reason why the report profiles can appear completely 

different from each other by using just a single data group field in the profile. 

• The + and – icons are used to add and remove subfields from the list. The 

ED icon is used to change the subfield configuration after it’s already been 

added to the list. 

• The clear icon will erase all subfields in the group. 

• The undo icon reverses all changes made since you started editing the group. 

• The up and down arrows move selected subfields up and down within the list. 

• The save icon will commit all subfield changes for the group to the profile. 

These changes will not be saved until you commit the field profile 

configuration and then save the profile from the main profile edit window. 

• The cancel icon will discard all changes you made and close the editor. 

• The DG icon will create a default set of subfields to work with. This option in 

itself can be tricky to understand so will be described in the next section. 

The list itself shows the display name for on-screen labels and the report viewer, 

the short and long names for header labels on printed reports, the display format 

for the data and the grades which are used to build the net sum for quantity and 

currency values. 
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Creating a Default Subfield List 

The easiest way to work with a new grade data group is to create a generic set of 

subfields and then edit the list after the fact. Click the DG icon to show the 

following window. 

 

The list in the middle contains one or more replication types. You build this list by 

selecting a single replicate type from the drop down list and clicking the Add 

button.  

To remove a replication type from the list, select one or more entries and click the 

Remove button. 

Each grade defined for the current country will be assigned into the subfield list 

(any current subfields will be erased). There will be one subfield for each replication 

type. In the example shown, assuming the first 4 grades are MH-VG, MH-F, MF-VF 

and MH-XF, the first 12 subfields will be: 

1 Quantity for MH-VG  

2 Market Value for MH-VG 

3 Net Value for MH-VG 

4 Quantity for MH-F 

5 Market Value for MH-F 

6 Net Value for MH-F 

7 Quantity for MH-VF  

8 Market Value for MH-VF 

9 Net Value for MH-VF 
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10 Quantity for MH-XF  

11 Market Value for MH-XF 

12 Net Value for MH-XF 

 

If there are 21 grades defined for the country, the total number of subfields created 

would be 21 * 3 = 63. 

Adding and Editing Subfields 

A single subfield is added using a simple dialog window, which is also used for 

editing existing fields (Note: the term Grade Group is how EzStamp defines a 

subfield for inventoried grade data groups): 

 

The subfield is referred to as a grade group, since the value of the data is based on 

a combination of one or more grades, as shown in the current grades list on the 

right. When you group up multiple grades, the sum total of the corresponding 

value(s) shown in the Format drop down list will be shown on the report. 

In this example, a Mint Very Fine subfield is created using the Hinged and Never 

Hinged very fine grades. The format is defined as Grade Quantity + Net Value, 

which is a split cell format on the report (see below for format types). When 

showing the report data, the grade quantity for both grades will be added together 

and displayed. 

Use the Select Grades button to choose which grades will be used to define the 

group for the subfield. 
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Grade Group Format Types 

The following formats are available to display on reports for inventoried grade data. 

Grade Quantity + Grade Value The grade quantity will appear together with the 

grade value (user custom value or market value) 

in one cell, with the quantity on the left and the 

currency value on the right. 

Grade Quantity + Net Value The grade quantity will appear together with the 

net value in one cell. 

Stamp Quantity + Grade Value The stamp quantity (grade quantity * stamps per 

grade) will appear with the grade value in one 

cell. 

Stamp Quantity + Net Value The stamp quantity will appear with the net value 

in one cell. 

Grade Quantity The grade quantity will appear in the cell. 

Stamp Quantity The grade quantity * stamps per grade will 

appear in the cell. 

Grade Value The grade value (user custom value if provided, 

market value if not) will appear in the cell. 

Net Value The grade value * quantity will appear in the cell. 

Purchase Price The purchase price will appear in the cell. 

Sell Price The sell price will appear in the cell. 

Purchase Date The purchase date will appear in the cell. 

Sell Date The sell date will appear in the cell. 

Net Profit The net profit (sell price – purchase price) will 

appear in the cell. If adjusted net profit is in 

effect (EzStamp general preference) then net 

profit is zero unless a sell price is present. 

Market Value The supplied price (if the grade is not derived 

from another grade with a base price), or the 

calculated price (based on a derived grade) of the 

grade will appear in the cell. For custom countries 

and grades without pre-supplied prices, the 

market value is always zero. 

Supplied Mint Price The pre-supplied mint price is displayed. 

Supplied Used Price The pre-supplied used price is displayed. 

Supplied PB Mint Price The pre-supplied plate block mint price is 
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displayed. 

Supplied PB Used Price The pre-supplied plate block used price is 

displayed. 

Supplied Mint Sheet Price The pre-supplied mint sheet price is displayed. 

Supplied FDC Price The pre-supplied FDC price is displayed. 

Supplied LP Mint Price The pre-supplied line pair mint price is displayed. 

Supplied LP Used Price The pre-supplied line pair used price is displayed. 

 

Copying Subfield Formats 

If you select a single subfield, you can duplicate the display format to all other 

subfields in the list, using the Copy Selected Format option. 

Printer Setup 

 

The printer setup tab allows you to set specific printer settings for this profile. Much 

like the EzStamp general printer settings, the default settings are based on the 

following: 

• Your default Windows printer. 

• Default paper size. 

• Left and right margins of ½ inch. 
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• Top and bottom margins of 1 inch. 

• Landscape orientation. 

You can change these settings and they will be applied to the current report profile 

only.  

Note: If you don’t see any printers in the drop down list, use the Refresh Printers 

option in either the main EzStamp menu or from the general preferences window. 

EzStamp creates a printer list when application is first initialized. If you add or 

remove printers after EzStamp has been installed, you will need to refresh your 

printer list. 

Titles and Subtitles 
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A report has 6 title areas and 6 subtitle areas as follows: 

Left 
Margin 

Top Margin 

Right 
Margin 

Title 1 Title 2 Title 3 

Subtitle 1 Subtitle 2 Subtitle 3 

Data Grid 

Title 4 Title 5 Title 6 

Subtitle 4 Subtitle 5 Subtitle 6 

Bottom Margin 

 

The titles and subtitles are printed within the top and bottom margin areas of the 

page. If you decrease the size of these margins, you reduce the available space to 

print the text – always ensure there is sufficient space to print the titles and 

subtitles, unless you intend to create a report without any of the areas being used. 

Each of the 12 areas is defined by choices made in the appropriate drop down lists. 

You can choose from one of several attributes to place into a title or subtitle area. 

Nothing No attribute will be printed in the title/subtitle area. 

Report Title The text which appears in the Report Title text box. 

Report Sub Title The text which appears in the Report Subtitle text box. 

Date and Time The date and time based on the date and time format 

chosen from the 2 drop down lists. 

Page Numbers Page numbers, using the format chosen from the drop 

down list. 

Country Name The name of the country identity, for example any country 

derived from USA will be the text “USA”. 

Country Description The description as stored in the country file settings. 

Country File Name The file name as stored in the DB folder of the EzStamp 

application path. 

User Defined 1 Any text of your choice, which is entered in the 

corresponding text box in the dialog window. User Defined 2 

User Defined 3 

User Defined 4 
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Report Parameters EzStamp will attempt to output as much of the search input 

conditions as will fit without overwriting any other text in 

the report or running off the margin edges. This is the 

same text as appears in the title bar of the report viewer 

window, less the report title. 

EzStamp Signature For trial versions of EzStamp, a special copyright signature 

string is attached to the bottom left of all reports, and can’t 

be removed. You are free to add or remove this message 

as long as you have a registered copy of EzStamp. 

 

One last item on this tab is the date format for Data cells. Choose from this drop 

down list to enforce a specific format pattern on all dates in the report data grid. 

 

Print Attributes 
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This tab contains several options which control how each page will be formatted on 

the report. With the exception of the value format setting, all other attributes are 

for the printed pages only. 

Data Row Coloring If this option is enabled, the odd and even rows of the data 

grid will alternate background colors, much like the report 

viewer’s data grid. 

Row Band Gap This value, which is in inches, is the amount of white space 

to add between each row in the data grid. This gap value 

can be useful for staggered reports, as it will provide a 

clear division between the stamp records. 

Staggered Report 

Indent 

When used the staggered report style, this indent is 

applied to rows 2+ for each stamp record. For example, if a 

stamp record requires 3 physical rows on the page to print 

all the fields, an indent of 1 inch would be applied to the 

second and third rows to clearly show the starting row for 

each stamp record. 

Header and Footer 

Lines 

Check these options to draw a thin horizontal line across 

the page between the header/footer titles/subtitles and the 

data grid. 

Grid Line Type This option specifies the border style to use when drawing 

gridlines around the cells in the data grid. 

Grid, Header & 

Footer Line Thickness 

These drop down lists give you a choice of line thickness to 

use for the lines which separate titles, subtitles, and the 

data grid cells. 

Header/Footer Gaps These gaps provide a small amount of white space between 

text areas. The margin gaps are measure upwards from the 

top margin (header area) and downwards from the bottom 

margin (footer area). The title gap provides extra white 

space between titles and subtitles. 

Cell Indents The indent values provide a safe margin of white space 

within each cell of the data grid. The 2 values act as 

margins within each cell to keep the text from creeping into 

the grid lines which separate each cell’s data from one 

another. 

Grid Offsets Grid offsets of 0 and 0 will align the grid to fit within the 

page margins. A negative value will force the grid to 

expand into the margin areas, while a positive value will 

make the grid shrink within the margin areas. 



EzStamp Reference – Version 8.0 

Page | 301 
 

Vertical Alignment This option specifies how the text should vertically align 

with each cell of the data grid. 

Image Size The image width and height values allow you to set the 

size of all image fields on the report. Image dimensions 

must fall between ¼ and 4 inches in either direction. 

Image Quality This option controls the print quality of images. Bicubic 

options provide the highest quality output. 

Quantity & Value 

Format 

This text box contains arbitrary text which defines the 

default number of measurement characters to use for 

grades and values appearing as part of an inventoried 

grade data group. EzStamp will measure the width of this 

string to set the default column widths in the report viewer. 

This option is not used for printed reports.  

Pixel Size for Image 

Reduction 

When printing images, EzStamp can reduce the size and 

increase the printing performance of the reports by scaling 

down the images before sending them to the print spooler. 

This setting controls the maximum width or height of an 

image before it is scaled down. 

 

Fonts and Text Colors 
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This tab contains all of the font settings for printed reports. 

Header Rows Font The top row of the data grid containing the header labels 

for each column on the report. 

Data Rows Font The interior data cells representing the stamp information. 

Total Rows Font The bottom row(s) of the very last page of the report, for 

showing sum totals on columns which can be totaled. 

Title and Subtitle 

Fonts 

Each of the 6 titles and 6 subtitles can have unique font 

assignments. 

Font Scaling The 3 attributes in the upper right corner define how font 

sizes can be dynamically reduced for the data grid text if 

the information doesn’t fit within the cell. For multi-line or 

fixed width field types, scaling doesn’t apply, as the text 

will either wrap to multiple lines, or the cell width will auto-

size to fit the text. 

 

If font scaling is disabled, then text which doesn’t fit a cell 

will be truncated and denoted with the … ellipsis string. 

 

When font scaling is applied, EzStamp will attempt to 

reduce the font size by the adjustment value down to the 

minimum allowable point size you specify until the text fits. 

If the text still doesn’t fit, truncation will be used. 
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Changing Fonts 

For each font in the window, you can click the ellipsis buttons to display the font 

picker dialog. 

 

The easiest way to set a new font is to click on the Font button and use the 

standard Windows font selection dialog window. This will populate the font name, 

width, height, bold and italic attributes. The color can be changed by clicking on the 

color swatch in the above window. 

The 3 labels at the top display character samples in the current font chosen. 

The Copy button can be used to duplicate the current font settings to other report 

fonts without having to individually adjust each report font for the same values. 
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Background Colors 

 

This tab contains the background colors for the printed reports. The Transparent 

buttons to the right of each color swatch are used to set a background color to 

transparent. This will be indicated with the text of “None” on the swatch. 

Header Rows Color Applied to the background of the top row of the data grid 

containing the column header labels. 

Odd Rows Color Applied to rows 1, 3, 5, etc. of the data grid cells. 

Even Rows Color Applied to rows 2, 4, 5, etc. of the data grid cells. 

Totals Rows Colors The bottom row(s) of the very last page of the report, for 

showing sum totals on columns which can be totaled. 

Banding Gap Color If you set a banding gap (the space between each row of 

stamp records in the data grid), then this will be color of 

the spacing band. 

Grid Line Color The color for the grid lines surrounding the data cells, and 

also the color for the header and footer grid lines. 

Image Background 

Color 

When printing images, this color will fill up the empty space 

within the cell where the stamp image itself isn’t 

occupying. 
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Using Save and Save As 

The Save button is used to save all changes from all the various editors within the 

report editing tool (fields editor, data group editors and all the attributes within the 

tabs of the main editor window). If you attempt to close the editor without saving 

changes, you will be given a warning and a chance to back out. 

The Save As button will create a copy of the current profile under a new name and 

description of your choice. New reports are always saved as custom format – you 

can’t save new reports as supplied format. 

Click on Delete to remove the current report profile. You will not be able to delete 

supplied profiles. Once a profile is deleted, it can’t be recovered except from a 

backup. If the report you deleted was assigned to any report or search in EzStamp, 

you will have to choose a different profile when you run that search or report. 

The Change button is used to change the description, name and report type 

designation for a profile. You will not be able to change the name or description if 

they are already in use by an existing profile. Pre-supplied reports are not allowed 

to be changed at all. The report type designation is used to filter out custom 

profiles from appearing in search or report dialog window profile dropdown lists 

where you don’t wish them to appear. The current report type designation is 

displayed as the “Assigned To” item in the General Setup tab. 

The Restore button will undo the previous report profile edit changes by taking the 

profile from the backup folder and replacing the current copy. When you save 

changes to any report profile, the current file is saved to the backup folder. There is 

only one level of undo, as there is only one backup of any report profile. 

Note: Supplied profile backups are read only, so a restoration of a supplied file will 

restore the profile back to the original pre-supplied state. 

The restoration screen provides a list of all RPT files stored in the EzStamp Profiles 

folder. Simply select one or more profiles from the list and click on the Restore 

button. 

The Reset button will apply default settings to the current report profile. 
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The Copy button provides a powerful method to clone one or more attributes from 

the current profile to any (or all) other profile in your installation of EzStamp. 

 

Select which attributes to copy from the checklist options in the upper half of the 

window. Use the Clear or All buttons to clear or check all of the options in one 

step. 

The checkbox list at the bottom contains the current set of report profiles (custom 

and supplied). Use the No Profiles and All Profiles buttons to clear or check all of 

these profiles in one step. The All Custom button will check every custom report 

and leave all the supplied profiles unchecked. 

Click on Copy to clone the selected attributes across to the selected report profiles. 

If you made any mistakes or wish to undo this, you must immediately choose the 

Restore option and restore every profile you changed. Otherwise, you will need to 

restore the profiles from a backup. 
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Utilities 

Report Fields Configuration 

There are 2 report field editors under the Utility menu: 

• Standard Reports contain all the fields which can be included in any search 

or report in EzStamp which uses a report profile for a country file. Custom 

fields are not part of this list and are maintained on a per country basis, 

using a separate editor. 

• Grand Totals Reports contain fields specifically for use in a grand totals 

report (horizontal and vertical formats). Unlike standard report fields, a 

grand totals report works with all country files collectively, and the fields are 

primarily focused on net quantity and value totals. 

Standard Report Fields 

There are more than 200 report fields available which can be used in your report 

profiles. The following table categorizes the fields based on primary and secondary 

stamp information, and special net totals fields. 

Primary Stamp Details 

Scott Number Alternate Catalog Numbers 

Year Issued Date of Issue 

Denomination and Color Watermark 

Perforation Notes 

Supplied Prices 

Mint Price Used Price 

Plate Block Mint Price Plate Block Used Price (not supplied now) 

Line Pair Mint Price Line Pair Used Price (not supplied now) 

Mint Sheet Price FDC Price 

Primary Attributes 

Never Hinged Percentage Plate Block Size 

Mint Sheet Size Quantity Issued 

Custom Variety Status Inventoried Status 

Price Lock Status Main Variety Status 

Supplied Modified Status Duplicate Sequence Number 

Date of Last Update  

Your Inventoried Details 

Category Location 

Cross Reference Comments 
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Image Links 

Primary Image Image 2 

Image 3 Image 4 

FDC Image  

Net Values 

Total Net value for FDC data Net value for VF-Hinged PNB data 

Net value for VF-Never-Hinged PNB data Net value for all PNB records 

Net Value for PNC Strip of 1 Net Value for PNC Strip of 3 

Net Value for PNC Strip of 5 Net Value for all PNC records 

Net value for FDC, PNC, PNB, and Grade Data Total purchase price for all FDC Cachet data 

Total purchase price for all inventoried grades Total purchase price for all PNB entries 

Total purchase price for all PNC entries Total sell price for all FDC Cachet data 

Total sell price for all inventoried grades Total sell price for all PNB entries 

Total sell price for all PNC entries  Total sell price for all PNC, PNB, FDC and grade 

data 

Total purchase  price for all PNC, PNB, FDC and 

grade data 

Net profit for all PNC, PNB, FDC and grade 

buy/sell prices 

Net profit for all inventoried FDC buy/sell prices Net profit for all inventoried grade buy/sell prices 

Net profit for all inventoried PNB buy/sell prices Net profit for all inventoried PNC buy/sell prices 

Net Quantities 

Total Item quantity for Grade data Total Item quantity for FDC cachet data 

Total item quantity for PNB VF-Hinged data Total item quantity for PNB VF-Never-Hinged data 

Total item quantity for all PNB data Total item quantity for PNC Strip of 1 data 

Total item quantity for PNC Strip of 3 data Total item quantity for PNC Strip of 5 data 

Total item quantity for all PNC data Total quantity to sell for all PSL records 

Total quantity to buy for all PWL records Total inventoried records for grade data 

Total inventoried records for FDC cachet data Total inventoried records for PNB data 

Total inventoried records for PNC data Total records added to the PSL for this stamp 

Total records added to the PWL for this stamp Total stamp Count for inventoried grades per 

stamp 

Inventoried Grades 

Grade Name Display Name 

Supplied Value Your Value 

Quantity Net Value 

Buy Date Buy Price 

Sell Date Sell Price 

Net Profit Stamps Per Grade (SPG) 

Stamp Qty Grade Comments 
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FDC Cachet Data 

FDC/Cachet # Day Issued 

FDC/Cachet Description FDC Maker 

FDC/Cachet Value FDC/Cachet Qty 

FDC/Cachet Net Worth FDC/Cachet Comments 

FDC/Cachet Buy Date FDC/Cachet Buy Price 

FDC/Cachet Sell Date FDC/Cachet Sell Price 

FDC Net Profit FDC Image Link 

Plate Number Coils 

PNC Plate # PNC Notes 

Strip of 5 Value Strip of 5 Quantity 

Strip of 5 Net Value Strip of 3 Value 

Strip of 3 Quantity Strip of 3 Net Value 

Strip of 1 Value Strip of 1 Quantity 

Strip of 1 Net Value PNC Net Qty 

PNC Net Worth PNC Comments 

Strip of 5 Buy Date Strip of 5 Buy Price 

Strip of 3 Buy Date Strip of 3 Buy Price 

Strip of 1 Buy Date Strip of 1 Buy Price 

Strip of 5 Sell Date Strip of 5 Sell Price 

Strip of 3 Sell Date Strip of 3 Sell Price 

Strip of 1 Sell Date Strip of 1 Sell Price 

PNC Net Buy Price PNC Net Sell Price 

Strip of 5 Net Profit Strip of 3 Net Profit 

Strip of 1  Net Profit PNC Net Profit 

PNC Image Link  

Plate Number Blocks 

PNB Plate Number PNB Notes 

VF-H Value VF-H Quantity 

VF-H Net Value VF-NH Value 

VF-NH Quantity VF-NH Net Value 

PNB Net Quantity PNB Net Worth 

PNB Comments PNB VF-H Buy Date 

PNB VF-H Buy Price PNB VF-NH Buy Date 

PNB VF-NH Buy Price PNB VF-H Sell Date 

PNB VF-H Sell Price PNB VF-NH Sell Date 

PNB VF-NH Sell Price PNB Net Buy Price 
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PNB Net Sell Price VF-H Net Profit 

VF-NH Net Profit PNB Net Profit 

PNB Image Link  

Priority Want and Sell Lists 

Grade Name Sell Quantity 

Type to Sell Buy Quantity 

Type to Buy  

 

Reports and Image Links 

An image link is a file name reference to a stamp image located on the original 

EzStamp supplied CD/DVD media, in the EzStamp Images folder of the application 

path, or in an alternate location you define. The 5 primary image links (images 1 to 

4 plus a special FDC image) can be represented on reports as either the image 

itself, or the file name reference. The secondary image links tied to FDC Cachet 

Numbers and PNC/PNB Plate Numbers can only be represented on reports as the 

file names. Primary images are named with the word “link” to denote the file name 

in a report. For example, “Image 1” is the image to display on the report, and 

“Image Link 1” is for the file name on the report. 

 

The report field editor allows you to change display and print attributes for the 

fields which appear in the report viewer and on printed reports. Some of these 
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fields can also appear in drop down lists and in various dialog windows, or as 

header labels within data grids. The following table summarizes what field 

attributes can be modified. 

Display Name This attribute is used in most dropdown lists within EzStamp 

windows, as header labels in data grids, and as general 

purpose labels. 

Short Name This label type can be used in data grid headers to shorten the 

width of the grid columns. A general preference option in 

EzStamp allows you to switch the data grid header labels from 

Display Name to Short Name. 

Print Short Name This attribute will populate a printed report’s header row if 

short print names are set at the profile level (short names can 

also be enabled globally across all reports using an EzStamp 

preference option). 

Print Long Name This attribute defines the label text on printed reports when 

long labels are in effect. Note that you can rotate the labels on 

printed reports 90 or 270 degrees to allow for shorter column 

widths. 

Alignment This attributes determines if the fields should be left, center or 

right justified within the cell area of a report. 

Displayable 

Characters 

For a field which can have a variable number of characters 

(such as Denomination and Color), EzStamp allows you to 

define the default number of characters to set for the column 

width in the report viewer. 

This is just a default for every report profile. Once you resize a 

field within the report viewer, the new size gets locked in and 

saved to a configuration file on a per profile basis. 

This attribute is not used for printed reports and will not be 

allowed for any field which is defined as fixed width (such and 

currency and quantity fields). 

Print Width The default width of the field for printed reports only, 

measured in inches. Fixed width fields will not allow for this 

setting, as those field types are auto-sized on the printed 

report to “just fit” within the cell. 

Display Mask This attribute is specifically used for the report viewer (not 

printed reports) to define a default “nominal” size for fixed 

width fields. Printed reports will auto-size as needed. Columns 

in the report viewer will set a default size for fixed width fields 
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based on the text value defined in the display mask. 

The mask doesn’t require any special format – it’s just a 

collection of arbitrary characters which makes up a default 

text value. You can use strings such as “Abcdef”, “9,999-99” 

or “123xYz” for any field mask. EzStamp will simply measure 

the on-screen width of this text value and use that to set the 

cell’s column width in the report viewer. 

Once you resize columns in the report viewer, the new widths 

are saved individually on a per-report basis. 

 

Field Types 

The fields are grouped according to primary and secondary types: 

Primary Fields Main stamp details and inventoried attributes. 

Grade Data Inventoried grade information. 

FDC Cachet The FDC cachet records which appear in the FDC tab of the main 

EzStamp window. 

PNC Data The plate number coil records which appear in the PNC tab of the 

main EzStamp window. 

PNB Data The plate number block records which appear in the PNB tab of 

the main EzStamp window. 

PWL/PSL Data The priority want and sell list fields. 

 

Custom fields are not defined in this list. Refer to the custom fields edit utility for 

more information. 

Data Types and Attribute Restrictions 

A field has a base data type and a report data type. The base data type can be one 

of the following: 

• A general purpose text field. 

• A Yes/No status field. 

• An image (image is displayed/printed) or image link (file name is 

displayed/printed). 

• A currency field. 

• A numeric value which can include fractions. 

• A whole number value which can’t have fractions. 

• A date field (which can’t include a time component). 
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The field is further classified by EzStamp with a print attribute used for printed 

reports only, which can be one of the following: 

Fixed Width: The field will never be truncated or resized on a printed report. This 

type is reserved for dates, currency and quantity fields. 

Multiline: The text information will not be truncated or resized, but will instead 

wrap around to multiple lines on printed reports, causing the data row to grow 

taller. 

Truncated: The text information will always occupy one line of text on the report. 

However, if the text value doesn’t fit within the cell width, it will be resized (the font 

size will shrink as needed), and if it still doesn’t fit, it will be truncated on the right 

and marked as such using the ellipsis (…) notation. 

Image: The cell is defined to contain an image, and as such will be sized based on 

the cell image size in the EzStamp general preferences. 

Most of the fields are fixed width types. The following table shows which fields are 

defined as multi-line and truncated. 

Multiline Truncated 

FDC/Cachet Comments FDC/Cachet # 

FDC/Cachet Description Display Name 

FDC Maker Category 

Grade Comments FDC Image Link 

Special Information Image Link 1 

Comments Image Link 2 

Denom. & Color Image Link 3 

Notes Image Link 4 

Date of Issue PNB Plate Number 

Watermark PNC Plate # 

Location Type to Sell 

Perforation Type to Buy 
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X-Reference  

PNB Notes  

PNB Comments  

PNC Notes  

PNC Comments  

 

When editing the display mask, print width, or number of characters attributes in 

the editor, the ability to do so is based on the field’s print attribute type. 

• The Display Mask can be changed for Fixed Width field types. 

• The Display Characters and Print Width can be changed for Truncated and 

Multi-line field types. 

Editing Field Data 

To change settings for a field, move the cell cursor to the field you want to change 

and press F2 (or start typing with any valid character). Press ENTER to save the 

new cell value, or ESC to cancel the change. 

You will not be able to edit any read-only cell in the grid – this will be indicated 

using a different text and background color. 

Undo and Revert 

Use the Undo option to restore all field settings back to the original values before 

you made any changes. Use the Revert option to restore all fields back to pre-

supplied values. EzStamp maintains a read-only copy of all field settings to allow 

for a full restoration. 

Revert and Supplied Data Updates 

If SoftPro makes any changes to the read-only copy of the report fields from a 

supplied data update, they will NOT be applied to your copy of the configuration. 

You will need to use the Revert option to see the changes. The only exception to 

this is when SoftPro adds new report fields in the future – these will automatically 

show up in your configuration. 

Any changes between current and pre-supplied data field values will be shown in 

the data grid with different cell coloring. When reverting back to pre-supplied data, 

you can choose to revert some or all of the attributes, and also choose if you only 

want to revert on the current selected row. 
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Copy and Paste 

You can use the Copy and Paste options in the Edit menu to copy the contents of 

one cell to another. 

Setting a Global Currency Mask 

Use this option in the Edit menu to change the mask value for all currency fields. 

Note: There is no similar option for quantity fields, as they have variable sizes – 

use the Copy and Paste options to quickly change a quantity mask for multiple 

fields. 

Grand Totals Field Editor 

This editor is identical to the standard report field editor. The only difference is that 

the field list is based on the grand totals reports only. There are separate menu 

choices for the vertical and horizontal report formats, as these reports use different 

choices for which fields are available. 

List Editors 

EzStamp maintains lists of text values for the following: 

• FDC Makers 

• Categories 

• Priority Want/Sell List Types 

• Purchased (Buy) From 

• Sold To 

• Locations 

• Cross References 

The first 5 lists are shared among all country files. The latter 2 maintain lists at the 

country file level. The editor is accessed from the List Editor options under the 

Utility menu. 



EzStamp Reference – Version 8.0 

Page | 316 
 

 

The title bar will indicate the list type. The menu and toolbar provide the basic 

functions to manipulate the list of items. 

The list itself is very simple. Each line is a single item in the list. The background 

color determines if an item is pre-supplied by SoftPro (grey in the screen example), 

or is a custom entry you created either from within the editor or when inventorying 

a stamp record (white in the screen example). 

The bottom field contains the text for the current selected item in the list. You can 

change an existing item by simply entering new text in the bottom field. Adding a 

new item is just as simple. Enter some text at the bottom and click the + icon. You 

can remove one or more items from the list by selecting them in the grid and 

clicking the - icon. 

Toolbar Options 

 

1. Add the text in the bottom input field as a new entry in the list. If the item 

already exists, you will be given a warning message, as EzStamp doesn’t 

allow duplicate items in a list. Note, list items are automatically sorted 
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alphabetically when saved. 

2. Remove selected items from the list. If you remove items, in most cases 

you can get them back, provided: 

a. They are a pre-supplied list item from SoftPro. 

b. The item is currently used in one or more inventoried stamp records. 

In any other case, once you save changes to the list after removing items, 

you will not be able to get them back (lists can be saved as part of an 

EzStamp data backup, or by using the export option). 

3. The current selected list item will be updated with the text in the bottom 

input field. If no items are selected, or more than 1 item is selected, this 

option has no effect. 

4/5. The import and export icons provide the ability to store lists as external 

files. Lists can only be exported in the .LST list file format. Importing lists 

can also accept .TXT text files, as long as the file is formatted as one text 

item per line, without tab characters. 

6. This option will erase all items in the list. 

7. This option is only enabled if you have a country file currently opened. 

EzStamp has the ability to check all stamp records to see if any list items 

exist which may have been deleted. For example, if you refresh FDC Makers 

from the country file, every FDC Cachet record will be checked for all 

stamps, and if the FDC Maker isn’t currently in the list, it will be added. 

8. Changes to the list are not saved until you click this icon. EzStamp 

maintains an original list and the current list with all your changes pending. 

Once you choose save, all changes will be saved to the EzStamp master file 

or the country file (depending on the list type). 

9. Click this icon to cancel all changes and restore the list to what it was before 

you started making changes. The editor will then be closed. 

 

Reverting to a Supplied List 

This option is available in the Options menu, and allows you to restore the current 

list to pre-supplied entries. All of your custom entries will be left intact, and only 

pre-supplied values are replaced with the original backup data. This option is 

available for FDC Makers, Categories and PWL/PSL type lists. 

Text List Imports 

When importing from .TXT files, the current list will be left intact. All new text 

additions will be attached to the end of this list. Any duplicate items will 

automatically be ignored in the .TXT file. 
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7 

Search and Replace 

This option allows you to perform a search against all stamp records in the current 

country file and replace values as needed. The search functionality is split into 3 

separate windows: 

• The search window, which provides the input conditions to find stamp 

records. It works much the same as a single level Power Search. 

• The results window, which is a simple data grid showing matching records in 

a manner similar to the Stamp List viewer. 

• The replacement window, which allows you to replace existing values with 

new ones. 

Search Window 

 

The search window is displayed when you choose the Search and Replace option 

from the Utility menu. Note: Only inventoried records can be searched upon. 

Search Category Similar to the Power Search, the following categories are 

available: 

• Primary Stamp Fields 

• Custom Fields 

• Inventoried Grades 

• Plate Number Blocks 

• Plate Number Coils 

• FDC Cachet Data 

• Priority Want List 

• Priority Sell List 
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When you choose a category, the Search Field will be 

populated for all valid fields associated with the category. 

Unlike a Power Search, you can’t choose multiple fields to 

search on at one time – only 1 field can be selected for a given 

search. 

Search Field Only replaceable fields will be shown in this drop down list 

based on the search category. Any fields which are read-only 

can’t be part of a search and replace. 

Search Method This method defines how to compare the search values you 

enter to the field contents in the stamp record. 

Search From/For If you have entered a search method which requires a 

matching value, this field is displayed and expects you to enter 

something. 

Search To If you have chosen the Between search method, then you must 

provide a start and end value to search against. 

Case-Sensitive For text fields, this option is available to force all text 

comparisons to distinguish between upper and lower case 

letters. 

 

Click on Search to begin. EzStamp will look at every record for a matching 

condition. The total record match count will be shown in the status bar. If at least 

one match is found, you can click on the Show button to display the matching 

records. 
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Results Window 

 

This window can be dragged around and resized independently from the main 

EzStamp window. You can continue to work within the main window while the 

search results are displayed. You can close the search results window at any time. 

The records displayed contain only the matching record key and the matching value 

as follows: 

• The Scott number is always the first column. 

• The current alternate catalog ID number is always the second column. 

• If the search category was for secondary stamp information (PWL, PSL, FDC, 

PNB or PNC data), the secondary key reference value (Grade, Plate Number 

or FDC Number) will always be shown as the third column. For custom fields 

and primary stamp fields, this column is not displayed. 

• The last column always contains the search field and the record’s current 

value. 

For secondary stamp information, it’s possible the results window will show several 

records for the same Scott number. For example, if 7 plate numbers for Scott 

#1891 all matched, then 7 rows will be shown in the data grid. Duplicate records 

can also show up in the results, as the screen example shows. 

The toolbar at the bottom of the window contains the options you can apply to the 

search results. 
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1. Perform a replacement on selected rows only. 

2. Perform a replacement against all rows in the data grid. 

3. Select all rows in the data grid. 

4. Select nothing (deselect all rows in the data grid). 

 

Replacement Window 

 

This window provides a replacement method and a replacement value. 

The original search value is displayed in the Search Value field. If the search 

method didn’t require a search value (i.e. a Not Empty search method), then this 

field will be blank. 

The replacement method can be one of the following. Depending on the search 

value and the data type, not all of these options will be available. 

• Replace all occurrences of the search value with the replacement value (text 

fields only, and only if the search method is of type: Contains, Starts With, 

Ends With, or Equals. 

• Insert the replacement value before the current field value (text fields only). 

• Append the replacement value after the current field value (text fields only). 

• Replace the entire field with the replacement value. 

The Do not confirm replacements option, if unchecked, will provide a confirmation 

every time you click the Replace button. It will NOT prompt you for every 
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replacement on a per record basis. If you have selected 12 records to replace from 

the results data grid, you will only be asked to confirm one time. 

Once changes are made, the original values in the search list will be updated to 

show new values. Keep in mind that when a value changes, the original value is 

lost, and this means that the replace all occurrences drop down option will no 

longer match on the original value, since it’s been changed. 
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Grade Configuration Editor 

EzStamp associates a standard grade list with any given country. Most pre-supplied 

country files will contain the same basic list, summarized below. 

Grade Name Description Derived From Base Price 

MH-VG Mint Hinged - Very Good MH-VF Mint 

MH-F Mint Hinged - Fine MH-VF Mint 

MH-VF Mint Hinged - Very Fine  Mint 

MH-XF Mint Hinged - Extra Fine MH-VF Mint 

MNH-VG Mint Never Hinged - Very Good MNH-VF Mint 

MNH-F Mint Never Hinged - Fine MNH-VF Mint 

MNH-VF Mint Never Hinged - Very Fine  Mint 

MNH-XF Mint Never Hinged - Extra Fine MNH-VF Mint 

USED-VG Used - Very Good USED-VF Used 

USED-F Used - Fine USED-VF Used 

USED-VF Used - Very Fine  Used 

USED-XF Used - Extra Fine USED-VF Used 

PB-UL Plate Block - Upper Left - Mint  PB Mint 

PB-UR Plate Block - Upper Right - Mint  PB Mint 

PB-LL Plate Block - Lower Left - Mint  PB Mint 

PB-LR Plate Block - Lower Right - Mint  PB Mint 

PB-UL-USED Plate Block - Upper Left - Used  PB Used 

PB-UR-USED Plate Block - Upper Right - Used  PB Used 

PB-LL-USED Plate Block - Lower Left - Used  PB Used 

PB-LR-USED Plate Block - Lower Right - Used  PB Used 

MINT-SHEET Mint Sheet  Mint Sheet 

FDC First Day Cover  FDC 

COVER Covers  No base price 

MINT-LP Mint Line Pair  LP Mint 

USED-LP Used Line Pair  LP Used 

 

Grades values have a base supplied price (with the exception of Covers), and can 

be derived from another grade, in which case its value is calculated using one or 

more multipliers to arrive at the market value. 
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The grades editor can be accessed from the Grades Configuration Editor from 

the Utility menu. 

 

The data grid shows the attributes associated with each grade, which is 

summarized in the following table. 

Type This column contains an icon to indicate a supplied (S) or user (U) 

grade. User grades are ones which you create. 

Grade Name The short or abbreviated name for a grade. 

Description The description for the grade. 

Print Short The short version of a grade name used in the header labels for 

printed reports. 

Print Long The long version of a grade name used in the header labels for 

printed reports. 

Multiplier The auto-calculation multiplier for a grade which is derived from 

another grade, expressed as a percentage. For example, MH-XF is 

derived from MH-VF, and its market value is based on 125% of the 

mint hinged very fine value. 
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Derived If a grade is derived from the base price of another grade, this 

column will indicate the source grade. Currently only mint and used 

prices have derived grades. 

Source If a grade isn’t derived, then it will likely have a supplied base price 

as its source. With the exception of Covers, all pre-supplied grades 

have a base price. This column shows the abbreviated base price 

name. 

NH Grade This status column indicates if a grade is considered to be Never 

Hinged in terms of price calculations. 

NH Ratio This ratio percentage, along with the NH percentage for the Scott 

number associated with the stamp record, is used to modify the 

market value for any grade defined as never hinged. 

Stamps The number of physical stamps which are assigned to the grade. 

For example, plate blocks use 4 stamps per grade. 

Visible The visibility status is used to turn off grades which you don’t want 

to appear in EzStamp. The grade information is still saved in the 

country file, but they will not be present in reports or the main 

EzStamp window. 

 

Toolbar Options 

 

1. Add a new custom grade. 

2. Remove custom grades. You can’t remove a pre-supplied grade, or remove a 

custom grade if you have inventoried stamp records which are using that 

grade. 

3. Edit the selected grade. 

4. Move the selected grades up or down in the list. 

5. Save all changes and close the editor. 

6. Cancel all changes and close the editor. 

7. Undo all changes. 

8. Export and import grade files. 
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Adding Custom Grades 

You can extend the pre-supplied grade list using custom entries. When adding new 

grades, you will be provided with a dialog window for entering the required grade 

attributes. 

 

Check the Copy Grade Name option if you want to use the same value for the 

print short/long fields as you enter it to the Grade Name field. Grade names can’t 

be duplicated, and should be short abbreviations (EzStamp allows up to 32 

characters for a grade name, but they should be as short as possible as they will be 

used for report header labels). 

Your custom grade can be Derived From any other grade, even a custom grade. If 

you derive from another grade, the price source drop down list is disabled, as the 

price is based on the grade you derive from. 

The Price Source can be set to any of the 8 current pre-supplied base price types, 

or you can set the price source to nothing. If you don’t use a base price, then the 

only way to attach a value to your inventory is to set custom values on a per-grade 

basis for each stamp record. 

The Apply NH Grade option is only available if the grade is not derived and is 

based on a price which can have NH surcharges applied to it, such as Mint grades. 

Check the Visible option to ensure your grade is visible in EzStamp. 

The Multiplier is used to adjust the market value. It’s intended to be used for 

grades which are derived from another grade. A value of 100 is a one-to-one price 

calculation – the value is not modified. Any value over 100 is a price increase; any 

value under 100 is a price reduction. 
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The NH Ratio option is only enabled when the NH Grade option is also enabled and 

checked. This is an additional multiplier used to adjust never hinged grade prices. 

Stamps per Grade defines the physical count of stamps for the grade. 

Editing Existing Grades 

Select any grade and click on the edit icon in the toolbar. The dialog window is 

identical to the one used for adding grades. You can also double click any row in the 

data grid to bring up the edit window. You will not be able to change the names for 

pre-supplied grades. 

Grade Ordering 

The order in which the grades are displayed in the editor window is defined to be 

the Default Grade Order, which is how they would be displayed in the main 

EzStamp window. You can change the default order by selecting grades and moving 

them using the up/down arrows in the toolbar. Hold down CTRL while clicking to 

move the selection to the start or end of the list. 

Exporting Grades 

If you wish to use custom grade configurations in other country files, or maintain a 

backup copy of your configuration, use the export option. This will save the grade 

definitions to a file with a .GRD extension. You can import grade files provide that 

this will not result in removal of custom grades which are already being used by 

inventoried records. 

Reverting to Pre-Supplied Status 

EzStamp maintains a read-only backup copy of the grade configuration in the 

country file. You can restore the grade list to the original pre-supplied state by 

choosing the Revert option from the Options menu. 

Selected Grade Changes 

There are a few options under the Edit menu to allow making changes to all the 

selected grades at one time.  

• Grade visibility. 

• Auto calculation multiplier. 

• NH Ratio. 
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Custom Fields Editor 

Custom fields are provided to allow you to extend the basic information provided 

for stamp records. By default no custom fields are provided for any pre-supplied 

country. You create custom fields using the Custom Fields Editor under the Utility 

menu, or you can automatically generate them from any import from prior versions 

of EzStamp which have the 64-bit Export capability. The custom fields created from 

older EzStamp imports will automatically generate the same fields and data types 

from the older version, and preserve all your custom data for the stamp records 

you exported. 

 

The custom fields editor works similar to the grade configuration editor, with the 

same toolbar options. A custom field is defined with the following attributes. Many 

of these attributes are common to the report field master list. 

Field Name The field as it will uniquely be identified in EzStamp.  

Data Type The type of data, which can be any of the following: 

• Plain text, in mixed case format 

• Upper case text 

• Whole numbers without fractions (i.e. quantities) 

• Currency 

• Numeric with fractions 
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• Date (without the time component) 

• Yes/No status 

• Image link (file path + file name format) 

• Web URL (or any type of document) 

• Category (allows for multiple categories per stamp) 

Display 

Name 

The name as it will appear on screen and in reports. 

Short Print 

Name 

The short format of the field as it will appear in header labels on 

printed reports. 

Long Print 

Name 

An alternate long format for the printed name. 

Alignment How the field value is justified on reports: Left, Centered, or Right. 

Print Type Fixed width, truncated, or multi-line using automatic word 

wrapping. Not all print types are available for a given data type. 

Visible If a field is not visible, it won’t appear in reports or in the custom 

fields edit windows. 

Totals The field will show a grand total at the bottom of the report by 

adding all the row values for the field together. Test fields cannot 

be totaled. 

Copy The field will automatically have its inventoried value copied to the 

next non-inventoried pre-supplied record when stepping through a 

country file. 

Searchable The field is available in Power Search and other dialog windows 

where custom fields can be used in country file searches. 

Reportable The field is available to add to a custom report profile. 

Display 

Chars 

For a data type which is not a fixed width print type, you can enter 

the number of characters to define a default display width for the 

column. 

Print Width This is the default print width for multi-line and truncated print 

types, measured in inches. 

Display Mask For a data type which is a fixed width print type, you can enter any 

arbitrary set of characters to create the “default width” for the 

report viewer columns. This value is not used for printed reports. 
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Toolbar Options 

 

1. Add a new custom field. 

2. Remove custom fields. You can’t remove a field if you have any inventoried 

stamp records which are using it. 

3. Edit the selected field. 

4. Move the selected fields up or down in the list. 

5. Save all changes and close the editor. 

6. Cancel all changes and close the editor. 

7. Undo all changes. 

8. Export and import custom field files. 

 

Web URL and Image Link Types 

Image links for custom fields can reference any valid image file in any location. As 

such, an image link is stored with a full path name along with the file name. 

Web URL data types are primarily intended to reference a Web site. However, you 

can set a URL data type to point to any type of file as well. 

Adding and Editing Custom Fields 

Click on the + icon to add a new custom field. 



EzStamp Reference – Version 8.0 

Page | 331 
 

 

This window provides all of the attributes to define a custom field. Depending on 

the data type and print method chosen, some of the other options will automatically 

be disabled. 

To edit an existing custom field, select it and click on the edit icon, or double click 

the row in the data grid. The edit window is identical to one use to add new fields. 

Field Ordering 

The order in which the fields are displayed in the editor window is how they will 

appear in EzStamp in any window which displays them (custom fields secondary 

window, dropdown lists, etc.). You can change the field order by selecting rows in 

the editor and moving them using the up/down arrows in the toolbar. Hold down 

the CTRL key while clicking to move the selection to the start or end of the list. 

Exporting Custom Fields 

If you wish to use custom field configurations in other country files, or maintain a 

backup copy of your configuration, use the export option. This will save the fields to 

a file with a .CFF extension. You can NOT import custom fields if you currently have 

an existing custom field configuration with active inventoried data. 

Renaming In-Use Fields 

If a field already has inventoried data associated with it, you can’t rename it using 

the normal edit dialog window. EzStamp stores the field name with each data value 

in the individual stamp records. To rename a field which is in use, use the special 
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option named Rename a Field with Data. EzStamp will individually adjust each 

stamp record to use the new name. 

Deleting In-Use Fields 

If you want to delete a custom field, EzStamp will not allow you to do so using the 

remove field icon if any inventoried records have data on that field. You can use the 

special option named Delete Fields & Data to remove the custom field, and also 

any data values from all stamp records for that field. 
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Custom Country Editor 

EzStamp has an internal country list with more than 500 entries. When you create 

a custom country file, you can select from one of the pre-supplied country names, 

or choose to create a completely new country reference. Any country file name 

which is not recognized by EzStamp as a pre-supplied value will automatically be 

stored in a separate area reserved for Custom Countries.  

An editor is provided under the Utility menu. Use this editor to review or make 

changes to any custom country. 

 

The editor has no provision to add new custom countries, as this is handled 

automatically from the New Country option in EzStamp. What you can do is change 

the settings for an existing country, or delete the country record entirely. EzStamp 

will not allow you to remove a country which is already in use.  

The edit option allows you to change any of the following attributes: 

Data Directory 

Name 

This is the name under which all images are associated, and 

also uniquely identifies the country. You will not be able to use 

any data directory name which is already reserved for pre-

supplied countries. 

Upper Case Name The upper case version of the country name. 
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Mixed Case Name The mixed case version of the country name. 

Flag/Image File This drop down list contains all flag images stored in a special 

folder in EzStamp. 

eBay Category The category which will be used to initiate an eLook™ eBay 

search. 

Stamp Wants 

Category 

The category which will be used to initiate an eLook™ Stamp 

Wants search. 

 

Removing Custom Countries 

When creating a new custom country using the New option from the File menu, 

EzStamp will automatically add the country name to the current Custom Country 

list, which is maintained separately from the pre-supplied list. As long as you have 

at least one country file (.SDF file in the DB folder) active in EzStamp, you can’t use 

the minus (-) icon to remove the custom country – it’s in use. As long as the 

country name is in use by at least one country SDF file, you can’t remove it.  

If you want to remove a custom country from the list, you must use the Remove 

Country option in the Country Data File Utilities submenu and remove every 

SDF file associated with the custom country name. 

Custom Flag Images 

Flag images are created using 2 sizes: 

• Small flags are 80 pixels wide by 50 pixels tall. 

• Large flags are 176 pixels wide by 110 pixels tall. 

The pre-supplied images are in Windows RLE Bitmap (.BMP) format, using 256 

colors. 

Images are stored in the Images folder in the EzStamp application path. A 

subfolder named ~~Flags\Small contains the small image files, and the 

~~Flags\Large contains the large image files. 

If you want to use a custom flag image for your custom countries, then you will 

need to create 2 image files in the proper sizes, and manually copy them into the 2 

subfolders. Once you do this, they will become available in the drop down list. You 

are not permitted to use the same file names as existing pre-supplied flag images.  
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User Data Copy Filter 

A feature in previous versions of EzStamp allowed you to copy over inventoried 

data attributes from the current inventoried record to the next available pre-

supplied non-inventoried record, as you step through the country file. This option is 

still available in version 8, but is turned off by default. To enable the data copy 

filter, choose this option from the Utility menu. 

 

There are 8 filters for inventoried data, plus special copy settings for your custom 

fields. At the bottom of the window is an on/off switch for enabling all of these 

options.  

If you un-check Enable Selected Options, then all user copy functionality is 

disabled, regardless of the other checked states – the options are all grayed out. 

• For Grade options, all inventoried grades and their associated attributes will 

be copied from the previous inventoried stamp record to the next available 

pre-supplied stamp record which is not inventoried. 

• For PNB and PNC data, only inventoried plate numbers are copied. 

• For FDC Cachet data, all FDC numbers will be copied. 

• The custom fields copy option can be used as an on/off switch, using the first 

2 radio buttons. The bottom radio button, if chosen, will only copy custom 

field data for fields which are defined to be User Data Copy Enabled. Refer to 

the documentation for the custom fields editor. 
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Image File Copy 

When you install EzStamp, the image files are not copied to your hard disk 

installation path. As such, you will need to keep the CD/DVD/BD disc in your drive 

to view the images. 

If you want to copy the image files to your hard disk, you can use the Image File 

Copy option from the Utility menu. 

 

If you have a country file currently open, it will be displayed in the title bar and the 

radio button option Copy the current Country will be enabled and selected by 

default. 

The Source Drive dropdown list will show all available removable media drives on 

your system. Network drives and hard disks will not appear, as they are not valid 

sources for disc media copy. 

Check the all countries option to copy all image files for every country on the disc. 

Use the current country option to only copy file for the open country file.  

Set the Copy To option to point to the directory you want to store the image files. 

Each country will be stored in a separate subfolder underneath the copy folder. Use 

the Browse button to set a target directory. If the directory doesn’t current exist, it 

will be created for you. The recommended Copt To location is C:\EZSTAMP. 

The Check button can be used to determine how much data needs to be copied. 

This will be shown in the status bar when the file sizes have all been calculated. 
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If you are swapping discs, or inserting new removable media after the dialog 

window is already displayed, click on the Refresh button to update the dropdown 

list. 

When copying images, be aware that any files which already exist under the same 

name in the target directory will automatically be overwritten. 

The bottom status bar will indicate progress by file count, speed (in MB/Sec.), and 

percentage completed. The current folder being copied will also be shown. Note 

that the speed at which the copy takes place is dependent on many factors, such as 

media type, drive type, and your system in general. Depending on the volume of 

data to copy, it can take several minutes or more to copy all of the image files. 

Media copies from CD/DVD tend to be much slower when copying thousands of 

small files, which is the case here. 
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Removing Pre-Supplied Bitmaps 

With newer releases of EzStamp, pre-supplied stamp images are provided using the 

JPEG file format. This results in a significantly smaller file size. When EzStamp 

updates are providing images in JPEG format, the original bitmap (BMP) files will 

remain on your PC, if you chose to copy pre-supplied images to a hard disk 

location. 

This utility provides the ability to remove pre-supplied bitmap files from your hard 

disk. 

You should not remove pre-supplied bitmaps if you are using the export to 

AlbumGen features for version 2 of that application. Version 3 of AlbumGen 

supports JPEG image formats, among other types. 

Any custom image links you create using BMP format will not be affected. Pre-

supplied images are linked based on specific file names. If you chose to replace a 

pre-supplied image using the reserved pre-supplied image name, they will be 

removed. 

 

Image Location 

If the images are referencing a location on your hard disk, this path will be the 

current location based on your EzStamp preferences. Ensure this is the location you 

want to use for removal of bitmap images. 

Do Not Check Matching JPEG Option 

This option should only be checked if you are certain you want to remove pre-

supplied bitmap images knowing that matching JPEG versions of the file name have 

been installed to the same location. 
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Changing the Images Location 

Click on the Browse button to point to a different location for pre-supplied bitmap 

images. 

Selecting Countries 

Images are located in subfolders underneath the Images Location path. You choose 

the countries affected for image removal using the Select Countries button. 

Starting Image Removal 

Click on the Remove button to start. Once started, you can click on the Stop 

button to halt the task. Images are not sent to the Windows recycle bin, so take 

care in using this option. They will be permanently removed and can’t be restored 

unless you made a personal backup outside of EzStamp. 
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Converting Image File Formats 

This utility will allow you to convert image files from one format to another. 

 

Images are converted from the Source Path with backups of the original images 

being placed in the Backup Path. Use the ellipsis buttons to browse for new 

locations for source and backup images. 

The source formats are checked along with the format to convert to. Any images 

which are already in the target format will be left as is. 

For JPEG conversion, choose an image quality option. You may want to 

experiment with the conversion, but the medium choice is a good balance in quality 

vs. size. 

Check the Process Sub-folders option to convert all images inside subfolders in 

the source path. If unchecked, only the root files in the source path are converted. 

Click on Verify to confirm the number of  images detected for conversion and the 

total size of the image files found. 

Click on Convert to begin. At each image is converted, a backup of the original is 

placed into the Backup Path. You are responsible for removing the backup images if 

they are no longer needed. 

If you stop the conversion, you may resume at any time, but any images processed 

up to the stop point will already be converted with the appropriate backups being 

made. 
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Recalculating Country Totals 

Under normal operating conditions, EzStamp will maintain totals (record counts, 

quantities and currency values) automatically for you. However, in case you notice 

that totals seem to be “off” in a report, you can easily rebuild the country totals 

information quickly using this option from the Utility menu. Unless an unexpected 

error occurred in a country file, the totals should not need to be recalculated. 

Recalculating Grand Totals 

Each country maintains totals information. EzStamp will also maintain a grand 

totals list for every country file you have opened and inventoried at least one record 

on. Normally, grand totals are built and maintained automatically. However, if you 

add or remove country files outside of EzStamp’s provided mechanisms to support 

this (i.e. copy a country .SDF file manually from Windows Explorer), you are 

bypassing the grand totals tracking capabilities in EzStamp. 

The grand totals recalculation involves opening all country files you have installed, 

and extracting the country file’s individual totals information. As with country totals 

recalculations, you should never have to use this option unless you notice the grand 

totals are not matching the country totals when running a Grand Totals report. 

Recalculating Everything 

This option basically performs a country totals recalculation for your entire set of 

installed country files, including a grand totals recalculation on each one. Only use 

this option if you notice report discrepancies on more than one country file for 

calculated values. 

Exporting to AlbumGen 
You can send the current stamp information or use one of two multi-export 

methods to send more than one stamp to the AlbumGen application. AlbumGen 

export options can be found under the Extras menu. You must have AlbumGen 

installed on your system, and EzStamp must be configured to know where 

AlbumGen is located. EzStamp will attempt to find the location of AlbumGen 

automatically, but if this fails, you can manually set the path in the EzStamp 

general preferences. 

Linking to AlbumGen 

This is the simplest type of export to AlbumGen. Recall any stamp to the main 

EzStamp window, than choose the Link to AlbumGen option, or press the F2 key. 

The image information will be sent to AlbumGen. From within that application 

choose the Import from EzStamp option. The choice of Alternate Catalog ID and 

image priority for the export can be set in the general preferences. Note: EzStamp 

can’t export Scott numbers to AlbumGen. 
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Multi-Export to AlbumGen 

The multi-export option uses the Advanced Search window to set the input 

conditions to filter the stamp records which will be sent to AlbumGen. Refer to the 

Searches and Reports help section for details on this window. Once you have found 

at least one matching record, you can click on the Export button to send the 

records to AlbumGen. Then use the EzStamp Multi-import option from AlbumGen. 

Report View Export to AlbumGen 

The most flexible method to export to AlbumGen is by using the report viewer. This 

allows you to build export information using any search or report type available in 

EzStamp. In addition, this multi-export feature works on bookmarks, which 

provides the ability to send only a subset of the report data to AlbumGen. 

To use this type of export, run any search or report and display the results in the 

report viewer. Use the bookmark feature in the viewer to mark one or more 

records. Then choose the Export to AlbumGen option from the Bookmarks 

menu. 
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Snapshot Viewer 
The report viewer in EzStamp provides an option to save all or part of the report 

records to a Snapshot file. These files have an extension of .SNP and by default are 

saved to the Snapshots folder within the EzStamp installation path. 

The snapshot view is available from the Extras menu, and also as freely 

distributable standalone application which can be downloaded from the EzStamp 

web site. An example of the viewer window is shown below. 

 

The viewer provides a read-only copy of the report from which you saved to the 

snapshot file. The data grid and its contents are an exact copy of what you saw in 

the report viewer at the time of the save – there is no reference to a country file, as 

all of the information is contained in the snapshot file itself. 

The bottom of the window contains some basic information (the standalone version 

contains an Open file button not shown in the integrated version), including the 

description of the snapshot file, country of origin (by name and description), and 

some basic country settings: 

• Auto Calculation multiplier status for grades 

• NH Ratios Calculation multiplier status 

• NH Percentage Modifier status 
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• Currency format (number of decimal places) and conversion rate (1.0 = 

USD) 

• Version of the country file which contained the data 

• Effective date of the last pricing and supplied data applied 

• Number of records in the report 

• When the snapshot file was created 
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Washington Franklin Identifier (WFID) 
This utility is an optional component which is available in the Extras menu. To use 

it, you must have purchased on activation code to unlock it first. To activate your 

copy of WFID, you can contact SoftPro to obtain a code to unlock it for v8 of 

EzStamp. 

The WFID utility only works if the country file currently opened is USA.SDF or is 

derived from this country file. A custom country file without pre-supplied 

information based on USA is not permitted. 

Activating WFID 

To activate the utility, go to the EzStamp Activation option under the Help menu, 

select Washington Franklin Identifier from the dropdown list, and enter the 16 

character activation code you have been provided. Then click the Activate button to 

the right of the code you entered. If the feature is already active, the option will be 

grayed out and the code will be replaced with asterisk characters. 

An example of the WFID window is shown below. 
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The two portrait images in the upper right corner of the window are used to select 

the type of stamp to browse: Washington or Franklin. 

The bottom of the window is used to show up to 14 images at one time in a format 

similar to the thumbnail image viewer. If more than 14 matches are found, then 

you will notice 2 arrow buttons at the top right of the window, which allows for 

paging through the stamp images. 

The dropdown list fields are designed to work with each to refine a search. The 

starting point is always the Denomination. Once you choose from this list, all 

remaining lists will adjust. Each time you select an option from one of the other 

dropdown lists, the other lists will change their available choices as needed.  

Each time you select new choices in the list, the total match count will be adjusted. 

The Design Type button will be enabled for any stamp which contains special notes 

or information, much like the SPI button in the main EzStamp toolbar. 

When you click a stamp image in the grid area, it will be selected into the main 

EzStamp window. If you double click the image, the WFID window be closed. 

  



EzStamp Reference – Version 8.0 

Page | 347 
 

SRS (Stamp Recognition Software) 
This utility is an optional component which is available in the Extras menu. To use 

it, you must have purchased & installed SRS and activated it within Ezstamp v8.0.  

The SRS utility only works if the country file currently opened has SRS data to work 

with. A custom country file without pre-supplied SRS data is not permitted. 

Activating SRS 

To activate the utility, go to the EzStamp Activation option under the Help menu, 

select one of the SRS package types from the dropdown list, and enter the 16 

character activation code you have been provided. Then click the Activate button to 

the right of the code you entered. If the feature is already active, the option will be 

grayed out and the code will be replaced with asterisk characters. 

SRS Documentation 

SRS is an application which runs separately from EzStamp, even thought it can’t be 

used by itself, as EzStamp controls the interactions to it. Detailed documentation on 

the SRS application itself can be found in a separate user guide. 

SRS Options 

The SRS options can be found in a submenu under the Extras menu. 

 

1. Run SRS in automatic mode. 

2. Run SRS in interactive mode using either the Advanced Field Search or Power 

Search method. 

3. Recall the previous SRS results from the most recent Automatic or Interactive 

SRS search. 

4. Start SRS in batch mode. 

5. Recall SRS batch mode results allowing for batch and result file selections for 
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the current open country. 

6. This is a checkmark menu item. When checked, only Main numbers will be 

searched in SRS. 

7. This is a checkmark menu item. When checked, the power search method is 

used for SRS interactive mode. When not checked, the advanced field search 

method is used. 

8. EzStamp will attempt to automatically locate SRS on your system when you 

start the application. If EzStamp can’t locate SRS, or you want to specifically 

point to an SRS installation, choose this option to open a browse dialog 

window. 

 

Automatic Mode 

Automatic Mode will search the entire database for the country you currently have 

opened in EzStamp. It requires no intervention by you other than to select the 

option Automatic Mode from the SRS menu. 

To speed up your searches, you can elect to have SRS only search for main 

numbers in the country file. That means that item numbers such as 100a, 100b, 

etc. will not be looked at. In most cases, this is okay, but in some instances, where 

Scott has numbered single stamps from a sheet or pane with minor numbers, your 

stamp may not be found. For example, if Scott has assigned a number to a pane of 

20 as #1000 and the individual stamps as 1000a – 1000t, and if you scan in a 

single stamp from the pane of 20, do a search for Main numbers only, your stamp 

will not be found. Use the Process Main #s Only option in the SRS Menu to 

change this setting. 

Interactive Mode 

This option uses either the Advanced Field Search window or the Power Search 

window to define input conditions to restrict the list of stamp records to pass to 

SRS. Refer to the Searches and Reports help section for details on how to run the 

data searches. Once you build a matched record set, you simply choose the Run 

SRS option from either search window to launch the SRS application. 

Batch Mode 

When you choose this option from the SRS menu, the SRS application will 

immediately be launched by EzStamp. Refer to your SRS user guide for details on 

how to prepare images for batch recognition. Until SRS has finished, or you have 

chosen to stop the recognition process, you will not be able to launch SRS again. 

However, EzStamp is free to use without any waiting. SRS will continue to run on 

its own, and you can use any other functionality in EzStamp other than SRS. 
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When batch mode has completed or been stopped in SRS, you can recall the search 

results using the recall option. 

Recalling SRS Results 

SRS Status Indicator 

When running SRS in batch mode, a red “SRS” indicator will appear in the status 

bar of the main EzStamp window. This indicates that SRS is currently running and 

busy working on one or more batches. EzStamp will monitor SRS activity in the 

background twice every minute. If EzStamp detects that SRS has finished 

processing, the status indicator will turn green. If SRS is stopped without any 

recognition results, the status indicator will be turned off completely. 

Interactive/Automatic Recall 

When running interactive or automatic SRS modes, EzStamp will always display the 

stamp results in the Stamp List viewer, assuming you selected at least 2 stamps 

from the SRS results window. If you only selected a single stamp entry, then it will 

automatically be shown in the main EzStamp window after you close SRS. 

You can choose to recall the most recent SRS stamp list by choosing the 

Interactive/Manual recall option from the SRS menu. Assuming you have the 

country open which matches the SRS search results, they will be recalled to the 

main screen (1 match) or the Stamp List (more than one stamp result). 

Batch Mode Recall 

This type of search result from SRS is slightly more involved, as multiple images 

(there can be multiple images per batch file) and multiple batch files can be present 

in the SRS installation path. Neither SRS nor EzStamp will clean up batch mode 

result files automatically. The batch recall window provides this ability. 
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Automatic and interactive modes only have a single batch file based on a single 

image. As such, there is no selection screen required. For batch mode, this window 

shows all current SRS batch files on the left side, and SRS result files for the 

selected batch on the right side. Each result file for the selected batch file contains 

the stamp match list for each image in the batch. 

Use the Select Results File to recall the matching stamp records to the Stamp 

List. The original (i.e. scanned) image you provided in the batch to SRS will 

automatically be shown in the Image Compare window. 

You can delete the selected result files on the right side for the selected batch file 

on the left side by clicking on the Delete Results button. You can delete the 

selected batch files on the left side using the Delete Batches option. When you 

delete a batch file, all associated result files for the batch are also deleted. 

Note: Only batches which are associated with the current open country file will be 

displayed. If you need to remove all batch files for all countries, you will have to 

open each country file to do this via the SRS menu, or use Windows Explorer (or 

similar) to manually remove the .BTF and .BRF files from your system. 
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EzStamp General Preferences 
The first item under the Options menu will display the EzStamp general preferences 

window, which is a tabbed dialog organized into 8 sections. The tables which follow 

describe the settings under each tab. 

Right Click Quick Help 

You can right click any preference option to see popup help. Buttons within the 

dialog window also have popup help windows, but you must hold down the CTRL 

key while clicking a button for help. 

Resetting Preferences 

Click on the Reset button to initialize all preference options to default values which 

reflect a fresh installation of EzStamp. Your current settings are always saved to a 

file named EzStamp.cdt, located in the installation path. If you delete the CDT file 

from outside EzStamp and then run the application, the preferences will 

automatically be recreated using these default values. 

Exporting Settings 

Click on the Export button to save the current preference setting to a file of your 

choice. The file extension will be set as .CDT. You can restore the settings at any 

time using the Import button. 

 

General Settings I 

Automatically back up country files before opening 

Check this option to create a backup of the country (.SDF) file prior to opening it. You can 

use the Restore from Backup Files (Autobackup) utility to restore the previous backup. 

Only one level of restore is available and each time a country is opened, the previous auto 

backup is replaced. 

Automatically open the last country file when starting EzStamp 

Check this option to automatically open the most recently accessed country file when you 

start EzStamp. 

Keep a backup of the country when supplied updates are applied 

Check this option to retain a copy of the country file before applying pre-supplied pricing 

and data updates. Only one copy of the country file is retained, and will be replaced upon 

the next supplied update you apply. 

Automatically  add selected grades when saving to inventory 

When inventorying a stamp record, this option allows you to auto-commit selected grades 
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at the same time, avoiding the need to click on the Add Selected Grades button first. 

Autosave the stamp record from grid editors (FDC, PNB, PNC, Grade) 

When using the quick edit options for Grade, FDC Cachet, PNB, PNC, and priority 

want/sell list data, the changes are not updated to the country file when you apply them 

within the spread sheet editor. 

Check this option to force an auto-save of the stamp record when applying the edits from 

within the quick editor screen. 

Always refresh the stamp data when tabbing from Scott/Alt. Cat.  # 

Check this option to force a stamp record lookup when tabbing out of the Scott or 

Alternate Catalog fields in the main EzStamp window. This is the default behavior which 

mimics the same behavior of previous versions of EzStamp. 

Uncheck this option to disable the tab feature. When disabled, you can use the ENTER key 

to perform the stamp record lookup. 

Step to previous supplied on inventory deletions 

Check this option to automatically recall the previous supplied stamp record (by Scott #) 

when removing the current stamp from inventory. 

Include duplicates when using navigation stepping methods 

If this option is checked, then duplicate stamp records will count when stepping forwards 

and backwards using the navigation arrow buttons (green, blue and violet) in the main 

EzStamp screen. 

 

With this option disabled, you will need to use the smaller arrow buttons in the bottom 

status bar to step between duplicate stamps. 

FDC, PNC and PNB Copy/Paste = Duplicate and replace all data rows 

Check this option to enable full FDC, PNC and PNB data copy from one stamp record to 

another. If unchecked, only the selected data rows will be copied. 

Use faster in-memory method to sort reports 

By default, EzStamp will sort reports using a file-based method, which is slower, but 

consumes less memory. If you check this option, all reports will be sorted using your PC’s 

memory instead, which is significantly faster. If you are using an older PC with limited 

memory capacity, it’s recommended to leave this option unchecked. 

Slide show interval (sec.) 

When presenting a slide show of stamp records using the Navigation List feature of 

EzStamp, this value controls the delay between showing each stamp record. The value is 
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in seconds. 

Smart mouse cursor movement for dialog windows 

Check this option to enable smart mouse cursor movement when navigating between the 

various windows in EzStamp. The choice of the default "hot spot" for the cursor 

movement in each window is pre-determined and can't be changed. 

 

This option will not work on windows which are outside the EzStamp application, such as 

a file open dialog. 

Use quick entry for Priority Want and Sell Lists 

Check this option to use quick entry for Adding and Removing grades to and from the 

Priority Want/Sell Lists. With this option disabled, you will always be presented with a 

dialog window to allow for specific grade, quantity and type options. 

Set the Advanced From/To search window as default 

Check this option to use a more advanced set of conditions when running the various 

Search and Report options in EzStamp. The basic/advanced search dialogs also have an 

option to swap between the two modes without having to check the option here. 

Only items with sell prices count towards net profit values 

When displaying net profit values (based on sell and purchase prices), this option controls 

how net profit values are calculated. 

When this option is checked, net profits are calculated ONLY if there is a selling price 

present. If this option is unchecked, the net profit is always calculated, even without a 

selling price. 

Disable changed stamp warning messages 

There are many operations within EzStamp which could result in temporary changes (on 

the main EzStamp window) being lost if you didn’t save them to your inventory 

beforehand. This option controls the display of the warning dialog which allows you to 

back out before performing such an operation. If you check this option, no change 

warning dialogs will appear. 

Exclude image link file names in generic text Power Searches 

Power Searches have the ability to match your text-based search values against every 

text field associated with a stamp record, including the image link file names. This may 

cause unwanted matches when searching for basic text information such as Scott # or 

Denomination and Color. To avoid hitting an image link on a Power Search, check this 

option. 
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Copy full DOI data when adding new FDC Cachet records 

Check this option to transfer the entire Date of Issue field from the primary stamp data 

into new FDC Cachet records. If unchecked, then only the date portion is copied over. 

Potential Profit is based on purchase price / quantity 

Check this option to calculate potential profit values in reports based on the quantity of 

stamps in your inventory. For example, a purchase price of $500.00 with a market value 

of $1000.00 and quantity of 2 = a potential profit of $500.00 for 2 stamps. The potential 

profit will be $250.00. 

Potential Profit value is profit or loss per stamp 

Check this option to show the total potential profit for selling a single stamp for the 

associated grade. If unchecked, the potential profit will be what is gained (or lost) for all 

quantities in your inventory for that grade. 

Do not show losses on potential profit report totals 

Check this option to suppress showing any calculated losses (market value is below the 

last purchase price) in a potential profit report grand totals. Losses will be shown for each 

stamp item, if applicable, but that loss will not count towards the total profit of all items 

which did have a positive profit. 

 

General Settings II 

AlbumGen Export 1st and 2nd Catalog No 
When exporting stamp records to AlbumGen, you can send up to 2 catalog ID references 

per stamp. Use the 2 drop down lists here to define the first and second catalog ID values 

to send to AlbumGen. 

AlbumGen Export Image Link Priority 
EzStamp allows up to 5 images to be linked to a given stamp record. AlbumGen only 

allows a single image to be exported. 

Compact Country File Reminder Notice 
Over a period of time, additions, deletions, changes and pre-supplied data updates to 

your country files can cause them to grow in size due to data fragmentation, much like 

the hard disk on your PC. EzStamp has a built in monitor on each country file to detect 

when a certain amount of time has elapsed before reminding you to compact your country 

file to reclaim space and make the file as small as possible. 

 

You can change the interval on the reminder period or disable it altogether. If disabled, 

you can choose to compact the country files at any time using the Compact Country 

utility. 

Fill in Method for Dropdown Lists 

When you choose a value from a dropdown list, you may use the keyboard to begin 

typing a value to find. How the list is filtered to show possible matches is based on this 

preference setting. It’s recommended that you try each one to see which choice is easiest 
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for you to work with. 

X-Ref/Loc'n List Sort Method 
Your cross reference and location values retain a “most recent” history available on the 

main EzStamp window via the drop down lists. This option chooses whether to retain the 

history lists in alphabetical or most recently used sort order. 

List History Size 
The history lists for location and cross reference fields can have a maximum limit before 

the oldest used values are recycled. Set this value to 0 to have no imposed limit. This 

option doesn’t take effect if the lists are sorted in alphabetically order (for the latter sort 

method, the limit is implied to be 0, or no limit). 

Grid view height adjust 
There are many windows in EzStamp which make use of data grids (aka spread sheet 

views) to display information in rows and columns format. This setting can be used to 

increase or decrease the height of the data rows based on a percentage adjustment of the 

default row height. 

Date Input and Output Formats 
EzStamp displays dates using a pre-defined pattern for the day, month, and year values. 

It also uses a second pre-defined pattern for any input field where a date is expected. You 

select the patterns to use from the available values in the drop down lists.  

Note that the Date Output value can be used as a valid format for entering dates, as can 

any date which is currently in the format defined by the Date/Time settings for your PC. 

AlbumGen Path 
Before you can export stamp information to AlbumGen, you must provide the location to 

where AlbumGen is installed. Due to the way AlbumGen is installed, it’s not possible for 

EzStamp to auto-detect its location. Use the browse button to locate the AlbumGen.exe 

application file and its location will automatically be pasted into the path input box. 

Alternate Method for Data Connections for Cloud Backups and Updates 

This option will use a different method to exchange files between your PC and the 

provider for SoftPro cloud services. If you have any issues with connections for cloud 

backups or downloading updates, you can check this option. It’s possible that security 

settings with Windows and/or third party software may block the default connection 

method used by EzStamp. 

 

Display Options 

Show different colors for supplied and inventoried stamp fields 
Check this option to show a different background and text color for fields on the main 

EzStamp window where pre-supplied values are different from the inventoried values. 

 

To set the colors, change the Difference Color values under the Colors tab in the 

Preferences window. 

Use country file-specific labels for Cat IDs, X-Ref and Location 
Check this option to use country-specific labels for the Cross Reference, Location, and 

alternate catalog ID field names. This setting affects the main window labels, the Report 

Viewer and printed reports. 

Display Scott numbers as mixed case 
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Normally Scott numbers are displayed in the main EzStamp window using upper case 

characters. Check this option to display Scott numbers using mixed case characters. 

EzStamp main tabs and quick editors will use the same sort order 
Check this option to ensure that the quick editors for FDC Cachet, grade, PNB, PNC, and 

priority/want sell/list data retain the same order in the editor grid as in the main EzStamp 

window grid. 

Show PWL in main tab list 
Check this option to add a grid to the tab list of the main EzStamp window for the Priority 

Want list. 

Show PSL in main tab list 
Check this option to add a grid to the tab list of the main EzStamp window for the Priority 

Sell list. 

Show custom fields in main tab list 
Check this option to add a grid to the tab list of the main EzStamp window for the Custom 

fields for the current country. 

Disable automatic tooltip text for Report, Stamplist and Snap views 
Check this option to disable the automatic tooltip text which shows when you hover the 

mouse over cells in the following data grids: Report Viewer, Snapshot Viewer, and Stamp 

List Viewer. You will need to restart the application for this change to take effect. 

Show high currency values in a different color on report views 
Check this option to show a different background and text color in the Report Viewer 

window whenever a currency value exceeds the minimum amount shown in the Minimum 

High Currency field. 

To set the colors, change the High Value Color values under the Colors tab in the 

Preferences window. 

Displaying comments in the main window 
Stamp comments are normally displayed in a small area between the tabbed grid 

information and the main stamp details fields. EzStamp also allows you to display the 

comments in a sizeable floating window you can drag around independent of the main 

window. If you prefer to use the floating window, you can uncheck this option to allow for 

more space for the tabbed grid area. 

 

When displaying comments in the main EzStamp window, you can choose the vertical size 

of the comments area by choosing from a predefined set of values based on a percentage 

of the height of the application window. 

 

The stamp details/image area height can't be reduced, so any increase in the comment 

height will be deducted from the available height of the tabbed grid area. 

Changing Fonts for Text Box and Drop Down Fields and Data Grids 

Use these options to change the fonts for text box fields and data grid views which 

contain stamp details. If you want to slightly increase the size of the display text or 

change the font used, choose a new font and/or size from as needed. The reset buttons 

will change the font back to the EzStamp default name and size. 

 

Colors 

Grid Odd Rows 
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For on-screen grids and the report viewer, these are the text and background colors for 

rows 1, 3, 5, etc. 

Grid Even Rows 
For on-screen grids and the report viewer, these are the text and background colors for 

rows 2, 4, 6, etc. 

Grid Header 
For on-screen grids and the report viewer, these are the text and background colors for 

the header caption labels for each column of the spread sheet. 

Grid Highlight 
For on-screen grids and the report viewer, these are the text and background colors for 

date rows which are currently selected. 

Grid Cursor 
For on-screen grids and the report viewer, these are the text and background colors for 

selected cells. This color combination only appears for grids which allow individual cells to 

be selected. 

Grid Non-Editable 
For on-screen grids used by various edit windows, these are the text and background 

colors for cells which can’t be edited (aka read only). 

Grid Marked 
For the grades quick editor and the report viewer, these are the text and background 

colors for data rows which are marked for changes or bookmarked in the viewer. 

Help Hint Windows 
For the Quick Help message windows, you can set custom text and background colors. 

You can’t change the font type or font size for help hints. 

Difference Color 
You can indicate changes between pre-supplied data values and your inventoried values 

of the same fields using special text/background colors, which are applied to the main 

EzStamp window and the report viewer. 

 

You will also need to enable the appropriate preference/report option to display these 

colors. 

High Value Color 
You can enable high currency value color coding in the report viewer by enabling the 

preference option and setting a minimum currency value for which these colors will be 

displayed. 

Inventoried Record 
These colors are used to mark inventoried records in the report viewer. The color coding 

is applied to the record number column (left most) in the report view grid. 

Grid Lines 
This color is applied to all grid lines used for on-screen spread sheet views. 

Main Image Background: 
This color is used as the background color for the main EzStamp image area. 

Viewer Image Background: 
This color is used as the background color for the report and stamp list viewer image 
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areas. 

 

Image Options 

Clipboard Save Format 
EzStamp allows you to use the image links editor to paste in a stamp image from the 

Windows clipboard. This option determines what format will be used to save the clipboard 

image as a file. 

Image Quality 
For displayed images, this option controls the image rendering quality. If you are running 

EzStamp on an old PC, you may want to use a lower quality setting. 

 

Note that printed reports use an independent image quality setting defined in each 

report’s profile. 

Allow images to expand beyond 100% actual size 
This option controls if images displayed on screen will be expanded to larger than 100% 

size to fit the available image window area. 

Do not search the EzStamp CD/DVD/BD drive for image files 
Check this option to disable checking the CD/DVD/BD drive from which EzStamp was 

installed from for image files, if they can’t be located in other locations (i.e. the hard disk 

image copy path) first. 

Keep the main image area width no larger than its height 
If you are only using a single image display format on the main EzStamp window, and are 

using a high resolution display (i.e. 1920 x 1200 pixels or higher), you may want to make 

use of the image area by removing all the extra space in the upper right corner of the 

main window. 

 

If you check this option, the main image area will be constrained to be of equal width and 

height. 

Images 2, 3, and 4 use separate sub folder locations 
EzStamp can locate images using a segregated folder arrangement. If this option is not 

checked, all images (image 1, 2, 3, 4 and the FDC image) will all appear in the same 

folder, under the country name. 

 

If this option is checked, images will be split into additional subfolders. The primary image 

will be under the country folder still. Image 2 will be under a ‘2’ subfolder, image 3 under 

‘3’, 4 under ‘4’ and the FDC image under ‘FDC’. 

 

If you have no intention of using the same image file name for each image type (i.e. 

23.bmp is not the same for the primary image as it is for the FDC image), you can leave 

this option unchecked. 

Search for Images in the Alternate Image Location First 
With the option unchecked, the first search location will be the EzStamp application path. 

Report View Format 
When enabling the image previous option under the report viewer, the left side of the 

viewer window will be used for images of the current selected stamp. This option controls 

how many images will be shown at one time for the selected stamp record – the 
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arrangement will always be vertical format. 

Main Image View Format 
You can display from 1 to 4 images in the main EzStamp window, using a variety of 

arrangements. The number of images available may alter the arrangement selected for 

any given stamp. For example, if you define the display format as 2 images across by 2 

down, and only 1 image is available for the current stamp, then the arrangement defaults 

to a single image format. 

FDC Image Mode 
EzStamp allows for 5 images to be associated for a given stamp record: Primary, images 

2, 3, 4, and the FDC image. Since a maximum of 4 images are allowed to be shown, this 

option is provided to allow you to choose either image 4 or the FDC image for the last 

image to display. 

Supplied Images Location 
If you have copied supplied images to your hard disk, this path defines where they are 

located. The image copy utility will set this path name for you. If you ever change the 

path without using this utility (or copied the images manually from the CD/DVD masters), 

then you must manually browse for the image location. 

Alternate Images Location 
EzStamp allows you to specify an alternate image path which can be used separately from 

the hard drive image copy path. This is convenient as it allows you to keep your images 

separated from the pre-supplied set. 

 

By default, EzStamp will reference your images from within the Images subfolder of the 

EzStamp application installation path. If you prefer to isolate the images from where 

EzStamp is installed, then this path is what you will use to point to that image location. 

EzStamp CD/DVD/BD Drive 
When EzStamp is installed, the CD/DVD/BD drive which was used has the path name 

automatically saved. The path setting is based on the user who installed EzStamp. If you 

have multiple users logging into your PC, or you wish to reference images from a drive 

other than the one which was used to install EzStamp, you must manually change the 

drive location here. Use the ellipsis button to browse to a new location. 

Custom Image Storage Location 
When saving new custom images, you can choose 3 possible destinations for store the 

image files. You can change this location at any time, but any custom images in the other 

2 locations will remain there unless you move them or choose to archive the images to a 

backup. When restoring images from an archive, they all get restored to the location 

chosen here, even if they were backed up from 3 different locations. 

 

Thumbnail Viewer Options 

Selection Rectangle Transparency: 
When selecting stamp images in the thumbnail viewer, a rectangle will outline the 

selected stamp. This option allows you to set the transparency level. A higher value will 

allow more of the image underneath the selection rectangle to appear. 
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Viewer Background Color 
This color is used as the backdrop for all stamp images in the thumbnail viewer. 

Grid Line Color 
This color is used to draw the gridlines between the stamp rows and columns in the 

thumbnail viewer. 

Selection Rectangle Color 
This color is used to draw the rectangle around the current stamp selected in the 

thumbnail viewer. 

Label Color (Supplied) 
Pre-supplied stamps which are not part of your inventory will show the Scott number with 

this background color. 

Label Color (Inventoried) 
Stamps which you have inventoried based on pre-supplied data will show the Scott 

number with this background color. 

Label Color (Custom Inventoried Grades) 
Stamps which you have inventoried which have no pre-supplied (custom variety) data 

with at least one grade record added will show the Scott number with this background 

color. 

Label Color (Custom No Inv. Grades) 
Stamps which you have inventoried which have no pre-supplied (custom variety) data 

with at least no grade records added will show the Scott number with this background 

color. 

Number of Rows 
This value determines how many rows of images will be displayed in the thumbnail 

viewer. Note that you can drag the viewer to be larger or smaller, but the number of rows 

will not change. There are two sets of numbers, one for the normal country-only viewer, 

and a second set for the Global Search viewer. 

Number of Columns 
This value determines how many columns of images will be displayed in the thumbnail 

viewer. Note that you can drag the viewer to be larger or smaller, but the number of 

columns will not change. 

Label Text Color 
This color is used for the Scott number text below each stamp image in the viewer. 

Image Quality 
Thumbnail image quality can be defined using this drop down list. If you are running 

EzStamp on an old PC with limited performance, use a lower quality setting, or reduce the 

number of rows and columns to display. 

Label Font 
You can change the font to be used for the Scott numbers displayed below each image. 

Left click the font name to change the current setting. 

Image to Show 
The thumbnail viewer can only show 1 image per stamp record. This drop down prioritizes 

which image is displayed. If the stamp record doesn’t have an available image based on 
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your choice, the primary image will be substituted automatically. 

Allow images to expand beyond 100% actual size 
Check this option to allow images to exceed 100% of their actual size. In this case the 

image will grow to fit within the boundaries of each image cell in the viewer. 

Show grid lines between image rows and columns 
You can hide grid lines between stamp images in the viewer by un-checking this option. 

Show Scott # labels below each image 
You can hide Scott number labels displayed below each image by un-checking this option. 

 

Report Viewer Options 

Image Quality 
The report viewer image quality can be defined using this drop down list. If you are 

running EzStamp on an old PC with limited performance, use a lower quality setting, or 

reduce the number of rows and columns to display. 

Image Background 
When displaying in image column in the report viewer, this option is used to define the 

background color. 

Image Size 
When displaying an image column in the report viewer, this option is used to define how 

large the image cell will be. The columns of text data will be adjusted to match this 

height. 

Suppress Zero Override 
This option controls how the report viewer will display zero quantity and zero currency 

values. The default is to let the report profile (which has its own suppression setting) 

handle this. You can globally override the report profile at any time by using this option to 

always suppress or always show zero values. 

Display the alternate Catalog ID column on reports 
Check this option to globally enable the current alternate catalog ID value (as shown in 

the main EzStamp window) on all reports. Note that if you have added alternate catalog 

ID values explicitly into the field profile for a report, this option will have no effect on that 

particular report. 

Display the duplicate sequence # column on reports 
Check this option to show the duplication number on all reports. For example, a stamp 

which has been duplicated 2 times can show as 3 rows on the report viewer. This column 

allows you to see the duplication count on the report. If a report profile has been defined 

with the duplication field already, this option will have no effect. 

Enable search match columns on reports 
Enable this option to show all matching columns from a Power Search. For example, if you 

matched on Denomination and Color and it wasn’t in the field profile for a report, it will 

automatically be added to the right side of the column set. 

Image Caching 
The report viewer can speed up the display of reports which contain image columns by 

caching the images as smaller thumbnails on your hard disk.  
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Use the Clear Cache button to flush out the file list from your PC. If you want to have the 

cache auto-cleared when exiting EzStamp, enable the Clear Cache on Exit option. 

Note that if you change the size of the image cells, you will need to clear the cache or the 

previous sized images will be used. 

Auto hide empty columns on reports 
Check this option to automatically hide any column which contains no data for all records 

on the report. 

Use short column names on report views 
The report viewer can use either the Long or Short display names for column header 

captions. The short format will reduced the amount of horizontal scrolling needed to view 

the report data. 

Calculate grade net values using VF supplied prices 
Check this option to only use the Very Fine prices for any Mint and Used grades to 

calculate the Net Value. 

Group Header Colors 
If you include field data groups (PNB, PNC, Grades, FDC Cachet, PWL, or PSL) in a report 

field list, the header labels can be shown with different background colors, to better 

distinguish normal primary stamp information from the group columns.  

Printer Settings 

Printer Selection 
Each report profile can have a specific printer assigned to it. The general preference 

option allows you to have a master default printer assigned for every report, regardless of 

each report’s individual settings. 

 

Note: if you add or remove printers after EzStamp has been installed, you may need to 

refresh the printer list. For performance reasons related to some network-based printer 

configurations, EzStamp only builds a list of printers on demand. Use the Refresh Printers 

button to update the list. 

 

If you don’t select a printer, EzStamp will use the default printer assigned on your PC. 

Paper Size 
You can set a global paper size to be applied to all reports. If you don’t set a global paper 

size, the report will use the default paper size for the selected printer. 

Orientation 
The Default option will use the current paper orientation of the current printer. Use the 

other two options to enforce a specific page orientation for all reports. 

Apply this orientation, margins, paper and printer to all reports 
Check this option to enable global Printer, Paper Size, Orientation and Margin settings, 

which are basically the values you choose in the preferences window. If the option is not 

checked, the report profile’s internal printer settings will be used instead.  

 

The global setting is recommended if you intend to output the report using the same 

printer and paper size consistently regardless of the report type. 

Margins 
Global margins can be assigned for reports using these values. The header and footer are 
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based on the top and margins, and occupy space which is deducted from those margins. 

 

Margins must be entered in units of inches. 

Autosize all column widths for Multi Page Reports 
For a report type defined as multiple pages, this option will automatically adjust the 

widths for any columns which aren’t defined as multi-line format. A multi-line format 

column will still be restricted to the width defined in Master Report Fields list. 

Adjust Fit to 1 Page Reports to fill the page width 
For any report which only occupies a single physical page width, this option is used to 

proportionally enlarge each column’s width so that the grid size fully occupies the page 

between the left and right margins. 

Refreshing Printers 
EzStamp only creates a printer list when you install the application. If you add or remove 

printers after this time, you will need to refresh the available list of printers. This button 

performs this task and is identical to the Refresh Printers option in the main EzStamp 

menu. 

Resetting Preferences 

Click on the Reset button to initialize all preference options to default values which 

reflect a fresh installation of EzStamp. Your current settings are always saved to a 

file named EzStamp.cdt, located in the installation path. If you delete the CDT file 

from outside EzStamp and then run the application, the preferences will 

automatically be recreated using these default values. 

Exporting Settings 

Click on the Export button to save the current preference setting to a file of your 

choice. The file extension will be set as .CDT. You can restore the settings at any 

time using the Import button. 
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Customizations 
EzStamp provides several options to customize your copy of EzStamp. All of these 

customizations are located under the Options menu. 

Keyboard Shortcuts 

EzStamp defines a handful of default shortcut keys for the main EzStamp menu, 

most of them set according to previous versions of the application. You are free to 

redefine the keyboard shortcut mappings for EzStamp using the Keyboard 

Shortcut Configuration option under the Options menu. 

 

The shortcut list contains all of the items in the main EzStamp menu, grouped by 

the primary name in the menu bar. If a shortcut is assigned, the item will be 

highlighted in a different color to indicate this. Shortcuts can consist of a 

combination of the key on the keyboard and qualifiers, which are the CTRL, SHIFT, 

and ALT keys. Not every keyboard combination is valid for a shortcut. For example 

unqualified letters and digits are not allowed, as are keys reserved by Windows. 
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Toolbar Options 

 

1. Removes a shortcut from the selected item. You can also Right click the item 

to remove shortcuts. 

2. Assign or change a shortcut key. This option will bring up a small dialog 

window, prompting you to enter a valid shortcut. If the shortcut is already in 

use, a warning will be given – duplicate shortcut keys are not allowed. To 

cancel, you must click the small X in the caption bar of the window. 

3. Undo all changes you have made. 

4. Erase all keyboard shortcuts. 

5. Save keyboard changes. 

6. Cancel all changes and close the editor. 

7. Click the export button to save the keyboard shortcuts to a file. Keyboard 

shortcut files are saved with a .EKM extension. Use the import button to recall 

saved shortcuts from a file. 

 

Reverting to Pre-supplied Shortcuts 

Use the Revert option in the File menu to change the shortcut mappings to the 

default pre-supplied settings. 
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Menu Shortcut Buttons 

EzStamp’s main toolbar provides a limited set of buttons for the more frequently 

used options. If you find using shortcut keys cumbersome and prefer to have icons 

to click on to perform the equivalent menu actions, you can attach most menu 

items to shortcut buttons which will appear as a secondary window you can position 

alongside the main EzStamp window. The editor is accessible from the Shortcut 

Buttons Configuration item under the Options menu. The shortcut button 

window is displayed or hidden using the Command Shortcuts option under the 

View menu. 

 

The edit window shows available menu commands in the left side list and assigned 

commands on the right side list. Up to 5 sets of shortcut buttons can be configured. 

The current set of buttons is shown in the title bar (Set 1 to 5). The bottom area of 

the edit window shows the selected item’s description, location in the EzStamp 

menu, and any shortcut key attached to it. 
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Toolbar Options 

 

1. Removes the selected assigned items from the right side list. You can also 

Right click the selection on the right side list to remove them. 

2. Assign selected items from the available list in the left side list to the assigned 

items in the right side list. You can also right click the selection in the left side 

list to assign them. 

3. Undo all changes you have made. 

4. Erase all button assignments in the right side list for the current set. 

5. Move the selected items in the right side list up or down. Topmost items will 

be the first ones visible in the shortcut window. Hold down CTRL while clicking 

to move the selection to the top or bottom of the assigned list. 

6. Save shortcut changes for all 5 sets. 

7. Cancel all changes and close the editor. 

8. Click the export button to save the button shortcuts to a file. Button shortcut 

files are saved with a .ECF extension. Use the import button to recall saved 

shortcuts from file. Note: The import and export options work with the 

current set (1-5). If you export while working within set #2, then only set 

#2’s shortcuts are exported. 

9. These buttons change the current command set. The assigned and available 

lists will automatically be adjusted when you click on one of these buttons. 
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Resetting EzStamp Application Windows 

This option is available as Reset Application Windows under the Options menu. 

 

As indicated in the dialog notes above, nearly every window in EzStamp has some 

type of configuration element, such as a checkbox state, text field value, or the size 

and position of the window on your screen. This information is stored in special 

window configuration files in the CFG folder of the EzStamp installation path.  

The reset dialog provides only 3 checkbox options. This is based on the 3 main 

window types in EzStamp: 

• The primary window for EzStamp. 

• Supporting windows which can be positioned alongside the primary window, 

such as the Thumbnail Viewer or the Stamp List. These windows are 

displayed or hidden using items under the View menu. 

• Secondary windows, which is basically every other window in EzStamp. 

Resetting a window removes all customizations and settings on the windows, 

including their current size and position (if applicable). The window states will 

return to what they were when EzStamp was first installed. 
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Application Shortcut Links 

The Create Shortcuts item under the Options menu will allow you to create or 

update the shortcuts to the EzStamp application on the desktop and program start 

menu. The shortcuts will also include updates to the help files and the EzUpdate 

application. 

 

In order to avoid any issues with UAC (User Access Control) under Windows 

Vista/Windows 7, EzStamp will not try and access any restricted areas of your 

Windows installation which would otherwise require Administrator rights or UAC 

permissions. Shortcuts to the desktop and program start menu are created by the 

EzSetup application with ownership set to the user who runs EzSetup. 

If you run Windows under a different user, the shortcut links will need to be 

updated for the new user. This dialog will perform that task. 

In addition, if you elect to copy EzStamp from one location to another, you can 

easily re-point the shortcut links to the new location. 

The checkbox option is for updating the Desktop shortcuts. If you don’t check this 

option, then shortcuts are only updated to the program start menu. 
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Setting the Grade Data Display Order 

The Grade Display Order submenu under the Options menu allows you to control 

how grades are sorted in the Grades tab of the main EzStamp window. There are 4 

options in this submenu. 

Inventoried Grades This sort order (the default one) will always prioritize the 

inventoried grades to come first. 

Priority Want List Priority Want List grades will be sorted first. 

Priority Sell List Priority Sell List grades will be sorted first. 

Default Grade Order The grades will always retain the default order as defined 

in the Grades Configuration editor. 

 

In addition to these 4 sort orders, you can click any column in the grades data grid 

to sort the data in ascending or descending order. 

Setting the Fields to Display in the Tabbed Grid Area 

For Grades, PNC, PNB and FDC Cachet data grids, you can choose which fields you 

want to display in the grid area of the main EzStamp window. These options are 

available in the Field Display Filter for Tabbed Data submenu under the 

Options menu. 

NOTE: This dialog window is also used to set the fields to display for report profile 

which contain data groups for Grade, FDC Cachet, PNB and PNC data. 
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The left side list is the available fields to show in the data grid. The right side list is 

the assigned fields. The top to bottom ordering in this list corresponds to the left to 

right ordering of these fields in the main EzStamp window data grids. 

Toolbar Options 

 

1. Removes the selected fields from the right side list. You can also Right click 

the selection on the right side list to remove them. 

2. Assign selected items from the available list in the left side list to the right 

side list. You can also right click the selection in the left side list to assign 

them. 

3. Undo all changes you have made. 

4. Erase all field assignments in the right side list. You can’t save an empty list, 

so at least one field must be assigned. Use the Reset menu option to restore 

the assignment list back to the default fields. 

5. Move the selected items in the right side list up or down. Hold down CTRL 

while clicking to move the selection to the top or bottom of the assigned list. 

6. Save the filtered field list. The main EzStamp data grid will update 

accordingly. 

7. Cancel all changes and close the editor. 

 

Custom Grid Field Display Files 

Given the number of combination of fields for the spreadsheet grid tabs in the main 

EzStamp window, a Save Custom File option is provided to save the current 

assigned fields to a customization file in the User folder of the application. The 

customization files represent temporary field settings for the main window data 

grids. When you close down EzStamp and restart the application, your default field 

settings will be applied. Custom field files are a quick way to change the fields in 

the EzStamp data grids without having to generate a new default field list each time 

you want to hide or show fields in the grid. 

This option is available from the File menu. When you select it, you will be 

prompted for a description, which will also be used for the name of the file. The 

extension is applied for you automatically: 

.fgrd Grade field customized setting 

.ffdc FDC Cachet field customized setting 
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.fpnc PNC field customized setting 

.fpnb PNB field customized setting 

 

Choosing a Customized Field Display File 

Switching to a new set of fields to display in the main EzStamp tabbed grids is 

simple: right click anywhere in the data grid area of the tab you want to adjust the 

fields for, and choose the Custom Display Fields option from the pop-up menu. 

This will present a simple dialog window with a list of custom field files appropriate 

to the corresponding tab (i.e. FDC field settings files are the only ones which will 

appear when right-clicking from the FDC tab of the main EzStamp window). 

 

You can select any field settings file in the list then click Select to use that file. You 

can also Double-click the item in the list to select the file and close the dialog 

window at the same time. 

To delete a settings file, select it then click on the Delete button. 

To rename a settings file to a different name, click on the Rename button. 

To undo any custom field display setting in the EzStamp main window and restore 

the fields to the default set, click on the Undo button. Keep in mind that custom 

field settings are not retained once you close the EzStamp application. 
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Installed Printers Configuration 

EzStamp keeps a configuration file (EzStamp.pcf) for all installed printers on your 

system. This file is automatically generated when it isn’t found in the installation 

path (which is the case when you first install the application). The purpose of the 

configuration is to build a list of the printer capabilities (paper type and other 

printing attributes) ahead of time, which aids in making printer and paper selection 

fast.  

Some versions of Windows and certain types of printer installations (especially 

those across a network) can take several seconds to obtain the printer attributes. 

This would in turn make EzStamp quite slow in responding to paper and printer 

selections. 

Given this, you will want to refresh the printer configuration file after installing a 

new printer. There are refresh options under the Options menu, and also within 

the Report Profile editor and EzStamp general preference windows. 

 

Setting the Label Text for Country Fields 

Most of the labels associated with stamp fields are shared across all country files 

(i.e. Denomination and Color, Mint Price, FDC Net Value, etc.). However, 6 fields 

have labels which can be unique per each country: 

• Alternate Catalog ID fields (4 in total). 

• Location (Loc’n). 

• Cross Reference (X-Ref). 

The item Change Country Field Labels under the Option menu allows you to 

rename these labels. 
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Select one of the 6 label fields using the radio buttons. For each selection, the 4 

label names will be changed accordingly. There are 2 display formats for the label 

and 2 print formats. 

Click the Copy Display to All button to transfer the long format display name to 

the other 3 fields. Click on Reset to restore the labels to current global values 

stored in the report field configuration.  

The checkbox option at the bottom determines if the label names will be set 

globally in the report field configuration. If you check this option, then the labels 

are saved not only to the country file, but also to the master field labels which are 

shared by all the country files. If you only want to change the labels for the current 

open country file, make sure that you do NOT check this option. 
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Custom Catalog ID Numbering Formats 

EzStamp allows you to use up to 4 alternate catalog ID formats which can co-exist 

with the default Scott/Catalog ID number. With any pre-supplied or new country file 

you create, the 4 alternate formats are all set to use the Scott numbering system.  

This format is based on a group of 3 sets of 5 characters each, set one being 

numeric, set 2 alphabetical, and set 3 also numeric. However, sets 1 and 3 are 

optional in this format, and there some special validation rules which further restrict 

which numbers are allowed. 

If you need an alternate numbering format which fits within 15 characters (the 

maximum allowed for alternate catalog ID values), you can change the format 

using the Edit Catalog Numbering Formats item in the Options menu. 

 

There are 7 numbering formats available. Choose the Catalog ID to change from 

the dropdown list. The number of stamp records which currently are inventoried 

with the selected catalog format is shown to the right of this. If any values are in 

use, you will not be able to change the format. 

EzStamp Default This is the standard Scott number system format. 

A-N-A Three groups, alpha, numeric, and alpha. 

N-A-N Three groups, numeric, alpha, numeric. 

A-N Two groups, alpha, numeric. 

N-A Two groups, numeric, alpha. 

N Numeric only. 

A Any valid combination of letters and digits. This is basically a 
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format with no restrictions or formatting rules. 

 

As with the Scott format, the multi-group formats allow you to enter values without 

making use of all the groups. For example, under A-N-A format, the values A9 (3rd 

group not part of the value) and 9A (1st group not part of the value) are both 

acceptable. 

Each group which is part of the format must have a length assigned to it, of at least 

1 character and no more than 15. In addition, the total lengths of all groups in use 

can’t exceed 15 characters. 

A catalog format can’t use spaces between characters, can only contain digits, 

upper or mixed case letters, or the underscore characters. All other characters are 

invalid. 

The current saved formats are shown below the group length text fields. 

Click the Clear button to erase all assigned values for the selected catalog ID. This 

will remove all your ID values from the stamp records and you will not be able to 

recover them. 

Click the Export button to save a cross-reference index to a tab-delimited text file. 

All inventoried records which use the selected Catalog ID and have a value attached 

to the stamp will be saved to the file, along with the Scott number. 

Click the Import button to load a cross-reference file into your inventoried stamp 

records. You will need to use the exact same tab-delimited text format used for 

Exporting. The text file must have a header row, and the spelling of the header 

labels must be exact. Even though the export option shows Scott plus 4 columns for 

the alternate catalogue ID values, you don’t have to populate all the rows or all the 

columns for each Scott number. 
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Additional EzStamp Features 

Context-Sensitive and Quick Help Hints 

The main EzStamp window provides context-sensitive hint messages in the status 

bar at the bottom of the window when you move the mouse cursor over buttons 

and menu items. 

Hover over the blue checkbox: 

 

To see the hint message: 

 

In addition, you can get a more detailed popup quick help message displayed when 

right clicking on any button or label. 

Right click on Denomination and Color to see the popup help message: 

 

Tips of the Day 

The default status of the tips of the day is to show it when EzStamp is first started. 

You can use the similar named item under the Help menu to show the tips screen 

at any time. The tips dialog provides a checkbox option to turn it off, and also to 

step through all the tip messages. 
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About EzStamp and Sending Email 

The about dialog window is displayed when choosing the About EzStamp item from 

the Help menu. This window will show the current EzStamp build version in the title 

bar, along with some basic information about your installation of Windows. 

The Web site and Email links are clickable. The former item takes you to the 

EzStamp web site. The latter can be clicked to compose an email to SoftPro. The 

Send Email button works the same as clicking on the email address link. It will 

launch a simple email composition window: 

 

Enter your message text into the input box below the To and Subject lines, then 

click on Send. This will bring up your default mail client at which point you can 

send the message. 

Your contact information is automatically added to the end of the message, along 

with some basic information about your version of EzStamp and your Windows 

installation. SoftPro uses this information to help identify what version of EzStamp 

you are using and what your operating system is. It’s recommended that you don’t 

remove this information. 

If you need to change your contact information, click the Change Contact Info 

button before sending the email. 
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Checking for Free Updates 

SoftPro will provide free updates for EzStamp to address bug fixes and minor 

software enhancements. These updates basically cover most things in EzStamp 

except for supplied data and pricing updates and new images. 

Choose the Check for Free Updates option from the Help menu. EzStamp will 

check online for any pending updates. EzStamp updates are bundled in one or more 

archive files, each one containing a special date stamp which determines if your 

copy of the application is up to date. Only required archive files are downloaded, 

saving time and space. 

If EzStamp determines that your files are up-to-date, you will be notified with the 

message: Your installation of EzStamp requires no new application updates at this 

time. 

If any updates were downloaded, EzStamp will close down, and the EzUpdate 

application will be launched. Refer to the EzUpdate help topic for more information. 

Forcing a Full Update 

Note: Unless you are experiencing any strange behavior with either EzStamp or the 

Free Update process, do NOT perform the following action. 

EzStamp uses a special update history file named EzStamp.upd located in the 

EzStamp installation path. This file contains the to-date download activity on your 

PC for EzStamp updates. If you delete this file and run the free update option, 

EzStamp will perform a full download of every archive file, and EzUpdate will 

replace/update from each of these files. 

Checking for Updated CD/DVD Releases 

Choose the option Check availability of Updated CDs/DVDs from the Help 

menu to launch your default Internet browser and navigate to the SoftPro EzStamp 

updates web page. 
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EzStamp Color Guide 

EzStamp has built into the program a guide to aid in identifying shades of colors. 

The color guide displays three different sample stamps with identical color 

descriptions but varying shades of color. 

This option is available from EzStamp Color Guide option under the Help menu. 

 

When you start the color guide, a drop down list will be provided to choose a color 

from. 

You can view two colors at the same time so that on screen comparisons can easily 

be made. Just select the second color from the list to display a new set of three 

stamps below the original set. 

As always, great care should be taken with rare stamps. Always try to identify 

stamp colors by comparing to an actual stamp. Your monitor & video display 

settings play a big role in how accurate the stamps appear. 

  



EzStamp Reference – Version 8.0 

Page | 381 
 

EzStamp Envelope and Paper Guide 

To aid in the identification of US Envelope papers, the envelope and paper guide 

options is available from the Extras menu. This option is only available for the 

Unites States Revenues country file. 

 

The paper used for US envelopes varies widely. Not only does the shade of 

particular colors vary but the texture and quality of paper also varies. Keep in mind 

that each shade of paper can vary considerably from issue to issue and in many 

cases within the same issue. 

Always use the inside of the envelope to compare as the outside (stamp side) may 

be discolored, faded or soiled. 

There are also two major kinds of paper to consider as well as paper color. Laid 

paper, with very few exceptions was used on US envelopes up to 1915 when it was 

discontinued. Laid paper can easily be distinguished by the parallel watermarked 

lines which are easily visible when held up to a light. On envelopes, these lines run 

diagonally, while on wrappers, they run horizontally. Wove paper used from 1915 

to date does not show the laid lines and the paper is very uniform in texture. 
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Dealers, Suppliers and Auctioneers 

This option is available from the Help menu as a handy reference for reputable 

dealers and wholesale and retail philatelic suppliers. 

 

Simply choose a dealer/supplier from the drop down list and the associated 

information such as phone/fax numbers and contact details will be displayed for 

you. It can save you hours of hunting through ads for a dealer near you. 

Please note that SoftPro is not affiliated with any particular dealers. 
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EzUpdate – Applying Free and Supplied Data Updates 
As part of the EzStamp installation, a support application named EzUpdate is 

provided. This application is automatically launched whenever free updates are 

downloaded. You can manually run the application by choosing it from Windows 

program menu: 

 

EzUpdate has only one of two windows to display, the choice of which is based on 

the type of update. 

Free Updates 

For free updates, the EzUpdate window will appear as below: 

 

The window contains some basic information about the update: 

• A brief description of the update package. 

• The effective date of the update archive files. 

• The cumulative size of all files that were downloaded. 

The View Notes button can be used to see special information and release notes. 
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Click on the Install Updates button to install any changes from the downloaded 

archive files. Each file in EzStamp has effective date signatures contained inside of 

them. EzUpdate will ensure that only files which are newer or different from what is 

installed with your version of EzStamp is updated. Custom data files, exported 

information and custom images are never replaced, modified or deleted by 

EzUpdate. Only pre-supplied data is updated. 

Pressing F1 will provide a simple reference to this help topic. 

Note that you can’t cancel an update once started. However, if it didn’t complete, 

you can run EzUpdate again and continue from where you left off. You should 

NEVER run EzStamp until EzUpdate has completely applied the update, or you may 

experience unpredictable behavior. 

Supplied Data and Pricing Updates 

The EzUpdate window is slightly different for this type of update: 

 

You must use the Browse button to locate the update archive file (which will be a 

specially formatted .ZIP file). The archive files can be from online downloads, or 

distributed on CD/DVD/BD disc media. 

Once you select a file, it will be validated for authenticity and integrity. The 

description, date and size fields will be updated if the file passes validation. Any 

release notes for the update can be viewed by clicking the View Notes button.  
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Click the Install Updates button to start the update process. As with free updates, 

you can’t cancel the update, but can resume an update if it didn’t finish on a prior 

attempt. 

EzUpdate and Master/Country Data File Updates 

EzUpdate doesn’t contain any special functionality to apply updates to your country 

files or the EzStamp master configuration file (EzStamp.sdf). These updates are 

handled by EzStamp the next time you start it. Pending country file and master 

data updates are handled using special files stored in the Setup subfolder of the 

EzStamp installation path. EzUpdate will extract these files from the update archive 

and let EzStamp apply the updates from those files. For every country in the 

archive file, there will be one pending setup file for EzStamp to apply to the 

associated country SDF file. 
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  PLEASE READ CAREFULLY        

SOFTPRO 2001 LICENSE AGREEMENT 

The use of this package indicates your understanding and acceptance of the 

following terms and conditions. This license shall supersede any verbal or prior 

verbal or written statement or agreement to the contrary. If you do not understand 

or accept these terms you must remove this software from any computer system 

that it has been installed on and discontinue its use. 

COPYRIGHT:  This product is Copyright (c) SoftPro 2001, All rights reserved. This 

product is protected by Canadian and United States copyright laws, international 

treaties and all other applicable national or international laws. This software 

application and any accompanying documentation, images or any other component 

may not be copied, translated, or reduced, in whole or part, to any electronic 

medium or machine or human readable form, without prior consent in writing, from 

SoftPro 2001. SoftPro 2001 does not transfer title to the software package to you. 

You have the non-exclusive, non-commercial use of the software package. SoftPro 

2001 retains the full and complete title to the software package, and all intellectual 

property rights therein. 

PROPRIETARY RIGHTS AND RESTRICTIONS: Subject to this Agreement, 

SoftPro 2001 retains all copyrights, trade secret rights, patents, trademarks, and 

any other proprietary rights covering or relating to this software package. You 

acknowledge that the software package includes or incorporates proprietary and 

confidential information belonging to SoftPro 2001. All rights not expressly granted 

by SoftPro 2001. in this Agreement are reserved. All images supplied with the 

software are copyright protected and may not be used for any commercial use. 

EzStamp and all supplied images are strictly for PERSONAL use. You may not 

modify or alter the application executable code or any associated files. You may not 

attempt to unlock or bypass any copy protection or registration authentication 

algorithm incorporated in the program executable. You may not remove or modify 

any copyright notice, nor any dialog screens containing such copyright notices. 

LIABILITY DISCLAIMER: This software package and/or license is provided 'AS 

IS', without any representation or warranty of any kind, either express or implied, 

including without limitation any representations or endorsements regarding the use 

of, the results of, or performance of the product, its appropriateness, accuracy, 

reliability, or correctness. In no event shall SoftPro 2001 be liable for any losses, 

direct, indirect, consequential, or incidental damages arising out of use, the results 

of use, or inability to use this product. SoftPro 2001 does not warrant that the 

operation of the software package will be uninterrupted or error free. The entire 

risk as to the results & performance of this program is assumed by you. 



EzStamp Reference – Version 8.0 

Page | 387 
 

LIMITED WARRANTY:  SoftPro 2001 warrants that the physical contents 

(CD/DVD/BD) to be free from defects for a period of thirty (30) days from the date 

of purchase.  In the event of notification within the warranty period of covered 

defects in material or workmanship, the defective components will be replaced so 

long as you mail, freight prepaid, the defective material to SoftPro 2001. This shall 

be the sole remedy for breach of this warranty & shall be limited to the replacement 

of the defective CD/DVD/BD.  

OPERATING LICENSE: One registered copy of EzStamp may be used by a single 

person who uses the software personally on one or more computer systems or by 

multiple persons on a single workstation non-simultaneously. 

Use of EzStamp over a LAN (Local Area Network), or a WAN (wide area network) is 

strictly prohibited under any circumstances. 

BACKUP AND TRANSFER OF LICENSE RIGHTS: You may make one copy of the 

program solely for back-up purposes as prescribed by Canadian, United States, and 

international copyright laws. You may not transfer the software package to any 

other person or third party. This license is effective until it is terminated. You may 

terminate the license by destroying the software package in its entirety, including 

any back-up copy you may have made. This license also terminates if you fail to 

comply with any terms or conditions of the license agreement. You agree upon such 

termination to destroy all copies of the software package and any associated 

documentation, or to return them to SoftPro 2001.  

You may not redistribute, sell, decompile, reverse-engineer, disassemble, or 

otherwise reduce the Software to a human-perceivable form. All other rights and 

restrictions not specifically granted in this license are reserved by SoftPro 2001. 

YOU MAY NOT PUBLISH, DISTRIBUTE OR MAKE AVAILABLE ANY PORTION 

OF THE SCOTT NUMBERING SYSTEM WHICH IS USED UNDER LICENSE 
SCOTT PUBLISHING Co.. ALL RIGHTS RESERVED. 

 The marks SCOTT and SCOTT’S are Registered in the U.S. Patent and Trademark 

Office, and are trademarks of Amos Press, Inc. dba Scott Publishing Co. No use 

may be made of these marks or of material in this publication which is reprinted 

from a copyrighted publication of Amos Press, Inc., without the express written 

permission of Amos Press, Inc., dba Scott Publishing Co., Sidney, Ohio. 
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